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1 About the Basic FEA 
System 
Introduction

COSMOS/M a complete, modular, self-contained finite element system devel-
oped by Structural Research and Analysis Corporation for personal computers 
and workstations. The program includes modules to solve linear and nonlinear 
static and dynamic structural problems, in addition to solving problems in the 
fields of structural optimization, heat transfer, fluid mechanics and electromag-
netics. Modules for special problems like fatigue are also available. The system is 
constantly developed and maintained by using state-of-the-art techniques along 
with up-to-date hardware capabilities. It is designed to satisfy its users needs. The 
modularity of the system facilitates its upgrading as the needs of the user grow.

The Basic FEA System is composed of three modules: GEOSTAR for model cre-
ation and results display, STAR for linear static analysis, and DSTAR for buck-
ling and modal analysis. The integrated system lets you model, analyze, and 
evaluate your design within one graphical environment.

This chapter focuses on presenting some of the salient features of finite element 
modeling and analysis you can apply using the Basic System. The mathematical 
background for some of the analysis features presented here are explained in the 
next chapter. To preserve clarity in presentation, and moreover owing to space 
limitations, the documentation for GEOSTAR is provided to you separately in 
two parts: COSMOS/M User Guide (V. 1), and COSMOS/M Command Manual 
(V. 2).
COSMOS/M Basic FEA System 1-1
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✍ The Basic FEA System or Basic System quoted throughout this manual there-
fore refers to linear static, natural frequency, and buckling analysis only.

COSMOS/M Structure

The COSMOS/M system consists of a pre- and postprocessor, various analysis 
modules, interfaces, translators and utilities as shown in Figure 1-1. The Basic 
System modules, highlighted in the figure, are the ones that are most commonly 
used for the evaluation of mechanical systems including linear static, buckling, 
and natural frequency and mode shape analyses.

Figure 1-1. COSMOS/M Modules and Translators

GEOSTAR module is the pre- and postprocessor of the COSMOS/M finite ele-
ment system. It is the nucleus of the COSMOS/M system, providing the graphical 
user interface (GUI) for geometric modeling and finite element analysis. In a typ-
ical COSMOS/M session, you will first enter GEOSTAR, build your model using 
various geometry and meshing tools, apply loads and boundary conditions, and 
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then subject it to analysis. At this point, you will automatically exit GEOSTAR 
and link up with the required COSMOS/M analysis module. After completion of 
analysis, the program automatically returns to the GEOSTAR graphical environ-
ment for postprocessing.

GEOSTAR is an interactive full three-dimensional CAD-like graphic geometric 
modeler, mesh generator and a powerful tool for FEA pre- and postprocessing. 
The user can create the model, provide all related analysis information, choose 
the type of analysis, review, plot and print the results, without leaving the GEO-
STAR screen. The program is powerful, intuitive and easy to learn. The average 
user can quickly learn to create and solve real life problems after a few hours of 
training.

The GEOSTAR program, as shown in Figure 1-1, controls the analysis modules 
and provides an interaction environment among them. These modules are as 
shown below in Table 1-1:

Table  1-1. Functions of COSMOS/M Modules

In addition, GEOSTAR can transfer data and information between COSMOS/M 
and other CAD and FEA packages, as shown in Figure 1-1. These programs are:

Table  1-2. COSMOS/M CAD and FEA Translators

Basic System
STAR
DSTAR

Linear Static Analysis
Buckling, Frequency and Mode Shape Analysis

Advanced 
Modules

ASTAR
ESTAR
FSTAR
HSTAR
NSTAR
OPTSTAR
HFS Suite
FLOWPLUS
FLOWSTAR

Advanced Dynamic Linear Analysis
Electromagnetic Analysis
Fatigue Analysis
Heat Transfer Analysis
Nonlinear Static and Dynamic Analysis
Structural Optimization
High Frequency Electromagnetic Analysis
Turbulent Fluid Flow Analysis
Fluid Flow Analysis (discontinued)

CAD
IGES
DXF

FEA

ABAQUS
ANSYS
NASTRAN
PATRAN
SINDA
TEAP
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Basic System Modules

The Basic System consists of two main modules STAR and DSTAR, and a sub-
module, STRESS, which performs stress calculations. These modules interact 
with each other as shown in the figure below:

Figure 1-2. Basic System Modules

The linear static analysis module (STAR) uses the linear theory of structures, 
based on the assumption of small displacements, to calculate structural deforma-
tions. For many structures (for example, frames), the computation of stresses is 
often unnecessary. To provide this flexibility, the computation of stresses is 
performed in a separate submodule called STRESS in COSMOS/M. The module 
STAR calls the STRESS submodule to calculate the element and nodal stresses 
for most elements. The DSTAR module evaluates natural frequencies and the cor-
responding mode shapes of a system. The module can also calculate the buckling 
loads and the associated mode shapes. For modal analysis, the STRESS submod-
ule also calculates the element and nodal virtual stresses for most elements based 
on the results from DSTAR.

The Linear Static Analysis Module (STAR) 

STAR uses the linear theory of structures, based on the assumption of small 
displacements, to calculate structural deformations. As mentioned earlier, STAR 
calls the STRESS submodule to calculate stresses. The STRESS submodule 

Basic FEA System

DSTAR
Natural Frequency

DSTAR
Buckling

STAR
Linear Static

STRESS
COSMOS/M Basic FEA System 

http://www.cosmosm.com


Part 1   Linear Statics, Modal, and Buckling Analysis
calculates element and nodal stresses for most elements based on the results from 
STAR or DSTAR (modal analysis only). Stresses for multiple load cases are 
obtained in a single run and the combination of load cases is possible in the post-
processing stage. Stresses can be obtained in any defined coordinate systems. The 
STRESS module supports all of STAR features.

In a typical linear static stress analysis, you will determine the stresses, displace-
ments, strains, and reactions in the finite element model. The analysis is linear if 
the nonlinearities due to various sources can be either linearized or completely 
ignored. Results from a linear analysis include nodal displacements, nodal and 
element stresses, forces, reactions, etc. These results can be graphically viewed 
on the screen or inspected in the output file.

The following are some important features of the linear static stress analysis 
module STAR:

• Extensive element library (see Chapter 5, Element Library).
• Isotropic, orthotropic, anisotropic and composite material properties.
• Temperature-dependent material properties.
• Failure criteria for composite elements.
• Prescribed displacements, with or without other loadings.
• Coupled degrees of freedom and constraint equations.
• Thermal, gravitational and centrifugal loads.
• Beam loading.
• In-plane effects in the stiffness evaluation (geometric or differential stiffness).
• Multiple load cases in a single run.
• Soft spring option to prevent instabilities.
• Substructuring capability (for large problems) to build and analyze the chosen 

superelements through condensation and recovery process.
• Fluid-solid interaction.
• Gap-friction problems.
• Grid-force balance and reaction force calculation.
• Asymmetric loading of axisymmetric models.
• Strain energy and error calculations.
COSMOS/M Basic FEA System 1-5
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• 2D and 3D crack element options: the program computes the stress intensity 
factors for all three modes of fracture.

• Adaptive P-, H- and H-P versions of the adaptive finite element method, 
including three dimensional problems using tetrahedral elements.

• Bonding of (or connecting) non-compatible parts at the common boundary 
of the same model even if nodes and element types do not match. Solid-solid, 
solid-shell and shell-shell bonds can be made by specifying the interface 
geometric entity. This feature can be used to make curve-to-curve, curve-to-
surface and surface-to-surface bonding of your models with non-compatible 
meshes; see Chapter 8, Modeling Guidelines, for more information. The 
figure below shows an example where the bond capability can be applied. 
This model consists of tetrahedron solid elements in the hull of the missile to 
which the fins modeled with shell elements are connected.

Figure 1-3. Bonding of Non-Compatible Element Meshes

Nodes DO NOT Need to Match 
at the BOND Interfaces

Enlarged View of theFinite 
Element Model of a Missile
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• Combining Static and Dynamic Analysis Results: you can link the results of 
an advanced dynamic analysis (performed in the ASTAR module) at any spec-
ified time step or frequency with static analysis results during postprocessing; 
see Chapter 10, Postprocessing, for more information.

• Coupling of Analysis Results: you can link the results of other COSMOS/M 
analyses, such as heat transfer, fluid flow, and electromagnetics, to include 
their effects as loads in the stress and strain calculations performed in the 
Basic System. This coupling is unidirectional (see Chapter 12, Multidisci-
plinary Analysis) for performing interaction analysis, as indicated in the fol-
lowing figure.

• Submodeling:
After you run your problem with a relatively coarse mesh, you may define the 
areas of concern as submodels where stresses may not have been calculated 
accurately due to sharp corners, geometric non-uniformity, and/or load con-
centration. With submodeling, you need only to solve for the areas of concern. 
Submodeling accelerates the job of obtaining accurate results in areas of stress 
concentration.

• Multi-Thermal load cases:
a. User-defined nodal temperature profiles may be defined for every primary 

load cases.
b. Transient thermal stress analysis where temperature profiles are read 

directly from the results of thermal analysis. The temperature profile from 
a particular time step may be assigned to a primary load case. Results are 
then calculated for all load cases as usual.

• ASME stress check:
An evaluation of stress results of FEA solution in a form suitable for compar-
ison to the ASME code section III stress requirements is formulated. Formula-
tions are developed to compute the membrane, bending, peak stress intensities 
on arbitrary cross-sectional slices.

• Saving of the decomposed stiffness matrix:
The decomposed stiffness matrix from static, frequency or buckling analysis 
is saved for subsequent run by any other analysis to save time and effort by 
reading the decomposed matrix rather than recalculating it.

• Inertia Relief:
Balancing the external load on the accelerating bodies such as rockets by their 
inertia forces.
COSMOS/M Basic FEA System 1-7
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• Automatic Rigid or Hinge connection:
Rigid or Hinge connections at the interface of incompatible solids and shell 
elements with mesh continuity at the interface.

• Support of ADAMS software:
A direct interface is established between STAR and ADAMS, a product of 
Mechanical Dynamic Inc., is a leading kinematics and dynamics program. 
The interface enables you to model real working conditions of your designs 
by including flexural and kinemetic effects. Loading conditions from 
ADAMS may be exported to COSMOS/M.

• Application of the J-integral:
You may use the J-integral in addition to the crack element to compute the 
stress intensity factors. Available both for rectangular (PLANE2D) and trian-
gular (TRIANG) elements.

• Large File managements:
You may direct some of the major files of the database to other available 
drives in order to avoid running out of disk space. You may also instruct the 
program to break the large files into several segments and write each segment 
to a different drive.

Figure 1-4. Interaction of Other Analysis Modules with the Basic System
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Frequency and Buckling Analysis Module (DSTAR)

The DSTAR module evaluates natural frequencies and the corresponding mode 
shapes of a system (modal analysis). The module can also calculate the buckling 
loads and the associated mode shapes of eigenvalue buckling problems.

In a typical buckling analysis, the quantities to be computed include the critical 
loads at which the structure becomes unstable, and the corresponding buckling 
mode shapes. For eigenvalue buckling, the first few modes are of practical impor-
tance. The buckling modes can be plotted or animated during postprocessing. 

Modal analysis which determines the natural frequencies and mode shapes is an 
important phase in the design of many structural components. Similar to buck-
ling, modal analysis involves the computation of eigenvalues, and DSTAR pro-
vides many types of eigenvalues extraction techniques. The vibration modes can 
be plotted or animated on the screen. 

The following are some important features of the DSTAR module:

• A variety of eigenvalue extraction procedures:
- Subspace iteration,
- Lanczos,
- Jacobi,
- Inverse power iteration (one pair only),
- Guyan Reduction.

• Frequency shift to calculate eigenvalues in a specified range or to treat models 
with rigid body modes.

• Sturm sequence to check for missed modes.
• Lumped and consistent mass matrices for representing structural mass.
• In-plane effects on stiffness.
• Soft-spring option to treat models with rigid body modes.
• Modal analysis of Piezoelectric Materials: calculates natural frequencies and 

mode shapes using Hexahedron SOLID elements to account for coupling 
between elastic and electric fields of piezoelectric materials.

• Non-axisymmetric mode extraction for axisymmetric models.
COSMOS/M Basic FEA System 1-9
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• Guyan Reduction:
During design, when changes are being made, Guyan reduction would save 
significant time. The reduction enables the analyst to exercise some degree of 
control over the extraction process, selectively ignoring those modes which 
are of no or little value to a specific analysis of large complex models.

• Automatic Rigid or Hinge connection:
Rigid or Hinge connections at the interface of incompatible solids and shell 
elements with mesh continuity at the interface.

• Large File management:
Partitioning of Large files (such as Stiffness Matrix file) into several drives/
directories.

• Spin Stiffening:
Accounting for the large displacements effect for spinning structures.

• Interface with the Nonlinear Module (NSTAR) for Frequency and Buckling 
analyses (Refer to the Advanced Modules manual).

• Bonding of noncompatible meshes (similar to the one described for Static 
Analysis).

Basic FEA System Limits

The pre- and postprocessing module GEOSTAR and the analysis modules STAR 
and DSTAR which constitute the Basic System, have the following size limits. 
The tables below list these limits for the full version only. 
COSMOS/M Basic FEA System 
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Table  1-3. Modeling Size Limits Modeling in GEOSTAR

* GEOSTAR versions supporting 64,000, 128,000, and 256,000 nodes/
elements are automatically installed.

Quantity
Preprocessing

Size 
Limit

Quantity
Miscellaneous

Size 
Limit

Nodes 256,000* Consecutive zooms 10

Elements 256,000* Selection sets per entity 10

Keypoints 24,000 Number of saved views 10

Curves 24,000 Text messages 100

Surfaces 8,000 Function keys (GEOFUN file) 50

Volumes 2,000 Number of windows 4

Contours 5,000 Colors 256

Regions 5,000 Length of file (including path) 40

Polyhedra 100
Length of a parameter name 
(single variable, array, function)

10

Parts 100 No. of parametric arrays 20

Coordinate systems 5,000 No. of user-defined parametric functions: 200

Curves for contour 500 - Length of a function argument name 10

Contours for a region 120 - Number of arguments for a function 20

Surfaces/Regions for a 
polyhedron

1000 - Length of a function parametric expr. 200

Polyhedra for a part 60 Length of a macro name 10

Bond target surfaces 20 No. of arguments for a macro 10

Bond sets 100
No. of local user defined parametric 
variables in a macro

50

Material property sets 999
No. of local user defined functions in a 
macro

50

Real constant sets 5,000 No. of local arrays in a macro 10

Element groups 5,000
No. of command lines starting with # in 
the entire session file or macro

500

Quantity
Postprocessing

Size 
Limit

Isoplanes 12

Section planes 12

Number of XY curves per plot 6
COSMOS/M Basic FEA System 1-11
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Table  1-4. Analysis: Limits in the Basic FEA System

Quantity Size Limit

Degrees of freedom No Limit

Primary load cases 50

Secondary load cases 50

Coupled degrees of freedom 1,500

Constraint equations 1,500

Temperature curves
   - Points for a temperature curve

100
5,000

Superelements
   - Super nodes for a superelement
   - Degrees of freedom associated with a superelement

99
180

2,000

Prescribed non-zero displacements 3,000

Concentrated forces for beam loading 5

Distributed loads for beam loading 3

Number of eigenpairs 200
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2 Mathematical 
Background
Introduction
The previous chapter presented some of the important analysis and modeling fea-
tures of the Basic System. This chapter presents the mathematical background on 
some of the important features. COSMOS/M has been specially designed to solve 
finite element problems with a large number of degrees of freedom. The needs of 
a finite element analyst have been considered in all aspects of design. However, in 
view of the wide range of possible applications of the program, a high degree of 
generality and flexibility have been incorporated in many areas of the program. 
The information provided in this chapter may not discuss all aspects of application 
of the Basic System.

✍ This chapter only highlights some of the theoretical concepts applicable in the 
Basic System. For a detailed discussion of the finite element theory, please 
refer to the Theoretical Manual.

Mathematical Background
The types of analysis you can perform using the Basic FEA System include:

• Linear static analysis
• Eigenvalue buckling analysis
• Natural frequency and mode shape analysis
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In the following paragraphs, brief mathematical background for the above types 
of analysis are presented.

Linear Static Analysis

Static analysis deals with the computation of displacements and stresses due to 
static loads. The term static loads refers to loading that does not cause inertial or 
damping effects to be significant for consideration in the analysis. Static analysis 
is linear if nonlinearities due to plasticity, large deflection, large strain, in-plane 
effects, contact surfaces, creep and relaxation effects, and other sources can be 
either linearized or completely ignored. The procedure for performing a linear 
static analysis with modeling hints and guidelines is provided in Chapter 8, 
Modeling Guidelines and Chapter 4, Input Data Requirements.

The formulation of a linear static problem for solution by the displacement 
method is fully described by the matrix equation:

[K]{U} = {F} = {Fa} + {Fc} (2-1)

where [K] is the structural (assembled) stiffness matrix, {U} is the vector of 
unknown nodal displacements, and {F} is the load vector. The load vector {F} 
has components from mechanical, thermal, and gravitational loads (see Chapter 
7, Loads and Boundary Conditions, for information). The load vector {F} can be 
expressed as a combination of applied nodal loads {Fa} and reaction (or single 
point constraint) forces {Fc}. For linear static problems, each of these load vec-
tors are the superposition of mechanical, thermal, and gravitational loads as 
shown below:

{Fa} = {Fm} + {Fth} + {Fgr} (2-2)

The mechanical load vector {Fm} is computed as the sum of applied nodal forces 
and moments, and element pressures as shown below:

(2-3)

where {Fnd} is applied nodal load vector, and {Fe
pr} is the element pressure load 

vector. The thermal, and gravitational load vectors are computed as follows:
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(2-4)

where {Fnt} is the load vector of nodal temperatures, {Fe
th} is the element ther-

mal load vector, [Me] is the element mass matrix, and {a} is the acceleration vec-
tor.

If constraint equations (also known as multipoint constraints) which define rela-
tionships in displacements between nodes are used, equation (2-1) is partitioned 
and solved to eliminate some unknowns as explained in the next section. For 
specified boundary conditions (single point constraints) and prescribed displace-
ments, the structural stiffness matrix is partitioned as shown below:

(2-5)

where the subscript f refers to free dof's, and s refers to dof's with specified values. 
Equation (2-5) therefore describes the behavior of the structure under forces and 
fixed and/or prescribed motions.

Constraint Equations (Multipoint Constraints)

Constraint or coupling equations which are also known as multipoint constraints, 
specify a linear relationship of displacements between two or more nodes. The 
constraint equations provide one approach to modeling dependent dof's which are 
defined as linear combinations of one or more other dof's. The other approach to 
modeling dependent dof's involves the use of rigid links (RBAR element, for 
example). In COSMOS/M, only the selected components of dof's are considered 
in the constraint equation, and the remaining components of dof's at these nodes 
where the constraint equations are applied remain unaltered.

In COSMOS/M, a constraint equation is expressed as a homogeneous linear 
equation for the dependent dof's in terms of independent dof's as follows:

ui = a1u1 + a2u2 + a3u3 + ... + anun (2-6)

where ui represents the dof's to be constrained (dependent dof's), u1…un repre-
sent the other independent (or retained) dof's, and a1…an represent the constraint 
coefficients provided by the user. Equation (2-6) can be symbolically represented 
as:
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{Um} = [Cm]{Un} (2-7)

where {Um} is the vector of dependent dof's, {Un} is independent dof's, and [Cm] 
is the constraint equation matrix. The above equations are applied in equation 
(2-1) after partitioning both sides of equation (2-1) for dependent and indepen-
dent dof's. In addition, equilibrium conditions require the constraint forces to be 
added to equation (2-1) before the elimination of {Um}.

✍ The benefits of using coupling equations are many; see Chapter 8, Modeling 
Guidelines, and Chapter 11, Analysis Examples, for more information. 

In-plane Effects in Static Analysis - Stress Stiffening

For many slender structures with in-plane loading, the membrane forces alter the 
bending stiffness. Buckling occurs when the compressive membrane forces 
reduce the bending stiffness to zero for a kinematically admissible deformation 
mode. However, when the membrane forces are reversed (tensile instead of com-
pressive), then the bending stiffness is effectively increased. Thus, the structure 
becomes more stiff under tensile in-plane loads, exhibiting what is known as the 
stress stiffening effect. The stress stiffening or softening effect can also be consid-
ered in the computation of natural frequencies; see the section, In-plane Effects in 
Modal Analysis, for more information. Buckling is discussed separately in 
another section.

For these types of structures, the stiffness properties are a function of both the 
static loads and the deformed shape. While an accurate solution of such problems 
requires the use of geometrically nonlinear solution techniques, reasonable accu-
racy can be obtained by using the differential stiffness approach. In this method, 
it is assumed that the geometrically nonlinear problems can be approximated by 
adding a geometric stiffness matrix KG (also known as stress, initial stress or dif-
ferential stiffness matrix, or stability coefficient matrix) to the conventional 
structural stiffness matrix. The displacements are computed with respect to the 
original configuration of the structure, and the change in geometry is reflected 
only in the geometric stiffness matrix. It is also assumed that the magnitude and 
direction of the loads remain fixed during motion of the structure, and their points 
of application move with the structure.

Since the geometric stiffness matrix depends on the displacements, the linear 
static analysis is performed in two stages. In the first stage, the displacements 
{ui} are computed using the conventional stiffness matrix [K]. In the second 
stage, the geometric stiffness matrix [KG(ui)] is established based on the 
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computed displacements, {ui}, and added to the conventional stiffness matrix [K] 
to solve for the new displacements, {ui+1}. The finite element system of equa-
tions for linear static stress analysis in the presence of in-plane effects can there-
fore be written as:

([K] + [KG(ui)]){ui+1} = {F} (2-8)

Ideally, the displacements {ui+1} could be used to compute the new geometric 
stiffness matrix [KG(ui+1)] and hence compute yet another set of solutions, 
{ui+2}, and so on. The iterations can be carried out till successive solutions do 
not differ by more than the specified tolerance. However, if the applied in-plane 
(compressive) load is in the vicinity of the buckling load, the iterations may 
diverge, indicating instability. Such problems warrant the use of buckling analy-
sis, explained in another section. In COSMOS/M, the in-plane effects are consid-
ered by performing one iteration only. More options for these iterations are 
provided if you are using the nonlinear analysis module, NSTAR.

The geometric stiffness matrix in COSMOS/M is consistent, built from the same 
shape functions used to form the conventional stiffness matrix. It is symmetric, 
but unlike the conventional stiffness matrix, it does not contain terms with elastic 
moduli. It depends on the element geometry, displacement field, and the state of 
stress. The geometric stiffness matrix KG is in general indefinite, and hence can-
not be inverted. When used in buckling analysis, the overall structural stiffness 
matrix which is composed of the normal and geometric stiffness matrix becomes 
singular with respect to buckling modes.

✍ The in-plane effects in linear static stress analysis can be considered for 
only one load case.

Treatment of Rigid Body Modes in 
Static Analysis - Soft Spring Addition

A rigid (free) body mode of a structure represents motion without internal defor-
mations. In structural analysis, rigid body modes arise due to either insufficient or 
nonexistent constraints imposed on the structure. However, there are many analy-
sis problems where the imposition of constraints is not desirable, yet the deform-
able behavior of the structure under loads is of interest. For example, you may 
come across a stress analysis problem where an equilibrium state is maintained 
by the applied loads, thus requiring no constraints. Ordinarily, for such problems 
the program will execute unsuccessfully, indicating a message about singular 
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stiffness matrix. However, if you specify the option for soft spring addition, the 
program will automatically add a small stiffness to the diagonal terms of the 
structural stiffness matrix as shown below, enabling numerical stability during 
solution:

(2-9)

where kss denotes the stiffness added due to the soft spring option. The soft 
spring option is available for all types of analysis in the Basic FEA System, and 
is specified using the analysis commands (for example, A_STATIC (Analysis > 
STATIC > Static Analysis Options), etc.); see Chapter 9, Performing Analysis, 
for more information.

Singular stiffness matrices are also encountered due to ill-posed problems, i.e., 
models with very low or highly disproportionate elastic moduli and section prop-
erties. Owing to the solution method implemented, the use of soft springs is some-
times required when you use the gap (contact) elements in the Basic FEA System.

The treatment of rigid body modes in the analysis of natural frequencies can be 
accomplished in two ways: by using the soft spring option outlined above, and also 
by using the shift option in eigenvalue extraction. These methods are explained 
later in the section, Modal Analysis.

Substructuring

For the solution of very large finite element models, COSMOS/M provides a 
procedure known as substructuring in which the large structure is divided into 
smaller parts to be processed in separate executions. These executions generate 
data for a final merging operation where the solution for the combined structure 
is obtained. Following this, detailed solutions for each structure can be recovered 
in separate executions.
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In COSMOS/M, each substructure is known as a superelement. Each superelement 
is a complete disjointed structure and it can be connected to a main supported 
structure and/or other superelements. There are limits imposed on the number of 
superelements and their boundary nodes. It is possible to combine several super-
elements to form a pseudo superelement in what is known as multilevel substruc-
turing.

The static stress analysis of a model with substructures is performed in three stag-
es. In the first stage, each superelement is analyzed to produce a description of its 
behavior as seen at the boundary nodes. In the second stage, the matrices produced 
for each superelement are combined with the main structure and analyzed. In the 
third stage, the analysis of individual superelements is completed for displacement 
and stress recovery at all nodes. The following lines describe these operations in 
brief.

Consider a superelement for which the finite element system of equations can be 
written as:

[K]{U} = {F} (2-10)

The substructuring solution process involves partitioning the above equation to 
obtain partial solution. The partial solution is then merged into the total solution. 
For the superelement, with superscript I denoting the interior and B denoting the 
boundary, the above equation can be partitioned as:

(2-11)

where UI represents the displacements at interior nodes, and UB represents the 
displacements at boundary or superelement nodes. The above equation can be 
expanded to:

(2-12)

 

Solving for the interior displacements leads to:

{UI} = [KII]
-1{FI} - [KII]

-1[KIB]{UB} (2-13)

By inspection, the first term on the right hand side of the above equation is the 
solution that results from constraining the boundary degrees of freedom and 
applying the external loads on the interior nodes. It is therefore a partial solution 
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of the interior nodes. The remaining solution component at the interior nodes is 
given by applying the second part of the above right hand side in equation (2-12) 
which yields a partial solution due to the motion of boundary nodes as follows:

[[KBB] - [KBI] [KII]
-1[KIB]] {UB} = {FB} - [KBI] [KII]-1{FI}

i.e.,

[KBB]*{UB} = {FB}* (2-14)

where,

[KBB]* = [KBB] - [KBI] [KII]
-1[KIB] (2-15)

{FB}* = {FB} - [KBI] [KII]
-1{FI}

The above equations can be repeatedly applied to different superelements. The 
complete system stiffness matrix is given by the following equation:

(2-16)

where nel is the number of elements in the main structure, and nsel is the number 
of superelements attached to the main structure. Once the displacements on the 
boundary or superelement nodes are computed, the displacements and hence 
stresses in the individual superelements can be recovered using equation (2-12).

Cyclic Symmetry

There are some structures such as 
impellers in a gas turbine, pressure 
vessels, and many others made up of 
identical segments yet do not have 
planes of reflective symmetry. Even 
though there is an axis of symmetry, 
they cannot be analyzed as axisym-
metric structures since their geometry 
cannot be described as solids of 

Figure 2-1. A Cyclic Symmetry Structure

A B

A B
COSMOS/M Basic FEA System 

http://www.cosmosm.com


Part 1   Linear Statics, Modal, and Buckling Analysis
revolution. This type of symmetry is known as cyclic symmetry, sectorial symme-
try, or rotational periodicity. Instead of analyzing the entire structure, it is possible 
to model and analyze a representative substructure.

For a typical substructure shown in the figure above with interface boundaries A 
and B, the equilibrium equations can be written in the following form:

(2-17)

where {DA} and {DB} contain interface degrees of freedom along AA and BB 
respectively, and {DI} represents the interior degrees of freedom. The load vec-
tors {RA} and {RI} represent applied loads on the substructure whereas the load 
vectors {FA} and {FB} result from elastic deformations and are applied along the 
AA and BB by the neighboring substructures. Since all repeating substructures 
are identical, {DB} = {DA} and {FB} = -{FA}. Equation (2-17) reduces to:

 (2-18)

Linear Elastic Fracture Mechanics

The Basic System supports the analysis of linear elastic fracture mechanics prob-
lems for both 2D and 3D problems. There are three fundamental modes of crack 
opening as shown in the following figure. Mode-I represents the opening of the 
crack due to applied tension loading perpendicular to the plane of the crack 
whereas mode-II describes the solution around the crack due to shear loading par-
allel to the crack faces (in-plane shear). Mode-III describes the solution around 
the crack due to shear loading perpendicular the crack faces (anti-plane shear). 
Two different techniques are used to evaluate the Fracture Mechanics characteris-
tics as follows.
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Figure 2-2. Coordinates and Deformation Modes at the Crack Tip

Displacement Method

For mode-I, the stress and displacement fields in the neighborhood of a crack in 
crack tip coordinates (see figure above) have the following form (Irwin, 1961):

(2-19)

 

(2-20)

In the above equations, KI is known as the stress intensity factor for the opening 
mode. Each mode of fracture has a stress intensity factor dependent on the crack 
geometry and applied loading. The stress intensity factors are not related to stress 
concentration factors. The stress intensity factors not only describe the displace-
ment and stress field in vicinity of a crack tip, but also determine the elastic 
energy release rates (G) associated with a crack. The relation between K factors 
and G is:

G = (1 - n 2)(KI2 + KII
2)/E + KIII

2/E (2-21)
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J-Integral

For two dimensional homogenous models, along any curve S which is traversed 
in the counterclockwise direction between the two crack sides (Figure 2-3), the 
J-integral is defined as:

where:

 is the strain energy density, and

 ui = displacement in i direction

and,

ρi is the traction exerted on the body bounded by S and the crack surface

The J-integral vanishes in the 
absence of singularities. However, 
once there is a singularity such as a 
crack inside the path of integration, 
the integration becomes non-zero. 
The J-integral is a scalar measure of 
the state of straining at the crack 
tip. Characteristics of the crack 
such as the Stress Intensity Factor 
(K) are evaluated using the J-inte-
gral approach. It can be shown that 
this integration is path-independent 
and should be evaluated along a 
path chosen to give the greatest 
computational advantage.

The above formulation is only applicable for plane strain and plane stress models 
with no internal body forces. For axisymmetric models and problems with ther-
mal loads, additional terms should be added which include area integration of the 
fields inside the path.

Figure 2-3. A Crack Tip Enclosed by 
a J-integral Path

x1

x2

S
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Thermal Problems

In the presence of thermal loads, the J-integral is modified to the form:

where, 

A = Area inside the path
β = Coefficient of thermal expansion
δij = Cronecker delta (δij = 1 if i=j, and δij = 0 if i≠j)

T = Temperature

Axisymmetric Problems

For axisymmetric models, the J-integral is modified to the form:

where, 

Rc = Crack tip radius

R = Radius (distance of the point of integration from the axis of 
symmetry)

r, θ = Radial and tangential directions
A = Area inside the path

Main Features of J-Integration

1. Can be used for the rectangular (PLANE2D) and triangular (TRIANG) ele-
ments with or without midside nodes. Also available for plane strain, plane 
stress as well as axisymmetric models.

2. Can be easily defined for any circular path by specifying only a few parame-
ters.
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3. The path does not have to lie on the element edges and can pass through ele-
ments.

4. There is no limitation on the mesh formation (it can be generated as automatic 
mesh and does not have to conform to any symmetric patterns).

5. Evaluated entirely in the Stress module, therefore, can be modified and 
re-evaluated by rerunning of the stress module only.

How to Define the Path

The paths are defined as circles centered at the crack tip. The following steps are 
required to define the path and other characteristics:

1. Activate the J-integral evaluation flag (in A_STRESS).

2. Define the crack tip node.

3. Define the starting node on the path. This node specifies the crack radius as 
well.

4. Define the direction of the crack by specifying a node on the crack face (could 
be the same as starting node).

5. Specify the type of 
crack (half or full 
circle).

6. Specify the number of 
integration points on 
the path.

The above path character-
istics are specified by 
issuing a single command 
(J_INTCRDEF). The ele-
ments along the path as 
well as those inside (in the 
case of the area integra-
tion) are identified auto-
matically.

Figure 2-4. Nodes which Define a J-integral Path
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✍ Notes:
1. The path starting node should lie on the side of crack such that it would 

conform to the counterclockwise direction of the path.
2. The nodes on the two faces of the crack should not be merged in order to 

model the material rupture, due to the crack, properly.
3. You may define multiple cracks on the same model with more than one path 

for each crack. (Up to a total of 10 paths.)
4. Avoid passing the circular path through regions with high stress gradient or 

defining the path too close to the crack tip singularity.
5. In cases where the stress gradients are inevitably high, use more integration 

points. (You may wish to refine the mesh as well.)
6. You may use the J-integral in conjunction with the crack element (where it 

is available, i.e., higher order rectangular element). Using the crack element 
has the effect of increasing the accuracy of the calculated fields in the 
vicinity of the crack tip by moving the just-off-the-crack-tip-midside node 
to the element quarter points in order to produce the representative 
singularity conditions at the crack tip. (This increases the accuracy of the 
J-integration significantly where the path is close to the crack tip.)

Symmetric Modeling
If the problem is crack-axisymmetric, meaning that the model geometry, the 
boundary conditions as well as the applied loads are symmetric with respect to the 
crack axis, then only half of the model may be modeled with the appropriate sym-
metric boundary conditions. The J-integral in this case reduces to a half circle. 

✍ According to the convention described earlier and comparing the following 
two models, the path starting node does not always lie on the crack face when 
only half of the model is considered. However, the crack direction node 
always lies on the crack face.

Figure 2-5. Two Different Models for a Half Circle J-integral Path

Crack FaceCrack Face

Constrained Surface 
Due to Symmetry

Starting NodeStarting Node

y

xx

y
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Evaluated Quantities

The combined J-integral value is evaluated as the sum of the individual values for 
each one of the two crack modes (for 2D problems): J = JI + JII 

Figure 2-6. Modes of Cracking for Two Dimensional Problems

where JI and JII correspond to Modes I and II, respectively.

The corresponding Stress Intensity Factors can be evaluated according to:

 

where, 

JI, JII = Modes I and II stress intensity factors

E = Modules of Elasticity

= 1 for plane stress models
= 1/1-γ2 for plane strain and axisymmetric models

γ = Poisson Ratio

In this case, due to symmetry, the J-integral is equal to JI and JII is equal to zero. 
Consequently, the output J is twice the value which is computed from the half 
circle path.

Mode IIMode I

{α    
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✍ Notes:
1. Individual J-integral and K modes are always evaluated except for the 

thermal and axisymmetric problems.
2. For the crack-axisymmetric problems (whether the path is modeled as half 

or full circle), Mode II cracking is irrelevant. Therefore the combined J 
corresponds entirely to Mode I cracking.

3. From the above two statements, it is inferred that, for general thermal or 
axisymmetric problems, J and K cannot be evaluated for individual modes. 
However, for crack-axisymmetric models, the combined J corresponds to JI 
from which KI can be evaluated.

4. There are no limitations on the mesh type (whether it is crack-axisymmetric 
or not).

Modal Analysis

The computation of natural frequencies and mode shapes is known as modal or 
normal modes analysis. The finite element system of equations for dynamical 
systems can be written as:

(2-22)

where [M] is the mass matrix, and [C] is the damping matrix. For free vibrations, 
the above equation takes the form:

(2-23)

When undamped linear elastic structures are initially displaced into a certain 
shape, they will oscillate indefinitely with the same mode shape but varying 
amplitudes. The oscillation shapes are called the mode shapes and the corre-
sponding frequencies are called natural frequencies. The term modal analysis has 
been used throughout this manual for the study of natural frequencies and mode 
shapes. For undamped linear elastic structures, the above equation reduces to:

(2-24)

With no externally applied loads, the structure is assumed to vibrate freely in a 
harmonic form defined by:

U(t) = φ sin(ω t + θ) (2-25)
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which leads to the eigenvalue problem:

[[K] - ω 2[M]] {φ} = {0} (2-26)

where ω is the natural frequency and φ is corresponding mode shape of the struc-
ture.

Eigenvalue Extraction Methods in Modal Analysis

There are four methods of computing the eigenvalues in the Basic System. They 
are:

• Subspace Iteration
• Lanczos Method
• Jacobi Method
• Inverse Power Method

These methods are fully discussed in the COSMOS/M Theoretical Manual.

Treatment of Rigid Body Modes in Modal Analysis - Shifting

Shifting can be viewed as a displacement of the origin in a plot of the eigenval-
ues. By appropriately selecting the shift points, the iteration process can be made 
to converge to any or all modes (including rigid body modes) of the structural 
system. The speed of convergence can be accelerated by shifting close to the root 
being sought, and it is therefore a good practice to shift at intervals during an iter-
ation process. The shift option is applicable to both the subspace and inverse iter-
ation methods.

Treatment of Rigid Body Modes in Modal Analysis - Soft Spring 
Addition

In addition to or in lieu of frequency shifting, COSMOS/M allows you to use the 
soft spring option for computing natural frequencies and mode shapes of struc-
tures with rigid body modes. As in static stress analysis, the soft spring stiffnesses 
are added to the diagonal terms of the stiffness matrix. However, the computed 
frequencies depend on the magnitude of the soft spring stiffness. In addition, the 
natural frequencies computed when using either the shift option or the soft spring 
addition, or a combination of both, may vary in each case, depending on the mag-
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nitudes of shift or spring stiffness specified; see Chapter 9, Performing Analysis, 
for more information.

In-Plane Effects in Modal Analysis - Stress Stiffening and Softening

The effect of stress stiffening on structures in linear static analysis was discussed 
in an earlier section. The following is a continuation of this discussion for free 
vibration problems. In order to consider the in-plane effects on the natural fre-
quencies of a structure, the structure must be first loaded and constrained for 
computing the geometric stiffness matrix. Therefore, a static stress analysis pre-
cedes the computation of natural frequencies with in-plane effects. In-plane loads 
have a stiffening or softening effect on the vibrational behavior of structures. 
Tensile membrane forces increase the natural frequencies where as compressive 
membrane forces decrease them. Similar to the static solution with in-plane 
effects, normal modes analysis in the presence of membrane forces is performed 
in two stages. In the first stage, the displacements {ui} for the loaded and con-

strained structure are computed using the conventional stiffness matrix [K]. In the 
second stage, the geometric stiffness matrix [KG(ui)] is established based on the 
computed displacements {ui} and added to the conventional stiffness matrix [K], 
and then along with the mass matrix, the natural frequencies (ω) and the corre-
sponding virtual displacements which are the eigenvectors, {φi+1}, are solved. 
With the inclusion of in-plane effects, the finite element system of equations for 
computing the natural frequencies and mode shapes can therefore be written as:

([K] + [KG(ui)] - ω2 [M]){φi+1} = {0} (2-27)

where [KG(ui)] is the geometric stiffness matrix computed based on {ui}, [M] is 
the mass matrix, ω is the natural frequency, and {φi+1} represents the eigenvectors 
which describe the natural modes of the structure.

The inclusion of in-plane effects in natural frequency computation is specified 
using the A_FREQUENCY (Analysis > FREQUENCY/BUCKLING > Frequency 
Options) command.
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Eigenvalue Buckling Analysis

Buckling can be defined as the sudden deformation which occurs when the stored 
membrane energy is converted into bending energy with no change in the exter-
nally applied load. Buckling occurs when the total stiffness matrix becomes sin-
gular:

[K - λKG]{q} = {0} (2-28)

where KG is the geometric stiffness matrix (also referred to as stress stiffness 
matrix or differential stiffness matrix), and it is independent of the material prop-
erties of the structure in contrast to the conventional structural stiffness matrix. 
The multiplier λ represents the factor to the applied loads to cause buckling. The 
computation of buckling load factors is an eigenvalue problem, and all methods 
discussed earlier under modal analysis are applicable.

Modal Analysis of Piezoelectric Materials

The electromechanical constitutive equations for linear behavior are written as 
follows:

{σ} = [D]{ε} - [e]{El}

{Dl} = [e]T{ε} + [εd]{El} (2-29)

where {σ} is the stress vector, {Dl} is a vector of electric flux density, [D] is the 
matrix of elastic coefficients at constant electrical field, {ε} as before represents 
the mechanical strain, [e] is a matrix of piezoelectric properties, {El} is the vector 

representing the electric field, and [εd] is the dielectric property matrix at con-
stant mechanical strain. The elastic, dielectric, and piezoelectric material proper-
ties and the procedure for their input are fully explained in Chapter 6, Material, 
Sectional, and other Physical Properties. Without the coupling term provided by 
the piezoelectric matrix [e], the above equations represent the constitutive equa-
tions for elastostatic and electrostatic problems.

The finite element system of equations for the computation of natural frequencies 
and mode shapes have the same form as that of the modal analysis. The eigen-
value extraction methods in piezoelectric modal analysis are the same as those 
used in modal analysis.
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Guyan Reduction

For very large problems, computing eigenvalues and eigenvectors requires a lot 
of time and computational effort. However, condensation in the form of Guyan 
Reduction can be used to reduce the number of degrees of freedom significantly, 
thus, increasing the speed of the program substantially. In COSMOS/M the 
Guyan Reduction can be used with the Subspace and Jacobi eigenvalue extraction 
schemes whereby the number of the equations is reduced by eliminating degrees 
of freedom of lesser importance. Let Dm represent the more important or master 
degrees of freedom, and Ds represent degrees of freedom of lesser importance or 
slave. The equations of motion can then be written as:

(2-30)

 

The basic assumption in the Guyan Reduction is that for lower frequency modes, 
inertia forces due to slave d.o.f. are much less important than elastic forces trans-
mitted by the master d.o.f. This criteria must be used in selecting which d.o.f. 
should be master and which ones should be slave. With this assumption in mind, 
the lower part of the mass matrix can be ignored and we find from the lower por-
tion of the matrix:

{Ds} = -Kss
-1 Kms

T Dm (2-31)

The slave degrees of freedom are then eliminated from the upper set of equations 
to yield:

([Keq] - ω2 [Meq]){Dm} = {0} (2-32)

where,

Keq = Kmm - Kms Kss
-1 Kms

T (2-33)

Meq = Mmm - Mms Kss-1 Kms
T         (or lump mass at master d.o.f.)

From the above equation, it can be concluded that Keq and Meq are in general full 
matrices, therefore, m (no. of master d.o.f.) must be considerably smaller than the 
total d.o.f. for Guyan reduction to be cost effective. If the matrix structure of the 
problem has small bandwidths, it may be more advantageous to avoid condensa-
tion.
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How to Use Guyan Reduction in COSMOS/M

1. Model your problem as usual.

2. Select master d.o.f. by using commands in the “MASTER DOF” submenu in 
LoadsBC > STRUCTURAL.

3. Create MASS elements at locations of master degrees of freedom using the 
M_PT (Meshing > PARAMETRIC MESH > Points) or EL (Meshing > 
ELEMENTS > Define Element) commands. If you use the EL command, 
remember to use keypoints as the associated geometric entity. Estimate the 
associated masses and enter the information using the RCONST (Propsets > 
Real Constant) command.

4. Use the A_FREQUENCY (Analysis > FREQUENCY/BUCKLING > 
Frequency Options) command to specify Guyan reduction with Jacobi (GJ) 
or Subspace (GS).

5. Run frequency analysis using the R_FREQUENCY (Analysis > 
FREQUENCY/BUCKLING > Run Frequency) command. The frequencies 
and mode shapes will be available in the database.

Verification problem F27A.GEO illustrates the proper sequence of commands 
pertinent to the Guyan Reduction technique.

ASME Section III Stress Evaluation

An evaluation of stress results, in a form suitable for comparison with the ASME 
code section III requirements, is formulated. Stress resultants, membrane, bend-
ing, peak, and stress intensities are computed based on an arbitrarily defined 
cross-sectional.

The failure criteria for typical FEA include the peak stresses. Allowable stresses 
Sm, 1.5 Sm, and 3.0 Sm, specified by the ASME code section III are based on 
redundant forces and moments along a section associated with shell-type struc-
ture (Gordon, 1976). In the formulation presented here (Kroenke, 1974), the 

stresses are linearized along a “stress classification line” (or so called “section”) 
in an axisymmetric model and the primary plus secondary and peak stresses are 
evaluated (at the two ends of the section) in a form which is convenient for 
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comparison with the allowable stresses (i.e., Sm, 1.5 Sm and 3 Sm) specified by 
the ASME code and in accordance with Gordon, 1976 and Kroenke, 1974.

The in-plane bending moment, membrane and shear forces, as well as the out-of-
plane membrane forces and bending moments are evaluated first along a section, 
from which the peak stresses are calculated for two types of models: plane stress/
strain and axisymmetric problems.

A section is defined by a line passing through the thickness and is specified by 
nodes at its two ends.

The section must present a 
rational plane of bending 
which, in most cases will be 
perpendicular to both surfaces 
and the mid-plane. For most 
structures with parallel sur-
faces, such as pipes, shells 
and external nozzles, this cri-
teria can be easily met. How-
ever, in irregular areas such as 
in the nozzle to the shell junc-
ture, rational planes of bend-
ing may be specified to be 
perpendicular to the mid plane 
and have the same angle as 
between the section and the 
surface on both sides. The lin-
earized stresses at the two 
ends are calculated as the sum 
of the membrane (primary) 
stresses which are constant 
along the section and the bending stresses which vary linearly along the section. 
These stresses are calculated from the internal forces and moments on the section. 
The evaluation procedure of these stresses is described in Appendix C.

Figure 2-7. Section Defined Through the 
Thickness and the Corresponding 
Section Coordinates

CL
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Figure 2-8. FEA Calculated Stresses (Actual Stress) and the 
Linearized Stresses Along a Section

The “peak” stress value at a point along the section is defined as the difference 
between the actual stress calculated by the FEA and the linearized (membrane 
plus bending) stress. Therefore the “peak stress” at the two ends and the center of 
the section are:

σ pi1 = si1 - σm
i - σb

i1         (at end 1)

σ pi2 = si2 - σm
i - σb

i2         (at end 2) (2-34)

σ pic = sic - σm
i                  (at the section center)

Where i corresponds to the i-th component of stresses. σm
i corresponds to the 

constant membrane along the section and σb
i1 and σb

i2 correspond to bending 
stresses at the two ends. Note that the bending stress at the center of the section
 is considered to be zero.

Bending at X

Along 
Section

Membrane(Membrane
+ Bending)

Linear Stress

Actual Stress

σσσσσ

X
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Spin Softening

The Small Deflection theory of Linear Static analysis can 
not directly account for large changes in geometry due to 
the centrifugal loads. Therefore the effect can be accounted 
for by an adjustment of the stiffness matrix, called spin 
softening. To understand the application of this effect, 
consider the following spinning shaft.

For an infinitesimal element mass (m) inside the shaft the 
equilibrium of force without accounting for the effect of 
the radial deflection (small deformation theory) requires:

Ku = mrωs
2 (2-35)

where:

mrωs
2= Centrifugal force on the mass

K = Stiffness

r = Radial distance of the mass

u = Radial deflection of the mass

ωs = Angular spin velocity

Now if the deflection is large enough to not be 
ignored in evaluation of centrifugal forces, the 
equilibrium force requires:

Ku = m (r+u) ωs
2 (2-36)

where the centrifugal force [m (r+u) ωs
2] is evaluated at its final resting position. 

Rearranging terms, lead to:

(K- mωs
2)u = mrωs

2 (2-37)

Defining:

Ks = K - mωs
2 (2-38)

From equations (2-37):

Ks u = mrωs
2 = Fs (2-39)

r

m

ω
s

u

K

s
ω

r

m

Simplified Model
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Comparing equation (2-39) with equation (2-35), it is clear that K should be 
reduced in magnitude by the amount of mωs

2 (i.e., spin softening) to account for 
the large deformation effect in the plane of rotation.

The above formulation can be extended to frequency analysis, where the eigen-
value problem is represented by:

[Ks - ω2M] {φ} = 0 (2-40)

where ω is the natural frequency of the spinning body.

When the spin softening is considered in the solution, it is often useful to activate 
the stress stiffening effect as well (see note below).

In COSMOS/M only the spin softening effect is considered in frequency analysis 
of rotating bodies. It is not incorporated into Static analysis, since the NSTAR 
program can be used more properly to solve problems with large deformation.

For a general 3D problem with angular velocity in different direction, the reduced 
stiffness can be represented by:

Kxx
s = Kxx - Mxx (ωy

2 + ωz
2)

Kyy
s = Kyy - Myy (ωx

2 + ωz
2) (2-41)

Kzz
s = Kzz - Mzz (ωx

2 + ωy
2)

Kxy
s = Kxy,   Kyz

s = Kyz,   Kxz
s = Kxz,   

where, Kxx
, Kyy’ and Kzz are the element stiffness calculated in x, y, and z direc-

tions, Kxx
s, Kyy

s and Kzz
s, are the reduced stiffnesses used in place of the element 

stiffnesses, Mxx’ Myy’ and Mzz, are the element masses and ωx,ωy, and ωz
 are the 

angular velocities about the x, y and z axis.

✍ To activate stress stiffening effect, turn on the centrifugal loading option 
flag in A_STATIC command together with In-plane Load flag in A_FREQ 
command.
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Inertia Relief

In Linear Static analysis, the external forces on an elastic body can be balanced 
by inertia forces induced by a translational acceleration field.

(2-42)

where:

{F}t = Applied external forces

{a}t = Translational acceleration due to inertia (to be calculated)

ρ = Material density
v = Material volume

The above equation may be represented as:

(2-43)

where Mxx, Myy and Mzz are total masses in x, y and z directions and are evalu-
ated by a row-by-row summation of the elemental mass matrices over transla-
tional degrees of freedom. Once Mxx, Myy and Mzz are evaluated, equation (2-43) 
yields the induced accelerations ax, ay and az which then will be applied as an 
acceleration field to the FEA solution. 

✍ Only translational field is considered in the above field and any induced rota-
tion is ignored.

F{ }t a{ }tρ vd

v

∫+ 0=
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Mode Correlation and Checking
The MODE_CHECK (Analysis, Frequency/Buckling, Mode_Check Option) 
command provides several options that can be very useful in checking modes 
obtained from experimental (secondary) data against primary modes resulting 
from FEA. The secondary data can also come from a different FEA run.

The command provides 3 options:

6. Calculate cross-correlation,

7. Check mode orthogonality, and

8. Evaluate modal assurance neglecting the effect of mass.

Cross-Correlation

While frequencies obtained from experimental data are recognized as the most 
reliable, frequencies from FEA are considered accurate if they are within 5% dis-
crepency. In general, the frequencies are far less sensitive to structural changes 
than mode shapes. The quality of the secondary modes is evaluated based on their 
observance of the orthogonality with respect to the primary mass matrix as illus-
trated below:

Let [ΦP] represent the matrix of the primary mode shapes where each column rep-
resents a mode shape. Similarly, let [ΦS] represent the matrix of the secondary 
mode shapes. The mass matrix of the primary system will be denoted by [ΜP].

The product [OPP] = [ΦP]T[ΜP][ΦP] will always generate a diagonal matrix. Now 

if the secondary data are exact, the product [OPS]=[ΦP]T[ΜP][ΦS] will generate 
the same diagonal matrix. In practice [OPS] is not expected to be equal to [OPP] or 
even to be a perfect diagonal matrix. Instead, [OPS] will have off-diagonal terms. 
However, the degree of how diagonal this product is, represents a tool for identi-
fying and assessing the quality of correspondence between the primary and sec-
ondary modes. Off-diagonal terms smaller than 10% of the diagonal are generally 
considered acceptable in practice.

✍ For mass-normalized mode shapes, the dominant terms of [OPS] should have 
magnitudes close to unity to indicate similarity. The sign is insignificant when 
comparing mode shapes. +1 or -1 indicate perfect similarity.
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The statement in the above paragraph assumes that [ΦS] contains an ordered set of 
modes with one-to-one correspondence with [ΦP]. Obviously this may or may not 
be the case since [ΦS] may contain a different number of modes than [Φp] and the 
order of the modes may be different. In other words, ΦS1, the first column (mode) 
in [ΦS] may or may not belong to Φp1. It follows that the product 

[OPS]=[ΦP]T[ΜP][ΦS] may or may not be diagonal or square, even when some 
modes match perfectly. However a dominant term OPs ( ) indicates matching 
between primary mode l and secondary mode k. A dominant term is identified if 
other terms are less than 10%. The presence of more than one dominant term may 
indicate multiple matching. For example if the columns of [ΦS] are identical and 
they match primary mode l, all the terms of row l of OPS will be equal, but other 
rows should have no dominant terms. It should also be noted that the dominant 
terms can be negative since multiplying a mode by (-1) does not change its signa-
ture.

✍ Before carrying matrix multiplications, the program modifies the secondary 
matrices to correspond to the same degrees of freedom used by the primary 
system. 

✍ If the normalization flag in the command is activated, the dominant terms 
should be around unity for a mode matching.

Orthogonality of Secondary Modes

To evaluate the integrity of the secondary modes, it is important to check their 
orthogonality with respect to the primary mass matrix. In other words, the prod-
uct [Φs]

T[ΜP][Φs] should be dominantly diagonal (off-diagonal terms within 10% 
of the diagonal). If the secondary modes do not pass this test, a thorough re-
examination of the test data and the FEA model should be carried out. For mass-
normalized mode shapes, the magnitudes of dominant terms of [OPS] should be 
close to unity to indicate similarity.

Cross Modal Assurance Criterion

The modal assurance criterion is used to check the independence of two modes. 
Basically, it is similar to cross-correlation but it ignores the effect of the system 
mass. The cross modal assurance criterion matrix [M] is computed from:

[M] = [[ΦP]T[Φp]x[Φs]T[Φs]]/[{Dpp}{Dss}T]
COSMOS/M Basic FEA System 

http://www.cosmosm.com


Part 1   Linear Statics, Modal, and Buckling Analysis
Where:

x denotes element-by-element multiplication,

/ denotes element-by-element division, 

{Dpp} represents the vector of diagonal terms of [ΦP]T[Φp], and 

{Dss} represents the vector of diagonal terms of [Φs]
T[Φs]

Interpolation

In performing any of the mode-check options described above, the secondary 
data need to be modified to correspond to the primary model. There are two 
options available in the Mode_Check command for preparing the secondary data. 
The first option is to use linear interpolation of the secondary data at the primary 
grid locations. Extrapolation may also be used in some cases. The second option 
uses the primary grid point of the closest mass.

✍ The normalization flag should always be activated unless the secondary data 
is obtained from an FEA program using the same grid used for the primary 
model.

To check/identify mode shapes:

1 Run frequency analysis on the current model to calculate the desired number of 
modes. The primary mode shapes are now defined.

2 If you are using experimental data or modes resulting from an FEA program 
other than GEOSTAR for the secondary data, write the information in the 
specified format. Refer to the online help for the Mode_Check command for 
details.

3 If you are using another GEOSTAR database, run frequency analysis. Close 
the secondary database and re-open the primary database in GEOSTAR. Then 
select Analysis > FREQUENCY/BUCKLING >Mode check option and select the 
desired task specifying the secondary database.

4 Run frequency analysis on the primary model. The results of the mode check 
will be written in the output file. 
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✍ It is recommended to run the modal assurance criterion first to evaluate the or-
thogonality of the secondary modes with respect to the primary mass. If the 
secondary data passes this test successfully, the other two options may be 
tried. Otherwise, a re-evaluation of the test data as well as the primary model 
is needed before proceeding.

✍ When you run frequency analysis while the check option is set to an option 
other the  (0: Off) option, the program performs only the check, it does not 
calculate the frequencies. To return to the regular mode, issue the 
MODE_CHECK command again and select the default option.
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3 Getting Started
Introduction

The previous chapters presented some of the finite element analysis and modeling 
features in the Basic System and their mathematical background. In this chapter, 
you will be presented with a hands-on example which walks you through a linear 
static analysis. A simple well designed drawing or illustration can indeed explain 
a concept that may otherwise take several paragraphs to describe, and this chapter 
will attempt to substantiate that. Moreover, you will see how simple it is to create 
and analyze models in COSMOS/M. A simple model geometry has been selected 
for linear static analysis using a compatible mesh as well as a non-compatible 
mesh to illustrate the bond feature. 

Linear Static Stress Analysis

The figure below shows the geometry of the model for analysis with the applied 
loads and boundary conditions. The problem represents a beam with a stepped 
cross section, and it will be modeled with plane continuum elements (PLANE2D) 
only to show some features of the STAR module. Otherwise, this problem can be 
accurately modeled using beam elements in the Basic System.
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To start with, enter GEOSTAR 
and provide a job name for this 
example. In order to proceed with 
geometry creation, execute the 
following steps to change the 
view and to define a working 
plane. Using the View Direction 
option icon (Binocular), select the 
second icon for X-Y view. Next, 
from Geometry > GRID, select 
the Plane command and provide 
the following input in the dialog 
box (defaults in this case):

Geo Panel: Geometry > GRID 
> Plane

Rotation/Sweep Axis > Z
Offset on Axis > 0.0

Grid Line style > Solid

Geo Panel: Geometry > GRID > Grid On

Accept defaults...

From Geometry > SURFACES, select Draw w/ 4 Coord (for creating a surface by 
either snapping four coordinates on the grid or by typing them in the dialog box). 
Accept the following input (you may use the mouse directly to create the surface 
or use the dialog box):

Geo Panel: Geometry > SURFACES > Draw w/ 4 Coord

Surface > 1
XYZ-Coordinate of Keypoint 1 > 55,0,0

XYZ-Coordinate of Keypoint 2 > 60,0,0

XYZ-Coordinate of Keypoint 3 > 60,20,0

XYZ-Coordinate of Keypoint 4 > 55,20,0

Similarly, create surfaces 2 and 3 using the following coordinates in the dialog 
box:

Surface > 2
XYZ-Coordinate of Keypoint 1 > 50,20,0

XYZ-Coordinate of Keypoint 2 > 65,20,0

XYZ-Coordinate of Keypoint 3 > 65,100,0

XYZ-Coordinate of Keypoint 4 > 50,100,0

Figure 3-1. Problem for Analysis
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Surface > 3
XYZ-Coordinate of Keypoint 1 > 55,100,0

XYZ-Coordinate of Keypoint 2 > 60,100,0

XYZ-Coordinate of Keypoint 3 > 60,120,0

XYZ-Coordinate of Keypoint 4 > 55,120,0

The top and bottom sections which have the same dimensions will be modeled 
with the same number of elements.

Use the Auto Scaling icon (SCALE;) to properly view the created surfaces. For 
this problem, we will use the PLANE2D element to capture the in-plane behavior 
due to the applied load. Since the thickness of the top and bottom surfaces is dif-
ferent from that of the mid-section, we need two section (real) constant groups. 
When the finite element mesh is generated, the active element group number and 
the active real constant set are associated with the generated elements. Execute 
the following commands to define the element group, the material properties, and 
the first real constant set. From Propsets, select Element Group (EGROUP) com-
mand and specify PLANE2D (area type) element under group number 1. Accept 
all defaults in the next dialog box. From the Propsets menu, select Pick Material 
Lib (PICK_MAT command) and Accept all defaults. Alloy Steel (A_STEEL) in 
FPS units will be selected for material group number 1. Next, from the same 
menu Propsets, select Real Constant (RCONST command), accept default 
options for the first two dialog boxes and in the last, provide the thickness input 
as follows:

Geo Panel: Propsets > Real Constant

Associated element group > 1
Real constant set > 1

Start loc. of real const. > 1
No. of real const. to be entered > 2

RC1: Thickness > 0.15

RC2: Material Angle (Beta) > 0.0

You can now proceed to generate the finite element mesh for the top and bottom 
surfaces as follows. From Meshing > PARAMETRIC MESH, select Surfaces 
(M_SF command) and furnish the following input in the dialog boxes:
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Geo Panel: Meshing > PARAMETRIC MESH > Surfaces

Beginning surface > 1
Ending surface > 3
Increment > 2
Number of nodes per element > 4

Number of elements on 1st curve > 4

Number of elements on 2nd curve > 8

Spacing ratio for 1st curve > 1.0

Spacing ratio for 2nd curve > 1.0

Before meshing the mid surface, define a second real constant set using Real 
Constant from Propsets, and provide the following input in the dialog boxes:

Geo Panel: Propsets > Real Constant

Associated Element Group > 1
Real Constant set > 2

Start loc. of real const. >1

No. of real const. to be entered > 2

RC1: Thickness > 0.016667

RC2: Material Angle (Beta) > 0.0

Next, generate the finite element mesh of the mid-section as follows. From 
Meshing > PARAMETRIC MESH, select Surfaces (M_SF command) and type 
the following input in the dialog boxes:

Geo Panel: Meshing > PARAMETRIC MESH > Surfaces

Beginning surface > 2
Ending surface > 2
Increment > 1
Number of nodes per element > 

Number of elements on 1st curve > 12

Number of elements on 2nd curve > 36

Spacing ratio for 1st curve > 1.0

Spacing ratio for 2nd curve > 1.0
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The figure shows the surface plots as 
well as the generated finite element 
mesh. 

The displacement constraints are 
enforced as follows: at the top support, 
the x-component of displacement is 
restrained whereas at the bottom sup-
port, both x- and y-components are 
fixed. These boundary conditions at 
the nodes are enforced as follows. 
From LoadsBC > STRUCTURAL > 
DISPLACEMENT, select Define 
Nodes (DND command) and provide 
the following input in the dialog box:

Geo Panel: LoadsBC > STRUC-
TURAL > DISPLACEMENT > 
Define Nodes

Beginning node > 88

Displacement Label > UX: X translation

Value > 0.0

Ending node > 88

Increment > 1

Accept the defaults for the next dialog box. Note that the flow between the dialog 
boxes is recursive which means that you can also input the boundary conditions 
for node 3 as follows:

Beginning node > 3
Displacement Label > UX: X translation

Value > 0.0

Ending node > 3
Increment > 1

Displacement Label > UY: Y translation

After you Accept the last input (UY), you will again see the first dialog box for 
displacement boundary conditions. Click on Cancel to terminate the command.

Figure 3-2. Surface and Finite 
Element Mesh Plots
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The applied displacement boundary conditions are shown in the figure below.

Figure 3-3. Applied Boundary Conditions and Loads

The vertical load is applied as pressure loading on curve 10 shown in the figure 
above. From LoadsBC > STRUCTURAL > PRESSURE, select Define by 
Curves (PCR command) and provide input in the dialog box as follows:

Geo Panel: LoadsBC > STRUCTURAL > PRESSURE > Define by Curves

Beginning curve > 10

Pressure Magnitude > 1
Ending curve > 10

Increment > 1
Pressure at the end of direction > 1
Pressure Direction > Normal Direction

Similar to the previous operation, this command is also recursive. Therefore, after 
you Accept the above input, click on Cancel to terminate the command.

Since the mesh for each surface is generated independent of the neighboring one, 
there will be duplicate definition of nodes on the common boundary. These nodes 
need to merged in order to satisfy compatibility as follows. From Meshing > 
NODES, select Merge (NMERGE command) and Accept all defaults in the dialog 
box. The numbering gaps in the nodes as a result of merging is removed by using 
Edit > COMPRESS > Nodes (NCOMPRESS command). There will be 10 nodes 
compressed for this problem.

The finite element model is now ready for analysis. Use the command R_STATIC 
(Analysis > STATIC > Run Static Analysis) to perform a linear static stress anal-
ysis. The results of analysis are written to the output file with extension OUT.
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The deformed shape plot of the model can be viewed using the command 
DEFPLOT (Results > PLOT > Deformed Shape). You can superimpose the curve 
plot to better visualize the deformed state using the CRPLOT (Edit > PLOT > 
Curves) command.

To visualize the stress and displacement contours, use the following commands 
respectively: from Results > PLOT, select Stress (ACTSTR and STRPLOT) and 
from Results > PLOT, select Displacement (ACTDIS and DISPLOT). When you 
execute these commands with default options, you will be processing von Mises 
stresses and resultant displacement contours.

The figures below show the resultant displacement and von Mises stress contours 
as well the deformed shape plots of the model. The plots on the left half refer to 
the analysis results you just performed. On the right are the results from an analy-
sis using the bond feature (see Chapter 8 and 11) in which the nodes at the com-
mon boundary curves were deliberately mismatched for verification purposes. As 
you can notice, the results from the two analysis appear to be identical.

Figure 3-4. Deformed Shape and Contour Plots of Compatible
and Non-Compatible Models
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3-8
You can try other postprocessing features for this problem. We will plot a line 
section along the center line from top to bottom of the von Mises stress contours. 
To start with, we will deactivate the display of the chart using the following pro-
cedure. From Results > PLOT, select the Path Graph (LSECPLOT) command and 
pick nodes from top to bottom along the center line of the model. When you reach 
the last node, click twice on that node to terminate the command. Note that you 
may need to use the Translate icon to position the contour plot away from the 
X-Y graph. As shown in the following figure, you will see the variation of the 
plotted result component along the line you just traced.

Figure 3-5. Line Section Graph for von Mises Stress Plot
COSMOS/M Basic FEA System
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4 Input Data 
Requirements
Introduction

Proper modeling and analysis specifications are crucial to the success of any 
finite element analysis. Irrespective of the type of analysis (structural, thermal, 
fluid flow, etc.), numerical solution using finite element analysis requires com-
plete information of the model under consideration. The finite element model you 
submit for analysis must contain all the necessary data for each step of numerical 
simulation - geometry, elements, loads, boundary conditions, solution of system 
of equations, visualization and output of results, etc. This chapter attempts to 
conceptually illustrate the procedure for building a complete model for the three 
types of analysis you can perform in the Basic FEA System - linear static, buck-
ling, and modal analysis.

Since a major portion of the effort in building a finite element model is in 
geometry creation and meshing, these topics will not be discussed here. The 
COSMOS/M User Guide (Volume 1) presents in-depth information on the proce-
dures for model building and postprocessing in GEOSTAR. This chapter there-
fore only outlines those commands which are relevant for analysis in the Basic 
System. Chapter 10 presents some information on postprocessing features appli-
cable to analysis in the Basic System.

✍ For a detailed description of all commands, please refer to the COSMOS/M 
Commands Manual (Volume 2).
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Modeling and Analysis Cycle in the Basic System

The basic steps involved in a finite element analysis are:

• Create the problem geometry.
• Mesh the defined geometry with appropriate type of element(s).
• Apply constraints on the finite element model.
• Define the loads on the model.
• Define the material and sectional properties.
• Submit the completed finite element model for analysis.
• Interpret and analyze the results.

These steps can be schematically represented as shown in the figure below.

Figure 4-1. Finite Element Modeling and Analysis Steps

Preprocessing refers to the operations you perform such as defining the model 
geometry, mesh generation, applying loads and boundary conditions, and other 
operations that are required prior to submitting the model for analysis. The term 
analysis in the above figure refers to the phase of specifying the analysis options 
and executing the actual analysis. Postprocessing refers to the manipulation of the 
analysis results for easy understanding and interpretation in a graphical environ-
ment.

As outlined in Chapter 1, About the Basic System…, each analysis type in the 
Basic System has many features. Building the finite element model for a particu-
lar problem therefore depends on how you can utilize these features in an optimal 
and efficient way to yield the most accurate solution for the finite element model.

START

PREPROCESSING POSTPROCESSING

STOP
Analysis and

Design DecisionsProblem Definition

ANALYSIS
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Flow Charts and Commands for Analysis 
in the Basic System

In the following pages, you are presented with flow charts of each analysis type 
and the corresponding commands or menu in a tabular form to assist you in 
developing your finite element model efficiently.

Linear Static Analysis

Figure 4-2. Flow Chart for Linear Static Analysis in the Basic System

Start

Geometry

Mesh the required  
part of geometry

Define/Activate EG, 
RC, MP

Compatible Mesh?

Yes

No

Define BOND

Define loads and 
constraints

No

Yes Multidisciplinary 
Analysis?

Read loads from 
other modules

Multiple load cases?
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Yes

Select required 
load cases

A

A

Analysis 
Specifications

Stop

Output 
Specifications
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Postprocessing

In-plane effects?
Yes
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Select any one 
load case
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Important Commands for Linear Static Analysis

The commands tabulated below provide you with information on the input of ele-
ment groups, material and sectional properties, loads and boundary conditions, 
analysis specifications, and output specifications.

Table  4-1. Important Commands for Linear Static Analysis

* Please refer to Appendix B, Command Summary, for 
locating the path to menus from cryptic commands.

Function COSMOS/M Menu Command

Property 
definition

Propsets

EGROUP, MPROP, RCONST, 
PICK_MAT, USER_MAT, PICK_SEC, 
BMSECDEF, EPROPSET, 
EPROPCHANGE

Loads

LoadsBC
  > STRUCTURAL
      > DISPLACEMENT
      > FORCE
      > PRESSURE
      > GRAVITY
  > THERMAL
       > TEMPERATURE

. . .

. . .
D_ commands for displacements
F_ commands for forces
P_ commands for pressure
Gravity load commands
. . .
NT_ commands for temperatures

Boundary 
conditions

LoadsBC
   > STRUCTURAL
      > DISPLACEMENT
      > COUPLING
      > BONDING

. . .

. . .
D_ commands for displacements
CP_ commands for coupling
BOND_ commands for bonding

Model verification
Meshing
  > ELEMENTS
Analysis

. . .
ECHECK
DATA_CHECK, R_CHECK

Specifying 
analysis options

Analysis
  > STATIC

. . .
LCSET, ADAPTIVE, P_ORDERLABS, 
A_STATIC, A_STRESS, STRESS

Specifying output 
options

Analysis
  > OUTPUT OPTIONS

. . .
PRINT_OPS

Executing linear 
static analysis

Analysis
  > STATIC

. . .
R_STATIC, R_STRESS

Postprocessing Results
Refer to COSMOS/M User Guide (V.1) 
for more details.
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Buckling Analysis

Figure 4-3. Flow Chart for Buckling Analysis in the Basic System
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Important Commands for Buckling Analysis

The commands tabulated below provide you with information on the input of ele-
ment groups, material and sectional properties, loads and boundary conditions, 
analysis specifications, and output specifications.

Table  4-2. Important Commands for Buckling Analysis

* Please refer to Appendix B, Command Summary, for 
locating the path to menus from cryptic commands.

Function COSMOS/M Menu Command

Property 
definition

Propsets

EGROUP, MPROP, RCONST, 
PICK_MAT, USER_MAT, 
PICK_SEC, BMSECDEF, 
EPROPSET, EPROPCHANGE

Loads

LoadsBC
   > STRUCTURAL
       > DISPLACEMENT
       > FORCE
       > PRESSURE
       > GRAVITY
   > THERMAL
       > TEMPERATURE

. . .

. . .
D_ commands for displacements
F_ commands for forces
P_ commands for pressure
Gravity load commands
. . .
NT_ commands for temperatures

Boundary 
conditions

LoadsBC
   > STRUCTURAL
       > DISPLACEMENT

. . .

. . .
D_ commands for displacements

Model 
verification

Meshing
   > ELEMENTS
Analysis

. . .
ECHECK
DATA_CHECK, R_CHECK

Specifying 
analysis options

Analysis
  > FREQUENCY/BUCKLING

. . .
A_BUCKLING

Specifying output 
options

Analysis
   > OUTPUTOPTIONS

. . .
PRINT_OPS

Executing linear 
static analysis

Analysis
   > FREQUENCY/BUCKLING

. . .
R_BUCKLING

Postprocessing Results
Refer to COSMOS/M User Guide 
(V.1) for more details.
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Modal Analysis

Figure 4-4. Flow Chart for Modal Analysis in the Basic System
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Important Commands for Modal Analysis

The commands tabulated below provide you with information on the input of ele-
ment groups, material and sectional properties, loads and boundary conditions, 
analysis specifications, and output specifications.

Table  4-3. Important Commands for Modal Analysis

* Please refer to Appendix B, Command Summary, for 
locating the path to menus from cryptic commands.

Function COSMOS/M Menu Command

Property 
definition

Propsets

EGROUP, MPROP, RCONST, 
PICK_MAT, USER_MAT, 
PICK_SEC, BMSECDEF, 
EPROPSET, EPROPCHANGE

Loads (only if 
In-plane effects 
are considered)

LoadsBC
   > STRUCTURAL
      > DISPLACEMENT
      > FORCE
      > PRESSURE

. . .

. . .
D_ commands for displacements
F_ commands for forces
P_ commands for pressure

Boundary 
conditions

LoadsBC
   > STRUCTURAL
      > DISPLACEMENT
      > MASTER DOF
      > COUPLING
      > BONDING

. . .

. . .
D_ commands for displacements
MD_ commands for Guyan reduction
CP_ commands for coupling dof
BOND_ commands for bonding dof

Model 
verification

Meshing
   > ELEMENTS
Analysis

. . .
ECHECK
DATA_CHECK, R_CHECK

Specifying 
analysis options

Analysis
   > FREQUENCY/BUCKLING

. . .
A_FREQUENCY

Specifying 
output options

Analysis
   > OUTPUT_OPS

. . .
PRINT_OPS

Executing linear 
static analysis

Analysis
   > FREQUENCY/BUCKLING

. . .
R_FREQUENCY

Postprocessing Results
Refer to COSMOS/M User Guide 
(V.1) for more details.
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Verification of Model Input Data

One of the difficulties you may come across in the solution of finite element 
problems is to avoid errors in model input data. Some of the errors can be 
detected by plotting the model in various positions, listing the element connectiv-
ities, listing material and sectional properties, plotting or listing loads and con-
straints, and many other on-line tools. For small problems, it is often easier to 
perform these checks to see if all required input data have been properly gener-
ated and defined. However, you may still miss some errors that are not easily 
identifiable. For these types of situations and also for larger problems, it is 
plausible to perform model checks in an automated environment. COSMOS/M 
provides powerful tools to verify the robustness and validity of the finite model 
you build within GEOSTAR automatically. The table below shows the commands 
you can use in model verification and their functions. 

Table  4-4. Commands for Model Input Verification

As you can notice from the above table, the Data Check command is a subset of 
the Run Check command. Even though the Run Check command identifies ele-
ments with bad geometry, the deletion of degenerate elements is performed by the 
ECHECK (Meshing > ELEMENTS > Check Element) command.

✍ You are strongly recommended to use the Run Check command and apply any 
corrections to the finite element model before performing any analysis.

Note that the Run Check command is a general model verification tool. You may 
still find some errors that are not trapped by the use of this command. In most 
cases, the diagnostic messages either printed on the screen or written to the out-
put file provide further information as to the nature of error and its remedies.

Command Menu Function

ECHECK
Meshing 
   > ELEMENTS

Checks the aspect ratios of specified elements. 
The command automatically deletes the 
degenerate elements from the model. The 
command also checks the element 
connectivities. 

DATA_CHECK Analysis
Checks if an element group, material property 
set, and a real (section) constant have been 
defined for each element in the model.

R_CHECK Analysis
Performs rigorous checks on the model for 
validity and completeness for the specified type 
of analysis.
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5 Element Library
Introduction

The Basic System features an extensive element library to suit your finite element 
modeling and analysis requirements for all types of practical problems. These 
elements model behavior of 1D, 2D, and 3D problems in linear static, buckling, 
and natural frequency and mode shape computations. Some of the elements are 
available as adaptive finite elements for application in the H-, P-, and HP-meth-
ods of analysis.

A detailed description of all elements is provided in the COSMOS/M User Guide 
(V. 1). In this chapter, a brief description of the available elements and their mod-
eling and analysis options are presented.

✍ The second part of this manual, Verification Problems, provides a listing of 
verification problems by element type. You may review these examples to 
understand the application of different types of elements available in the 
Basic FEA System.
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Basic System Element Library

The commands for element group definition and manipulation of associated ele-
ment properties are shown in the table below.

Table  5-1. Commands for Element Group Definition, Modification, and Listing

The following pages show pictorial representations of all elements available in 
the Basic System. COSMOS/M User Guide (V. 1) presents a detailed description 
of all elements in Chapter 4, Element Library.

✍ Unless otherwise specified, all commands referred to in this chapter are found 
in the Propsets and Edit menus.

EGROUP (Propsets > Element Group)

Defines element groups and the 
associated element analysis options.

The maximum number of element 
groups permitted in a model is 5000.

EPROPSET (Propsets > New Property Set)

Assigns existing element group, material 
property, and real constant groups as 
well as element coordinate system to 
newly created elements.

—

EPROPCHANGE (Propsets > Change El-Prop)

Changes the association between 
element groups, real constants sets, and 
material property sets.

—

EGLIST (Edit > LIST > Element Groups)

Lists specified element groups and the 
associated element analysis options.

The on-screen listing can be piped to a 
text file if desired, using the Control > 
MISCELLANEOUS > List Log 
command.
See Chapter 5 for more discussion on 
defining and modifying element groups.

EGDEL (Edit > DELETE > Element Groups)

Deletes specified element groups and 
the associated element analysis options.

—
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Elements for Linear Static Stress, Buckling, and Modal Analyses

3-D Truss/ Spar
Element: TRUSS3D
Nodes:     2

2-D Beam
Element: BEAM2D
Nodes:     2

3-D Beam
Element: BEAM3D 
Nodes:    2 or 3

Rigid Bar
Element: RBAR
Nodes: 2

Linear Spring
Element: SPRING
Nodes: 2

Elbow 
(Curved Pipe)
Element: ELBOW
Nodes: 3

Straight  Pipe
Element: PIPE
Nodes: 2

Linear Gap
Element: GAP
Nodes: 2

Concentrated 
Mass
Element: MASS
Nodes: 1

Boundary 
Element
Element: BOUND
Nodes: 2

4-node Plane 
Quadrilateral
Element: PLANE2D
Nodes: 4

8-node Plane 
Quadrilateral
Element: PLANE2D
Nodes: 8

4-node 
Axisymmetric  
Quadrilateral
Element: PLANE2D
Nodes: 4

8-node 
Axisymmetric  
Quadrilateral
Element: PLANE2D
Nodes: 8

3-node Plane 
Triangle
Element: TRIANG
Nodes: 3

2-D Truss/ Spar
Element: TRUSS2D
Nodes:     2

3-D Truss/ Spar
Element: TRUSS3D
Nodes:  2
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Elements for Linear Static Stress, Buckling, and Modal Analyses (Continued)

6-node Plane 
Triangle
Element: TRIANG
Nodes: 6

3-node 
Axisymmetric  
Triangle
Element: TRIANG
Nodes: 3

6-node 
Axisymmetric  
Triangle
Element: TRIANG
Nodes: 6

3-Node Thin Shell
Element: SHELL3
Nodes: 3

4-Node Thin Shell
Element: SHELL4
Nodes: 4

8/ 9-Node Thin Shell
Element: SHELL9
Nodes: 8/9

3-Node Thick Shell
Element: SHELL3T
Nodes: 3

4-Node Thick Shell
Element: SHELL4T
Nodes: 4

3-Node 
Composite Shell
Element: SHELL3L
Nodes: 3

4-Node Composite 
Shell
Element: SHELL4L
Nodes: 4

8/ 9-Node 
Composite Shell
Element: SHELL9L
Nodes: 8/9

2-Node 
Axisymmetric  Shell
Element: SHELLAX
Nodes: 2

8/ 20-Node Solid
Element: SOLID
Nodes: 8/20

4-Node Tetrahedral 
Solid
Element: TETRA4
Nodes: 4

4-Node Tetrahedral 
Solid with 
Rotat ional DOFs
Element: TETRA4R
Nodes: 4

10-Node 
Tetrahedral Solid
Element: TETRA10
Nodes: 10
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Elements for Linear Static Stress, Buckling, and Modal Analyses (Concluded)

Definition of Element Groups and Related Options

The EGROUP (Propsets > Element Group) command is used to define the ele-
ment group number and the element type, and the modeling and analysis options 
associated with the specified element. A maximum of 20 element groups can be 
defined in your finite element model.

The options “element group” is the element group number, and “element name” 
is the valid element name. Table 5-2 shows all valid element names in the Ele-
ment Group command. The elements applicable in the Basic FEA System are 
also indicated.

The command EGLIST (Edit > LIST > Element Groups) can be used to list the 
data defined by the Element Group command on the screen. By default, this 
information is also written to the output file after an analysis has been performed. 
The command EGDEL (Edit > DELETE > Element Groups) can be used to delete 
an existing element group and the associated element options. 

8-Node 
Composite 
Solid
Element: SOLIDL
Nodes: 8

8/ 20-Node 
Piez oelectric  
Solid
Element: SOLIDPZ
Nodes: 8/20

General 
St if fness
Element: GENSTIF
Nodes: 2

6-Node Shell
Element: SHELL6
Nodes: 6
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Table  5-2. Valid Element Names for the Element Group Command

Element 
Name

Description
Basic FEA 

System

BEAM2D Two dimensional elastic beam element •

BEAM3D Three dimensional elastic beam element •

BOUND Boundary element •

BUOY
1-node spherical buoyant element (usually used with 
IMPIPE element)

N/A

CLINK Convection link N/A

ELBOW Elastic curved pipe (elbow) element •

ELINK Electrical link N/A

FLOW2D Two dimensional fluid flow element N/A

FLOW3D Three dimensional fluid flow element N/A

GAP Gap element •

GENSTIF General stiffness element •

HLINK Hydraulic link •

IMPIPE 2-node immersed pipe or cable element N/A

MAG2D 2D magnetic element N/A

MAG3D 3D magnetic element N/A

MASS General mass element •

PIPE Elastic Straight pipe element •

PLANE2D 4- to 8-node plane and axisymmetric element •

RBAR Rigid bar element •

RLINK Radiation link N/A

SHELL3 3-node thin shell element •

SHELL3L Multi-layer 3-node shell/plate element •

SHELL3T 3-node thick shell element •

SHELL4 4-node thin shell element •

SHELL6 6-node thin shell element •

SHELL6T 6-node thick shell element •

SHELL4L Multi-layer 4-node shell/plate element •
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Table  5-2. Valid Element Names for the Element Group Command (Concluded)

Every element in the foregoing table has different analysis and modeling options 
(maximum of seven entries), designated as OP1, …, OP7. When you execute the 
Element Group command, you are prompted for the physical interpretation for the 
options depending on the selected element. Some of the arguments in the option 
field are unused for analysis in the Basic System.

Table 5-3 in the following pages shows a summary of the analysis and modeling 
options in the Basic System. Table 5-4 shows the output coordinate systems for 
all elements. Refer to Chapter 4, Element Library, of the COSMOS/M User Guide 
(V. 1) for more information on elements.

Element 
Name

Description
Basic FEA 

System

SHELL4T 4-node thick shell element •

SHELL9 9/8-node shell element •

SHELL9L Composite 9/8-node shell element •

SHELLAX Axisymmetric shell element •

SOLID 8- to 20-node 3D solid element •

SOLIDL Composite 8-node solid element •

SOLIDPZ 8- to 20-node 3D solid piezoelectric element •

SPRING Spring element •

TETRA10 10-node tetrahedral solid element •

TETRA4 4-node tetrahedral solid element •

TETRA4R
4-node tetrahedral solid element with translational and 
rotational dof

•

TRIANG 3- to 9-node triangular plane and axisymmetric element •

TRUSS2D Two dimensional truss/spar element •

TRUSS3D Three dimensional truss/spar element •
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Element
OP1

TRUSS2D unused

TRUSS3D unused

BEAM2D unused

BEAM3D Section Type
0=symmetric
1=un-symm.
2=sym. taper

RBAR

SPRING Spring Type
0=axial sprin
1=rotat. sprin
2=both

PIPE

ELBOW

GAP Surface Upda
0=fixed
1=movable

MASS

BOUND Boundary Typ
0=axial sprin
1=rotat. sprin
2=both

PLANE2D Element type
0=struct./ther
1=fluid

TRIANG unused
Table  5-3. Modeling and Analysis Options for Elements

Element Options

OP2 OP3 OP4 OP5 OP6 OP7

unused unused unused default default default

unused unused unused default default default

unused unused default default default unused

ed

unused unused default default default unused

none

g
g

default unused unused default default unused

none

none

te Friction
0=no friction
1=friction, no sliding
2=friction, sliding

default default default Cmprsv Gap 
Msmnt
0=user defined
1=auto

default

none

e
g
g

unused unused unused unused unused unused

m.
Quadrature
0=Red. Int.
1=QM6
2=Full Int.

Prob. Type
0=Pl. Stress
1=Axisymm.
2=Pl. Strain
3=Axisymm.

Str. Output
0=global CS
1=ECS

default default default

unused Prob. Type
0=Pl. Stress
1=Axisymm.
2=Pl. Strain

Str. Output
0=global CS
1=ECS

unused unused unused
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Element
OP1

SHELL3 unused

SHELL4 Element Type
0=QUAD2
1=QUAD4
2=QUAD

SHELL6 unused

SHELL3T unused

SHELL4T Element Type
0=QUAD2
1=QUAD4
2=QUAD

SHELL6T unused

SHELL3L unused

SHELL4L Element Type
0=QUAD2
1=QUAD4
2=QUAD

SHELL9 No. of Nodes
0=9 nodes
1=8 nodes
Table  5-3. Modeling and Analysis Options for Elements Continued)

Element Options

OP2 OP3 OP4 OP5 OP6 OP7

Ana. Option
0=shell
1=membrane
2=shear panel

Stress Print
0=elem. center
1=+nodal force
2=+nodal str.

Nodal Stress 
Dir.
0=global CS
1=local CS

default default unused

Ana. Option
0=shell
1=membrane
2=shear panel

Stress Print
0=elem. center
1=+nodal force
2=+nodal str.

Nodal Stress 
Dir.
0=global CS
1=local CS

default default unused

Integ. type
0=Red. 
1=full

unused Nodal Stress 
Dir.
0=global CS
1=local CS

unused unused unused

Ana. Option
0=shell
1=membrane
2=shear panel

Stress Print
0=elem. center
1=+nodal force
2=+nodal str.

Nodal Stress 
Dir.
0=global CS
1=local CS

default default unused

Ana. Option
0=shell
1=membrane
2=shear panel

Stress Print
0=elem. center
1=+nodal force
2=+nodal str.

Nodal Stress 
Dir.
0=global CS
1=local CS

default default unused

Ana. Option
0=shell
1=membrane
2=shear panel

Stress Print
0=elem. center
1=+nodal force
2=+nodal str.

Nodal Stress 
Dir.
0=global CS
1=local CS

default default unused

No. of Layers Nodal Str. Dir.
0=global CS
1=local CS
2=material CS

Layer 
number for 
plotting 
stresses

default default Input
0=layers
1=sandwich

No. of Layers Nodal Str. Dir.
0=global CS
1=local CS
2=material CS

unused default default Input
0=layers
1=sandwich

Quadrature
0=γ  - φ method
1=Red. Integr.

unused Nodal Stress 
Dir.
0=global CS
1=local CS

unused unused unused
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Element
OP1

SHELL9L No. of Node
0=9 nodes
1=8 nodes

SHELLAX

TETRA4 N/A

TETRA4R N/A

TETRA10 N/A

SOLID Element Typ
0=solid
1=fluid

SOLIDL Quadrature
0=red. Int.
1=hybrid
2=full Int.

SOLIDPZ Integration T
1=hybrid
2=full

GENSTIF
Table  5-3. Modeling and Analysis Options for Elements (Concluded

Element Options

OP2 OP3 OP4 OP5 OP6 OP7

s Quadrature
0=γ  - φ method
1=Red. Integr.

No. of Layers Layer 
number for 
plotting 
stresses

Stress Dir.
0=glob.
1=local 

unused unused

none

unused unused Str. Output
0=global CS
1=ECS

unused unused unused

unused unused Str. Output
0=global CS
1=ECS

unused unused unused

unused unused Str. Output
0=global CS
1=ECS

unused unused unused

e Quadrature
0=red. Int.
1=hybrid
2=full Int.

unused Str. Output
0=global CS
1=ECS

default default default

No. of Layers Nodal Str. Dir.
0=global CS
1=local CS
2=material CS

Layer 
number for 
plotting 
stresses

unused unused unused

ype unused Nodal Str. Dir.
0=global CS
1=local CS
2=material CS

Print Str.
0=Top & 
Bottom.

unused unused unused

none
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Table  5-4. Element Output Coordinate Systems

Element Name
Element Local Coordinate System

(ECS=-1, or 1) Global
(ECS=0)

Default Cartesian Cylindrical Spherical

TRUSS2D -1 0 1 2 0

TRUSS3D -1 0 1 2 0

BEAM2D -1 0 1 2 0

BEAM3D -1 0 1 2 0

RBAR -1 0 1 2 0

SPRING -1 0 1 2 0

PIPE -1 0 1 2 0

ELBOW -1 0 1 2 0

GAP -1 0 1 2 0

MASS -1 0 1 2 0

BOUND -1 0 1 2 0

PLANE2D 4-NODE -1 0 1 2 0

PLANE2D 8-NODE -1 0 1 2 0

PLANE2D 4-NODE (Axi.) -1 0 1 2 0

PLANE2D 8-NODE (Axi.) -1 0 1 2 0

TRIANG 3-NODE -1 0 1 2 0

TRIANG 6-NODE -1 0 1 2 0

TRIANG 3-NODE (Axi.) -1 0 1 2 0

TRIANG 6-NODE (Axi.) -1 0 1 2 0

SHELL3 -1 0 1 2 0

SHELL 6 -1 0 1 2 0

SHELL4 -1 0 1 2 0

SHELL3T -1 0 1 2 0

SHELL4T -1 0 1 2 0

SHELL3L -1 0 1 2 0

SHELL4L -1 0 1 2 0

SHELL9 -1 0 1 2 0

SHELL9L -1 0 1 2 0

SHELLAX -1 0 1 2 0

TETRA4 -1 0 1 2 0

TETRA4R -1 0 1 2 0

TETRA10 -1 0 1 2 0

SOLID -1 0 1 2 0

SOLIDL -1 0 1 2 0

SOLIDPZ -1 0 1 2 0

GENSTIF -1 0 1 2 0
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Property Definitions for Elements
The material and sectional properties for elements are defined using commands in 
the Propsets menu. The table below summarizes the functions of commands in this 
menu.

Table  5-5. Commands for Property Definitions (Propsets and Edit Menus)

The next chapter provides an in-depth coverage of property definitions for 
elements in the Basic System. The table below provides a summary of available 
material and sectional properties in the Basic System. Table 5-7 lists the available 
built-in material and section library features for elements.

Command Description Remarks

MPROP (Propsets > 
Material Property)

Defines a material property set and 
the property values for valid material 
names (see Table 6-2) in this set.

The maximum number of 
material property sets allowed in 
a model is 90.

PICK_MAT (Propsets > 
Pick Material Lib)

Selects a material from the built-in 
material library.

There are 14 materials in the 
built-in material library.

USER_MAT (Propsets > 
User Material Lib)

Selects a material from the user-
defined material library.

The format of the user-defined 
library must be the same as that 
of the built-in library, and should 
be named USERMAT.LIB in the 
COSMOS/M directory.

R_MATLIB (Propsets > 
Material Browser)

Runs the add-on material browser to 
select materials from an extensive 
library that includes temperature and 
stress-strain curves.

It is required to purchase the 
material browser before using 
this utility.

MPLIST (Edit > LIST > 
Material Props)

Lists material properties defined for 
the specified sets on the screen.

You can also route the on-screen 
listing of material properties to a 
file.

MPDEL (Edit > DELETE 
> Material Props)

Deletes material properties for the 
specified set(s).

RCONST (Propsets > 
Real Constant)

Defines a section property set and the 
property values applicable (see Table 
6-11) for the type of element in this set.

The maximum number of real 
constant sets is 1000. The 
element group must be selected 
prior to executing this command.

PICK_SEC (Propsets > 
AISC Sect. Table)

Selects a specified shape of AISC 
section from the built-in section library 
and the corresponding section 
properties.

See AISC handbook for more 
information on standard steel 
sections.

RCLIST (Edit > LIST > 
Real Constants)

Lists section and other physical 
properties defined for specified sets 
on the screen.

The on-screen listing can be 
piped to a text file if desired, 
using the List Log command.

RCDEL (Edit > DELETE 
> Real Constants)

Deletes section and other physical 
properties for the specified sets.
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* 
** 
Table  5-6. Summary of Properties for Elements in the Basic FEA System

COSMOS/M 
lement Name

Material Properties Section 
Constant

Mass Element Loads

Iso Orth Anis Th Pz Lu Dis Me Th Gr

2D • • 2 • • • •

3D • • 2 • • • •

2D • • 7 • • • • •

3D • • 14 to 27 • • • • •

N/A N/A N/A N/A N/A 1 • • N/A N/A N/A

G N/A N/A N/A N/A N/A 2 • • N/A N/A N/A

• • 3 • • • • •

• • 4 • • • • •

N/A N/A N/A N/A N/A 2 N/A N/A

N/A N/A N/A N/A N/A 7 • N/A N/A N/A

D N/A N/A N/A N/A N/A 2 N/A N/A

2D 4-NODE • • • 2 • • • • •

2D 8-NODE • • • 2 • • • • •

2D 4-NODE (Axi.) • • • 1 • • • • •

2D 8-NODE (Axi.) • • • 1 • • • • •

G 3-NODE • • • 2 • • • • •

G 6-NODE • • • 2 • • • • •

G 3-NODE (Axi.) • • • 1 • • • • •

G 6-NODE (Axi.) • • • 1 • • • • •

3 • • 3 • • • • •

4 • • 3 • • • • •

 6 • • • 2 • • • • •

3T • • 3 • • • • •

4T • • 3 • • • • •

3L • • • • 2+3NL* • • • • •

4L • • • • 2+3NL* • • • • •

9 • • 1 • • • • •

9L • • • 2+3NL* • • • • •

AX • • 1 • • • •

4 • • • N/A • • • • •

4R • • • • N/A • • • • •

10 • • • • N/A • • • • •

• • • • 9** • • • • •

L • • • 2+6NL* • • • • •

PZ • • • N/A • N/A • •

TIF • • • N/A • N/A • • N/A N/A N/A

depends on the number of layers (NL)
for defining orthotropic material axis orientation only
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Table  5-7. Material and Section Libraries for Elements in the Basic FEA System

Element Name
Material Library Section Library

Built-In User-Defined COSMOS/M AISC

TRUSS2D • •

TRUSS3D • •

BEAM2D • • • •

BEAM3D • • • •

RBAR N/A N/A N/A N/A

SPRING N/A N/A

PIPE • •

ELBOW • •

GAP N/A N/A N/A N/A

MASS N/A N/A N/A N/A

BOUND N/A N/A N/A N/A

PLANE2D 4-NODE • •

PLANE2D 8-NODE • •

PLANE2D 4-NODE (Axi.) • •

PLANE2D 8-NODE (Axi.) • •

TRIANG 3-NODE • •

TRIANG 6-NODE • •

TRIANG 3-NODE (Axi.) • •

TRIANG 6-NODE (Axi.) • •

SHELL3 • •

SHELL4 • •

SHELL3T • •

SHELL 6 • •

SHELL4T • •

SHELL3L * *

SHELL4L * *

SHELL9 • •

SHELL9L * *

SHELLAX • •

TETRA4 • •

TETRA4R • •

TETRA10 • •

SOLID • •

SOLIDL * *

SOLIDPZ N/A N/A

GENSTIF N/A N/A

* A different material can be assigned to each layer (see Chapter 6)
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Elements for Adaptive FEA

In the Basic System, an automated approach is available for mesh refinement 
based on reducing errors due to mesh discretization. The H-method of the finite 
element method refers to a convergence based on progressive reduction of ele-
ment size whereas the P-method is refers to the refinement approach in which the 
polynomial degree is adaptively refined. The combined approach is called the 
HP-method.

The table below summarizes the adaptive method and the applicable elements in 
the Basic System.

Table  5-8. Elements for Adaptive Analysis in the Basic System

Please refer to COSMOS/M User Guide (V. 1) for more information on adaptive 
finite element analysis.

Adaptive Method Available Elements

H-method TRIANG, SHELL3, SHELL3T, TETRA4, TETRA4R, TETRA10

P-method 6-node TRIANG, 8-node PLANE2D, SHELL9L,TETRA10

HP-method 6-node TRIANG, TETRA10
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6 Material, Sectional and 
Other Physical Properties
Introduction

In finite element analysis, the elements provide the spatial approximation to the 
model geometry, whereas the mathematical models for material properties pro-
vide the physical representation. It is well known that the accuracy of finite 
element analysis depends on the accuracy with which these idealizations are car-
ried out, in addition to various other factors. Accurate description of material 
properties is therefore an important aspect of finite element modeling. A com-
prehensive finite element solver should provide all required capabilities for accu-
rately describing the physical nature of the material in your model. COSMOS/M 
meets this goal by providing elaborate and extensive yet tractable capabilities for 
describing the material, sectional, and other types of physical properties in your 
finite element model.

In the Basic FEA System, the material property definitions include elastic, ther-
moelastic, mass, and piezoelectric properties. The mass density is required when 
the analysis type needs mass information. For example, in natural frequency 
calculations and in elastostatic analysis with inertial loading, mass density is 
required to be input. The material property definitions also include the allowable 
stresses for computing the failure indices in layered composites. The sectional 
and other physical property definitions include cross sectional area, moment of 
inertia, depth or thickness, perimeter, temperature gradients across the thickness, 
end release conditions, and other information for computing the element matri-
ces. They also include the definition of spring constants and friction coefficients.
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In order to numerically evaluate the behavior of finite element models, the mate-
rial properties input are applied in various mathematical models, otherwise 
known as Constitutive Relations. Hooke's law which represents a linear relation 
between stress and strain is a simple form of constitutive relation. This chapter 
presents a detailed description of the various material properties required for 
analysis in the Basic FEA System and the corresponding constitutive relations. 
The commands and procedures to accomplish these along with the definition of 
sectional and other physical properties are also presented. The descriptions are 
supplemented with many illustrations and examples to make your understanding 
clear and comprehensive.

Property Definitions in COSMOS/M

The definition of element type to be used in the analysis as well as the associated 
material and sectional properties are specified using the Propsets, Control > 
MEASURE, Edit > LIST, and Edit > DELETE menus in COSMOS/M. The table 
below outlines the function of all commands in this menu.

Table  6-1. Functions of Commands in the Propsets, Control > MEASURE, 
Edit > LIST, and Edit > DELETE Menus

Command Description Remarks

MPROP (Propsets > 
Material Property)

Defines a material property set and the 
property values for valid material 
names (see Table 6-2) in this set.

The maximum number of 
material property sets 
allowed in a model is 90.

PICK_MAT (Propsets > 
Pick Material Lib)

Selects a material from the built-in 
library.

There are 45 materials in the 
built-in library.

USER_MAT (Propsets > 
User Material Lib)

Selects a material from the user-
defined material library.

The format of the user-defined 
library must be the same as 
that of the built-in library.

MPLIST (Edit > LIST > 
Material Props)

Lists material properties defined for the 
specified sets on the screen.

You can also route the on-
screen listing of material 
properties to a file using 
LISTLOG.

MPDEL (Edit > DELETE> 
Material Props)

Deletes material properties for the 
specified set(s).

RCONST (Propsets > 
Real Constant)

Defines a section property set and the 
property values applicable (see Table 
6-2) for the type of element in this set.

The maximum number of real 
constant sets is 5000. The 
element group must be 
selected prior to executing 
this command.
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Table  6-1. Functions of Commands in the Propsets, Control > MEASURE, 
Edit > LIST, and Edit > DELETE Menus (Concluded)

Command Description Remarks

RCONST (Propsets > 
Real Constant)

Defines a section property set and the 
property values applicable (see Table 
6-2) for the type of element in this set.

The maximum number of real 
constant sets is 5000. The 
element group must be 
selected prior to executing 
this command.

PICK_SEC (Propsets > 
AISC Sect Table)

Selects a specified shape of AISC 
section from the built-in section library 
and the corresponding section 
properties.

See AISC handbook for more 
information on standard steel 
sections.

RCLIST (Edit > LIST > 
Real Constants)

Lists section and other physical 
properties defined for specified sets on 
the screen.

The on-screen listing can be 
piped to a text file if desired, 
using the LISTLOG command.

RCDEL (Edit > DELETE> 
Real Constants)

Deletes section and other physical 
properties for the specified sets.

MASSPROP (Control > 
MEASURE > Find Mass 
Property)

Computes length, area, volume, mass, 
center of gravity, moment of inertia, 
radius of gyration, direction cosines, 
etc., for selected elements and 
displays the results on the screen.

The on-screen listing can be 
piped to a text file if desired, 
using the LISTLOG command.

EGROUP (Propsets > 
Element Group)

Defines element groups and the 
associated element analysis options.

The maximum number of 
element groups permitted in a 
model is 20.

EPROPSET (Propsets > 
New Property Set)

Assigns existing element group, 
material property, and real constant 
groups as well as element coordinate 
system to newly created elements.

EPROPCHANGE 
(Propsets > Change 
El-Prop)

Changes the association between 
element groups, real constants sets, 
and material property sets.

The active element group, real 
constant or material property 
sets can be listed using the 
STATUS1 command.

EGLIST (Edit > LIST > 
Element Groups)

Lists specified element groups and the 
associated element analysis options.

See Chapter 5 for more 
discussion on defining and 
modifying element groups.

EGDEL (Edit > DELETE> 
Element Groups)

Deletes specified element groups and 
the associated element analysis 
options.

BMSECDEF (Propsets > 
Beam Section)

Selects a standard beam cross section 
from the built-in section library.

There are 10 standard sections 
in addition to a user-defined 
section of arbitrary shape.

BMSECLIST (Edit > 
LIST> Beam Section)

Lists the selected standard beam 
cross section.
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This chapter focuses on presenting you with in-depth information on defining the 
material, sectional, and other physical properties of your finite element model. 
Related theoretical concepts and mathematical models are briefly explained (for a 
more detailed theoretical discussion, please refer to the COSMOS/M Theoretical 
Manual). However, you will learn more in detail about how to use these mathe-
matical models in COSMOS/M and the required input for proper usage. This 
chapter also discusses the procedure to compute mass and inertia properties of 
structures using the MASSPROP (Control > MEASURE > Find Mass Property) 
command.

In order to preserve the clarity of presentation, the element groups definitions, 
corresponding element option selections, and the modification of these defini-
tions are discussed in Chapter 5, Element Library.

✍ Unless otherwise specified, all commands referred to in this chapter are found 
in the Propsets, Control > MEASURE, Edit > LIST, and Edit > DELETE 
menus.

Almost all commands referenced in this manual are the cryptic ones which are 
actually parsed and interpreted by the program. Enhanced (or English-like) com-
mands you also see on the screen only serve the purpose of increasing the read-
ability and user-friendliness of the graphical interface.

A Note About Units

In COSMOS/M, you can adopt any system of units, including standard and non-
standard systems. However, units must be consistent and you should interpret the 
results accordingly. Appendix A presents a detailed description of consistent 
units applicable to analyses in the Basic FEA System. This appendix also features 
conversion factors from one system of units to another, and other useful informa-
tion.

If you are making use of the built-in material library in COSMOS/M (using 
PICK_MAT (Propsets > Pick Material Lib) or USER_MAT (Propsets > User 
Material Lib) commands), a word of caution about units is in order. The material 
properties in these material libraries are available in FPS, MKS, and SI systems. 
However, the property values stored are not literal versions of units implied in 
these systems. The only exception is the SI system.
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✍ Even though the FPS system implies foot as the unit of length, the built-in 
material libraries use inch. This was done to make it easier for the practicing 
engineers and scientists who can relate to the prevailing industry standards.

✍ On the same token, if you choose the MKS system, the built-in material 
libraries use centimeter as the unit of length instead of meter. You need to 
keep this in mind when building a finite element model.

Material Properties in COSMOS/M

All material properties in COSMOS/M are defined using the command MPROP 
(Propsets > Material Property). This command assigns a material set number 
under which you can define more than fifty different material properties. The 
defined material set number can be related to one or more element group num-
bers. Table 6-2 shows the valid material names you can use for defining the 
required material properties. Some of the property names in this table are not 
applicable in the Basic FEA System.

All valid material names from Table 6-2 can be assigned to one set. Each material 
name may have one or more (up to 21) property values to be input. The com-
mands PICK_MAT (Propsets > Pick Material Lib) and USER_MAT (Propsets > 
User Material Lib) can also be used to define a material set and select properties 
from the built-in or your own material libraries for that set. The properties 
selected from the libraries can be further appended by executing the MPROP 
(Material Property) command.

The command MPDEL (Edit > DELETE > Material Props) can be used to delete a 
material property set. If you only need to modify or delete a particular property in 
a material set, you need to re-execute the MPROP (Material Property) command 
and specify either zero or any other required value for that property name. For 
more information on modification of material property definitions, please refer to 
the section, Modification, Display, and Output of Material Property Definitions.

The command MPLIST (Edit > LIST > Material Props) can be used to list all 
material properties associated with a set on the screen. If you request for a 
detailed output using the PRINT_OPS (Analysis > OUTPUT OPTIONS > Set 
Print Options) command, the material property data will also be written to the 
output file (jobname.OUT) after an analysis is performed.
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To define material properties, execute the MPROP (Material Property) command 
and specify the required property names from Table 6-2. You will be again 
prompted to specify another property name (and the corresponding property 
value if you respond to the prompt) for a maximum of 21 times. If you need to 
define more than 21 material properties under the same material set, you need to 
re-execute the MPROP (Material Property) command. The significance of num-
ber 21 is that it represents the maximum number of elastic coefficients to be input 
for anisotropic materials. Most other materials with isotropic or orthotropic elas-
tic and thermal properties can be adequately described with fewer constants. The 
MPROP (Material Property) command is illustrated below:

Geo Panel:     Propsets > Material Property
Material property set > 1
Material Property Name > EX: Elasticity modulus in X mat. dir.
Property value > 20E6

Table  6-2. Property Names in COSMOS/M

Property Name Description Basic 
System Units

ALPH1, ALPH2, 
ALPH3, ALPH4

First, second, third and fourth power 
coefficients of Ogden material model N/A

ALPX, ALPY, ALPZ Coefficient of thermal expansion in 
material X-, Y-, and Z-directions • Strain/Temp

BETA Coefficient of volume expansion N/A

C Specific heat N/A Heat/
(Mass•Degree)

COHESN Cohesion strength N/A Force/Area

CREEPC Creep constants for the classical creep 
law (three constants are needed) N/A none

CREEPX Creep constants for the exponential creep 
law (seven constants are needed) N/A none

DAMP Material Damping coefficient N/A none

DCij
Coefficients of the dielectric matrix (six 
constants are needed) •

DENS Mass density • Mass/Volume

ECONX, ECONY, 
ECONZ

Electric conductivity in the global 
Cartesian X-, Y-, and Z-directions N/A Current/Potential

EMIS Emissivity (Radiation) N/A none

ETAN Tangent elastic modulus N/A Force/Area

EX, EY, EZ Elasticity modulus in X-, Y-, and Z-
directions • same as above
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Table  6-2. Property Names in COSMOS/M (Continued)

Property Name Description Basic 
System Units

FRCANG Friction angle N/A Degrees

G1 through G8 Shear relaxation moduli (for 
viscoelasticity) •

GAMMA Ratio of specific heats N/A

GXY, GXZ, GYZ Shear modulus, X-Y, X-Z, and Y-Z 
directions • Force/Area

HC Convection film coefficient N/A Heat/(Time•Area•
Degree)

K1 through K8 Bulk relaxation moduli (for viscoelasticity) N/A

KX, KY, KZ Thermal conductivity in the global 
Cartesian X-, Y-, and Z-directions N/A Heat•Length/(Time•

Area•Degree)

MCij
Anisotropic elastic moduli (twenty one 
constants are needed)

Force/Area or Area/
Force

MOONEY_A, 
MOONEY_B, 
MOONEY_C, 
MOONEY_D, 
MOONEY_E, 
MOONEY_F

First, second, third, fourth, fifth, and sixth 
material constants for Mooney-Rivlin 
hyperelastic material model

N/A Force/Area

MPERM Magnetic permeability N/A Inductance/Length

MU1 through MU4 First, second, third and fourth constants 
for Ogden material model N/A

NUXY
Poisson's ratio, strain in the second 
material direction due to unit strain in the 
first material direction 

• none

NUXZ
Poisson's ratio, strain in the third material 
direction due to unit strain in the first 
material direction

• none

NUYZ
Poisson's ratio, strain in the third material 
direction due to unit strain in the second 
material direction 

• none

PCij
Coefficients of the piezoelectric material 
matrix (eighteen constants are needed) •

PERMIT Permittivity (dielectric constant) N/A Farads/Length

PMAGR, PMAGT
Coercivity of a permanent magnet in the 
radial and tangential directions of the 
global cylindrical system

N/A Amperes/Length

PMAGX, PMAGY, 
PMAGZ

Coercivity of a permanent magnet in the 
global Cartesian X-, Y-, and Z-direction N/A Amperes/Length
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Table  6-2. Property Names in COSMOS/M (Concluded)

The types of material descriptions applicable in linear static stress analysis 
encompass elastic, thermoelastic, piezoelectric, and mass properties. Elastic 
properties include the various elastic moduli and Poison's ratios. If the elastic 
properties are temperature sensitive, then the material description should use 
thermoelastic properties which includes the coefficient of thermal expansion as 
well as some form of dependencies of the elastic moduli and Poison's ratios on 
temperature. Piezoelectric material description includes the elastic, dielectric, 
and piezoelectric properties required to be input in electroelastic analysis. Mass 
property includes the density of the material which can also be made temperature 
dependent.

The material descriptions mentioned above can be applied to all available ele-
ments in the Basic FEA System, with the only exception of piezoelectric descrip-
tion which is applicable to the SOLIDPZ element. The types of material 
descriptions available for all elements in the Basic FEA System are shown in 
Table 6-3. Note that the mass property is applicable to all elements in this table 
with the exception of BOUND, GAP, GENSTIF, RBAR, and SPRING elements. 

Property Name Description Basic 
System Units

REFTMP Glassy transition temperature for 
viscoelasticity N/A

SIGXC Compressive strength in material X-
direction • Force/Area

SIGXT Tensile strength in material X-direction • same as above

SIGXY Shear strength in material X-Y plane • same as above

SIGYC Compressive strength in material Y-
direction • same as above

SIGYLD Yield stress N/A same as above

SIGYT Tensile strength in material Y-direction • same as above

TAUG1 through 
TAUG8

Time values associated with shear 
relaxation moduli G1 through G8 (used in 
viscoelasticity)

N/A

TAUK1 through 
TAUK8

Time values associated with bulk 
relaxation moduli K1 through K8 (used in 
viscoelasticity)

N/A

VC1, VC2 Constants for the William-Landel-Ferry 
equation used in viscoelasticity N/A

VISC Dynamic Viscosity N/A Force•Time/Area
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The description of elastic property covers the definition of isotropic, orthotropic, 
and anisotropic properties and the procedure to input them in COSMOS/M, fol-
lowed by a section for the description of thermoelastic property. Properties for 
layered composites as well as the available failure criteria are discussed in a sep-
arate section, followed by a section for the dielectric and piezoelectric matrices 
and their input for electroelastic analysis. There is also a section for mass and 
damping properties. The use of the built-in material library is fully documented 
in another section.

Table  6-3. Material Properties for Elements in the Basic System 

COSMOS/M
Element Name

Linear Elastic 
Properties

Thermoelastic 
Property Piezoelectric 

Property
Iso Ortho Anis Iso Ortho Anis

TRUSS2D • •

TRUSS3D • •

BEAM2D • •

BEAM3D • •

RBAR N/A N/A N/A N/A N/A N/A N/A

SPRING N/A N/A N/A N/A N/A N/A N/A

PIPE • •

ELBOW • •

GAP N/A N/A N/A N/A N/A N/A N/A

MASS N/A N/A N/A N/A N/A N/A N/A

BOUND N/A N/A N/A N/A N/A N/A N/A

PLANE2D 4-NODE • • • •

PLANE2D 8-NODE • • • •

PLANE2D 4-NODE (Axi.) • • • •

PLANE2D 8-NODE (Axi.) • • • •

TRIANG 3-NODE • • • •

TRIANG 6-NODE • • • •

TRIANG 3-NODE (Axi.) • • • •

TRIANG 6-NODE (Axi.) • • • •

SHELL3 • •

SHELL4 • •

SHELL3T • •
COSMOS/M Basic FEA System 6-9

http://www.cosmosm.com


Chapter 6   Material, Sectional and Other Physical Properties

6-10
Table  6-3. Material Properties for Elements in the Basic System (Concluded)

Elastic Material Properties

The behavior of a material is said to be elastic when its displacement is linearly 
proportional to the applied load, and returns to its undeformed state when the 
load is removed. For elastic materials, stress is directly proportional to the strain 
as indicated below:

{σ} = [D] {ε  - ε t}  (6-1)

where [D] is the elastic (isotropic, anisotropic, or orthotropic) material or mate-
rial stiffness matrix, {σ} is the total stress vector, {ε} is the total strain vector, and 
{ε t} is the thermal strain vector. The above rule is an approximation and is valid 
as long as the strains are small, for certain types of materials. The inverse form of 
the above equation can be written as:

{ε  - ε t} = [C] {σ}  (6-2)

COSMOS/M
Element Name

Linear Elastic 
Properties

Thermoelastic 
Property Piezoelectric 

Property
Iso Ortho Anis Iso Ortho Anis

SHELL4T • •

SHELL3L • • • • •

SHELL4L • • • • •

SHELL6 • • •

SHELL9 • •

SHELL9L • • • •

SHELLAX • •

TETRA4 • • • • •

TETRA4R • • • • •

TETRA10 • • • • •

SOLID • • • • • •

SOLIDL • • • •

SOLIDPZ • • • N/A • N/A •

GENSTIF • • • N/A N/A N/A •

In the above table: Iso = isotropic, Ortho = orthotropic, Anis = anisotropic.
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where [C] represents the elastic material compliance matrix, and it is the inverse 
of the elastic material matrix [D]. Equations 6-1 and 6-2 are also known as con-
stitutive relations which assume a simple form for linear elastic materials. How-
ever, for nonlinear materials (available in NSTAR), the constitutive relations can 
be quite complex.

In COSMOS/M, for anisotropic materials, you can input the coefficients of either 
[C] or [D]. However, for isotropic and orthotropic materials, you can only input 
the coefficients of [D]. The definition of isotropic, anisotropic and orthotropic 
materials are provided in the following sections.

In order for you to better understand the linear elastic constitutive relations and 
the corresponding input, the components of displacement, stress, and strain vec-
tors encountered in one-, two-, and three-dimensional elastostatic analysis are 
shown in the table below:

Table  6-4. Displacement Components, Stress and Strain Vectors 
in Elastostatic Analysis

Isotropic Elastic Properties

If the properties of a material do not vary with direction, then it is said to be 
isotropic. Isotropic materials therefore have identical elastic modulus, Poisson's 
ratio, coefficient of thermal expansion, thermal conductivity, etc. in any direction. 
The term isothermal is some times used to denote materials with no preferred 
directions for coefficients of thermal expansion.

Problem Type Displacement 
Components Strain Vector {ε}T Stress Vector {σ}T

Bar (Truss) u [εx] [σx]

Beam w [θx] [Mx]

Plane Stress u,v [εx εy  γxy] [σx  σy  τ xy]

Plane Strain u,v [εx  εy  γxy] [σx  σy  τ xy]

Axisymmetric r,θ,z [ε r εθ γ rθ εz] [σr  σθ  τ rθ  σz]

Three-dimensional u,v,w [εx εy εz γxy  γyz γzx] [σx σy σz τ xy  τ yz τ zx]

Plate Bending w [θx  θy  θxy] [Mx My Mxy]

Notation
εx = u,x     εy = v,y     γxy = u,y + v,x
θx = -w,xx     θy = w,yy     θxy = 2w,xy
where “,” denotes partial derivaton, for example: εx = ∂u/∂x
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In order to define the isotropic elastic properties, you can input a combination of 
any two of the following coefficients: elastic modulus Ex, Poisson's ratio νxy, and 
shear modulus, Gxy. The third coefficient not input is internally computed by the 
program using the relation:

E = 2G(1 + ν)

The [C] or [D] matrix for an isotropic material contains only two independent 
coefficients.

The following sections describe the isotropic stress-strain relations in two- and 
three-dimensions as well as for axisymmetric solids including the effect of ther-
mal strains.

Two Dimensional Isotropic Stress-Strain Relations

For problems with in-plane loading, finite element analysis is frequently per-
formed using plane elements for which two dimensional stress-strain relations are 
applied. The deformation states in two dimensions can be either plane stress or 
plane strain, and for either one of these states to prevail, the plane under con-
sideration (normally, the x-y plane) must be a plane of elastic symmetry.

Plane Stress

Plane stress represents a condition that prevails in a flat plate, normally in the 
x-y plane, loaded only in its own plane and without z-direction restraint so that 
the z-components of stresses are zero. For an isotropic material, the stress-strain 
relations with thermal effects in plane stress are as shown below:

(6-3)

Plane stress elastic constitutive relations are applicable to PLANE2D and 
TRIANG elements only. After having specified these element names using the 
EGROUP (Propsets > Element Group) command, you need to input the plane 
stress condition under the third option, OP3; see Chapter 5, Element Library, for 
more information.
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Plane Strain
Plane strain represents a deformation state in which the z-components of strains 
are zero. The displacements in the x-y plane are functions of only x and y but not 
of z. For an isotropic material, the stress-strain relations with thermal effects in 
plane strain are as shown below:

(6-4)

The z-component of stress (σz) does not appear in the above equation even though 
it is usually not zero. However, it can be calculated once σx and σy are known.

Plane strain elastic constitutive relations are applicable to PLANE2D and 
TRIANG elements only. After having specified these element names using the 
EGROUP (Propsets > Element Group) command, you need to input the plane 
strain condition under the third option, OP3; see Chapter 5, Element Library, for 
more information.

Axial Symmetry

In many practical applications, the models are solids of revolution, and are there-
fore axially symmetric. The behavior of such models is independent of the cir-
cumferential coordinate. A two dimensional slice of the model can be used to 
accurately simulate the three dimensional problem. Axially symmetric solids 
therefore require a 4 by 4 elastic material matrix, as shown below:

(6-5)
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The equivalence for stress (or strain) components between axisymmetric solids 
and general three dimensional solids is as follows: σr = σx, σθ = σy, σz = σz. 

Axisymmetric elastic constitutive relations are applicable to PLANE2D, 
TRIANG, and SHELLAX elements only. For the axisymmetric shell element, 
these relations applied by default. But for PLANE2D and TRIANG elements, 
using the EGROUP (Propsets > Element Group) command, you need to specify 
the axisymmetric condition under the third option, OP3; see Chapter 5, Element 
Library, for more information.

Three-Dimensional Isotropic Stress-Strain Relations

The most general form of the isotropic stress-strain relations including thermal 
effects is shown below:

(6-6)

Three dimensional stress-strains relations are applied by default to all solid ele-
ments, and you do not need to use any other command.

Beam and Plate Bending

For beam bending, uniaxial stress prevails so that, σx = E εx. An alternate form of 
this equation that relates the bending moment with rotations is:

M = -EIθx  (6-7)

For beam and truss elements, only the elastic modulus (EX) is used in the element 
stiffness matrix computation. Expanded in two dimensions, the above expression 
can be modified for plate bending as:
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 (6-8)

where h is the plate thickness. However, plate and shell elements available in 
COSMOS/M use the constitutive relations in the stress-strain form as opposed to 
the moment rotation form shown above.

Orthotropic Elastic Properties

In contrast to an isotropic material, an orthotropic material has preferred direc-
tions of strength which are mutually perpendicular. The properties along these 
directions (also known as principal directions) are the extreme values of elastic 
coefficients. The [C] or [D] matrix for an orthotropic material has nine indepen-
dent elastic coefficients. In addition, there are three coefficients of thermal 
expansion.

In COSMOS/M, orthotropic material properties are applicable to all composite 
elements, SHELL3L, SHELL4L, SHELL9L, and SOLIDL, as well as the two 
dimensional continuum elements, PLANE2D and TRIANG. 

Two-Dimensional Orthotropic Stress-Strain Relations

In two dimensions, the orthotropic stress-strain relations can be written as fol-
lows, including temperature effects:

 (6-9)

Note that in order to satisfy symmetry in the matrix of elastic moduli, νxyΕy = 
νyx Εx.

✍ You need to therefore satisfy the foregoing symmetry condition when you 
input the numerical values of either the elastic modulus or Poisson's ratio.
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Further, if you do not input the numerical value of the shear modulus, the pro-
gram will compute it as shown below:

 (6-10)

The procedure for defining an orthotropic material input is illustrated below. The 
illustration assumes that the program will internally calculate the shear modulus. 
To satisfy orthotropic symmetry relations, two elastic moduli and a Poisson's 
ratio are specified.

Geo Panel:   Propsets > Material Property
Material property set > 1
Material Property Name > EX: Elasticity modulus in X mat. dir.
Property value > 15.5E6
Material Property Name > EY: Elasticity modulus in Y mat. dir.
Property value > 10.5E6
Material Property Name > NUXY: XY Poisson’s ratio
Property value > 0.25
Material Property Name > ALPX: Therm expansion coeff in X mat. dir.
Property value > 0.25E-5
Material Property Name > ALPY: Therm expansion coeff in Y mat. dir.
Property value > 0.45E-5

The two dimensional orthotropic properties defined above will be used by the 
plane elements (PLANE2D and TRIANG) as long as all required elastic coeffi-
cients have been input. Otherwise, the program will default to using isotropic 
properties.

Three-Dimensional Orthotropic Stress-Strain Relations

In three dimensions, the orthotropic strain-stress relations take the form:

(6-11)

εx

εy

ε z

γ xy

γ yz

γ zx 










  1 Ex⁄ νxy– Ey⁄ νxz– Ez⁄ 0 0 0

νyx– Ey⁄ 1 Ey⁄ νyz– Ey⁄ 0 0 0

νzx– Ez⁄ νzy– Ey⁄ 1 Ez⁄ 0 0 0

0 0 0 1 Gxy⁄ 0 0

0 0 0 0 1 Gyz⁄ 0

0 0 0 0 0 1 Gzx⁄

σx

σy

σz

τ xy

τ yz

τ zx











=
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In three dimensions, the orthotropic symmetry conditions dictate:

 (6-12)

When you input the orthotropic material properties in three dimensions, you must 
therefore make sure that the above symmetry conditions are not violated. The 
procedure for input of orthotropic elastic properties in three dimensions is similar 
to that demonstrated for two dimensions. Note that if you do not input the numer-
ical values of shear moduli, the program will compute them using the relations 
shown below:

 (6-13)

The default for νxy is 0.3 and for νxz and νyz is 0.0.

The three dimensional orthotropic properties defined above will be used by the 
elements SOLID and SOLIDL as long as all required elastic coefficients have 
been input. Otherwise, the program will default to using isotropic properties.

Axisymmetric Orthotropic Stress-Strain Relations

Axisymmetric solids with orthotropic material properties are also supported in 
COSMOS/M. Some times known as cylindrically orthotropic, the strain-stress 
relations for such material take the form:

 (6-14)

Note that equivalence for elastic coefficients in COSMOS/M between axisym-
metric solids and general three dimensional solids is as follows: Er = Ex, Eθ = Ez, 
Ez = Ey. You can use this information for input of the orthotropic material data.
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Notes on Input of Material Properties

General
• Ex must be given.
• If Ey and/or Ez are not given, they will be set equal to Ex.
• If Gxy is not given, it will be calculated from Gxy=Ex•Ey/(Ex+Ey+2NUxy• Ey).

• If Gyz and/or Gxz are not given, they will be set equal to Gxy.

PLANE 2D and TRIANG Elements

Isotropic 
• Any given E’s, G’s, or NU’s will be used even if not compatible.
• If any NU is not given, it will be assumed 0.3.
• If any G is not given, it will be set to zero.

Orthtropic 
• If Ex, NUxy, and Gxy are given, they will be used even if not compatible.
• If Ex, Gxy, and NUxy are given, they will be used even if not compatible.
• If NUxy is not given, it will be assumed 0.3.
• If Gxy is not given, it will be calculated from Gxy=Ex•Ey/(Ex+Ey+2NUxy•Ey).

SOLID, TETRA4, TETRA4R, and TETRA10 Elements

Isotropic 
• Given value of Gxy will be ignored. Gxy will always be computed from 

Gxy=Ex/[2(1+NUxy)] even if specified
• If NUxy is not given, it will be assumed 0.3.
• If you specify Ex and Gxy, Gxy will be re-calculated.

Orthotropic 
• If Gxy, Gxz, and Gyz are given, they will be used even though not compatible.
• If Gxz, and Gyz are not given, they will be set equal to Gxy.
• If Gxy is not given, it will be calculated from Gxy=Ex•Ey/(Ex+Ey+2NUxy•Ey).
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• The default for NUxy is 0.3 
• The defaults for NUxz, and NUyz are 0.0. 

SHELL3, SHELL4, SHELL3T, SHELL4T, SHELL9, 
and SHELLAX Elements
• User-defined Gxy is used only if the Shear Panel Option is supported and 

selected. For all other options, the given Gxy is ignored and will be calculated 
from Gxy=Ex/[2(1+NUxy)].

• The default value of NUxy is 0.3. 

BEAM3D, PIPE, SOLIDL, and All Composite SHELLS,
• All entered values of G’s are used even if not compatible.
• If not given, Gxy is set to zero.
• The default for NUxy is 0.3.

Orientation of Orthotropic Material Axes

By default, the orientation of the material coordinate axes for orthotropic materi-
als is the same as that of the element local coordinate system (ECS =-1). You can 
specify an angle of rotation for the material coordinates with respect to the ele-
ment local coordinate system while defining the section constants (RCONST 
(Propsets > Real Constant) command) for the applicable element. For example, if 
you are using 4-node plane element (PLANE2D) and would like to specify ortho-
tropic material coordinate axes at an angle of 30 degrees with respect to the ele-
ment local coordinates (see figure below), the procedure is illustrated below:

Figure 6-1. Specifying Orthotropic Material Axes 
in Element Local Coordinate System

1 2

34

x

y

x'

y'

30
o

Geo Panel: Propsets > Real Constant
   Associated Element group [1] >
   Real Constant set [1 ]>
   Start location of the real constants [1] >
   No. of real constants to be entered [2] >
   RC1  : Thickness > 0. 1
   RC2  : Material angle (Beta) [0] > 30
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In the figure above, the x-y axes represent the element local coordinates, and x'-y' 
represent the rotated orthotropic material coordinate axes. The above illustration 
is applicable to all elements with composite material description support except 
for SOLIDL for which the orthotropic material angle in a layer is specified under 
the RC4.

Anisotropic Elastic Properties

For general 3D anisotropic materials, there are no planes of symmetry and the 
elastic moduli are different in any direction. In three dimensions, the stress-strain 
relation for anisotropic materials involves 21 elastic constants as shown in the 
equation below:

(6-15)

Note that only the first three thermal expansion coefficients can be input in COS-
MOS/M and the remaining three are ignored. The property names of these coeffi-
cients considered are the same as those for orthotropic coefficients. The inverse 
form of the above relationship is written as follows:

 (6-16)

In COSMOS/M, the 3D anisotropic material property is currently supported for 
SOLID, SOLIDPZ, TETRA4, TETRA4R, TETRA10, and 2D anisotropic is 
available for SHELL3L, and SHELL4L elements only. You can input the coeffi-
cients of either the material stiffness or compliance matrix for anisotropic 
materials. All 21 material constants have unique names so that with suitable 
manipulations (explained a little later), you can describe materials with one or 
two planes of symmetry. If you need to model materials which are monoclinic, 
transversely isotropic or with cubic symmetry this feature becomes very useful.
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For input purposes, the anisotropic material stiffness matrix [D] is referred to as 
the standard matrix, and material compliance matrix [C] is referred to as the 
inverted matrix. The illustration below demonstrates the procedure for entering 
the elastic compliance coefficients of an anisotropic material:

Geo Panel:   Propsets > Material Property (MPROP)
Material property set [1] > 
Material Property Name > MC11: (1,1) stiffness matrix
Property value [0] > 0.03E-6
Material matrix type 1=Std 2=Inverted [1] > 2
Material Property Name > MC12: (1,2) stiffness matrix
Property value [0] > 0.01E-6
.
.
.
Material Property Name > MC66: (1,3) stiffness matrix
Property value [0] > 0.02E-6
Material Property Name > 

For 2D anisotropic, which is available for SHELL4L and SHELL3L elements 
only, equation (6-15) reduces to:

 (6-17)

where the elastic coefficients are defined in the element material coordinates. 
Any consideration for the shear factor should be included in the specified values 
for E55, E56, and E66 by the user.

You need to specify the same material names as that for a fully anisotropic mate-
rial and input only the non-zero coefficients.

In the case of a transversely isotropic material, the material exhibits a rotationally 
elastic symmetry about one of the coordinate axes. The number of independent 
constants in this case reduce to 5, and the stress-strain relations are as shown 
below:
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 (6-18)

In case of linearly elastic materials with cubic symmetry, the properties along the 
principal directions are identical. A material with cubic symmetry has only 3 
independent elastic constants. The stress-strain equation for such a material is 
shown below:

 (6-19)

For a fully isotropic material, the form of the stress-strain equations is the same 
as that for a transversely isotropic material, but there are only two independent 
constants, E and ν. You can therefore use the format of input for anisotropic 
materials to describe isotropic materials by properly entering the elastic coeffi-
cients. However, this procedure is unwarranted and therefore not recommended 
for isotropic materials for which the input very simple as explained earlier under 
Isotropic Elastic Properties.

✍ If you make use of the anisotropic material input format to describe isotropic 
materials, here is a word of caution. The program uses full integration in this 
case. The results will not be the same as those obtained using isotropic prop-
erties (defined using E and ν) which uses reduced integration by default.
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Thermoelastic Properties

The effect of change in temperature on structures is two fold: variations in tem-
peratures induce thermal strains affecting the state of stress; at the same time, 
temperature changes can also cause variations in the elastic material properties. 
Both effects can be efficiently treated in COSMOS/M. The following sections 
provide more information.

The table below summarizes the valid material properties in the Basic FEA 
System that can be input as temperature dependent.

Table  6-5. Temperature Dependent Material Properties in the Basic FEA System

Thermal Stress-Strain Relations

Temperature variations inducing thermal stresses are treated as thermal loads in 
COSMOS/M. It is also possible to transfer temperature results from a heat trans-
fer analysis as thermal loads in stress analysis for the same problem; see Chapter 
7, Loads and Boundary Conditions, and Chapter 12, Multidisciplinary Analyses, 
for more information.

Property Name Description Units

ALPX, ALPY, ALPZ Coefficient of thermal expansion in X-, Y-, and Z-direction Strain/Temp

DAMP Material damping coefficient

DCij Dielectric material constants

DENS Mass density Mass/Volume

EX, EY, EZ Elastic modulus in X-, Y-, and Z-directions Force/Area

GXY, GXZ, GYZ Shear modulus, X-Y, X-Z, and Y-Z directions same as above

MCij Anisotropic elastic moduli Force/Area

NUXY Poisson's ratio, Y strain due to X strain none

NUXZ Poisson's ratio, Z strain due to X strain none

NUYZ Poisson's ratio, Z strain due to Y strain none

PCij Piezoelectric material coefficients

SIGXC Compressive strength in material X-direction Force/Area

SIGXT Tensile strength in material X-direction same as above

SIGXYC Compressive shear strength in the material X-Y plane same as above

SIGXY Shear strength in material X-Y plane same as above

SIGYT Tensile strength in material Y-direction same as above
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The relationship between thermal stresses and strains can be written in a general 
form as:

 (6-20)

where [D] is the elastic (isotropic, anisotropic, or orthotropic) material matrix, 
{σt} is the thermal stress vector, and {ε t} is the thermal strain vector. The elastic 
moduli in [D] can be temperature dependent (discussed in the next section). 
Ignoring the effect of temperature on the coefficients of thermal expansion, the 
thermal strains are in general computed as:

 (6-21)

where {αt} is the vector of thermal expansion coefficients, T is the existing (or 
imposed) temperature, and To is the reference temperature (defined by the TREF 
(LoadsBC > LOAD OPTIONS > Reference Temp) command) at which the struc-
ture is free of stress. Note that the reference temperature is also the temperature at 
which the coefficients of thermal expansion are usually specified. However, in 
COSMOS/M, the coefficient of thermal expansion can be specified as tempera-
ture dependent. The various equations presented earlier for isotropic, anisotropic, 
and orthotropic materials, also include the effect of thermal strains. The compo-
nents of {αt} for thermally isotropic, orthotropic, or anisotropic materials are:

 (6-22)

For isotropic materials, you only need to specify ALPX for property name under 
the MPROP (Propsets > Material Property) command, and for orthotropic materi-
als, you need to furnish the remaining two components, ALPY and ALPZ. How-
ever, in COSMOS/M, for anisotropic materials which require all six coefficients, 
only the first three values are allowed and these coefficients can be isotropic or 
orthotropic.

If the coefficients of thermal expansion are temperature dependent, you can use 
the CURDEF (LoadsBC > FUNCTION CURVE > Time/Temp Curve) command 
to define a temperature versus thermal expansion coefficient curve, and associate 
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this curve with any component of {αt}. The following section illustrates in more 
detail.

Temperature Dependent Material Properties

Almost all elements in the Basic System can be used to model thermoelastic 
problems as indicated in Table 6-5. Many elastic material properties as well as the 
thermal expansion coefficients defined using the MPROP (Propsets > Material 
Property) command can be made temperature dependent. Typically, the elastic 
moduli decrease with increasing temperatures whereas Poisson's ratio remains 
constant. In case of stainless steel for example, the elastic modulus (E) decreases 
by about 20% when the temperature rises from 0°  to 450° C.

To define the dependence of temperatures on elastic moduli, you can make use 
of the temperature curve definitions in COSMOS/M. First, you need to activate 
temperature curve definition using ACTSET, TP, 1, (Control > ACTIVATE > 
Set Entity, Temperature Curve, 1) and then use the CURDEF (LoadsBC > 
FUNCTION CURVE > Time/Temp Curve) command to define different tempera-
tures and the corresponding elastic moduli, as illustrated below. The stiffness 
matrix is formed using the interpolated material properties based on the tem-
perature of the first considered load case in the analysis (i.e. with lowest load 
case label) regardless of the nature of that load case (i.e. whether it is a thermal 
load case or not). For this illustration, it was assumed that the elastic modulus 
decreases by 10% when the temperature increases from 0 to 100 degrees, and by 
20% when it increases to 1000 degrees, i.e., a bilinear dependence of elastic mod-
ulus on temperatures. Note that you can either define a curve of temperature vs. 
multiplying factor for the elastic modulus, or, a curve of temperature vs. the elas-
tic modulus.

Geo Panel:   LoadsBC > FUNCTION CURVE > Time/Temp Curve
Curve type > Temp
Curve number > 1
Start point > 1
Temperature for point 1 > 0
Function value for point 1 > 1
Temperature for point 2 > 100
Function value for point 2 > 0.9
Temperature for point 3 > 1000
Function value for point 3 > 0.8
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The above procedure associates the temperature curve labeled 1 with the depen-
dencies defined. You can use the command CURLIST (LoadsBC > FUNCTION 
CURVE > List Time/Temp) to list the temperature dependencies on the elastic 
moduli defined above. The procedure for plotting a curve of temperature depen-
dencies is illustrated below:

Geo Panel:   Display > XY PLOTS > Activate Pre-Proc
Graph Number > 1
Curve type > Time/Temp/BHC/MPC
Component > Temp
Curve number > 1
Graph color > 12
Graph line style > Solid
Graph symbol style > Circle

Geo Panel:   Display > XY PLOTS > Plot Curves
Plot graph 1 0=No, 1=Yes > Yes

A plot as shown in the following figure will be displayed on the screen.

Figure 6-2. Example of Temperature Dependent Elastic Modulus

Next, to associate the temperature dependencies with the elastic modulus EX, 
use the command MPROP (Propsets > Material Property) and specify a multipli-
cation factor for the property (the actual property values will be read from the 
temperature-elastic modulus curve defined earlier and multiplied by this factor) 
as illustrated below:
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Geo Panel:   Propsets > Material Property
Material property set > 1
Material Property Name > EX: Elasticity modulus 1st dir
Property value > 30E6

If you list the material properties on the screen (using MPLIST (Edit > LIST > 
Material Props) command), the summary will be as shown below, confirming the 
associativity between EX and the temperature curve:

If you continue defining other elastic moduli using the MPROP (Propsets > 
Material Property) command, they will also be associated with temperature-elas-
tic modulus curve 1. To deactivate this dependency, you need to issue the com-
mand, ACTSET, TP, 0, (Control > ACTIVATE > Set Entity, Temperature Curve, 0).

To define the dependence of temperatures on the coefficient of thermal expan-
sion, you need to first activate temperature curve definition using ACTSET, TP, 1, 
(Control > ACTIVATE > Set Entity, Temperature Curve, 1,) and then execute the 
CURDEF (LoadsBC > FUNCTION CURVE > Time/Temp Curve) command. 
This time, you can define the expansion coefficients vs. temperature values under 
temperature curve labeled 2 or any other non-zero integer, and follow this by the 
MPROP (Propsets > Material Property) command for defining ALPX or any 
other required component of thermal expansion coefficients.

✍ To compute the effect of temperature on material properties, for each element 
the program uses one value of temperature which is the average of element 
nodal temperatures.

Label      Name   Temp/BH_Cr         Value

A   1        EX            1      3.000000e+07

A   1        EX            1      3.000000e+07

A   1      NUXY            0      3.300000e-01

A   1       GXY            0      5.800000e+06

A   1      ALPX            0      1.100000e-05

A   1      DENS            0      7.893000e-04

A   1         C            0      3.477600e+01

A   1        KX            0      5.370000e-03
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Laminated Composite Materials

Laminated composite materials consist of two or more bonded layers of different 
thicknesses and material properties. The material properties in each layer can be 
either isotropic or orthotropic. A common arrangement of the layers consists of 
two of the principal material axes of each layer oriented orthogonally with those 
of the next layer. Laminates with this configuration of alternating material direc-
tions are known as the cross-ply laminates. The figure below shows an exploded 
view of two- and three-ply laminates in cross-ply orientation.

Figure 6-3. Exploded View of Plane Laminated Structures 
with Cross-Ply Configuration

A stack of laminae can be modeled with a single plate or shell element by the 
appropriate description of material properties of the stack in the element stiffness 
matrix. This is accomplished by utilizing the user-supplied information on num-
ber of layers, layer thickness, and relative orientation of orthotropic axes for each 
layer. The analysis results for each layer can be plotted and animated separately 
during postprocessing. The laminated composites can be modeled using three 
types of shell elements, SHELL3L, SHELL4L, SHELL9L, and the solid element, 
SOLIDL.

In COSMOS/M, the laminated composite is assumed to be made up of perfectly 
bonded laminae. The thickness of the bonds between laminae is assumed to be 
infinitesimally thin. The shear deformation at the bonds are negligible so that 
there is no interlaminar slip, and the displacements across the laminae boundaries 
are continuous.

✍ A laminated composite consisting of three laminae (with top and bottom 
layers of equal thickness and same material characteristics) is known as a 
sandwich plate or shell in COSMOS/M.
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X

Y
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2

1

2

2

1
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Three-ply Laminate
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In order to use the sandwich option, you need to specify the appropriate flag 
under the EGROUP (Propsets > Element Group) command.

Material Properties for Laminated Composites

For laminated composites, the material properties of each layer is addressed by a 
material set number and the corresponding material constants are defined as 
before using the MPROP (Propsets > Material Property) command. A material set 
number may be referenced by one or more layers. The material properties in each 
layer may be orthotropic or isotropic. Please refer to the sections on isotropic and 
orthotropic material properties for more information on defining the elastic con-
stants and the material axes. Note that the thickness of each layer, material group 
number and the orientation of material principal directions are specified under the 
RCONST (Propsets > Real Constant) command.

The procedure for defining the material properties of layered composites is as fol-
lows. It is recommended to first define the element group using the EGROUP 
(Propsets > Element Group) command and specify the composite element name 
and the number of layers in the element. The illustration below demonstrates this 
procedure for a laminated composite shell with four layers:

Geo Panel:   Propsets > Element Group
Element Group > 1
Element Name > SHELL4L: Multilayer 4-node shell/plate element

OP1:Type > QUAD4
OP2:Number of Layers > 4
... ... ...
Accept

Next, define the required material properties using the MPROP (Propsets > 
Material Property) command. For a composite with four laminae, four different 
material groups are necessary if the properties for each layer are different. You 
can then proceed to defining the individual layer data using the RCONST 
(Propsets > Real Constant) command. In the illustration shown below, the mate-
rial properties for all layers are the same, but the orientation of the material prin-
cipal directions are different. For each layer, you will be prompted for the layer 
thickness, material group number, and material angle. The RCONST (Propsets > 
Real Constant) command accepts a maximum of 10 input data in each execution, 
and you therefore need to re-execute this command to input data for the remain-
ing layers.
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Geo Panel:   Propsets > Real Constant
Associated Element group > 1
Real Constant set > 1
Start location of the real constants > 1
No. of real constants to be entered > 10

RC1 : Dist. from ref. plane to top surface > 0.5
RC2 : Temperature gradient > 0
RC3 : Thickness of layer 1 > 0.25
RC4 : Material number for layer 1 > 1
RC5 : Material angle for layer 1 > 0
RC6 : Thickness of layer 2 > 0.25
RC7 : Material number for layer 2 > 1
RC8 : Material angle for layer 2 > 30
RC9 : Thickness of layer 3 > 0.25
RC10 : Material number for layer 3 > 1

Re-execute the RCONST (Propsets > Real Constant) command for the remaining 
data, as shown below:

Geo Panel:   Propsets > Real Constant
Associated Element group > 1
Real Constant set > 1

Start location of the real constants > 11
No. of real constants to be entered > 4

RC11 : Material angle for layer 3 > 60
RC12 : Thickness of layer 4 > 0.25
RC13 : Material number for layer 4 > 1
RC14 : Material angle for layer 4 > 90

Failure Criteria for Laminated Composite Materials
A failure criterion provides the mathematical relation for strength under combined 
stresses. Unlike the conventional isotropic materials where one constant will 
suffice for failure stress level and location, laminated composite materials require 
more elaborate methods to establish failure stresses. The strength of a laminated 
composite can be based on the strength of individual plies within the laminate. In 
addition, the failure of plies can be successive as the applied load increases. There 
may be a first ply failure followed by other ply failures until the last ply fails, 
denoting the ultimate failure of the laminate. Progressive failure description is 
therefore quite complex for laminated composite structures.
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A simpler approach for establishing failure consists of determining the structural 
integrity which depends on the definition of an allowable stress field. This stress 
field is usually characterized by a set of allowable stresses in the material princi-
pal directions. The table below lists the required components of allowable 
stresses referenced in the failure theories and their material names in 
COSMOS/M.

Table  6-6. Required Material Strength Components 
for Failure Criteria of Composites

Two failure criteria which make use of the above allowable stresses input by the 
user are currently available. These include the Hill, and the Tsai-Wu failure crite-
ria. These failure criteria are used to calculate a failure index (F.I.) from the com-
puted stresses and user-supplied material strengths. A failure index of 1 denotes 
the onset of failure, and a value less than 1 denotes no failure. The following sec-
tions provide more information on the two failure criteria available.

✍ The failure criterion of Hill or Tsai-Wu is applicable to SHELL3L and 
SHELL4L elements only. All components of material strengths for all layers 
must be input in order to compute the failure indices.

The failure indices are computed for all layers in each element of your model. 
During postprocessing, you can plot failure indices of your mesh for any layer.

Hill Failure Criterion

The Hill failure criterion (sometimes known as the Tsai-Hill criterion) is 
frequently applied to orthotropic materials with equal strengths in tension and 
compression. The failure index computed according the Hill theory shown below 
represents the analytical expression for an ellipse in the σ1 - σ2 plane:

 (6-23)

Symbol Description Material Property Name

X1
T Tensile strength in the material longitudinal direction SIGXT

X1
C Compressive strength in the material longitudinal direction SIGXC

X2
T Tensile strength in the material transverse direction SIGYT

X2
C Compressive strength in the material transverse direction SIGYC

S12 In-plane shear strength in the material x-y plane SIGXY
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where σ1, σ2 and τ 12 are the computed stresses in the material directions, 
(SIGMA-X, SIGMA-Y and SIGMA-XY in the output file) and,

The application of Hill failure criterion is requested by specifying a value of 2 
under the A_STRESS (Analysis > STATIC > Stress Analysis Options) command 
as illustrated below:

Control Panel: Analysis > STATIC > Stress Analysis Options
AISC code check Flag > No
... ... ...
Type of failure analysis > Hill Criterion

The program computes the failure indices for all layers of each element and prints 
them along with the element stresses in the output file as shown below. For the 
listing shown below, SHELL3L elements were used with four layers.

 ELEMENT NUMBER    1

      NX        NY       NXY        MX        MY       MXY       VX        VY

  -2.70E+03 -1.04E+03 -4.39E+01 -3.75E+03 -2.73E+02 -6.51E+02 -1.26E+02 -1.21E+02

  LAYER  (ECS:-1) SIGMA-X     SIGMA-Y   SIGMA-XY     TAU-XZ       TAU-YZ          HILL
 NUMBER

   4    TOP    -2.941E+04  -4.544E+03  -4.193E+03  -1.322E+02  -1.551E+02    4.93245E+01

      BOTTOM   -1.686E+04  -3.564E+03  -1.452E+03  -1.322E+02  -1.551E+02    1.34369E+01

               (INTERLAMINAR SHEAR STRESSES)       -1.395E+02  -1.350E+02

   3    TOP    -2.621E+04   3.514E+03  -6.611E+03  -1.526E+02  -1.611E+02    1.23329E+02

      BOTTOM   -5.560E+03  -1.424E+03  -4.318E+02  -1.526E+02  -1.611E+02    2.45260E+00

               (INTERLAMINAR SHEAR STRESSES)       -2.231E+02  -1.774E+02

   2    TOP    -7.103E+03  -5.668E+02   9.327E+02  -1.679E+02  -1.464E+02    6.25082E+00

      BOTTOM    1.537E+04  -4.018E+03   5.256E+02  -1.679E+02  -1.464E+02    4.80744E+01

               (INTERLAMINAR SHEAR STRESSES)       -1.697E+02  -1.109E+02

   1    TOP     1.240E+04  -5.105E+02   4.030E+03  -1.630E+02  -1.258E+02    3.28336E+01

      BOTTOM    3.103E+04   9.984E+02   6.771E+03  -1.630E+02  -1.258E+02    1.69770E+0

2

      ENRGYE = 0.5509E+03  ENRGYD = 0.1344E+02
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Tsai-Wu Failure Criterion

The Tsai-Wu failure criterion (also known as the Tsai-Wu tensor polynomial the-
ory) is commonly used for orthotropic materials with unequal tensile and com-
pressive strengths. The failure index according to this theory is computed using 
the following equation:

where,

 (6-24)

and

 (6-25)

The application of Tsai-Wu failure criterion is requested by specifying a value of 
1 under the A_STRESS (Analysis > STATIC > Stress Analysis Options) com-
mand as illustrated below:

Geo Panel:   Analysis > STATIC > Stress Analysis Options
AISC code check Flag > No
... ... ...
Type of failure analysis > Tsai-Wu Criterion

The program computes the failure indices for all layers in each element and prints 
them along with the element stresses in the output file as shown below. The list-
ing shown below is for the same example as that for the Hill criterion using 
SHELL3L elements with four layers. You can notice the change in value of the 
failure indices.
COSMOS/M Basic FEA System 6-33

http://www.cosmosm.com


Chapter 6   Material, Sectional and Other Physical Properties

6-34
Piezoelectric Properties

The term piezoelectricity refers to the phenomenon of electrical polarization of 
some crystals due to deformation in certain directions. The reverse phenomenon, 
namely the mechanical deformations of crystals due to an applied electric field, is 
also termed as piezoelectricity. It is the latter phenomenon that is widely used in 
study of piezoelectric resonators and many other applications. A piezoelectric 
resonator for example, is a device consisting of a bar or a plate made from a 
piezoelectric material with two or more electrodes attached to its surface. When 
a harmonic electric voltage is applied to the electrodes, the piezoelectric material 
undergoes mechanical vibrations. For resonance, the exciting signal frequency 
(of the electric voltage) must be close to the resonant frequency. Piezoelectric 
effect also plays an important role in the fields of crystal physics and transducer 
technology. The type of finite element analyses you can perform on a piezoelec-
tric material include static, modal (natural frequency), harmonic, and transient 
analysis. The term electroelastic analysis is frequently used for the study of 
deformations in piezoelectric materials subjected to electric fields.

ELEMENT NUMBER      1

      NX       NY       NXY        MX        MY       MXY        VX        VY

 -2.70E+03 -1.04E+03 -4.39E+01 -3.75E+03 -2.73E+02 -6.51E+02 -1.26E+02 -1.21E+02

 LAYER (ECS:-1)   SIGMA-X     SIGMA-Y    SIGMA-XY      TAU-XZ       TAU-YZ       TSAI-WU 
NUMBER

   4    TOP     -2.941E+04  -4.544E+03  -4.193E+03  -1.322E+02  -1.551E+02   1.11044E+02

      BOTTOM    -1.686E+04  -3.564E+03  -1.452E+03  -1.322E+02  -1.551E+02   3.37088E+01

                (INTERLAMINAR SHEAR STRESSES)       -1.395E+02  -1.350E+02

   3    TOP     -2.621E+04   3.514E+03  -6.611E+03  -1.526E+02  -1.611E+02   1.46136E+02

      BOTTOM    -5.560E+03  -1.424E+03  -4.318E+02  -1.526E+02  -1.611E+02   3.78808E+00

                (INTERLAMINAR SHEAR STRESSES)       -2.231E+02  -1.774E+02

   2    TOP     -7.103E+03  -5.668E+02   9.327E+02  -1.679E+02  -1.464E+02   7.79441E+00

      BOTTOM     1.537E+04  -4.018E+03   5.256E+02  -1.679E+02  -1.464E+02   4.63253E+01

                (INTERLAMINAR SHEAR STRESSES)       -1.697E+02  -1.109E+02

   1    TOP      1.240E+04  -5.105E+02   4.030E+03  -1.630E+02  -1.258E+02   2.84385E+01

      BOTTOM     3.103E+04   9.984E+02   6.771E+03  -1.630E+02  -1.258E+02   1.51238E+02

     

 ENRGYE = 0.5509E+03  ENRGYD = 0.1344E+02
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COSMOS/M provides you the capability to analyze the free vibrations of 
piezoelectric components subjected to an electric field. A new solid element 
(SOLIDPZ) with isotropic, anisotropic or orthotropic elastic material properties 
can be used in the electroelastic analysis of piezoelectric components.

Piezoelectric Materials

A common example of piezoelectric material is the Quartz crystal used in wrist-
watches and other time-keeping devices. However, the application of piezoelec-
tric materials has grown to numerous other areas. Piezoelectric materials today 
are not restricted to crystalline forms alone, and they extend to ceramics and 
polymers. Modern piezoelectric ceramics is based on solid solutions of lead zir-
conate (PbZrO3) and lead titanate (PbTiO3) and is referred to as PZT ceramics. 
The table below provides examples of some commonly used piezoelectric materi-
als in the industry.

Table  6-7. Examples of Piezoelectric Materials

Piezoelectric Property Definitions in COSMOS/M

In order to perform electroelastic analysis, the elastic, dielectric, and piezoelec-
tric properties of the piezoelectric material need to input. Many piezoelectric 
materials have crystalline structure with well defined planes of strength and sym-
metry which often render the isotropic elastic description inadequate. Orthotropic 
or anisotropic elastic properties need to be used. However, isotropic elastic 

Type of 
Piezoelectric 

Material
Examples Remarks

Piezoelectric 
Crystalline 
Materials

Quartz
Berlinite
Lithium Niobate
Lithium Tantalate
Bismuth Germanium Oxide
Bismuth Silicium Oxide

. . .

. . .

. . .

. . .

. . .

. . .

Piezoelectric 
Ceramics

PZT
VIBRIT
PKM

Clevite Corporation
Siemens
. . .

Piezoelectric 
Polymers

Polyvinyl Chloride (PVC)
Polyvinyl Fluoride (PVF)
Difluor Polyethylene (PVF2)
Nylon 11

. . .

. . .
PVF2-β and PVF2-δ are the two common forms.
. . .
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property definitions are also supported for the SOLIDPZ element in addition to 
the orthotropic and anisotropic properties. The elastic properties can be input as 
explained before.

In electroelastic analysis, the elastic constitutive equations (equation 6-1) and the 
electric field constitutive equations (see Advanced Modules Manual) are coupled 
by the piezoelectric matrix. Therefore, the electromechanical constitutive equa-
tions for linear behavior are written as follows:

 (6-26)

where {σ} is the stress vector, {Dl} is a vector of electric flux density, [D] as 
before is the matrix of elastic coefficients at constant electric field (free of elec-
trostrictive effects), {ε} represents the mechanical strain, [e] is a matrix of 
piezoelectric properties, {EL} is the vector representing the electric field, and 
[εd] is the dielectric property matrix at constant mechanical strain. The coeffi-
cients of the elastic material matrix [D] are input as explained earlier, using 
isotropic, orthotropic, or anisotropic material descriptions. The following para-
graphs describe the input for piezoelectric and dielectric properties.

The piezoelectric matrix [e] relates the electric field to stress, and it is a 6x3 
matrix for 3D, and 4x2 matrix for 2D models. This matrix is shown below for 
3D models.

 (6-27)

As seen in Table 6-2, the property names of the coefficients in the piezoelectric 
matrix above are denoted as PCij where i varies from 1 to 6 and j varies from 1 to 
3. Therefore, to define piezoelectric material properties, the MPROP (Propsets > 
Material Property) command is used as follows:

Geo Panel:   Propsets > Material Property
Material property set > 1
Material Property Name > PC11: (1,1) Piezoelectric matrix
Property value [0]> -4.1
... ... ...
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Material Property Name > PC63: (1,3) Piezoelectric matrix
Property value [0] > 14.1

The dielectric property matrix [εd] is shown below:

 (6-28)

The property names of the coefficients in the above matrix are denoted as DCij 
where i and j vary from 1 to 3. To define dielectric material properties, the 
MPROP (Propsets > Material Property) command is used as follows:

Geo Panel:   Propsets > Material Property
Material property set > 1
Material Property Name > DC11: (1,1) Dielectric matrix
Property value > 7.124E-9
... ... ...
Material Property Name > DC33: (1,1) Dielectric matrix
Property value > 5.85E-9

Mass and Damping Properties

The description of mass properties requires the input of mass density which is 
specified by the property name DENS under the MPROP (Propsets > Material 
Property) command. This data is used for computing the element lumped or dis-
tributed mass matrix used in calculating natural frequencies. Mass data is also 
required if you want to apply gravity and centrifugal loading.

Concentrated mass at a node can be defined using a mass element; see Chapter 5, 
Element Library for more information.

Damping properties are specified using the property name DAMP under the 
MPROP (Propsets > Material Property) command. The inclusion of damping 
information results in the extraction of complex eigenvalues. Note that damping 
can be applied to models with 50 or fewer degrees of freedom in the Basic FEA 
System.
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Inelastic Material Behavior

In addition to the various types of elastic, thermoelastic, composite, and piezo-
electric material properties discussed so far, COSMOS/M features extensive 
inelastic, time and temperature dependent material descriptions for nonlinear 
structural, thermal, and electromagnetic analyses. The inelastic material proper-
ties can only be used in nonlinear analysis using the NSTAR program. For more 
information, please refer to the COSMOS/M Advanced Modules Manual - Part 1, 
NSTAR Chapter 3.

Material Library

The material library feature of COSMOS/M allows you to either select standard 
material properties from a built-in library, or, your own material properties from 
a user-defined material library. The built-in material properties are available in 
FPS, MKS, or SI system of units. The property names used in the material librar-
ies and their description is provided in the table below.

Table  6-8. Property Names in the Material Libraries

By default, both built-in and user-defined material libraries assume the material 
properties to be isotropic. If it is necessary to use orthotropic material properties 
in your model, you need to therefore provide the remaining property components 
under the same material group. However, it is not possible to append the material 
library properties for describing anisotropic materials at this time.

Property Name Symbol Description

ALPX αx Coefficient of thermal expansion in the x-direction

BETA β Coefficient of volume expansion

C (Cp) Cp Specific heat

DENS ρ Mass density

EX Ex Elastic modulus in the x-direction

GAMMA γ Ratio of specific heats

GXY Gxy Shear modulus in the x-y plane

KX Kx Thermal conductivity in the x-direction

NUXY νxy Poisson's ratio for x-strain due to y-stress

VISC η Dynamic viscosity
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The commands PICK_MAT (Propsets > Pick Material Lib) and USER_MAT 
(Propsets > User Material Lib) can be used for selecting the pre-defined material 
properties from the built-in or user-defined material libraries respectively. The 
following sections describe the procedure for using the material libraries in more 
detail.

Using the Built-In Material Library

For some of the commonly used types of materials, the properties have been 
pre-defined in COSMOS/M. For materials with isotropic, linear elastic and linear 
heat transfer properties, you can use the built-in material library using the 
PICK_MAT (Propsets > Pick Material Lib) command.

When you use the PICK_MAT (Propsets > Pick Material Lib) command, the mate-
rial properties are read from a text file, PICKMAT.LIB, installed in the COS-
MOS/M directory. The types of materials available and the corresponding names 
in COSMOS/M are listed in the table below:

Table  6-9. Available Material Types in the Built-In Library

COSMOS/M Name Material Type

ACRYLIC Medium-High Impact Acrylic

AIR Air (300 K)

ALUMINUM Aluminum Alloy

AL_1345 Aluminum 1345 Alloy

AL_1350 Aluminum 1350 Alloy

AL_2014 Aluminum 2014 Alloy

AL_2018 Aluminum 2018 Alloy

AL_2024 Aluminum 2024 Alloy

AL_3003 Aluminum 3003 Alloy

AL_6061 Aluminum 6061 Alloy

AL_7079 Aluminum 7079 Alloy

AL_BRONZE Aluminum Bronze

A_STEEL Alloy Steel

BRASS Silicon Brass & Bronze

CA_STEEL Cast Alloy Steel, below 8% alloy content

COBALT Cobalt
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Table  6-9. Available Material Types in the Built-In Library (Concluded)

COSMOS/M Name Material Type

CS_STEEL Cast Stainless Steel, CF-8M or CF-20, water quenched

D_NICKEL Nickel Alloy, Duranickel 301

GC_IRON Gray Cast Iron, ASTM Class 40

GLASS Glass

GOLD Pure Gold

IRON Iron

LEAD Pure Lead

MAGNES Magnesium Alloy, wrought or cast

MC_IRON Malleable Cast Iron, ASTM A220

MN_BRONZE Manganese Bronze

MOLYBDENUM Molybdenum

MONEL MONEL 400 alloy of Nickel

NYLON Nylon 6/10

PC_STEEL Plain Carbon Steel

PORCELAIN Ceramic Porcelain

RUBBER Rubber

SILVER Pure Silver

STEEL Steel

ST_1020 Steel, AISI C1020 (Hot Worked)

ST_304 Steel, AISI 304 (Sheet)

ST_ST Stainless Steel

TITANIUM Titanium

TUNGSTEN Tungsten

T_BRONZE Tin Bronze 1B

VANADIUM Vanadium

WATER Water (300 K)

WS_STEEL Wrought Stainless Steel

W_COPPER Wrought Copper

ZIRCONIUM Zirconium
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Material Name

Property Name
EX
NUXY 
GXY
ALPX 
DENS 
KX
C (Cp) 
✍ The properties in the built-in material library are valid at a temperature 
of 70°  F. Some of the properties can be made temperature dependent; see 
the section on thermoelastic properties.

Using the built-in material library is extremely simple. For example, if you like 
to select Wrought Copper using the FPS system of units for material set 1, the 
PICK_MAT (Propsets > Pick Material Lib) command is executed as follows:

Geo Panel:   Propsets > Pick Material Lib
Material property set > 1
Material Name > W_COPPER: Wrought Copper
Unit Label > FPS: British (Inch/Pound/Second)

The properties of Wrought Copper stored in the library are shown below:

For linear static stress analysis, the isotropic stress-strain relations (including 
temperature effects) for the selected material in FPS units under plane stress con-
ditions are as follows:

Appending the above material properties to describe orthotropy is straight for-
ward. For example, if you know the remaining orthotropic properties of copper 
(we are not suggesting here that copper is a orthotropic material!) and would like 
to use them, the procedure for appending the library properties for the remaining 
property components is illustrated below:

:    W_COPPER    Wrought Cooper

Value (English) 
0.16E+08   psi
0.33
0.58E+07   psi
0.11E-04    /Fahrenheit 
0.79E-03    lbf s2/in4

0.31E-02    BTU/in/s/F
35.0           BTU in/lbf/s/s/F 

Value (MKS)
0.11E+07   Kgf/cm/cm   
0.33 
0.41E+06   Kgf/cm/cm   
0.20E-04    /Centigrade 
0.86E-05    Kgf s2/cm4 
0.56           Cal/cm/s/C 
0.88E+05   Cal cm/kgf/s/s/C

Value (SI)
0.11E+12   Pascals
0.33
0.40E+11   Pascals
0.20E-04    /Kelvin
0.84E+04   Kgm/m3

0.23E+03   W/m/K
0.38E+03   J/kgm/K
COSMOS/M Basic FEA System 6-41

http://www.cosmosm.com


Chapter 6   Material, Sectional and Other Physical Properties

6-42
Geo Panel:   Propsets > Material Property
Material property set > 1
Material Property Name > EY: Elasticity modulus in Y mat. dir.
Property value > 20.5E6
Material Property Name > ALPY: Therm expansion coeff in Y mat. dir.
Property value > 15.5E-6
Material Property Name > KY: Thermal conductivity in Y mat. dir.
Property value > 8.5E-3

Note that it is necessary to input either NUYX (Poisson's ratio for y-strain due to 
x-stress) or EY (elastic modulus in the y-direction) as the program will internally 
compute one of these quantities using the symmetry condition, νxy Ey = νyx Ex. 
With the properties defined above, the orthotropic stress-strain relations for Cop-
per take the following form:

The above equations are used in the program for computing the element stiffness 
matrices and in other calculations.

You can use the command MPLIST (Edit > LIST > Material Props) to list the 
properties defined (as well as those selected from the library) on the screen for 
verification, as shown below:

Label      Name   Temp/BH_Cr         Value

A   1        EX            0      1.550000e+07

A   1        EY            0      2.050000e+07

A   1      NUXY            0      3.300000e-01

A   1       GXY            0      5.800000e+06

A   1      ALPX            0      1.100000e-05

A   1      ALPY            0      1.550000e-05

A   1      DENS            0      7.893000e-04

A   1         C            0      3.477600e+01

A   1        KX            0      5.370000e-03

A   1        KY            0      8.500000e-03
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Material Name
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EX
NUXY
GXY
ALPX 
DENS
KX
C (Cp) 
Contents of the Built-In Material Library

The material properties have been pre-defined for 45 materials in the built-in 
library. The properties in all three system of units are listed in the following para-
graphs.

✍ The properties in the built-in material library are valid at a temperature of 
70°  F. You need to make corrections if necessary for any other set of reference 
conditions, especially for temperature sensitive properties such as the coeffi-
cient of thermal expansion.

:   A_STEEL    Alloy Steel

Value (English)
0.30E+08   psi 
0.28
0.12E+08   psi
0.74E-05   /Fahrenheit 
0.73E-03   lbf s2/in4

0.67E-03   BTU/in/s/F 
42.0          BTU in/lbf/s/s/F

Value (MKS)
0.21E+07   Kgf/cm/cm 
0.28 
0.81E+06   Kgf/cm/cm   
0.13E-04    /Centigrade 
0.79E-05    Kgf s2/cm4

0.12            Cal/cm/s/C 
0.11E+06   Calscm/kgf/s/s/C

Value (SI)
0.21E+12   Pascals
0.28
0.79E+11   Pascals
0.13E-04    /Kelvin
0.77E+04   Kgm/m3

0.46E+03   J/kgm/K
0.46E+03   J/kgm/K

:    ACRYLIC    Acrylic (Medium-High Impact)

Value (English)   
0.35E+06   psi 
0.35
0.13E+06   psi 
0.29E-04   /Fahrenheit
0.11E-03   lbf s2/in4 
0.28E-05   BTU/in/s/F 
0.14E+03  BTU in/lbf/s/s/F

Value (MKS)
0.25E+05   Kgf/cm/cm 
0.35 
0.91E+04   Kgf/cm/cm
0.52E-04    /Centigrade 
0.12E-05    Kgf s2/cm4

0.50E-03    Cal/cm/s/C
0.34E+06   Cal cm/kgf/s/s/C

Value (SI)
0.24E+10   Pascals
0.35
0.89E+09   Pascals
0.52E-04    /Kelvin
0.12E+04   Kgm/m3

0.21            W/m/K
0.15E+04   J/kgm/K

:    ALUMINUM    Aluminum Alloy

Value (English) 
0.10E+08   psi
0.33
0.39E+07  psi
0.13E-04   /Fahrenheit 
0.25E-03   lbf s2/in4

0.27E-02   BTU/in/s/F
83.0          BTU in/lbf/s/s/F

Value (MKS)
0.70E+06   Kgf/cm/cm 
0.33 
0.27E+06   Kgf/cm/cm
0.24E-04    /Centigrade 
0.28E-05    Kgf s2/cm4 
0.49            Cal/cm/s/C 
0.21E+06   Cal cm/kgf/s/s/C

Value (SI)
0.69E+11   Pascals
0.33
0.27E+11   Pascals
0.24E-04    /Kelvin
0.27E+04   Kgm/m3

0.20E+03   W/m/K
0.90E+03   J/kgm/K
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:    AL_1345    Aluminum 1345 Alloy

Value (English) 
0.10E+08  psi
0.33
0.39E+07  psi 
0.13E-04   /Fahrenheit   
0.25E-03   lbf s2/in4

0.29E-02   BTU/in/s/F
93.0          BTU in/lbf/s/s/F 

Value (MKS)
0.70E+06   Kgf/cm/cm   
0.33 
0.27E+06   Kgf/cm/cm   
0.24E-04    /Centigrade   
0.27E-05    Kgf s2/cm4 
0.53           Cal/cm/s/C 
0.24E+06   Cal cm/kgf/s/s/C

Value (SI)
0.69E+11   Pascals
0.33
0.27E+11   Pascals
0.24E-04    /Kelvin
0.27E+04   Kgm/m3

0.22E+03   W/m/K
0.10E+04   J/kgm/K

:    AL_1350    Aluminum 1350 Alloy

Value (English) 
0.10E+08   psi 
0.33
0.39E+07   psi 
0.13E-04   /Fahrenheit 
0.25E-03   lbf s2/in4

0.31E-02   BTU/in/s/F
93.0          BTU in/lbf/s/s/F 

Value (MKS)
0.70E+06  Kgf/cm/cm 
0.33 
0.27E+06  Kgf/cm/cm
0.24E-04   /Centigrade 
0.28E-05   Kgf s2/cm4

0.56          Cal/cm/s/C
0.24E+06  Cal cm/kgf/s/s/C

Value (SI)
0.69E+11   Pascals
0.33
0.27E+11   Pascals
0.24E-04    /Kelvin
0.27E+04   Kgm/m3

0.23E+03   W/m/K
0.10E+04   J/kgm/K

:    AL_2014    Aluminum 2014 Alloy

Value (English) 
0.11E+08   psi
0.33
0.40E+07   psi 
0.13E-04   /Fahrenheit 
0.26E-03   lbf s2/in4

0.21E-02   BTU/in/s/F
89.0          BTU in/lbf/s/s/F 

Value (MKS)
0.78E+06  Kgf/cm/cm   
0.33 
0.28E+06  Kgf/cm/cm 
0.23E-04   /Centigrade 
0.28E-05   Kgf s2/cm4 
0.38          Cal/cm/s/C
0.23E+06  Cal cm/kgf/s/s/C

Value (SI)
0.77E+11   Pascals
0.33
0.28E+11   Pascals
0.23E-04    /Kelvin
0.28E+04   Kgm/m3

0.16E+03   W/m/K
0.96E+03   J/kgm/K

:    AL_2018    Aluminum 2018 Alloy

Value (English) 
0.11E+08  psi 
0.33 
0.39E+07  psi 
0.12E-04   /Fahrenheit   
0.26E-03   lbf s2/in4

0.21E-02   BTU/in/s/F
93.0          BTU in/lbf/s/s/F 

Value (MKS)
0.76E+06  Kgf/cm/cm
0.33 
0.27E+06  Kgf/cm/cm
0.22E-04   /Centigrade 
0.29E-05   Kgf s2/cm4

0.37          Cal/cm/s/C
0.24E+06  Cal cm/kgf/s/s/C

Value (SI)
0.74E+11   Pascals
0.33
0.27E+11   Pascals
0.22E-04    /Kelvin
0.28E+04   Kgm/m3

0.15E+03   W/m/K
0.10E+04   J/kgm/K

:    AL_2024    Aluminum 2024 Alloy

Value (English) 
0.11E+08   psi
0.33
0.40E+07   psi 
0.13E-04    /Fahrenheit   
0.26E-03    lbf s2/in4

0.19E-02    BTU/in/s/F
73.0           BTU in/lbf/s/s/F 

Value (MKS)
0.74E+06  Kgf/cm/cm
0.33 
0.28E+06  Kgf/cm/cm
0.23E-04   /Centigrade 
0.28E-05   Kgf s2/cm4 
0.34          Cal/cm/s/C 
0.19E+06  Cal cm/kgf/s/s/C

Value (SI)
0.73E+11   Pascals
0.33
0.28E+11   Pascals
0.23E-04    /Kelvin
0.28E+04   Kgm/m3

0.14E+03   W/m/K
0.80E+03   J/kgm/K
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:    AL_3003    Aluminum 3003 Alloy

Value (English) 
0.10E+08   psi 
0.33   
0.39E+07   psi
0.13E-04    /Fahrenheit
0.26E-03    lbf s2/in4 
0.22E-02    BTU/in/s/F
93.0           BTU in/lbf/s/s/F 

Value (MKS)
0.70E+06   Kgf/cm/cm
0.33 
0.27E+06   Kgf/cm/cm
0.23E-04    /Centigrade   
0.28E-05    Kgf s2/cm4

0.40           Cal/cm/s/C
0.24E+06   Cal cm/kgf/s/s/C

Value (SI)
0.69E+11   Pascals
0.33
0.27E+11   Pascals
0.23E-04    /Kelvin
0.27E+04   Kgm/m3

0.17E+03   W/m/K
0.10E+04   J/kgm/K

:    AL_6061    Aluminum 6061 Alloy

Value (English)   
0.10E+08   psi 
0.33 
0.38E+07   psi 
0.13E-04    /Fahrenheit 
0.25E-03    lbf s2/in4 
0.22E-02    BTU/in/s/F 
0.12E+03   BTU in/lbf/s/s/F

Value (MKS)
0.70E+06  Kgf/cm/cm
0.33 
0.27E+06  Kgf/cm/cm   
0.24E-04   /Centigrade   
0.28E-05   Kgf s2/cm4

0.40           Cal/cm/s/C 
0.29E+06  Cal cm/kgf/s/s/C

Value (SI)
0.69E+11   Pascals
0.33
0.26E+11   Pascals
0.24E-04    /Kelvin
0.27E+04   Kgm/m3

0.17E+03   W/m/K
0.13E+04   J/kgm/K

:    AL_7079    Aluminum 7079 Alloy

Value (English) 
0.10E+08   psi 
0.33 
0.39E+07   psi
0.14E-04   /Fahrenheit
0.26E-03   lbf s2/in4 
0.16E-02   BTU/in/s/F
89.0          BTU.in/lbf/s/s/F 

Value (MKS)
0.73E+06  Kgf/cm/cm
0.33 
0.27E+06  Kgf/cm/cm
0.25E-04   /Centigrade 
0.28E-05   Kgf s2/cm4

0.29          Cal/cm/s/C
0.23E+06  Cal cm/kgf/s/s/C

Value (SI)
0.72E+11   Pascals
0.33
0.27E+11   Pascals
0.25E-04    /Kelvin
0.27E+04   Kgm/m3

0.12E+03   W/m/K
0.96E+03   J/kgm/K

:    AL_BRONZE    Aluminum Bronze

Value (English) 
0.17E+08   psi 
0.30
0.62E+07   psi
0.95E-05   /Fahrenheit 
0.70E-03   lbf s2/in4

0.75E-03   BTU/in/s/F
35.0          BTU in/lbf/s/s/F 

Value (MKS)
0.12E+07   Kgf/cm/cm
0.30 
0.44E+06   Kgf/cm/cm   
0.17E-04    /Centigrade   
0.76E-05    Kgf s2/cm4 
0.13           Cal/cm/s/C 
0.88E+05   Cal cm/kgf/s/s/C

Value (SI)
0.11E+12   Pascals
0.30
0.43E+11   Pascals
0.17E-04    /Kelvin
0.74E+04   Kgm/m3

56.             W/m/K
0.38E+03   J/kgm/K

:    BRASS    Silicon Brass and Bronze

Value (English) 
0.15E+08   psi
0.33 
0.54E+07   psi
0.10E-04    /Fahrenheit 
0.80E-03    lbf s2/in4

0.15E-02    BTU/in/s/F
36.0           BTU in/lbf/s/s/F 

Value (MKS)
0.11E+07  Kgf/cm/cm
0.33 
0.38E+06  Kgf/cm/cm   
0.18E-04   /Centigrade   
0.87E-05   Kgf s2/cm4

0.26          Cal/cm/s/C 
0.90E+05  Cal cm/kgf/s/s/C

Value (SI)
0.10E+12   Pascals
0.33
0.37E+11   Pascals
0.18E-04    /Kelvin
0.85E+04   Kgm/m3

0.11E+03   W/m/K
0.39E+03   J/kgm/K
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Material Name
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NUXY
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C (Cp) 
Material Name

Property Name
EX
NUXY 
GXY
ALPX
DENS
KX
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EX
NUXY
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ALPX 
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KX
C (Cp) 
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NUXY
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ALPX 
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NUXY
GXY
ALPX 
DENS
KX
C (Cp) 
:    BRONZE    Bronze

Value (English) 
0.16E+08   psi
0.37 
0.59E+07   psi 
0.18E-04    /Fahrenheit 
0.81E-03    lbf s2/in4

0.35E-03    BTU/in/s/F
32.0            BTU in/lbf/s/s/F   

Value (MKS)
0.11E+07   Kgf/cm/cm
0.37 
0.41E+06   Kgf/cm/cm
0.32E-04    /Centigrade   
0.88E-05    Kgf s2/cm4 
0.62E-01    Cal/cm/s/C
0.81E+05   Cal cm/kgf/s/s/C

Value (SI)
0.11E+12   Pascals
0.37
0.41E+11   Pascals
0.32E-04    /Kelvin
0.87E+04   Kgm/m3

26.0           W/m/K
0.34E+03   J/kgm/K

:    CA_STEEL    Cast Alloy Steel (Below 8% Content)

Value (English) 
0.28E+08   psi 
0.26 
0.11E+08   psi
0.81E-05    /Fahrenheit 
0.68E-03    lbf s2/in4

0.50E-03    BTU/in/s/F
41.0           BTU in/lbf/s/s/F 

Value (MKS)
0.20E+07   Kgf/cm/cm
0.26 
0.79E+06   Kgf/cm/cm
0.15E-04    /Centigrade   
0.74E-05    Kgf s2/cm4

0.90E-01    Cal/cm/s/C
0.10E+06   Cal cm/kgf/s/s/C

Value (SI)
0.19E+12   Pascals
0.26
0.78E+11   Pascals
0.15E-04    /Kelvin
0.73E+04   Kgm/m3

38.             W/m/K
0.44E+03   J/kgm/K

:    COBALT    Cobalt

Value (English) 
0.33E+08   psi 
0.31 
0.13E+08   psi 
0.68E-05    /Fahrenheit   
0.83E-03    lbf s2/in4 
0.92E-03    BTU/in/s/F
38.0           BTU in/lbf/s/s/F 

Value (MKS)
0.23E+07   Kgf/cm/cm
0.31 
0.90E+06   Kgf/cm/cm
0.12E-04    /Centigrade 
0.91E-05    Kgf s2/cm4 
0.16           Cal/cm/s/C 
0.96E+05   Cal cm/kgf/s/s/C 

Value (SI)
0.23E+12   Pascals
0.31
0.88E+11   Pascals
0.12E-04    /Kelvin
0.89E+04   Kgm/m3

69.0           W/m/K
0.41E+03   J/kgm/K

:    COPPER    Copper

Value (English) 
0.16E+08   psi 
0.37 
0.58E+07   psi
0.13E-04    /Fahrenheit 
0.84E-03    lbf s2/in4

0.52E-02    BTU/in/s/F
36.0           BTU in/lbf/s/s/F 

Value (MKS)
0.11E+07  Kgf/cm/cm
0.37 
0.41E+06  Kgf/cm/cm   
0.24E-04   /Centigrade   
0.91E-05   Kgf s2/cm4 
0.92          Cal/cm/s/C 
0.90E+05  Cal cm/kgf/s/s/C

Value (SI)
0.11E+12   Pascals
0.37
0.40E+11   Pascals
0.24E-04    /Kelvin
0.89E+04   Kgm/m3

0.39E+03   W/m/K
0.39E+03   J/kgm/K

:    CS_STEEL    Cast Stainless Steel (Cf-8m or Cf-20)

Value (English) 
0.28E+08   psi 
0.26 
0.12E+08   psi 
0.84E-05    /Fahrenheit   
0.73E-03    lbf s2/in4 
0.50E-03    BTU/in/s/F
48.0           BTU in/lbf/s/s/F 

Value (MKS)
0.20E+07   Kgf/cm/cm 
0.26 
0.81E+06   Kgf/cm/cm
0.15E-04    /Centigrade   
0.79E-05    Kgf s2/cm4 
0.90E-01    Cal/cm/s/C
0.12E+06   Cal cm/kgf/s/s/C

Value (SI)
0.19E+12   Pascals
0.26
0.79E+11   Pascals
0.15E-04    /Kelvin
0.77E+04   Kgm/m3

37.0           W/m/K
0.52E+03   J/kgm/K
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:    GC_IRON    Gray Cast Iron (ASTM - Class 40)

Value (English)   
0.17E+08   psi
0.27 
0.72E+07   psi 
0.66E-05    /Fahrenheit 
0.67E-03    lbf s2/in4 
0.60E-03    BTU/in/s/F
47.0            BTU in/lbf/s/s/F   

Value (MKS) 
0.12E+07   Kgf/cm/cm 
0.27   
0.51E+06   Kgf/cm/cm 
0.12E-04    /Centigrade 
0.73E-05    Kgf s2/cm4

0.11           Cal/cm/s/C
0.12E+06   Cal cm/kgf/s/s/C 

Value (SI)
0.12E+12   Pascals
0.27
0.50E+11   Pascals
0.12E-04    /Kelvin
0.72E+04   Kgm/m3

45.0           W/m/K
0.51E+03   J/kgm/K

:    GLASS   Glass

Value (English) 
0.92E+07   psi 
0.22
0.15E+08   psi
0.55E-05    /Fahrenheit 
0.28E-03    lbf s2/in4

0.22E-04    BTU/in/s/F
70.0           BTU in/lbf/s/s/F 

Value (MKS)
0.64E+06   Kgf/cm/cm
0.22 
0.10E+07   Kgf/cm/cm
0.99E-05    /Centigrade   
0.31E-05    Kgf s2/cm4

0.38E-02    Cal/cm/s/C
0.18E+06   Cal cm/kgf/s/s/C

Value (SI)
0.63E+11   Pascals
0.22
0.10E+12   Pascals
0.99E-05    /Kelvin
0.30E+04   Kgm/m3

1.6              W/m/K
0.75E+03   J/kgm/K

:    GOLD    Pure Gold

Value (English) 
0.11E+08   psi 
0.42
0.38E+07   psi
0.79E-05    /Fahrenheit 
0.18E-02    lbf s2/in4

0.40E-02    BTU/in/s/F
12.0           BTU in/lbf/s/s/F 

Value (MKS)
0.76E+06   Kgf/cm/cm
0.42 
0.27E+06   Kgf/cm/cm
0.14E-04    /Centigrade   
0.20E-04    Kgf s2/cm4

0.71           Cal/cm/s/C
0.30E+05   Cal cm/kgf/s/s/C

Value (SI)
0.74E+11   Pascals
0.42
0.26E+11   Pascals
0.14E-04    /Kelvin
0.19E+05   Kgm/m3

0.30E+03   W/m/K
0.13E+03   J/kgm/K

:    IRON    Iron

Value (English) 
0.17E+08   psi 
0.31
0.11E+08   psi
0.61E-05    /Fahrenheit 
0.74E-03    lbf s2/in4

0.10E-02    BTU/in/s/F
42.0           BTU in/lbf/s/s/F 

Value (MKS)
0.12E+07   Kgf/cm/cm   
0.31 
0.78E+06   Kgf/cm/cm 
0.11E-04    /Centigrade 
0.80E-05    Kgf s2/cm4 
0.18           Cal/cm/s/C
0.11E+06   Cal cm/kgf/s/s/C

Value (SI)
0.12E+12   Pascals
0.31
0.77E+11   Pascals
0.11E-04    /Kelvin
0.79E+04   Kgm/m3

75.             W/m/K
0.45E+03   J/kgm/K

:    LEAD    Pure Lead

Value (English) 
0.20E+07   psi 
0.40
0.71E+06   psi
0.29E-04    /Fahrenheit 
0.11E-02    lbf s2/in4

0.47E-03    BTU/in/s/F
12.0           BTU in/lbf/s/s/F 

Value (MKS)
0.14E+06   Kgf/cm/cm
0.40 
0.50E+05   Kgf/cm/cm   
0.53E-04    /Centigrade   
0.12E-04    Kgf s2/cm4 
0.83E-01    Cal/cm/s/C
0.30E+05   Cal cm/kgf/s/s/C

Value (SI)
0.14E+11   Pascals
0.40
0.49E+10   Pascals
0.53E-04     /Kelvin
0.11E+05   Kgm/m3

35.              W/m/K
0.13E+03   J/kgm/K
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Material Name

Property Name
EX
NUXY
GXY
ALPX 
DENS
KX
C (Cp) 
Material Name

Property Name
EX
NUXY
GXY 
ALPX 
DENS
KX
C (Cp) 
Material Name

Property Name
EX
NUXY
GXY 
ALPX 
DENS
KX
C (Cp))
Material Name

Property Name
EX
NUXY
GXY
ALPX 
DENS
KX
C (Cp) 
Material Name

Property Name
EX
NUXY 
GXY
ALPX 
DENS 
KX
C (Cp) 
:    MAGNES    Magnesium Alloy - Wrought or Cast

Value (English) 
0.65E+07   psi 
0.35 
0.24E+07   psi
0.14E-04    /Fahrenheit 
0.16E-03    lbf s2/in4

0.21E-02    BTU/in/s/F
97.0           BTU in/lbf/s/s/F 

Value (MKS)
0.46E+06   Kgf/cm/cm
0.35 
0.17E+06    Kgf/cm/cm
0.25E-04     /Centigrade
0.18E-05     Kgf s2/cm4 
0.38            Cal/cm/s/C
0.25E+06    Cal cm/kgf/s/s/C

Value (SI)
0.45E+11   Pascals
0.35
0.17E+11   Pascals
0.25E-04    /Kelvin
0.17E+04   Kgm/m3

0.16E+03   W/m/K
0.10E+04   J/kgm/K

:    MC_IRON   Malleable Cast Iron (ASTM - A220)

Value (English) 
0.27E+08   psi 
0.27
0.13E+08   psi
0.67E-05    /Fahrenheit 
0.68E-03    lbf s2/in4

0.63E-03    BTU/in/s/F
47.0           BTU in/lbf/s/s/F 

Value (MKS)
0.19E+07   Kgf/cm/cm
0.27 
0.88E+06   Kgf/cm/cm   
0.12E-04    /Centigrade 
0.74E-05    Kgf s2/cm4 
0.11           Cal/cm/s/C 
0.12E+06   Cal cm/kgf/s/s/C

Value (SI)
0.19E+12   Pascals
0.27
0.86E+11   Pascals
0.12E-04    /Kelvin
0.73E+04   Kgm/m3

47.0           W/m/K
0.51E+03   J/kgm/K

:    MN_IRON    Maganese Bronze

Value (English) 
0.15E+08   psi 
0.37 
0.56E+07   psi
0.12E-04    /Fahrenheit 
0.78E-03    lbf s2/in4

0.13E-03    BTU/in/s/F
35.0           BTU in/lbf/s/s/F 

Value (MKS)
0.11E+07   Kgf/cm/cm
0.37 
0.39E+06   Kgf/cm/cm   
0.22E-04    /Centigrade   
0.85E-05    Kgf s2/cm4

0.23E-01    Cal/cm/s/C
0.88E+05   Cal cm/kgf/s/s/C

Value (SI)
0.11E+12   Pascals
0.37
0.39E+11   Pascals
0.22E-04    /Kelvin
0.83E+04   Kgm/m3

9.6            W/m/K
0.38E+03   J/kgm/K

:    MOLYBDENUM    Molybdenum

Value (English)   
0.47E+08   psi
0.38 
0.17E+08   psi 
0.28E-05    /Fahrenheit   
0.96E-03    lbf s2/in4 
0.20E-02    BTU/in/s/F
25.0           BTU in/lbf/s/s/F 

Value (MKS)
0.33E+07   Kgf/cm/cm   
0.38 
0.12E+07   Kgf/cm/cm 
0.50E-05    /Centigrade 
0.10E-04    Kgf s2/cm4
0.35           Cal/cm/s/C
0.64E+05   Cal cm/kgf/s/s/C

Value (SI)
0.32E+12   Pascals
0.38
0.12E+12   Pascals
0.50E-05    /Kelvin
0.10E+05   Kgm/m3

0.15E+03   W/m/K
0.27E+03   J/kgm/K

:    MONEL    Monel 400 Alloy of Nickel

Value (English) 
0.26E+08   psi 
0.34 
0.97E+07   psi 
0.77E-05    /Fahrenheit   
0.83E-03    lbf s2/in4 
0.29E-03    BTU/in/s/F
39.0           BTU in/lbf/s/s/F 

Value (MKS)
0.18E+07   Kgf/cm/cm   
0.34 
0.68E+06   Kgf/cm/cm   
0.14E-04    /Centigrade 
0.90E-05    Kgf vs2/cm4 
0.52E-01    Cal/cm/s/C   
0.10E+06   Cal vcm/kgf/s/s/C

Value (SI)
0.18E+12   Pascals
0.34
0.67E+11   Pascals
0.14E-04    /Kelvin
0.88E+04   Kgm/m3

22.0           W/m/K
0.43E+03   J/kgm/K
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Material Name

Property Name 
EX 
NUXY
GXY
ALPX 
DENS
KX 
C (Cp) 
Material Name

Property Name
EX
NUXY
GXY
ALPX 
DENS
KX
C (Cp) 
Material Name

Property Name
EX
NUXY
GXY
ALPX 
DENS
KX
C (Cp) 
Material Name

Property Name
EX
NUXY
GXY
ALPX
DENS
KX
C (Cp) 
Material Name

Property Name 
EX 
NUXY
GXY 
ALPX
DENS
KX 
C (Cp) 
:    NICKEL    Nickel

Value (English) 
0.31E+08   psi 
0.31 
0.11E+08   psi 
0.92E-05    /Fahrenheit   
0.80E-03    lbf s2/in4 
0.58E-03    BTU/in/s/F
42.0           BTU in/lbf/s/s/F 

Value (MKS)
0.21E+07   Kgf/cm/cm   
0.31 
0.81E+06   Kgf/cm/cm   
0.17E-04    /Centigrade 
0.87E-05    Kgf s2/cm4

0.10           Cal/cm/s/C 
0.11E+06   Cal cm/kgf/s/s/C

Value (SI)
0.21E+12   Pascals
0.31
0.79E+11   Pascals
0.17E-04    /Kelvin
0.85E+04   Kgm/m3

43.             W/m/K
0.46E+03   J/kgm/K

:    D_NICKEL    Duranickel 301

Value (English) 
0.30E+08   psi 
0.34 
0.11E+08   psi 
0.82E-05    /Fahrenheit 
0.77E-03    lbf s2/in4 
0.32E-03    BTU/in/s/F
54.0           BTU in/lbf/s/s/F 

Value (MKS)
0.21E+07   Kgf/cm/cm   
0.34 
0.79E+06   Kgf/cm/cm 
0.15E-04    /Centigrade 
0.84E-05    Kgf s2/cm4

0.57E-01    Cal/cm/s/C   
0.14E+06   Cal cm/kgf/s/s/C

Value (SI)
0.21E+12   Pascals
0.34
0.77E+11   Pascals
0.15E-04    /Kelvin
0.82E+04   Kgm/m3

24.0           W/m/K
0.59E+03   J/kgm/K

:    NYLON    Nylon 6/10

Value (English)
0.12E+07   psi
0.28 
0.47E+06   psi 
0.16E-04    /Fahrenheit 
0.13E-03    lbf s2/in4

0.70E-05    BTU/in/s/F 
0.14E+03   BTU in/lbf/s/s/F

Value (MKS)
0.84E+05  Kgf/cm/cm
0.28
0.33E+05  Kgf/cm/cm
0.30E-04   /Centigrade 
0.14E-05   Kgf s2/cm4

0.13E-02   Cal/cm/s/C
0.34E+06  Cal cm/kgf/s/s/C

Value (SI)
0.83E+10   Pascals
0.28
0.32E+10   Pascals
0.30E-04    /Kelvin
0.14E+04   Kgm/m3

0.53           W/m/K
0.15E+04   J/kgm/K

:    PC_STEEL    Plain Carbon Steel

Value (English)
0.30E+08   psi
0.28 
0.12E+08   psi
0.74E-05    /Fahrenheit 
0.73E-03    lbf s2/in4

0.57E-03    BTU/in/s/F
41.0           BTU in/lbf/s/s/F 

Value (MKS)
0.21E+07   Kgf/cm/cm
0.28 
0.81E+06   Kgf/cm/cm
0.13E-04    /Centigrade   
0.79E-05    Kgf s2/cm4

0.10           Cal/cm/s/C
0.10E+06   Cal cm/kgf/s/s/C

Value (SI)
0.21E+12   Pascals
0.28
0.79E+11   Pascals
0.13E-04    /Kelvin
0.78E+04   Kgm/m3

43.             W/m/K
0.44E+03   J/kgm/K

:    PORCELAIN    Ceramic Porcelain

Value (English) 
0.15E+08   psi 
0.22 
0.15E+08   psi
0.35E-05    /Fahrenheit 
0.24E-03    lbf s2/in4

0.68E-04    BTU/in/s/F
81.0           BTU in/lbf/s/s/F 

Value (MKS)
0.11E+07  Kgf/cm/cm
0.22 
0.10E+07  Kgf/cm/cm
0.63E-05   /Centigrade 
0.26E-05   Kgf s2/cm4 
0.12E-01   Cal/cm/s/C
0.21E+06  Cal cm/kgf/s/s/C

Value (SI)
0.10E+12   Pascals
0.22
0.10E+12   Pascals
0.63E-05    /Kelvin
0.25E+04   Kgm/m3

5.0             W/m/K
0.88E+03   J/kgm/K
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Material Name

Property Name
EX
NUXY
GXY
ALPX 
DENS
KX
Material Name

Property Name
EX
NUXY
GXY
ALPX
DENS 
KX
C (Cp) 
Material Name

Property Name
EX
NUXY
GXY 
ALPX 
DENS
KX
C (Cp) 
Material Name

Property Name
EX
NUXY 
GXY
ALPX   
DENS 
KX
C (Cp) 

Material Name

Property Name
EX
NUXY
GXY
ALPX 
DENS
KX
C (Cp) 
:    RUBBER    Rubber

Value (English) 
0.88E+03   psi 
0.4
0.42E+03   psi 
0.37E-03    /Fahrenheit 
0.93E-04    lbf s2/in4

0.19E-05    BTU/in/s/F

Value (MKS)
62.             Kgf/cm/cm
0.49 
29.0          Kgf/cm/cm
0.67E-03   /Centigrade
0.10E-05   Kgf s2/cm4

0.34E-03   Cal/cm/s/C

Value (SI)
0.61E+07   Pascals
0.49
0.29E+07   Pascals
0.67E-03    /Kelvin
0.10E+04   Kgm/m3

0.14            W/m/K
:    SILVER    Pure Silver

Value (English) 
0.10E+08   psi 
0.37
0.36E+07   psi
0.11E-04    /Fahrenheit 
0.98E-03    lbf s2/in4

0.56E-02    BTU/in/s/F
22.0           BTU in/lbf/s/s/F 

Value (MKS)
0.70E+06   Kgf/cm/cm
0.37 
0.26E+06   Kgf/cm/cm
0.20E-04    /Centigrade   
0.11E-04    Kgf s2/cm4 
1.0            Cal/cm/s/C 
0.55E+05   Cal cm/kgf/s/s/C

Value (SI)
0.69E+11   Pascals
0.37
0.25E+11   Pascals
0.20E-04    /Kelvin
0.11E+05   Kgm/m3

0.42E+03   W/m/K
0.23E+03   J/kgm/K

:    STEEL    Steel

Value (English) 
0.29E+08   psi 
0.32
0.11E+08   psi
0.65E-05    /Fahrenheit 
0.73E-03    lbf s2/in**4

0.40E-03    BTU/in/s/F
46.0           BTU in/lbf/s/s/F 

Value (MKS)
0.20E+07   Kgf/cm/cm   
0.32 
0.77E+06   Kgf/cm/cm 
0.12E-04    /Centigrade 
0.80E-05    Kgf s2/cm**4

0.72E-01    Cal/cm/s/C   
0.12E+06   Cal cm/kgf/s/s/C

Value (SI)
0.20E+12   Pascals
0.32
0.76E+11   Pascals
0.12E-04    /Kelvin
0.78E+04   Kgm/m3

30.0           W/m/K
0.50E+03   J/kgm/K

:    ST_1020    Steel, AISI C1020 (Hot Worked)

Value (English) 
0.29E+08   psi 
0.29
0.11E+08   psi
0.84E-05    /Fahrenheit 
0.74E-03    lbf s2/in4

0.62E-03    BTU/in/s/F
39.0           BTU in/lbf/s/s/F 

Value (MKS)
0.20E+07   Kgf/cm/cm   
0.29 
0.79E+06   Kgf/cm/cm 
0.15E-04    /Centigrade 
0.80E-05    Kgf s2/cm4

0.11           Cal/cm/s/C
0.98E+05   Cal cm/kgf/s/s/C

Value (SI)
0.20E+12    Pascals
0.29
0.77E+11    Pascals
0.15E-04     /Kelvin
0.79E+04    Kgm/m3

47.0            W/m/K
0.42E+03   J/kgm/K

:    ST_304    Steel, AISI 304 (Sheet)

Value (English) 
0.28E+08   psi 
0.29 
0.11E+08   psi 
0.99E-05    /Fahrenheit   
0.75E-03    lbf s2/in4 
0.22E-03    BTU/in/s/F
46.0           BTU in/lbf/s/s/F 

Value (MKS)
0.20E+07   Kgf/cm/cm
0.29 
0.76E+06   Kgf/cm/cm
0.18E-04    /Centigrade   
0.82E-05    Kgf s2/cm4

0.39E-01    Cal/cm/s/C
0.12E+06   Cal cm/kgf/s/s/C

Value (SI)
0.19E+12   Pascals
0.29
0.75E+11   Pascals
0.18E-04    /Kelvin
0.80E+04   Kgm/m3

16.0           W/m/K
0.50E+03   J/kgm/K
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Material Name

Property Name
EX
NUXY
GXY
ALPX 
DENS
KX
C (Cp) 
Material Name

Property Name 
EX 
NUXY   
GXY
ALPX   
DENS   
KX 
C (Cp) 
Material Name

Property Name
EX
NUXY 
GXY
ALPX 
DENS 
KX
C (Cp) 
Material Name

Property Name
EX
NUXY 
GXY
ALPX 
DENS 
KX
C (Cp) 
Material Name

Property Name
EX
NUXY 
GXY
ALPX 
DENS 
KX
C (Cp) 
:    ST_ST    Stainless Steel

Value (English) 
0.29E+08   psi 
0.28   
0.11E+08   psi 
0.60E-05    /Fahrenheit 
0.73E-03    lbf s2/in4 
0.24E-03    BTU/in/s/F
42.0           BTU in/lbf/s/s/F 

Value (MKS)
0.20E+07   Kgf/cm/cm
0.28 
0.78E+06   Kgf/cm/cm
0.11E-04    /Centigrade   
0.80E-05    Kgf s2/cm4

0.43E-01    Cal/cm/s/C
0.11E+06   Cal cm/kgf/s/s/C

Value (SI)
0.20E+12   Pascals
0.28
0.77E+11   Pascals
0.11E-04    /Kelvin
0.78E+04   Kgm/m3

18.0           W/m/K
0.46E+03   J/kgm/K

:    T_BRONZE    Tin Brearing Bronze

Value (English) 
0.13E+08   psi 
0.33 
0.54E+07   psi 
0.10E-04    /Fahrenheit   
0.78E-03    lbf s2/in4 
0.62E-03    BTU/in/s/F
35.0           BTU in/lbf/s/s/F 

Value (MKS)
0.91E+06   Kgf/cm/cm   
0.33 
0.38E+06   Kgf/cm/cm 
0.18E-04    /Centigrade 
0.85E-05    Kgf s2/cm4

0.11            Cal/cm/s/C
0.88E+05   Cal cm/kgf/s/s/C

Value (SI)
0.90E+11    Pascals
0.33
0.37E+11    Pascals
0.18E-04     /Kelvin
0.83E+04    Kgm/m3

47.0            W/m/K
0.38E+03    J/kgm/K

:    TITANIUM   Titanium

Value (English) 
0.16E+08   psi
0.30
0.63E+07   psi
0.49E-05    /Fahrenheit 
0.43E-03    lbf s2/in4

0.29E-03    BTU/in/s/F
2.0             BTU in/lbf/s/s/F

Value (MKS)
0.11E+07   Kgf/cm/cm 
0.3
0.44E+06   Kgf/cm/cm   
0.88E-05    /Centigrade 
0.47E-05    Kgf s2/cm4 
0.52E-01    Cal/cm/s/C   
0.11E+06   Cal cm/kgf/s/s/C

Value (SI)
0.11E+12   Pascals
0.30
0.43E+11   Pascals
0.88E-05    /Kelvin
0.46E+04   Kgm/m3

22.0           W/m/K
0.46E+03   J/kgm/K

:    TUNGSTEN    Tungsten

Value (English) 
0.59E+08   psi 
0.28
0.23E+08   psi
0.25E-05    /Fahrenheit 
0.18E-02    lbf s2/in4

0.27E-02    BTU/in/s/F
12.0           BTU in/lbf/s/s/F 

Value (MKS)
0.41E+07   Kgf/cm/cm   
0.28 
0.16E+07   Kgf/cm/cm   
0.45E-05    /Centigrade 
0.20E-04    Kgf s2/cm4 
0.48           Cal/cm/s/C 
0.31E+05   Cal cm/kgf/s/s/C

Value (SI)
0.41E+12   Pascals
0.28
0.16E+12   Pascals
0.45E-05    /Kelvin
0.19E+05   Kgm/m3

0.20E+03   W/m/K
0.13E+03   J/kgm/K

:    VANADIUM    Vanadium

Value (English) 
0.20E+08   psi 
0.36 
0.74E+07   psi 
0.46E-05    /Fahrenheit   
0.57E-03    lbf s2/in4 
0.41E-03    BTU/in/s/F
46.0           BTU in/lbf/s/s/F 

Value (MKS)
0.14E+07   Kgf/cm/cm   
0.36 
0.52E+06   Kgf/cm/cm   
0.83E-05    /Centigrade 
0.62E-05    Kgf s2/cm4 
0.74E-01    Cal/cm/s/C   
0.12E+06   Cal cm/kgf/s/s/C

Value (SI)
0.14E+12   Pascals
0.36
0.51E+11   Pascals
0.83E-05    /Kelvin
0.61E+04   Kgm/m3

31.0           W/m/K
0.50E+03   J/kgm/K
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Material Name

Property Name
EX
NUXY 
GXY
ALPX 
DENS 
KX
C (Cp) 

Material Name

Property Name
EX
NUXY 
GXY
ALPX   
DENS 
KX
C (Cp) 

Material Name

Property Name
EX
NUXY
GXY
ALPX 
DENS
KX
C (Cp) 

Material Name

Property Name
DENS
KX
C (Cp)
VISC 
BETA 

Material Name

Property Name
DENS 
KX
C (Cp) 
VISC 
BETA
GAMMA
:    W_COPPER    Wrought Cooper

Value (English) 
0.16E+08   psi
0.33
0.58E+07   psi
0.11E-04    /Fahrenheit 
0.79E-03    lbf s2/in4

0.31E-02    BTU/in/s/F
35.0           BTU in/lbf/s/s/F 

Value (MKS)
0.11E+07   Kgf/cm/cm   
0.33 
0.41E+06   Kgf/cm/cm   
0.20E-04    /Centigrade 
0.86E-05    Kgf s2/cm4 
0.56           Cal/cm/s/C 
0.88E+05   Cal cm/kgf/s/s/C

Value (SI)
0.11E+12   Pascals
0.33
0.40E+11   Pascals
0.20E-04    /Kelvin
0.84E+04   Kgm/m3

0.23E+03   W/m/K
0.38E+03   J/kgm/K

:    WS_STEEL    Wrought Stainless Steel

Value (English) 
0.29E+08   psi 
0.26
0.12E+08   psi
0.60E-05    /Fahrenheit 
0.75E-03    lbfs2/in4

0.25E-03    BTU/in/s/F
46.0           BTU in/lbf/s/s/F 

Value (MKS)
0.20E+07   Kgf/cm/cm
0.26 
0.81E+06   Kgf/cm/cm
0.11E-04    /Centigrade   
0.82E-05    Kgf s2/cm4

0.45E-01    Cal/cm/s/C
0.12E+06   Cal cm/kgf/s/s/C

Value (SI)
0.20E+12   Pascals
0.26
0.79E+11   Pascals
0.11E-04    /Kelvin
0.80E+04   Kgm/m3

19.0           W/m/K
0.50E+03   J/kgm/K

:    ZIRCONIUM    Zirconium

Value (English) 
0.14E+08   psi
0.34
0.53E+07   psi
0.61E-05    /Fahrenheit 
0.62E-03    lbf s2/in4

0.22E-04    BTU/in/s/F
27.0           BTU in/lbf/s/s/F 

Value (MKS)
0.10E+07  Kgf/cm/cm
0.34 
0.37E+06  Kgf/cm/cm
0.11E-04   /Centigrade   
0.67E-05   Kgf s2/cm4

0.40E-02   Cal/cm/s/C
0.69E+05  Cal cm/kgf/s/s/C

Value (SI)
0.98E+11   Pascals
0.34
0.36E+11   Pascals
0.11E-04    /Kelvin
0.66E+04   Kgm/m3

1.7             W/m/K
0.29E+03   J/kgm/K

:    WATER    Water

Value (English)
0.93E-04   lbf s2/in4

0.82E-05   BTU/in/s/F 
0.39E+03  BTU in/lbf/s/s/F
0.13E-06   lbf s/in/in
0.15E-03   /Rankin 

Value (MKS)
0.10E-05   Kgf*s2/cm* 
0.15E-02   Cal/cm/s/C   
0.98E+06  Cal cm/kgf/s/s/C
0.88E-08   kgf s/cm/cm
0.27E-03   /Kelvin 

Value (SI)
0.10E+04   Kgm/m3

0.61           W/m/K
0.42E+04   J/kgm/K
0.87E-03    kgm/m/s
0.27E-03    /Kelvin

:    AIR    Air (300 K)

Value (English) 
0.10E-06   lbf s2/in4 
0.36E-06   BTU/in/s/F
93.0          BTU in/lbf/s/s/F
0.27E-08   lbf s/in/in
0.19E-02   /Rankin 
1.40 

Value (MKS)
0.11E-08   Kgf s2/cm4

0.64E-04   Cal/cm/s/C
0.24E+06  Cal cm/kgf/s/s/C 
0.19E-09   kgf s/cm/cm 
0.33E-02   /Kelvin
1.40   

Value (SI)
1.1Kgm/m3

0.27E-01   W/m/K
0.10E+04   J/kgm/K
0.19E-04    kgm/m/s
0.33E-02    /Kelvin
1.40
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Using Your Own Material Library

If you need to frequently use material properties not available in the built-in 
material library, COSMOS/M provides you the feature to add material properties 
to a user-created library. The USER_MAT (Propsets > User Material Lib) com-
mand allows you to read your own material properties defined in the file 
USERMAT.LIB which has the same format as the PICKMAT.LIB file. Note that 
the file, USERMAT.LIB, has already been installed in the COSMOS/M directory, 
and its contents are the same as those in the PICKMAT.LIB file. Currently, there 
is no limit on the number of materials for which you can pre-define material 
properties in the USERMAT.LIB file.

The format of a typical material property entry existing in the USERMAT.LIB 
file is shown below. To define your own material properties, you need to modify 
the material names and the numerical values without altering the existing format.

As you can notice from the above, properties for each material are defined start-
ing with a MATL: statement and are terminated with the ENDMATL statement. The 
format of entries in between these statements should be identical to the entries 
shown above. For example, if you like to define material properties for Concrete 
(in compression only) in FPS units, the changes to the above lines are as follows:

12345678901234567890123456789012345678901234567890123456789012345678901234567890

MATL:W_COPPER :   WROUGHT COPPER

EX        15.5E+6  p.s.i.          1.0897E6  kg/sq.cm.        106.87E+9 Pascals

NUXY      0.33                     0.33                       0.33

GXY       5.80E+6  p.s.i.          4.078E+5  kg/sq.cm.        39.99E+9  Pascals

ALPX      11.0E-6  /Fahrenheit     19.80E-6  /Centigrade      19.80E-6  /Kelvin

DENS      7.893E-4 lb.s.s/in**4    8.6059E-6 kgf.s.s/cm**4    8442.4    kg/cu.m

KX        5.370E-3 BTU/in.s.F      0.062     Cal/cm.s.C       26        W/m.K

C (Cp)    34.776   BTUin/lbssF     88305.696 Calcm/kgssC      376.64    J/kg.K

ENDMATL
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You can complete the remaining entries by suitably multiplying the values in FPS 
units by conversion factors (see Appendix A, Units, for conversion factors). In 
order to use the properties defined above, the USER_MAT (Propsets > User 
Material Lib) command for material property set 1 in FPS units is executed as fol-
lows:

Geo Panel:   Propsets > User Material Lib
Material Property set > 1
Material Name > CONCRETE
Unit Label > FPS

Modification, Display, and Output of Material 
Property Definitions 

The command MPDEL (Edit > DELETE > Material Props) can be used to delete 
all properties defined in one or more material sets. If you like to delete or modify 
a specific property in a material set, then you need to execute the MPROP 
(Propsets > Material Property) command, specify the appropriate material set 
number and the property name, and simply enter the new value for that property.

During mesh generation, the material group currently active is associated with the 
elements created. If you have more than one material group in your model and 
would like to make a particular group active, then you need to use the command 
ACTSET (Control > ACTIVATE > Set Entity). In addition to activating material 
sets, this command can be used to activate sets for real constants, coordinate sys-
tems, temperature curves, and many others. The description of these sets and their 
set names are shown in the table below.

1234567890123456789012345678901234567890123456789012345678901234567890

MATL:CONCRETE :    CEMENT CONCRETE

EX        3.0E+6   p.s.i.          *.******  kg/sq.cm.        ***.****  Pascals

NUXY      0.18                     0.18                       0.18

GXY       1.27E+6  p.s.i.          *.******  kg/sq.cm.        **.*****  Pascals

ALPX      1.25E-5  /Fahrenheit     *.******  /Centigrade      **.*****  /Kelvin

DENS      2.20E-4  lb.s.s/in**4    *.******* kgf.s.s/cm**4    ******    kg/cu.m

KX        0.2      BTU/in.s.F      *.***     Cal/cm.s.C       **        W/m.K

C (Cp)    7.2E-4   BTUin/lbssF     *****.*** Calcm/kgssC      ***.**    J/kg.K

ENDMATL
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Table  6-10. Description of Set Names for Activating Using ACTSET Command

The set names that are currently active can be graphically viewed on the screen 
using the STATUS1 icon as shown below.

Figure 6-4. Status Table for Sets and Entities

To change the association of existing material property sets with element groups 
and real constant sets, the EPROPCHANGE (Propsets > Change El-Prop) com-
mand can be used. This command also assigns a specified color to a selected pat-
tern of elements. The assigned colors can be subsequently used to display and 
hence identify parts of your mesh with different material properties, element 
groups and real constant sets. The next section explains this in more detail.

Set Name Description Set Name Description

EG Element group BH B-H curve (for 
magnetic analysis)

MP Material property set CS Coordinate system

RC Real constant set
ECS Element coordinate 

systemLC Load case

TC Time curve LOC Fatigue location

TP Temperature curve MC Material curve
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Display of Material Property Definitions

For models with more than one material group, COSMOS/M provides a novel 
way to graphically represent the different material groups for model checking 
purposes. The command ACTECLR (Meshing > ELEMENTS > Activate Elem 
Color) can be used to activate the default colors for elements and one of the asso-
ciated sets (the material set in this case). The following demonstration explains 
the procedure for a 2D model with three different material properties as shown in 
the figure below. 

Figure 6-5. Example with Multiple Material Sets for Element Coloring

To start with, construct three connected surfaces as shown in the figure. Define 
the material properties for the first surface using either the MPROP (Propsets > 
Material Property) or PICK_MAT (Propsets > Pick Material Lib) (illustrated 
above) command. Next, generate the finite element mesh for the first surface so 
that the elements generated will be associated with material set 1. Before moving 
on to surface 2, define the material properties for set 2, and then proceed to mesh-
ing surface 2. Repeat this procedure for the last surface. If you list the elements 
generated using the ELIST (Edit > LIST > Elements) command, you will observe 
that the elements generated for each surface show the respective association of 
material sets.

To display the finite element mesh with default colors for material properties, you 
need to use the command ACTECLR (Meshing > ELEMENTS > Activate Elem 
Color), as illustrated below:

Material Property Set 3

Material Property Set 2

Material Property Set 1

Geo Panel:    Propsets > Pick Mate rial Lib
   Material property set [1] >
   Material Name [A_STEEL] > W_ COPPER
   Unit Label [FPS] >

Geo Panel:    Meshing : Parametric Mesh > Surfac
   Pick Beginning Surface : 1 ,
   Pick Ending Surface : 1 ,
   Increment [1] >
   Number of nodes per element [4] >
   Number of elements on first curve [2] > 6
   Number of elements on second curve [2] > 3 ;
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Geo Panel:   Meshing > ELEMENTS > Activate Elem Color
Color Flag > Activate

Set Label > Material Property Set
Default colors flag > Yes

The above procedure results in default colors (use the STATUS1 icon to see 
GEOSTAR's default colors and their numbers) assigned to elements with differ-
ent material property set numbers. Next, use the command EPLOT (Edit > PLOT 
> Elements) to plot the elements with different material sets. To obtain a more 
clear view, you can shrink and shade the elements using the commands SHRINK 
(Display > DISPLAY OPTION > Shrink) and SHADE (Display > DISPLAY 
OPTION > Shaded Element Plot). The figure below shows the shrunken finite 
element mesh with default coloring for material sets.

Figure 6-6. Element Shrink Plot with Default Colors for Material Groups

If you want to assign colors other than the default for elements, you need to use 
the command SETECLR (Meshing > ELEMENTS > Set Element Color). You 
need to re-execute this command separately for each material set number and 
assign the desired color.

Material Property Output

By default, the material property information is not written in the output file,
 jobname.OUT, created after you successfully complete the analysis. If you want 
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to include material property information, you need to request for a detailed output 
by activating the input print flag using the command PRINT_OPS (Analysis > 
OUTPUT OPTIONS > Set Print Options); see illustration below:

Geo Panel:   Analysis > OUTPUT INTERVAL OPTIONS > Set Print Options
Displacement Print Interval > Yes
... ... ...
Input Print Flag > Yes

The material properties defined can also be listed on the screen using the MPLIST 
(Edit > LIST > Material Props) command. This command will list material prop-
erties defined for all or specified material groups and will also indicate the mate-
rial set currently active (alphabet A), as shown below:

As with all listing commands in GEOSTAR, the information from MPLIST (Edit 
> LIST > Material Props) command can be routed to an ascii file using the com-
mand LISTLOG (Control > MISCELLANEOUS > List Log).

  Label    Name   Temp/BH_Cr         Value

    1        EX            0      1.550000e+07

    1      NUXY            0      3.300000e-01

    1       GXY            0      5.800000e+06

    1      ALPX            0      1.100000e-05

    1      DENS            0      7.893000e-04

    1         C            0      3.477600e+01

    1        KX            0      5.370000e-03

A   2        EX            0      1.550000e+07

A   2      NUXY            0      3.300000e-01

A   2       GXY            0      5.800000e+06

A   2      ALPX            0      1.100000e-05

A   2      DENS            0      7.893000e-04

A   2         C            0      3.477600e+01

A   2        KX            0      5.370000e-03
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Sectional and Other Physical Properties

In COSMOS/M, the sectional properties of elements and related physical proper-
ties not covered under the MPROP (Propsets > Material Property) command are 
called real constants and are defined using the RCONST (Propsets > Real Con-
stant) command. The term real constant refers to various sectional properties 
such as area, width and depth or thickness of the cross section, perimeter, 
moment of inertia, radius of curvature, internal hinges, material angles for ortho-
tropic materials, temperature gradients, spring constants, layer information for 
laminated composites, and many other physical properties (see Table 6-11 for a 
list of real constants for all elements in the Basic FEA System) that are necessary 
to compute the element stiffness matrices. The term has nothing to do with the 
nature of the numeric data you input, whether real or integer. Since the sectional 
and related physical constants depend on the type of element you are using, the 
element group information must be defined prior to real constants definition. The 
RCONST (Propsets > Real Constant) command defines a real constant set num-
ber, associates this with the an element group number, and then prompts you for 
the required real constants for the specified element type. The prompts for the 
RCONST (Propsets > Real Constant) command therefore depend on the type of 
element you are using, and they usually provide sufficient physical interpretation 
so that you can enter the required input with minimal difficulty. The use of 
RCONST (Propsets > Real Constant) command requires you to provide the ele-
ment group number associated with the real constant set, and the real constant set 
number. The argument on starting location of the first constant is fully explained 
in the next section.

✍ The maximum number of real constant sets permitted in a model is 5000.

As shown in Table 6-11, the number of real constants to be input varies from a 
small number such as 1 (for a rigid bar element) to as high as 78 (for a general 
stiffness element). However, the maximum number of real constants you can 
input using RCONST (Propsets > Real Constant) in one attempt is 10. If you 
need to input more constants, you need to re-execute the RCONST (Propsets > 
Real Constant) command, and input the remaining constants. In this case, the 
program will automatically prompt you with a starting location of 11 and 
onwards. If you make a mistake in entering the section constants, you do not need 
to redefine all of the section constants. You can move to a specific location (using 
the starting location concept, explained in the next section) of the real constants 
and input only the erroneous values. The program will also warn you if you input 
fewer than the required number of constants.
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Similar to the material library feature, COSMOS/M also provides built-in section 
libraries for standard cross sections. The command PICK_SEC (Propsets > AISC 
Sect Table) selects standard steel sections and the associated section properties 
from AISC (American Institute of Steel Construction) tables while the command 
BMSECDEF (Propsets > Beam Section) will allow you to select standard as well 
as user-defined sections from the COSMOS/M section library. When you use 
these commands, you will also be assigning a real constant set number, but the 
section properties are internally computed by the program. The command 
BMSECLIST (Edit > LIST > Beam Section) can be used to list the section 
selected from the COSMOS/M section library.

The command RCDEL (Edit > DELETE > Real Constants) deletes the section 
property set number and the associated properties defined using RCONST 
(Propsets > Real Constant), PICK_SEC (Propsets > AISC Sect Table), or 
BMSECDEF (Propsets > Beam Section) commands. The command RCLIST (Edit 
> LIST > Real Constants) can be used to list the section properties defined on the 
screen. For more information on the modification of section property definitions, 
please refer to the section, Modification, Display, and Output of Section Property 
Definitions. 

To illustrate the input of section properties using the RCONST (Propsets > Real 
Constant) command, consider an example using a 3-node composite shell ele-
ment (SHELL3L) with four layers (defined using EGROUP (Propsets > Element 
Group) command). In COSMOS/M, the layer data such as thickness and orienta-
tion of material principal axes are entered as real constants. For each layer, you 
will be prompted for the layer thickness, material set number, and material angle. 
Referring to Table 6-11, for four layers, there will be 14 section constants 
required to be input. As mentioned before, the RCONST (Propsets > Real 
Constant) command accepts a maximum of 10 input data in each execution, and 
you therefore need to re-execute this command to input data for the remaining 
layers as illustrated below:

Geo Panel:   Propsets > Real Constant
Associated Element group > 1
Real Constant set > 1

Start location of the real constants > 1
No. of real constants to be entered > 10
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RC1 : Dist. from ref. plane to top surface > 0.5
RC2 : Temperature gradient > 0
RC3 : Thickness of layer 1 > 0.25
RC4 : Material number for layer 1 > 1
RC5 : Material angle for layer 1 > 0
RC6 : Thickness of layer 2 > 0.25
RC7 : Material number for layer 2 > 1
RC8 : Material angle for layer 2 > 30
RC9 : Thickness of layer 3 > 0.25
RC10 : Material number for layer 3 > 1

Re-execute the RCONST (Propsets > Real Constant) command for the remaining 
data, as shown below:

Geo Panel:   Propsets > Real Constant
Associated Element group > 1
Real Constant set > 1

Start location of the real constants > 11
No. of real constants to be entered > 4

RC11 : Material angle for layer 3 > 60
RC12 : Thickness of layer 4 > 0.25
RC13 : Material number for layer 4 > 1
RC14 : Material angle for layer 4 > 90

Note that in order to continue entering the section constants, you need to specify 
the same real constant set number.

Table 6-11 in the following pages outlines the section constant information 
required for all elements in the Basic FEA System. The concept of starting loca-
tions is explained more clearly by means of an example in the next section, fol-
lowed by detailed descriptions of real constant data for all elements in the Basic 
FEA System. The descriptions are presented separately for 1D elements (includ-
ing truss and beam), 2D continuum elements, and 3D solid elements. The real 
constant data for rigid bar, gap, spring, mass, boundary and general stiffness ele-
ments is presented separately under special elements category.
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Table  6-11. Section Constants for All Elements in the Basic FEA System

COSMOS/M
Element Name

Section Property Constants Required

Number RC Description

TRUSS2D 2 RC1
RC2

Cross sectional area
Cross sectional perimeter (for thermal analysis only)

TRUSS3D 2 RC1
RC2

Cross sectional area
Cross sectional perimeter (for thermal analysis only)

BEAM2D 8

RC1
RC2
RC3
RC4
RC5
RC6
RC7
RC8

Cross sectional area
Moment of inertia
Depth (diameter for circular cross section)
End release code at node 1
End release code at node 2
Shear factor in the element y-axis
Temperature difference in the element y-axis
Perimeter (for thermal analysis only)

BEAM3D 14 to 27

RC1
RC2
…
…

Cross sectional area
Moment of inertia
… … …
Temperature difference in the element y-axis
Perimeter (for thermal analysis only)
… … …
(Refer to the elements chapter in the COSMOS/M User 
Guide - Volume 1, for more information)

RBAR 1 RC1 Axial stiffness

SPRING 2 RC1
RC2

Axial stiffness
Rotational stiffness

PIPE 3
RC1
RC2
RC3

Outer diameter
Wall thickness
Internal pressure

ELBOW 4

RC1
RC2
RC3
RC4

Outer diameter
Wall thickness
Internal pressure
Radius of curvature

GAP 2 RC1
RC2

Allowable relative displacement between two nodes
Coefficient of friction

MASS 7

RC1
RC2
RC3
RC4
RC5
RC6
RC7

Mass in x-direction
Mass in y-direction
Mass in z-direction
Rotary inertia about x-axis
Rotary inertia about y-axis
Rotary inertia about z-axis
Thermal capacity (in units of heat energy)
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Table  6-11. Section Constants for All Elements in the Basic FEA System (Continued)

COSMOS/M
Element Name

Section Property Constants Required

Number RC Description

BOUND 2 RC1
RC2

Axial stiffness
Rotational stiffness

PLANE2D 4-NODE 2 RC1
RC2

Thickness (for plane stress problems only)
Material angle

PLANE2D 8-NODE 2 RC1
RC2

Thickness (for plane stress problems only)
Material angle

PLANE2D 4-NODE 
(Axisymmetric) 1 RC2 Material angle

PLANE2D 8-NODE 
(Axisymmetric) 1 RC2 Material angle

TRIANG 3-NODE 2 RC1
RC2

Thickness (for plane stress problems only)
Material angle

TRIANG 6-NODE 2 RC1
RC2

Thickness (for plane stress problems only)
Material angle

TRIANG 9-NODE 2 RC1
RC2

Thickness (for plane stress problems only)
Material angle

TRIANG 3-NODE 
(Axisymmetric) 1 RC2 Material angle

TRIANG 6-NODE 
(Axisymmetric) 1 RC2 Material angle

TRIANG 9-NODE 
(Axisymmetric) 1 RC2 Material angle

SHELL3 3
RC1
RC2
RC3

Thickness
Temperature gradient
Foundation stiffness

SHELL4 3
RC1
RC2
RC3

Thickness
Temperature gradient
Foundation stiffness

SHELL3T 3
RC1
RC2
RC3

Thickness
Temperature gradient
Foundation stiffness

SHELL4T 3
RC1
RC2
RC3

Thickness
Temperature gradient
Foundation stiffness

SHELL3L 2+3NL RC1
RCxx

The number of real constants to be entered depends 
on the number of layers (NL). Refer to the elements 
chapter in the COSMOS/M User Guide - Volume 1, for 
more information.
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Table  6-11. Section Constants for All Elements in the Basic FEA System 
(Concluded)

The Concept of Starting Locations for Real Constants

When you are entering the input for different section properties under the 
RCONST (Propsets > Real Constant) command, you will also be prompted for 
the starting location of the real constants. If you are defining the section proper-
ties for the first time, you need to start from the first location. However, if you 
make a mistake in entering the section properties, you do not need to start from 
the beginning for that real constant set. You can move to the specific location of 
the real constant that needs to be modified by using the starting 

COSMOS/M
Element Name

Section Property Constants Required

Number RC Description

SHELL4L 2+3NL RC1
RCxx Same as above

SHELL6 2 RC1
RC2

Thickness
Temperature gradient

SHELL9 1 RC1 Thickness

SHELL9L 2+3NL RC1
RCxx

The number of real constants to be entered depends 
on the number of layers (NL). Refer to the elements 
chapter in the COSMOS/M User Guide - Volume 1, for 
more information.

SHELLAX 1 RC1 Shell thickness

TETRA4 9 RC1-9 X,Y,Z coordinates of three points (for orthotropic 
materials only)

TETRA4R 9 RC1-9 X,Y,Z coordinates of three points (for orthotropic 
materials only)

TETRA10 9 RC1-9 X,Y,Z coordinates of three points (for orthotropic 
materials only)

SOLID 9 RC1-9 X,Y,Z coordinates of three points (for orthotropic 
materials only)

SOLIDL 2+6NL RC1
RCxx

The number of real constants to be entered depends 
on the number of layers (NL). Refer to the elements 
chapter in the COSMOS/M User Guide - Volume 1, for 
more information.

SOLIDPZ 9 RC1-9 X,Y,Z coordinates of three points (for orthotropic 
materials only)

GENSTIF 78 RC1-78 The real constants are the numeric stiffness 
coefficients.
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location option. This feature lets you modify or redefine selected values of the 
section properties without altering the remaining already input. For elements with 
many real constants, this feature is particularly helpful. Consider for example, a 
problem using BEAM2D element (which requires 8 real constants) as shown in 
the figure below:

Figure 6-7. Problem for Illustrating the Starting Locations of Real Constants

The section constants for the above BEAM2D element are defined as follows:

Geo Panel:   Propsets > Real Constant
Associated Element group > 1
Real Constant set > 1

Start location of the real constants > 1
No. of real constants to be entered > 8

RC1 : Cross-sectional area > 0.785
RC2 : Moment of inertia (Iz) > 0.0491
RC3 : Depth [0] > 1
RC4 : End-release code (node 1) > 0
RC5 : End-release code (node 2) > 0
RC6 : Shear factor in elem. y-axis > 0.9
RC7 : Temp. diff. in elem. y-axis > 0
RC8 : Perimeter (HSTAR only) > 3.1416

The values input above will be stored in the proper locations of real constants as 
shown below:

RC1 RC2 RC3 RC4 RC5 RC6 RC7 RC8

0.785 0.0491 1 0 0 0 0 3.1416

Y

Z

1

Cross Section
Problem Geometry and 
Finite Element Model

Y

X

1

1 2
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Assume that you are now required to specify a temperature difference of 10 
degrees between the top and bottom edges of the beam (along the element 
y-axis). As you can see from the above illustration for BEAM2D element, the 
temperature difference is stored in location RC7. Therefore you need to change 
only the real constant value stored under RC7 for this set. The procedure to 
accomplish this is illustrated below:

Geo Panel:   Propsets > Real Constant
Associated Element group > 1
Real Constant set [2] > 1

Start location of the real constants [9] > 7
No. of real constants to be entered [2] > 1

RC7 : Temp. diff. in elem. y-axis [0] > 10

The above procedure will ensure that you are only altering the value stored under 
RC7, and the remaining real constants will be unaltered as shown below (shaded 
cells indicate constants defined earlier):

If you execute the RCLIST (Edit > LIST > Real Constants) command, the values 
shown above will be listed on the screen.

Explanation of Some Section Properties

For a detailed description of all real constants for any element type, refer to Chapter 
4, Element Library, of COSMOS/M User Guide Volume 1. The following sections 
present further explanations on some of the section properties of elements in the 
Basic FEA System. In order to facilitate a clear presentation, the elements have 
been grouped as shown in the table below and their real constants are explained in 
the corresponding sections.

Element Name See Section…
TRUSS2D, TRUSS3D, BEAM2D, Section Properties for 1D
BEAM3D, PIPE, & ELBOW Elements

RC1 RC2 RC3 RC4 RC5 RC6 RC7 RC8

0.785 0.0491 1 0 0 0 10 3.1416
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PLANE2D, SHELL3, SHELL4, SHELL3T, Section Properties for 2D
SHELL4T, SHELL3L, SHELL4L, SHELL9, Continuum and Axisymmetric
SHELL9L, SHELLAX, & TRIANG Elements

SOLID, SOLIDL, SOLIDPZ, Section Properties for 3D
TETRA4, TETRA4R & TETRA10 Solid Elements

BOUND, GAP, GENSTIF, MASS, Section Properties for Special
RBAR, & SPRING Elements

Section Properties for 1D Elements

The section properties discussed under 1D element category include TRUSS2D, 
TRUSS3D, BEAM2D, BEAM3D, PIPE, and ELBOW elements.

There are only two section properties for TRUSS2D and TRUSS3D elements 
which include the cross sectional area (RC1) and the perimeter (RC2). However, 
as shown in Table 6-11, the section constants for beam elements can be quite 
complex, and they include end release codes, shear factors, and other input infor-
mation which warrant further explanation. The following sections discuss some 
of the real constant information for beam elements to help you in better under-
standing of the element property input. 

The shear factors (otherwise known as reduced area factors) for beam elements 
are used in computing the shear deflections and they are input as real constants 
for both BEAM2D and BEAM3D. These factors are 0.8333 for a solid rectangu-
lar section, 0.9 for a solid circular section, and 0.5 for a hollow circular section.

If you are using unsymmetric beam cross sections (supported for BEAM3D 
only), there are 27 real constants required. The node of a 3D beam element need 
not be located at the centroid of the cross section, and you can use real constants 
15 through 27 for specifying the offset distances. Please refer to Chapter 4 of the 
COSMOS/M User Guide (V. 1).

The section constants for pipe elements in COSMOS/M (PIPE and ELBOW) 
include the outer diameter, wall thickness, and the radius of curvature. The inter-
nal pressure loading is treated as a section property so that for parts of the finite 
element model with different cross sectional dimensions, you can input 
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different values of pressure if necessary. Additionally, the inclusion of internal 
pressure as a real constant facilitates the application of external distributed loads 
on the curved pipe elements.

End-Release Codes for Beam Elements

For BEAM2D and BEAM3D elements, two of the real constant data includes the 
end release codes at nodes 1 and 2. These codes are provided to model internal 
hinges and rollers which are not necessarily located at supports. Support condi-
tions can be modeled using the boundary conditions commands (see Chapter 7, 
Loads and Boundary Conditions).

Figure 6-8. Degrees of Freedom for End Release Codes

As shown in the figure above, for a 3D beam element, there are six degrees of 
freedom at each node. The translational components (1 to 3, denoted by single 
arrows) occupy the first three locations of the end release code where as the rota-
tional components (4 to 6, denoted by double arrows) occupy the last three loca-
tions. The end release codes are therefore six digit integers with combinations of 
zeros and ones. If you do not have any internal hinges or rollers, then the input for 
end release codes is zero (default). If a value of one is placed in a location, then 
the force or moment in that direction is assumed to be zero. For example, in order 
to model a roller along the z-axis, you need to input an end release code of 001. 
The trailing zeros can be omitted since they are the default values. Table 6-12 
presents a summary of the different end release codes and the corresponding 
hinge/roller conditions represented by them.

X

Y

Z

1

2

3 4

5

6

DOFs for End Release Codes in Beam Elements
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Table  6-12. End Release Codes for Beam Elements

Note that for the BEAM2D element, since there are only three degrees of free-
dom at each node (ux, uy and θz), the end release codes at locations 3, 4, and 5 are 
always assumed to be zero irrespective of your input.

Torsional and Maximum Shear Stress Constants for Beam Elements

For BEAM3D element, one of the section constants input is the constant for 
maximum shear stress computations. This quantity designated as CTOR is input 
under RC14 for uniform symmetric sections, and under RC20 for symmetric 
tapered sections. The maximum shear stress is computed in terms of CTOR, tor-
sion constant J, and the applied twisting moment T as shown below:

 (6-29)

Table 6-13 lists the constants J and CTOR for some standard cross sections.

✍ If you are using the command BMSECDEF (Propsets > Beam Section) to 
select standard sections for BEAM3D elements from the COSMOS/M section 
library, then CTOR is internally computed by the program.

DOF End Release Code Description

ALL 000000 All components of forces are computed (default)

UX 100000 Force along the x-direction is zero (roller along x-axis)

UY 010000 Force along the y-direction is zero (roller along y-axis)

UZ 001000 Force along the z-direction is zero (roller along z-axis)

RX 000100 Moment along the x-direction is zero (hinge in y-z plane)

RY 000010 Moment along the y-direction is zero (hinge in x-z plane)

RZ 000001 Moment along the z-direction is zero (hinge in x-y plane)
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Table  6-13. Torsional and Maximum Shear Stress Constants
 for Standard Cross Sections 

Solid Circular Section Hollow Concentric
Circular Section

Solid Triangular
Section (Equilateral)

Hollow Eccentric Circular Section Solid Square Section

Solid Rectangular Section Hollow Rectangular Section

Hollow Elliptical Section Solid Elliptical Section

2 r
 r

 r
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Table  6-13. Torsional and Maximum Shear Stress Constants 
for Standard Cross Sections (Concluded)

Hollow Thin Elliptical Section Any Thin Tube Section 
(Uniform Thickness)

Thin Circular Open 
Tube Section

Any Thin Open Tube Section 
(Uniform Thickness)

Any Thin Open Tube Section 
(Variable Thickness)

Solid Hexagonal Section Thin Walled Open Sections (Constant Thickness)

2a

2b
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t
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Section Properties for 2D Continuum and 
Axisymmetric Elements

The section properties discussed under 2D continuum and axisymmetric element 
category include PLANE2D, SHELL3, SHELL4, SHELL3T, SHELL4T, 
SHELL3L, SHELL4L, SHELL9, SHELL9L, SHELLAX, and TRIANG elements.

As seen in Table 6-11, for all 2D continuum elements (with the exception of com-
posite shells), the first real constant (RC1) is the thickness. For PLANE2D and 
TRIANG (plane and axisymmetric) elements, the second real constant (RC2) is 
the material angle, required only if you are using the orthotropic material descrip-
tion. Whereas for all shell elements (except composites), the second real constant 
(RC2) represents the temperature gradient across the thickness. For SHELL3, 
SHELL4, SHELL3T and SHELL4T, the third real constant (RC3) represents the 
Foundation Stiffness. For a non-zero value for this real constant, the program 
attaches a spring at each node, applying a stiffness in the out-of plane direction. 
For more information on this constant refer to SHELL4 in Chapter 4, Element 
Library, of the COSMOS/M User Guide (Volume 1).

The procedure for defining real constants for most 2D continuum and axisymmet-
ric element is quite simple. However, for laminated composite shell elements 
(SHELL3L, SHELL4L, and SHELL4L), the thickness of each layer, material 
group number, and the orientation of material principal directions are specified 
depending on the number of layers. Please refer to the section, Material Proper-
ties for Laminated Composites, for more information on defining real constants 
for each layer. That section also illustrates how you can rotate the orthotropic 
material axes with respect to the element local coordinate system or orient them 
with respect to the global Cartesian coordinate system.

✍ The thickness of each layer is uniform in composite shell elements. If you 
need to model variable thickness in each layer, you are recommended to use 
the composite solid element, SOLIDL.

Section Properties for 3D Solid Elements

The section properties discussed under 3D solid elements category include 
SOLID, SOLIDL, SOLIDPZ, TETRA4, TETRA4R, and TETRA10 elements.
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If the material property is isotropic, then the sectional properties are not required 
to be input for all 3D solid elements. The only exception is the laminated compos-
ite solid element, SOLIDL. For this element, the thickness of each layer and the 
associated material property information (whether isotropic or orthotropic) are 
defined as real constants.

Consider an example using SOLIDL elements with three layers. It is assumed 
that all three layers have different material properties defined using the MPROP 
(Propsets > Material Property) command. Before proceeding to input the real 
constants, you need to first define the element group where you also specify the 
number of layers, as illustrated below:

Geo Panel:   Propsets > Element Group
Element Group > 1
Element Name > SOLIDL: Composite 8-node solid element

OP1 : Integr Type:1=Hybrid;2=Full > Full
OP2 : Number of Layers > 3
OP3 : Stress Dir:0=Global;2=Mat > Global

Referring to Table 6-11, the number of real constants to be entered for a SOLIDL 
element with three layers is 20. The real constants for individual layers are 
defined as illustrated below:

Geo Panel:   Propsets > Real Constant
Associated Element group > 1
Real Constant set > 1

Start location of the real constants > 1
No. of real constants to be entered > 10

RC1 : Thickness flag (0:thickness,1:ratio) > Thickness
RC2 : Symmetric flag (0:all,1:sym,2:antisym) > All
RC3 : Material number for layer 1 > 1
RC4 : Material angle for layer 1 > 0
RC5 : Thickness (ratio) of layer 1 along 1-5 > 0.2
RC6 : Thickness (ratio) of layer 1 along 2-6 > 0.25
RC7 : Thickness (ratio) of layer 1 along 3-7 > 0.3
RC8 : Thickness (ratio) of layer 1 along 4-8 > 0.35
RC9 : Material number for layer 2 > 2
RC10 : Material angle for layer 2 > 0
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You need to repeat the RCONST (Propsets > Real Constant) command, specify 
the same real constant set number, and input the remaining constants from start-
ing 

location 11. Since the SOLIDL element allows for the input of variable thickness 
in each layer, the input options are slightly different from those for composite 
shell elements.

If you are using solid elements with orthotropic material description, then the ori-
entation of the orthotropic material axes need to be defined as real constants. The 
9 real constants to be defined in this case the x-, y-, and z-coordinates of three 
points. Note that orthotropic material axes can be oriented only with respect to 
the default element coordinate system (ECS =-1). Please refer to Chapter 4, Ele-
ment Library, of the COSMOS/M User Guide (Volume 1).

Section Properties for Special Elements

The section properties discussed under the special elements category include 
BOUND, GAP, GENSTIF, MASS, RBAR, and SPRING elements. These 
elements are termed special in the sense that for most frequently used finite 
element analyses, they are sparingly used.

The section properties discussed so far for one-, two-, and three-dimensional 
elements are mainly geometric in nature. However, as remarked earlier, the 
RCONST (Propsets > Real Constant) command is also used to define some phys-
ical properties of special elements in COSMOS/M. They include properties such 
as mass, stiffness coefficients, and frictional constants described in the following 
sections.

Mass Element

The mass element (MASS) in COSMOS/M represents a concentrated mass that 
can be defined at a node and it uses the lumped mass representation. However, 
unlike lumped masses which normally do not have rotary inertia, you can define 
rotary inertia in all three directions for the mass element. The real constants of a 
mass element therefore represent the diagonal terms of the lumped mass matrix. 
Additionally, a seventh real constant is provided to define thermal capacity for 
use in heat transfer analysis.
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Before defining the real constants for a mass element, you need to first define the 
element (EGROUP (Propsets > Element Group)) as illustrated below:

Geo Panel:   Propsets > Element Group
Element Group > 1
Element Name > MASS: General mass element

OP1 : Unused option > 

Next, use the RCONST (Propsets > Real Constant) command to define the com-
ponents of mass and rotary inertia as illustrated below:

Geo Panel:   Propsets > Real Constant
Associated Element group > 1
Real Constant set > 1

Start location of the real constants [1] > 1
No. of real constants to be entered [7] > 7

RC1 : Mass in x-direction > 1
RC2 : Mass in y-direction > 1
RC3 : Mass in z-direction > 1
RC4 : Rotary inertia about x-axis > 2
RC5 : Rotary inertia about y-axis > 2
RC6 : Rotary inertia about z-axis > 2
RC7 : Thermal capacity [0] >

Rigid Bar Element

The 2-node rigid bar element (RBAR) can be used to model infinitely rigid mem-
bers in a finite element model. The element is used to transmit rigid body transla-
tions and rotations between two nodes. This element is defined as follows using 
the EGROUP (Propsets > Element Group) command.

Geo Panel:   Propsets > Element Group
Element Group > 1
Element Name > RBAR: Rigid bar element

OP1 : Unused option > 

The real constant information for the rigid bar element consists of the bar stiff-
ness, normally set to a high value as shown below:
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Geo Panel:   Propsets > Real Constant
Associated Element group > 1
Real Constant set > 1

Start location of the real constants > 1
No. of real constants to be entered > 1

RC1 : Rigid bar stiffness [1e+10] > 2E15

Boundary Element

The boundary element (BOUND) is a 2-node element (third node is required for 
the element orientation) with one of the nodes fixed while the other has two 
degrees of freedom, a translation and a rotation. The real constants for this ele-
ment therefore consist of the axial and rotational stiffnesses. This element is 
defined as shown below using the EGROUP (Propsets > Element Group) com-
mand.

Geo Panel:   Propsets > Element Group
Element Group > 1
Element Name > BOUND: Boundary Element

OP1 : Bound. Type:0=Axial;1=Rot;2=Axial & Rot [0] > 2

The corresponding real constants are defined as illustrated below using the 
RCONST (Propsets > Real Constant) command.

Geo Panel:   Propsets > Real Constant
Associated Element group > 1
Real Constant set > 1

Start location of the real constants > 1
No. of real constants to be entered > 2

RC1 : Axial stiffness > 1.5E6
RC2 : Rotational stiffness > 2E5

Spring Element

The spring element (SPRING) can be used to model translational and/or rota-
tional actions in one-, two-, and three-dimensional applications. The real con-
stants for this element consist of axial and torsional stiffnesses. This element is 
defined as shown below using the EGROUP (Propsets > Element Group) 
command.
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Geo Panel:   Propsets > Element Group
Element Group > 1
Element Name > SPRING: Spring element

OP1 : Spring Type:0=Axial;1=Rot;2=Both > 2
OP2 : Number of nodes:1=1-Node;2=2-Node > 2-Node

The associated real constants for this element are defined as illustrated below 
using the RCONST (Propsets > Real Constant) command.

Geo Panel:   Propsets > Real Constant
Associated Element group > 1
Real Constant set > 1

Start location of the real constants > 1
No. of real constants to be entered > 2

RC1 : Axial stiffness > 1.5E6
RC2 : Rotational stiffness > 2.E5

You can notice from the above that the real constant input for the boundary ele-
ment is the same as that of the spring element.

Gap Element

The gap element in the Basic FEA System (GAP) is a node-to-node interface ele-
ment capable of modeling contact problems with or without friction and sliding. 
The gap element is defined as illustrated below using the EGROUP (Propsets > 
Element Group) command.

Geo Panel:   Propsets > Element Group
Element Group > 1
Element Name > GAP: Gap element

OP1 : Surface coord. update:0=No;1=Yes [0] > No
OP2 : Friction:0=No;1=Yes;2=Yes & Slide [0] > Yes & Slide
OP3 : Frict. outside X-Y plane:0=No;1=Yes [0] > No
OP4 : Gap Type:0=N-N;1=N-L;2=N-S [0] > N-N
OP5 : Unused option > 
OP6 : Compressive gap measurement:0=User;1=Auto [0] > User

The last flag enables the user to avoid inputting the distance that the two nodes of 
each compressive gap have to move towards each other before resistance starts. 
Manual input is used in this example.
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The real constants for the gap elements are defined as illustrated below:

Geo Panel:   Propsets > Real Constant
Associated Element group > 1
Real Constant set > 1

Start location of the real constants [1] > 1
No. of real constants to be entered [7] > 7

RC1 : Relative displ. between 2 nodes [0] > 0.1
RC2 : Coefficient of friction [0] > 0.5
RC3 : Gap stiffness 0=No Spring k=Stiffness [0] > 1.5E4
RC4 : Spring pre-load [0] > 1000
RC5 : Maximum spring deflection [1e+08] > 10000000
RC6 : Damping constant (c) [0] > 0
RC7 : Damping constant (p) [1] > 1

Refer to Chapter 4, Element Library, of the COSMOS/M User Guide (Volume 1) 
for more information on the gap element.

General Stiffness Element

The general stiffness element in COSMOS/M is a 2-node three dimensional ele-
ment whose stiffness coefficients need to be supplied by the user for structural 
models. The real constants (a total of 78) for the GENSTIF element are the stiff-
ness coefficients stored as shown in the matrix below:

The above matrix also shows the corresponding real constant numbers (in paren-
theses) of the stiffness components. Before using the RCONST (Propsets > Real 
Constant) command, make sure that the GENSTIF element has been defined 
using the EGROUP (Propsets > Element Group) command. When entering the 
real constants, accept the number of real constants to be entered as 

k1,1(r1) k1,2(r2) k1,3(r3) k1,4(r4) k1,5(r5) k1,6(r6) k1,7(r7) k1,8(r8) k1,9(r9) k1,10(r10) k1,11(r11) k1,12(r12)
k2,2(r13) k2,3(r14) k2,4(r15) k2,5(r16) k2,6(r17) k2,7(r18) k2,8(r19) k2,9(r20) k2,10(r21) k2,11(r22) k2,12(r23)

k3,3(r24) k3,4(r25) k3,5(r26) k3,6(r27) k3,7(r28) k3,8(r29) k3,9(r30) k3,10(r31) k3,11(r32) k3,12(r33)
k4,4(r34) k4,5(r35) k4,6(r36) k4,7(r37) k4,8(r38) k4,9(r39) k4,10(r40) k4,11(r41) k4,12(r42)

k5,5(r43) k5,6(r44) k5,7(r45) k5,8(r46) k5,9(r47) k5,10(r48) k5,11(r49) k5,12(r50)
k6,6(r51) k6,7(r52) k6,8(r53) k6,9(r54) k6,10(r55) k6,11(r56) k6,12(r57)

k7,7(r58) k7,8(r59) k7,9(r60) k7,10(r61) k7,11(r62) k7,12(r63)
k8,8(r64) k8,9(r65) k8,10(r66) k8,11(r67) k8,12(r68)

k9,9(r69) k9,10(r70) k9,11(r71) k9,12(r72)
k10,10(r73) k10,11(r74) k10,12(r75)

k11,11(r76) k11,12(r77)
k12,12(r78)
COSMOS/M Basic FEA System

http://www.cosmosm.com


Part 1   Linear Statics, Modal, and Buckling Analysis
10, as illustrated below. The program will automatically remind you that you 
need 68 more constants to completely describe the GENSTIF element.

Geo Panel:   Propsets > Real Constant
Associated Element group > 1
Real Constant set > 1

Start location of the real constants > 1
No. of real constants to be entered > 10

RC1 : K 1,1 stiffness term > 2.0E10
RC2 : K 1,2 stiffness term > 2.5E8
RC3 : K 1,3 stiffness term > 1.5E10
RC4 : K 1,4 stiffness term > 2.8E4
RC5 : K 1,5 stiffness term > 4E10
RC6 : K 1,6 stiffness term > 3E12
RC7 : K 1,7 stiffness term > 5E10
RC8 : K 1,8 stiffness term > 6E8
RC9 : K 1,9 stiffness term > 7E6
RC10 : K 1,10 stiffness term > 6E10
RC set 2 may need 68 more constants

To define the remaining constants, re-execute the RCONST (Propsets > Real 
Constant) command, specify the same set number and continue from starting loca-
tion of 11 onwards.

Section Library

Similar to the material library feature, there are two different built-in section 
libraries in COSMOS/M for use with beam elements, BEAM2D and BEAM3D. 
These include the AISC (American Institute of Steel Construction, 9th Edition, 
1991) sections for standard shapes, and the COSMOS/M sections for standard 
as well as non-standard (user-defined) shapes. The commands BMSECDEF 
(Propsets > Beam Section) and PICK_SEC (Propsets > AISC Sect Table) are 
used to select the sections and their properties from the COSMOS/M and AISC 
built-in section libraries respectively. When you use these commands, you do not 
need to use the RCONST (Propsets > Real Constant) command for defining the 
real constants. The following sections provide more information on the different 
cross sections and the procedure to use these sections.
COSMOS/M Basic FEA System 6-79

http://www.cosmosm.com


Chapter 6   Material, Sectional and Other Physical Properties

6-80
✍ The COSMOS/M section library can be used with both BEAM2D and 
BEAM3D elements where as the AISC section library is applicable to 
BEAM3D element only.

Using the Built-In COSMOS/M Section Library

In order to use the built-in COSMOS/M section library, you must first define the 
required beam element and choose the appropriate option, i.e., whether symmet-
ric, unsymmetric, or tapered symmetric cross section. You can then use the 
BMSECDEF (Propsets > Beam Section) command illustrated below to select the 
section type and the cross sectional dimensions. For this command, you need to 
provide the associated element group number, the real constant set number, and 
the shape of the cross-section (described in the table below). The BMSECDEF 
(Propsets > Beam Section) command is used in lieu of RCONST (Propsets > 
Real Constant), and as such it also defines the end release codes and other real 
constant data for beam elements. Table 6-15 in the following page shows the 
shapes of cross sections and their identification parameters.

Table  6-14. Available Cross Sections in the COSMOS/M Section Library

Section 
Number Description Elements 

Supported Remarks

1 Solid rectangular section BEAM2D, 
BEAM3D All symmetry options are valid for BEAM3D

2 Solid circular section BEAM2D, 
BEAM3D All symmetry options are valid for BEAM3D

3 Hollow circular section BEAM2D, 
BEAM3D All symmetry options are valid for BEAM3D

4 Hollow rectangular 
section

BEAM2D, 
BEAM3D All symmetry options are valid for BEAM3D

5 Symmetric I-section BEAM2D, 
BEAM3D All symmetry options are valid for BEAM3D

6 Solid trapezoidal section BEAM3D BEAM3D must be unsymmetric

7 Channel section BEAM3D BEAM3D must be unsymmetric

8 Z-section BEAM3D BEAM3D must be unsymmetric

9 T-section BEAM3D BEAM3D must be unsymmetric

10 L-section BEAM3D BEAM3D must be unsymmetric

0 User-defined section BEAM3D BEAM3D must be unsymmetric
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Table  6-15. Identification Parameters of the Built-In COSMOS/M Section Library
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As seen in Table 6-14, the first five sections are symmetric and are applicable to 
both BEAM2D and BEAM3D elements. Sections 6 through 10 and 0 are applica-
ble to BEAM3D elements only. Further, some of these sections have restrictions 
placed on the proportions of cross sectional dimensions. The trapezoidal section 
for example (section number 6) has a restriction that the depth should be greater 
than the width at bottom which in turn should be greater than the top width. You 
need to keep this restriction in mind when using a trapezoidal section.

When you use the BMSECDEF (Propsets > Beam Section) command for 
BEAM3D elements, the torsional and maximum shear stress constants shown in 
Table 6-13 are automatically computed by the program and your input is not 
required. Since the beam sections are associated with a real constant set, you need 
to use the RCDEL (Edit > DELETE > Real Constants) command to delete a 
beam section selected. 

The following illustration demonstrates the selection of a hollow circular section 
(number 3 from Table 6-14) for the BEAM2D element. In order to use this sec-
tion, you must define the element group: Next, the BMSECDEF (Propsets > Beam 
Section) command is used to select this cross section as illustrated below.

Geo Panel:   Propsets > Beam Section
Associated Element group > 1
Real Constant set > 1

Section number [1] > 3

Start location of the section parameters > 1

No. of beam section constants to be entered > 7

BS1 : Outside diameter (D) > 1
BS2 : Thickness (T) > 0.1
BS3 : End-release code (node 1) > 0
BS4 : End-release code (node 2) > 0
BS5 : Shear factor in elem. y-axis > 0
BS6 : Temp. diff. in elem. y-axis > 0
BS7 : Perimeter (HSTAR only) > 0

Note that if you need to model any internal hinge or roller, you need to specify 
the appropriate input under the BMSECDEF (Propsets > Beam Section) com-
mand itself. The command BMSECLIST (Edit > LIST > Beam Section) can be 
used to list the section you selected as well as other real constant data input. The 
listing obtained on the screen will be of the form:
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To see the computed cross sectional data such as area and moment of inertia, you 
need to use RCLIST (Edit > LIST > Real Constants) command as before. The 
cross sectional properties computed will be listed along with other real constants 
for the element as shown below:

The procedure for using symmetric tapered and unsymmetric beam sections 
(6 through 10 and 0) is similar. Since these types of sections are applicable to 
BEAM3D elements only, you need to define this element first and specify the 
appropriate section type, before using the BMSECDEF (Propsets > Beam Sec-
tion) command.

                         Real Constant Sets

Real Constant Set :   1  (ACTIVE)

Associated Element Group :   1  ( BEAM2D  -  Symmetric  Pipe )

Center of Gravity : ( cgy = 0.000000e+00    cgz = 0.000000e+00 )

  Bs1 : Outside diameter (D) .  .  .  .  .  .  .  . =   1.000000e+00

  Bs2 : Thickness  (T) .  .  .  .  .  .  .  .  .  . =   1.000000e-01

  Bs3 : End-release code (node 1)  .  .  .  .  .  . =              0

  Bs4 : End-release code (node 2)  .  .  .  .  .  . =              0

  Bs5 : Shear factor in elem. y-axis  .  .  .  .  . =   0.000000e+00

  Bs6 : Temp. diff. in elem. y-axis   .  .  .  .  . =   0.000000e+00

  Bs7 : Perimeter (HSTAR only)  .  .  .  .  .  .  . =   0.000000e+00

                         Real Constant Sets

Real Constant Set :   1  (ACTIVE)

Associated Element Group :   1  ( BEAM2D )

  Rc1 : Cross-sectional area .  .  .  .  .  .  .  . =   2.827433e-01

  Rc2 : Moment of inertia (Iz)  .  .  .  .  .  .  . =   2.898119e-02

  Rc3 : Depth .  .  .  .  .  .  .  .  .  .  .  .  . =   1.000000e+00

  Rc4 : End-release code (node 1)  .  .  .  .  .  . =              0

  Rc5 : End-release code (node 2)  .  .  .  .  .  . =              0

  Rc6 : Shear factor in elem. y-axis  .  .  .  .  . =   0.000000e+00

  Rc7 : Temp. diff. in elem. y-axis   .  .  .  .  . =   0.000000e+00

  Rc8 : Perimeter (HSTAR only)  .  .  .  .  .  .  . =   0.000000e+00
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Using the Built-In AISC Section Library

If you are analyzing steel framed structures with standard AISC (American Insti-
tute of Steel Construction) cross sections, COSMOS/M provides you with the 
capability to select various properties such as center of gravity, area, moment of 
inertia, and others from a built-in section library. The PICK_SEC (Propsets > 
AISC Sect Table) command assigns a specified section from the AISC section 
tables to a real constant set. This command should only be used in conjunction 
with the FPS system. The unit of length is inches and that of weight is lb/ft. The 
“section name” option in this command refers to the valid AISC sections shown 
in the table below.

Table  6-16. Available AISC Sections in the Built-In Section Library

Also, in the above command, dim_1, dim_2, and dim_3 are the identification 
parameters for the section according to AISC. For example, if you want to select 
a W-section 36x300, then dim_1 is 36, and dim_2 is 300. The argument dim_3 
is required only for ANGLE, RANGLE, and STUBE sections. Note that the defi-
nitions of local x, y, and z coordinates are different in GEOSTAR and the AISC 
code. Table 6-17 shown on the next page, graphically illustrates the identification 
parameters dim_1, dim_2, and dim_3 for the available sections.

The weight of the section for sections other than angles is based on the density of 
steel. If you are using some other material in your finite element model, then the 
weight should be based on steel as in the AISC code. This does not affect any 
material properties since the weight is used only to define the section properties.

✍ The AISC sections can be currently used for BEAM3D elements only.

Section Name Description Example

ANGLE Standard angle sections L 9x 4 x 5/8

CBEAM American standard channel sections C 15 x 50

HPBEAM I-sections with equal flange and web thicknesses HP 14 x 117

MBEAM Miscellaneous I-sections M 14 x 18

MCBEAM Miscellaneous channel sections MC 18 x 58

PIPE Hollow circular pipe with uniform thickness 12 x 0.375

RANGLE Angle sections with rotated properties L 9x 4 x 5/8

SBEAM I-sections with narrower flanges S 24 x 121

STUBE Hollow rectangular tube with uniform thickness 16 x 16

WBEAM I-section with different flange and web thicknesses W 36 x 300
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It is possible to check if the structure you model and analyze using COSMOS/M 
meets the AISC specifications for allowable stress design (ASD). This is 
explained in the next section.

Table  6-17. Identification Parameters of AISC Sections

Angle C Be am HP Be am

M Be am C Be am 

R Angle S  Tube  S  Be am 

P ipe

d

d d

d d

d
d

b

t

d

b

t

d t

b

d

W Be am 

dim_1 = d (in)
dim_2 = b (in)
dim_3 = t (in)

dim_1 = d (in)
dim_2 = weight/length (lb/ft)

dim_1 = d (in)
dim_2 = weight/length (lb/ft)

dim_1 = d (in)
dim_2 = weight/length (lb/ft)

dim_1 = d (in)
dim_2 = weight/length (lb/ft)

dim_1 = d (in) nominal dia
dim_2 = t (in)

dim_1 = d (in)
dim_2 = b (in)
dim_3 = t (in)

dim_1 = d (in)
dim_2 = weight/length (lb/ft)

dim_1 = d (in)
dim_2 = b (in)
dim_3 = t (in)

dim_1 = d (in)
dim_2 = weight/length (lb/ft)

t
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To choose a standard AISC section in COSMOS/M is extremely simple: use the 
command PICK_SEC (Propsets > AISC Sect Table) and specify the section name 
(given earlier in Table 6-16), as illustrated below:

Geo Panel:   Propsets > AISC Sect Table
Associated Element group > 1
Real Constant set > 1
Section Name > WBEAM
AISC Dimension 1 > 36
AISC Dimension 2 > 300

You can use the command RCLIST (Edit > LIST > Real Constants) to verify the 
section properties accessed from the built-in AISC section library. The listing on 
the computer screen will be as shown below:

AISC Code Check (Using Steel Design Module)

If AISC standard sections are used in the analysis, you can specify an option in 
the A_STRESS (Analysis > STATIC > Stress Analysis Options) command to 
verify the validity of the chosen sections according to AISC provisions; see illus-
tration below:

Geo Panel:   Analysis > STATIC > Stress Analysis Options
AISC code check Flag 0=No 1=Yes >Yes
... ... ... >...
Accept Defaults

                        Real Constant Sets

Real Constant Set :   1  (ACTIVE)

Associated Element Group :   1  ( BEAM3D )

  Rc1 : Cross-sectional area .  .  .  .  .  .  .  . =   8.830000e+01

  Rc2 : Moment of inertia about y-axis (Iy) .  .  . =   1.300000e+03

  Rc3 : Moment of inertia about z-axis (Iz) .  .  . =   2.030000e+04

  Rc4 : Depth of beam (y-axis)  .  .  .  .  .  .  . =   3.674000e+01

  Rc5 : Width of beam (z-axis)  .  .  .  .  .  .  . =   1.665500e+01

  Rc6 : End-release code (node 1)  .  .  .  .  .  . =              0

  Rc7 : End-release code (node 2)  .  .  .  .  .  . =              0

  Rc8 : Moment of inertia about x-axis (Ix) .  .  . =   6.420000e+01
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When the AISC code check flag is turned on, the program generates a file, job-
name.AIS. This file can be used with the code checking program SDM (Steel 
Design Module) which is a stand alone program for applying the AISC code cri-
teria (contact Structural Research for availability).

Modification, Display and Output 
of Section Property Definitions

The command RCDEL (Edit > DELETE > Real Constants) can be used to delete 
all properties defined in one or more real constant sets. If you like to delete or 
modify a specific property in a real constant set, then you need to make use of 
the starting locations concept explained earlier.

If you have more than one real constant set in your model and would like to make 
a particular set active, then you need to use the command ACTSET (Control > 
ACTIVATE > Set Entity). In addition to activating real constant sets, this com-
mand can be used to activate sets for coordinate systems, temperature curves, and 
many others. The description of these sets and their set names is shown in the 
Table 6-10. The set names that are currently active can be graphically viewed on 
the screen using the STATUS1 icon from Control > UTILITY, as shown in Figure 
6-4.

To change the association of existing real constant sets with element groups 
and material property sets, the EPROPCHANGE (Propsets > Change El-Prop) 
command can be used. This command also assigns a specified color to a selected 
pattern of elements. The assigned colors can be subsequently used to display and 
hence identify parts of your mesh with different real constant sets. The next sec-
tion explains this in more detail.

Display of Section Property Definitions

For models with more than one real constant sets, COSMOS/M provides a novel 
way to graphically represent the different section constant sets for model check-
ing purposes. The command ACTECLR (Meshing > ELEMENTS > Activate 
Elem Color) can be used to activate the default colors for elements and one of the 
associated sets (the real constant set in this case). The procedure for displaying 
different sectional properties is similar to that for material properties; please 
refer to that section for more information.
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Section Property Output

By default, the section property information is not written to the output file. How-
ever, you can request for a detailed output using the PRINT_OPS (Analysis > 
OUTPUT OPTIONS > Set Print Options) command and specify the input print 
flag. The section properties defined can also be listed on the screen using the 
RCLIST (Edit > LIST > Real Constants) command. As with all listing commands 
in GEOSTAR, the information from RCLIST (Edit > LIST > Real Constants) 
command can be routed to an ascii file using the command LISTLOG (Control > 
MISCELLANEOUS > List Log).

Computing Mass and Inertia Properties

The MASSPROP (Control > MEASURE > Find Mass Property) command com-
putes and lists mass and inertia properties for a pattern of elements. The proper-
ties listed are: length, area, volume, mass, and the corresponding centers 
of gravity, moments of inertia and radii of gyration. Length properties are listed 
for one dimensional elements only (e.g. BEAM3D, ELBOW, PIPE, etc.), area 
properties are listed for two dimensional elements only (e.g. SHELL9L, SHEL-
LAX, FLOW2D, MAG2D, etc.), and volume properties are listed for all elements 
with volume (e.g. SOLID, FLOW3D, BEAM2D, SHELL4, etc.). Mass properties 
are listed for elements with mass (density must be specified). The command also 
computes the principal moments of inertia and the corresponding principal direc-
tions with respect to an arbitrary Cartesian coordinate system. The “check flag” 
option in this command if for checking inconsistent data such as undefined mate-
rial properties, section constants, connectivity, and degenerate elements. You can 
choose to compute mass and inertia properties for all or some of the elements.

The algorithm for computing the mass and inertia properties uses definite inte-
grals in one, two and three dimensions. These integrals are numerically evaluated 
for each element and summed over the total number of elements specified in the 
MASSPROP (Control > MEASURE > Find Mass Property) command. The fol-
lowing sections provide more information on the computation of mass and inertia 
properties for lattice (framed), planar (flat and curved), and solid structures mod-
eled using finite elements.
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Computing the mass and inertia properties using MASSPROP (Control > MEA-
SURE > Find Mass Property) command is quite simple. Simply issue this com-
mand after you have specified the element group, section constants, and material 
properties for your finite element mesh. It is a good practice to turn on the check 
flag to make sure the specified elements have all required properties defined, as 
illustrated below:

Geo Panel:   Control > MEASURE > Find Mass Property
Check flag: 1: Yes; 0: No [0] > 1
Beginning Element > 1
Ending Element > 40
Increment > 1
Coordinate system > 0

✍ Some of the mass and inertia properties discussed in this section are also com-
puted and printed in the output file when you perform natural frequency anal-
ysis or static analysis with gravity loading.

Mass and Inertia Property Computation of Lattice Structures

Consider the example of a truss shown in the figure below for computing the 
mass and inertia properties. The dimensions and mass density of the truss are also 
indicated in the figure. It is assumed that all elements are considered for mass 
property computations using MASSPROP (Control > MEASURE > Find Mass 
Property). The coordinate system indicated is used for computing the mass and 
inertia properties.

Figure 6-9. Example for Mass and Inertia Property 
Computations of a Lattice Structure

L = 100

h = 30

c/s area = 1
moment of inertia = 0.08333
mass density = 7.246E-04
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The length, volume, and mass of lattice structures are computed using:

 (6-30)

where Ai and li are the cross sectional area and length of an element i, and nel is 
the total number of elements specified. The coordinates of the centroid are estab-
lished by first computing the static moments and then dividing them by the total 
length, as shown below:

 (6-31)

where xci and yci are the centroidal coordinates of an element. The information 
on length, volume, and mass will be listed as shown below when the MASSPROP 
(Control > MEASURE > Find Mass Property) command is executed.

The equations for moments of inertia with respect to length are shown below:

 (6-32)

The products of inertia for lattice models are computed using the equations 
shown below:

 (6-33)

The radius of gyration is computed as follows:

 (6-34)

             Mass   Distribution   Table

Physical Properties:  Centroids w.r.t. Coord. Sys. [0]:

                                 x         y        z

  Length = 415.561     CGL =  ( 50   , 8.54282    , 0 )

  Area   = 0           CGA =  ( 0    , 0          , 0 )

  Volume = 415.561     CGV =  ( 50   , 8.54282    , 0 )

  Mass   = 0.301116    CG  =  ( 50   , 8.54282    , 0 )
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The moment and product of inertia with respect to the specified coordinate sys-
tem and the corresponding radii of gyration will be listed as shown below when 
the MASSPROP (Control > MEASURE > Find Mass Property) command is exe-
cuted:

The moment and product of inertia are also listed with respect to the centroid in 
the specified coordinate system as shown below:

The principal moments of inertia are the maximum and minimum moments of 
inertia which can be measured about any axis which passes through a given point. 
The product of inertia is zero for any two axes, one of which is a principal axis. 
An axis of symmetry is always a principal axis. The listing below shows the prin-
cipal moments of inertia with respect to the centroid.

 Moments of Inertia and Radii of Gyration (w.r.t. Coord. Sys. [0])

         Length         Area         Volume         Mass

  Ixx  | 59842.5      | 0          | 59899        | 43.4028

  Iyy  | 1.28185e+06  | 0          | 1.2819e+06   | 928.862

  Izz  | 1.34169e+06  | 0          | 1.34173e+06  | 972.215

  Ixy  | 177503       | 0          | 177503       | 128.619

  Iyz  | 0            | 0          | 0            | 0

  Izx  | 0            | 0          | 0            | 0

  Rx   | 12.0002      | 0          | 12.0058      | 12.0058

  Ry   | 55.5394      | 0          | 55.5404      | 55.5404

  Rz   | 56.821       | 0          | 56.8217      | 56.8217

 Moments of Inertia and Radii of Gyration (w.r.t. CG's in Coord. Sys.[0])

         Length         Area         Volume         Mass

  Ixx  | 29514.9      | 0          | 29571.4      | 21.4274

  Iyy  | 242946       | 0          | 242993       | 176.073

  Izz  | 272461       | 0          | 272495       | 197.45

  Ixy  | -0.0235475   | 0          | -0.0235475   | -7.92031e-06

  Iyz  | 0            | 0          | 0            | 0

  Izx  | 0            | 0          | 0            | 0

  Rx   | 8.42759      | 0          | 8.43565      | 8.43565

  Ry   | 24.1789      | 0          | 24.1813      | 24.1813

  Rz   | 25.6056      | 0          | 25.6072      | 25.6072
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The corresponding direction cosine vectors of the principal axes with respect to 
the specified coordinate system are listed below:

Mass and Inertia Property Computation 
of Plane Continuum Structures

Consider the example of a flat plate shown in the figure below to understand the 
mass property computations of two dimensional continuous (flat and curved) 
models. The dimensions of the plate and the mass properties are also shown. 
The bottom left corner of the plate is at coordinates (10,15) with respect to the 
coordinate system shown. The example chosen is quite simple so that you can 
verify the results obtained using MASSPROP (Control > MEASURE > Find 
Mass Property) by hand calculations. All elements shown in the figure will be 
considered in the coordinate system shown for mass property calculation.

 Principal Moments of Inertia ( w.r.t. CG's ) 

         Length         Area           Volume         Mass

  I1  | 272461       | 0            | 272495       | 197.45

  I2  | 242946       | 0            | 242993       | 176.073

  I3  | 29514.9      | 0            | 29571.4      | 21.4274

 Direction Cosine Vectors ( w.r.t. Coord. System [0] ) 

         Length         Area           Volume         Mass

  a11  | 0            | 0            | 0            | 0

  a21  | 0            | 0            | 0            | 0

  a31  | 1            | 0            | 1            | 1

  a12  | 1.10329e-07  | 0            | 1.10333e-07  | 5.1216e-08

  a22  | 1            | 0            | 1            | 1

  a32  | 0            | 0            | 0            | 0

  a13  | -1           | 0            | -1           | -1

  a23  | 1.10329e-07  | 0            | 1.10333e-07  | 5.1216e-08

  a33  | 0            | 0            | 0            | 0
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Figure 6-10. Example for Mass and Inertia Property 
Computations of a Plane Structure

The area, volume, and mass of a planar structure are computed as follows:

 (6-35)

where Ai is the area, ti is the thickness and ρi the mass density of element i, and 
nel is the total number of elements specified. The coordinates of the centroid are 
established by first computing the static moments and then dividing them by the 
total area, as shown below:

 (6-36)

The listing below shows the area, volume, mass and centroidal locations of the 
plate obtained using MASSPROP (Control > MEASURE > Find Mass Property) 
command:

                   Mass  Distribution  Table

Physical Properties:   Centroids w.r.t. Coord. Sys. [0]:

                                 x        y             z

Length = 0              CGL =  ( 0      , 0           , 0 )

Area   = 3150           CGA =  ( 50     , 42.5        , 0 )

Volume = 315            CGV =  ( 50     , 42.5        , 0 )

Mass   = 0.228249       CG  =  ( 50     , 42.4999     , 0 )

mass density = 7.246E-04
thickness = 0.1

L = 70

h = 45
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The moments and products of inertia for planar models are computed with respect 
to area, volume as well as mass. The equations for moment of inertia of a plane 
area are shown below:

 (6-37)

The products of inertia of a plane area are computed as shown below:

 (6-38)

The radius of gyration is computed using the equation 6-34 shown earlier. The 
moment and product of inertia with respect to the specified coordinate system 
and the corresponding radii gyration will be listed as shown below when the 
MASSPROP (Control > MEASURE > Find Mass Property) command is exe-
cuted:

The moment and product of inertia are also listed with respect to the centroid in 
the specified coordinate system as shown below:

Moments of Inertia and Radii of Gyration (w.r.t. Coord. Sys. [0])

          Length         Area           Volume         Mass 

   Ixx  | 0            | 6.22125e+06  | 622125       | 450.792

   Iyy  | 0            | 9.16125e+06  | 916125       | 663.824

   Izz  | 0            | 1.53825e+07  | 1.53825e+06  | 1114.62

   Ixy  | 0            | 6.69375e+06  | 669375       | 485.029

   Iyz  | 0            | 0            | 0            | 0

   Izx  | 0            | 0            | 0            | 0

   Rx   | 0            | 44.441       | 44.441       | 44.4409

   Ry   | 0            | 53.929       | 53.929       | 53.9289

   Rz   | 0            | 69.8808      | 69.8809      | 69.8808 
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For plane objects, there exists two mutually perpendicular axes through any given 
origin about which the product of inertia are zero. These axes are called the prin-
cipal axes. If ω represents the angle of rotation from the original coordinate axis, 
then the value of this angle to satisfy the condition that the product of inertia is 
zero is given by:

 (6-39)

The principal moments are given by:

 (6-40)

The principal moments of inertia are the maximum and minimum moments of 
inertia which can be measured about any axis which passes through a given point. 
The product of inertia is zero for any two axes, one of which is a principal axis. 
An axis of symmetry is always a principal axis. The listing below shows the prin-
cipal moments of inertia with respect to the centroid.

Moments of Inertia and Radii of Gyration  (w.r.t. CG's in Coord. Sys. [0])

          Length         Area           Volume         Mass

   Ixx  | 0            | 531564       | 53156.4      | 38.5176

   Iyy  | 0            | 1.28625e+06  | 128625       | 93.2023

   Izz  | 0            | 1.81781e+06  | 181781       | 131.72

   Ixy  | 0            | -0.510693    | -0.0510693   | 0.000538818

   Iyz  | 0            | 0            | 0            | 0

   Izx  | 0            | 0            | 0            | 0

   Rx   | 0            | 12.9904      | 12.9904      | 12.9905

   Ry   | 0            | 20.2072      | 20.2073      | 20.2073

   Rz   | 0            | 24.0225      | 24.0225      | 24.0226

Principal Moments of Inertia ( w.r.t. CG's):

          Length         Area           Volume         Mass

   I1  | 0            | 1.81781e+06  | 181781       | 131.72

   I2  | 0            | 1.28625e+06  | 128625       | 93.2023

   I3  | 0            | 531564       | 53156.4      | 38.5176
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The corresponding direction cosine vectors of the principal axes with respect to 
the specified coordinate system are listed below:

Mass and Inertia Property Computation of Solid Structures

Consider the following example of a solid finite element model with properties 
indicated. The model shown was built by first generating the finite element mesh 
of the plane cross section and sweeping this mesh about the Y-axis by an angle 
of 45 degrees to obtain a solid mesh of hexahedral elements. The command 
PHEXTR (Geometry > POLYHEDRA > Extrusion) was used for sweeping.

Figure 6-11. Example for Mass and Inertia Property 
Computations |of a Solid Structure

For solid models, volume and mass are computed as follows:

 (6-41)

Direction Cosine Vectors (w.r.t. Coord. System [0])

          Length         Area           Volume         Mass

   a11  | 0            | 0            | 0            | 0

   a21  | 0            | 0            | 0            | 0

   a31  | 0            | 1            | 1            | 1

   a12  | 0            | 6.76698e-07  | 6.76696e-07  | -9.85317e-06

   a22  | 0            | 1            | 1            | 1

   a32  | 0            | 0            | 0            | 0

   a13  | 0            | -1           | -1           | -1

   a23  | 0            | 6.76698e-07  | 6.76696e-07  | -9.85317e-06

   a33  | 0            | 0            | 0            | 0

mass density = 7.246E-04
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where Vi is the volume, ρi is the mass density of element i, and nel is the total 
number of elements specified. To compute the centroidal information, the static 
moments are first computed as follows:

 (6-42)

Coordinates of the centroid are then computed using:

 (6-43)

The computed mass, volume, and centroidal information will be listed as shown 
below when you use the MASSPROP (Control > MEASURE > Find Mass Prop-
erty) command.

The mass moments of inertia are computed as follows:

 (6-44)

Mass   Distribution   Table

 Physical Properties:          Centroids w.r.t. Coord. Sys. [0]

                                  x          y          z

  Length = 0              CGL =  ( 0         , 0         , 0       )

  Area   = 0              CGA =  ( 0         , 0         , 0       )

  Volume = 92140.4        CGV =  ( 59.5725   , 25        , -34.3942)

  Mass   = 66.7649        CG  =  ( 59.5725   , 24.9999   , -34.3942)
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The radii of gyration are computed using equation 6-34 shown earlier. The prod-
ucts of inertia are computed as follows:

 (6-45)

The computed moment and product of inertia along with radii of gyration with 
respect to the specified coordinate system will be listed as shown below:

The computed moment and product of inertia, and the radii of gyration will also 
be listed with respect to the centroid using the specified coordinate system as 
shown below:

 Moments of Inertia and Radii of Gyration  (w.r.t. Coord. Sys. [0])

         Length         Area           Volume         Mass

  Ixx  | 0            | 0            | 2.08959e+08  | 151412

  Iyy  | 0            | 0            | 5.01588e+08  | 363451

  Izz  | 0            | 0            | 4.16356e+08  | 301691

  Ixy  | 0            | 0            | 1.37226e+08  | 99433.8

  Iyz  | 0            | 0            | -7.92274e+07 | -57408.2

  Izx  | 0            | 0            | -1.7961e+08  | -130146

  Rx   | 0            | 0            | 47.6218      | 47.6218

  Ry   | 0            | 0            | 73.7817      | 73.7817

  Rz   | 0            | 0            | 67.2213      | 67.2213

yz

xz

xy
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Similar to planar objects, there exists a set of mutually orthogonal axes through 
any given origin about which the products of inertia of a solid are zero. These 
axes represent the principal axes of the solid. The orientation of the principal axes 
can be found by setting the products of inertia about any axis to zero and solving 
for the direction cosine vectors. If one of the principal axes is known, then the 
orientation of the remaining axes can be found the method discussed for plane 
sections. The principal moments of inertia for the solid finite element model are 
shown below:

The corresponding direction cosine vectors of the principal axes with respect to 
the specified coordinate system are listed below:

Moments of Inertia and Radii of Gyration  (w.r.t. CG's in Coord. Sys. [0])

         Length         Area           Volume         Mass

  Ixx  | 0            | 0            | 4.23736e+07  | 30704

  Iyy  | 0            | 0            | 6.55942e+07  | 47530.2

  Izz  | 0            | 0            | 3.17729e+07  | 23022.7

  Ixy  | 0            | 0            | 234.25       | 0.358757

  Iyz  | 0            | 0            | -205.045     | -0.266214

  Izx  | 0            | 0            | 9.18023e+06  | 6652.03

  Rx   | 0            | 0            | 21.4448      | 21.4449

  Ry   | 0            | 0            | 26.6813      | 26.6815

  Rz   | 0            | 0            | 18.5696      | 18.5697

 Principal Moments of Inertia (w.r.t. CG's):

         Length         Area           Volume         Mass

  I1  | 0            | 0            | 6.55942e+07  | 47530.2

  I2  | 0            | 0            | 4.76737e+07  | 34544.5

  I3  | 0            | 0            | 2.64727e+07  | 19182.2
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 Direction Cosine Vectors (w.r.t. Coord. System [0])

         Length         Area           Volume         Mass

  a11  | 0            | 0            | 6.96051e-06  | 1.00935e-05

  a21  | 0            | 0            | 1            | 1

  a31  | 0            | 0            | 7.95191e-06  | 1.36022e-05

  a12  | 0            | 0            | 0.866029     | 0.866028

  a22  | 0            | 0            | 5.59952e-06  | 1.36757e-05

  a32  | 0            | 0            | 0.499994     | 0.499995

  a13  | 0            | 0            | 0.499994     | 0.499995

  a23  | 0            | 0            | 3.40637e-06  | 6.73322e-06

  a33  | 0            | 0            | -0.866029    | -0.866028
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7 Loads and Boundary 
Conditions
Introduction

This chapter provides a summary of the commands for loads and boundary condi-
tions enforcement in the Basic System. For more information on applying differ-
ent types of loads, boundary conditions, constraint equations, coupling of nodes, 
coordinate systems, and other related information, please refer to COSMOS/M 
User Guide (V. 1).

Loads and Boundary Conditions in the Basic System

The types of loads you can apply on models in the Basic System can be catego-
rized as:

• Mechanical loads
• Thermal loads
• Gravitational loads
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Mechanical loads include imposed forces, pressures, moments, enforced dis-
placements, etc., Gravitational loads include loads generated due to gravitational 
effects, inertial effects, and so on. Thermal loads include temperatures imposed 
on the nodes of a finite element model. Gravitational and thermal loads are 
known as special loads in COSMOS/M, and as such, they require the activation 
of a special flag under the A_STATIC (Analysis > STATIC > Static Analysis 
Options) command. You may have more than one load case associated with all 
those load types.

The types of constraints you can apply as your model in the Basic FEA System 
(STAR and DSTAR) can be categorized as:

• Displacement boundary conditions.
• Coupling of degree of freedom between nodes.
• Coupling based on geometric entities such as point-to-point, point-to-curve or 

point-to-surface.
• Constraint equations by enforcing a mathematical linear relationship between 

different degree of freedoms.
• Automatic Rigid or Hinge connections at the interface between incompatible 

elements with mesh continuity at the interface.
• Rigid Bounding between any two intersecting geometries without having to 

preserve the element type compatibility or mesh continuity at the interface. 
(See chapter 1 and 3 for more detail on the Bond features).

The table below outlines the submenus required for applying loads and boundary 
conditions in the Basic System. The submenu in this table are found under the 
menu LoadsBC. For more information on how to use the commands in these sub-
menus, please refer to Chapter 3, Exploring GEOSTAR, of the COSMOS/M User 
Guide (V. 1).
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Table  7-1. Menu for Loads and Boundary Conditions Enforcement

* Displacement, nodal forces as well as pressures may be defined in any 
coordinate system including cylindrical and spherical systems.

Multiple Load Cases in the Basic System

It is required in many cases to calculate the response of structures to different 
types of loading conditions separately. The stiffness matrix for linear problems is 
constant while the load vector varies from one loading condition to another. If 
loading conditions were to be treated as different problems, then most of the solu-
tion steps would be identical including the stiffness matrix calculation and its 
decomposition. It is therefore plausible to compute and decompose the stiffness 
matrix only once and use it to calculate the results under different loading condi-
tions. 

A loading condition in GEOSTAR is referred to as a load case. By default, load 
case number 1 is active and all defined loading will be associated with load case 
1. Other load cases may be activated using the ACTSET (Control > ACTIVATE > 
Set Entity) command and specifying the LC argument for a load case. All loading 
conditions are associated with the active load case and will not affect other load 
cases. A load case defined through the LCSET (Analysis > STATIC > Activate 

Load/BC Type Menu

Mechanical Loads
LoadsBC > STRUCTURAL > DISPLACEMENT*
LoadsBC > STRUCTURAL > FORCE*
LoadsBC > STRUCTURAL > PRESSURE*

Gravitational Loads LoadsBC > STRUCTURAL > GRAVITY

Thermal Loads LoadsBC > THERMAL > TEMPERATURE

Thermal Loads LoadsBC > LOAD OPTIONS

Boundary Conditions

LoadsBC > STRUCTURAL > DISPLACEMENT
LoadsBC > STRUCTURAL > COUPLING
LoadsBC > STRUCTURAL > BONDING
Analysis > STATIC > Static Analysis Options
    (Hinged/ Rigid Connection)

Support Reactions Analysis > REACTION

Temperature Dependent Loads LoadsBC > FUNCTION CURVE

DOF Reduction in Frequency 
Analysis (Guyan)

LoadsBC > STRUCTURAL > MASTER DOF
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Load Case) command is referred to as a primary load case. Up to 50 primary load 
cases may be defined. 

The principle of superposition states that the response of a linear structure to a 
loading condition defined by scaling (multiplying factors for loads) and combin-
ing two other loading conditions may be obtained by scaling and combining the 
results of the two loading conditions in the same way. The LCCOMB (Results > 
Combine Load Case) command in GEOSTAR is used to create a new load case 
and calculate its results by scaling and combining other load cases. Load cases 
defined through the LCCOMB (Results > Combine Load Case) command are 
referred to as secondary load cases. Up to 50 secondary load cases may be 
defined. The following commands are related to multiple load cases in 
GEOSTAR:

Table  7-2. Commands for Multiple Load Cases in GEOSTAR

While the loading varies from one primary load case to other, boundary condi-
tions are usually kept the same. However, it is possible to combine load cases 
with different boundary conditions using the following procedure:

• Define one or more load cases with a set of boundary conditions.
• Use the R_STATIC (Analysis > STATIC > Run Static Analysis) command to 

solve.
• Define a new set of boundary conditions.
• Define new load cases.
• Use the LCSET (Analysis > STATIC > Activate Load Case) command to 

deactivate the previously solved load cases.
• Use the R_STATIC (Analysis > STATIC > Run Static Analysis) command to 

solve for the new load cases.
• Use the LCCOMB (Analysis > STATIC > Combine Load Case) command to 

combine results from the two sets as desired.

Command (Cryptic) Function

ACTSET Activates a particular load case

LCCOMB Defines a secondary load case

LCSET
Allows the user to select which defined load cases to 
solve and which to ignore, all primary load cases are 
considered by default

LCLIST Lists defined load cases
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In using multiple load cases, users should be aware of the following:

• If GAP elements exist in the model, secondary load cases may be meaningless 
in most cases.

• If in-plane loading effects are considered, results are calculated for the active 
load case only.

• If buckling or nonlinear analyses is performed on a database with multiple 
load cases, then only the active case is considered.

The results of secondary load cases are not written to the output file, but a listing 
of the results may be obtained by using the LISTLOG (Control > MISCELLA-
NEOUS > List Log) command and various on-line listing commands as desired.

Gravity, Centrifugal, and thermal loading are referred to as special loading in 
GEOSTAR and are only considered if the special loading flag is activated using 
the A_STATIC (Analysis > STATIC > Static Analysis Options) command. Grav-
ity and centrifugal loading as well as thermal loading can be included in any load 
case. Special loads are also associated with the active load case when they are 
defined and may be combined with other mechanical loads.

✍ Do not attempt to use multiple load cases when in-plane effects (differential 
stiffness) are activated for static, modal or buckling analysis. The program 
computes the results for the active load case only.

Multiple Thermal Load Cases

Thermal effects can be included in all of the 50 primary load cases in addition to 
other types of loading. In order for thermal effects to be considered in static anal-
ysis, the user has to activate the thermal loading flag using the A_STATIC (Analy-
sis > STATIC > Static Analysis Options) command. Thermal loading may be 
specified in two ways:

a. User-defined temperature profiles:
Nodal temperatures are defined through commands in the LoadsBC > TEM-
PERATURE submenu. The defined temperatures will be associated with the 
active primary load case. The TREF (LoadsBC > LOAD OPTIONS > Ref-
erence Temp) command may be used to specify a reference temperature.

b. Temperature profiles read from heat transfer analysis:
Temperature profiles from specified time steps are assigned to correspond-
ing primary load cases through the TEMPREAD (LoadsBC > LOAD 
COSMOS/M Basic FEA System 7-5

http://www.cosmosm.com


Chapter 7   Loads and Boundary Conditions

7-6
OPTIONS > Read Temp as Load) command. A heat transfer analysis must 
be performed prior to running the static analysis on the same database using 
HSTAR or the FFE Thermal module. Time step number one should be used 
in the TEMPREAD (LoadsBC > LOAD OPTIONS > Read Temp as Load) 
command to assign a temperature profile from a steady state heat transfer 
analysis.

The following restrictions must be considered in using thermal loading:

1. If the user associates a thermal time step to a certain load case, then all user-
defined nodal temperatures will be ignored for that load case.

2. You may use both types (a and b), mentioned above, in the same problem but 
in different load cases.

3. If you define temperature dependent material properties then the stiffness 
matrix is formed using the interpolated material properties based on the tem-
peratures of the first considered load case in the analysis (i.e. load case with 
lowest label) regardless of the nature of that load case (i.e. whether it has a 
temperature profile or not).

4. If a temperature gradient is defined, then for the applicable elements, the tem-
perature gradient will be applied to all load cases when the thermal loading 
flag is active.

5. Reference temperature applies only to the thermal load cases. A thermal load 
case has a temperature profile assigned.

6. Since buckling and other types of problems with geometric stiffness calcula-
tion are only considered for the active load case, therefore, only temperatures 
associated with the active load case will be considered in the analysis for 
those types of problems.

7. Use the TEMPRDLIST (LoadsBC > LOAD OPTIONS > List Step/Load Case) 
command to list assignments of temperature profiles from heat transfer time 
steps to primary load cases.

The TEMP1.GEO file in the example section illustrates the proper use of the 
commands pertinent to multiple thermal stress analysis.
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Analysis Guidelines
Introduction

This chapter presents some modeling hints on some special topics in the Basic 
System. For more information on many other modeling topics, please refer to 
Chapter 3, Exploring GEOSTAR, of the COSMOS/M User Guide (V. 1).

Bonding of Meshes with Noncompatible Elements

The bond feature allows the user to connect finite element meshes between any 
two intersecting geometries without having to preserve the element type compati-
bility or mesh continuity at the interface. The geometric entities and correspond-
ing element groups that can be bonded together are shown in the table below:
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Table  8-1. Geometric Connections for Using Bond

In the above table, SHELL refers to all 3-node triangular and 4- or 9-node quadri-
lateral shell elements that are supported in COSMOS/M. Similarly, SOLID refers 
to 8- or 20-node hexahedral solid elements as well as 4- or 10-node TETRA and 
4-node TETRA4R solid elements. Some of the typical applications of the bond 
command are also shown in the above table.

✍ The bond feature is currently applicable to linear static, frequency, buckling, 
nonlinear structural, and heat transfer analyses.

Primary 
Entity

Secondary 
Entity

To connect… Example

CR CR
PLANE2D to 
PLANE2D
SHELL to SHELL

CR SF or RG
SHELL to SHELL
SHELL to SOLID

SF or RG SF or RG SOLID to SOLID

Primary or 
Secondary

Primary or 
Secondary

Bonding 
Interface

Primary

Secondary

Bonding 
interface

Primary 
or 
Secondary

Primary 
or 
Secondary

Bonding Interface
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The bond capability is specified using the BONDING submenu from LoadsBC > 
STRUCTURAL. The BONDDEF (LoadsBC > STRUCTURAL > BONDING > 
Define Bond Parameters) command bonds faces of elements associated with the 
selected geometric entities. The user specifies a primary bond entity (curve, sur-
face, or region) and a pattern of target entities (curves, surfaces, or regions). All 
geometric entities must have been meshed before issuing this command in order 
to generate the bond information. Element edges/faces associated with the pri-
mary geometric entity are bonded with edges/faces of the secondary entities. The 
command is useful in connecting parts with incompatible mesh at the interface. 
Refer to the Command Reference Manual (Volume 2) or on-line help for details.

The BONDLIST (LoadsBC > STRUCTURAL > BONDING > List) command can 
be used to list a pattern of bond sets previously defined by the BONDDEF 
(LoadsBC > STRUCTURAL > BONDING > Define Bond Parameter) com-
mand. A typical listing is as follows:

Examples of Bond Connections

The following figures show examples of non-compatible connections where bond 
definition is required.

Figure  8-1. Solid-to-Shell Connection 

Set   Stype      Source     Ttype    #Targets    Targets
1  CR  53  SF  1  7
2  CR  50  SF  1  7
3  CR  47  SF  1  7
4  CR  44  SF  1  7
5  CR  41  SF  1  7
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Figure  8-2. Shell-to-Shell Connection 

Figure 8-3. Solid-to-Solid Connection 

Figure    8-4. Shell-to-Shell Connection 
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Figure 8-5. Shell-to-Shell Connection 

Guidelines for Using the Bond Capability

The following points should be considered in the application of this command:

• The BONDDEF (LoadsBC > STRUCTURAL > BONDING > Define Bond 
Parameters) command internally uses constraint equations to match the dis-
placements and rotations of the two parts. The quality assurance tests have 
shown that for parts with reasonable stiffness properties and mesh densities, 
the maximum displacement and stress values obtained from the bond com-
mand are within ten percent of those values obtained from a merged model 
with compatible elements.

• This command is currently applicable to linear static and nonlinear structural 
analysis, frequency, buckling and advanced dynamics analysis as well as heat 
transfer analysis using HSTAR.

• The BONDDEF (LoadsBC > STRUCTURAL > BONDING > Define Bond 
Parameter) command offers the option of choosing between uni-directional 
bond (i.e. connecting all the nodes on primary entity to the elements on the 
secondary entity) or bi-directional bond (i.e. connecting the nodes on each 
entity to the elements on the other entity). The one directional bond should be 
used when connecting lower order elements of the primary (source) entity to 
lower or higher order elements of the secondary (target) entity. The bi-direc-
tional bond should be used in connecting higher order elements of the primary 
entity to higher order elements of the secondary entity. The following figure 
illustrates uni-directional and bi-directional bonding.
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Figure 8-6. Uni-directional and Bi-directional Bonding Examples

• When bonding solids and shells, it is advisable to use shells as the source and 
solids as the target irrespective of the element order.

• When shell elements are connected to solid elements, the common nodes at 
the boundary should not be merged as this will free the rotational degrees of 
shell at that node. Actually, it is advantageous not to have coincident nodes at 
all in such problems. In shell-to-shell, or, solid-to-solid connections, merging 
of the coincident nodes at the boundary is allowed.

Sourc Target Source or Target or 

Unidire ct ional 

Sourc Target Source or Target or 

(Same Element (Same Element 

Sourc Target Sourc Target

(Same Element (Same Element 

Sourc Target

Bid irec tional 

Primary or the 
source ent ity  
is  always the 
one that has 
fewer degrees 
of f reedom

For both types 
of bonding:

•

Secondary  or 
the target 
ent ity is 
always the 
one that has 
larger number   

•

Unidire ct ional 

Sourc Target

(Same Element (Same Element 

Sourc Target Sourc Target

(Same Element (Same Element 

Bid irec tional 

(Same Element 
Type)

(Same Element 
Type)
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• In problems where the stress concentration at the bonded intersection is criti-
cal, both parts should have a fine mesh in this region.

• The results obtained from the BONDDEF (LoadsBC > STRUCTURAL > 
BONDING > Define Bond Parameter) command may deteriorate in problems 
where a rigid part is connected to a relatively flexible part. The bonded area in 
the flexible part undergoes warping or has high displacement gradients. The 
results will improve if the mesh density for the flexible part is increased in the 
bonded area.

• The actual constraint relations between the nodes of source and target geomet-
ric entities are formed and computed in the analysis stage.

Submodeling
After you run your problem with a relatively coarse mesh, you may define the 
areas of concern as submodels where stresses may not have been calculated accu-
rately due to sharp corners, geometric or load non-uniformity. The mesh inside the 
submodel will be refined and you may rerun the problem to improve results for the 
submodel only without changing results in the rest of the model. The submodeling 
process accelerates the job of obtaining accurate results in areas of stress concen-
tration for large problems. With submodeling, you avoid the overhead of having 
to solve the whole model including areas of less importance at which a coarse 
mesh would have been sufficient to obtain acceptable results.

Figure 8-8. Typical Submodel with Refined Mesh
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Submodeling Principles

Submodeling is based on the St. Venant's principle. You may cut a portion of the 
model and run analysis only for the selected portion provided that displacements 
are properly prescribed at the boundaries of the cut. If displacements at the 
boundaries of the cut are calculated accurately at the first run, then these dis-
placements may be considered as boundary conditions for the submodel run. The 
boundaries of the submodel must be adequately far from stress concentration 
areas.

Advantages of Submodeling
• For large problems (i.e., larger than 10,000 dof.), submodeling could save a 

lot of computer time and resources.
• You get accurate solutions at stress concentration areas.
• It allows you to repeatedly change or modify portions of the model during the 

design process.

Available Elements

The local mesh to be refined should consist of the following triangular shape ele-
ments.

• Linear TRIANG elements
• SHELL3, SHELL3T, and SHELL3L
• TETRA4 and TETRA4R

Available Features and Functions

1. Although the local mesh to be refined should consist of the elements men-
tioned above, the rest of the model may include any other types of elements.

2. You may deactivate submodeling at any time and run for the whole model.

3. Several disconnected portions of the model may be selected to create the 
submodel.

4. After you run for the submodel, you may define arbitrary new submodels. 
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5. The user need not be concerned about the nodal forces or element pressures 
within the submodel since the refinement is accomplished without moving the 
original nodes. In case of nodal temperatures however, the user may have to 
define temperature for the newly introduced nodes of the submodel.

6. You may use submodeling with multiple load case problems.

7. Displacement and stress fields outside of the submodel remain unchanged 
during the submodel run and may be integrated with the submodel during 
postprocessing by deactivating the element selection list.

Submodeling Steps 

Submodeling is an extremely simple process. You only need to follow these 
steps.

1. Run the whole model with a relatively coarse mesh.

2. Create an element selection list using commands in the Control > 
SELECTION submenu.

3. Activate submodeling using the SUBMODEL (Analysis > STATIC > Define 
SubModel) command.

4. Run analysis using the R_STATIC (Analysis > STATIC > Run Static Analysis) 
command.

5. Use postprocessing commands to display the results as usual. You may 
postprocess the submodel only or turn off the element selection list to 
postprocess the whole model.

6. Repeat the above steps as desired for new submodels if necessary. Refer to 
Chapter 11, Examples, for an example on submodeling.

Stresses in a Desired Coordinate System 
in Linear Static Analysis
In many cases, stresses are desired in a certain coordinate system. In 
COSMOS/M, stresses may be obtained in any defined Cartesian, cylindrical, or 
spherical coordinate system. It should be mentioned that the choice should be 
made before issuing the R_STATIC (Analysis > STATIC > Run Static Analysis), 
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or the R_STRESS (Analysis > STATIC > Run Stress Analysis) commands. If dis-
placements were already calculated, it is sufficient to choose the desired coordi-
nate system and issue the R_STRESS (Analysis > STATIC > Run Stress Analy-
sis) command. Two flags control the coordinate system that will be used for stress 
calculations for each element.

The first flag is an option in the EGROUP (Propsets > Element Group) command 
to specify whether stresses are desired in the local or the global coordinate system. 
The option is available for all 2D (TRIANG, PLANE2D, and all SHELL'S), and 
3D elements (SOLID and all TETRA'S).

The second flag is an element attribute referred to as the element coordinate sys-
tem (ECS) in the User Guide. Just like the element group, material property, and 
real constant sets, the ECS is listed for each element by the ELIST (Edit > LIST > 
Elements) command. To associate elements with a particular ECS, the ACTSET 
(Control > ACTIVATE > Set Entity) command may be used to activate the desired 
ECS before generating these elements. The ECS value for a pattern of elements 
may be modified using the EPROPCHANGE (Propsets > Change El-Prop) com-
mand. The default value for ECS is -1, which refers to the local element coordinate 
system defined by nodal connectivity as shown for each element group in Chapter 
4, Element Library, of the COSMOS/M User Guide (V. 1) 

The flag in the element group definition controls whether to use the assigned ECS 
values. If the global option (default) is used, then stresses are calculated in the Car-
tesian global coordinate system (system 0), regardless of the ECS values. If the 
local coordinate system is used, then control is transferred to the ECS values for 
all elements in that element group and the stresses are calculated in the specified 
ECS for each element. For shell elements, it is some times necessary to modify the 
ECS by projecting to the shell surface.

It should be remembered that the process of averaging the stresses is based on the 
values obtained in the specified coordinate system for each element. Element 
stresses at the center are calculated by averaging the stresses at the nodes of the 
element. Stresses at a node are calculated by averaging the corresponding values 
coming from all 2D and 3D elements to which the node is common. Mixed and 
meaningless results are generally obtained if averaging is performed in different 
coordinate systems. The fact that averaging of stresses is based on selection lists 
is helpful in cases where various ECS values are intentionally used for various ele-
ments. Selection lists may be defined using commands in the Control > SELECT 
menu.

Forces and stresses in 1D elements are always calculated in the ECS = -1 coordi-
nate system and are not included when nodal stresses are calculated by averaging.
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Introduction
Performing analysis for many finite element models is a very simple process in 
COSMOS/M. As you witnessed in the third chapter, whether your model is small 
or large, the preparation of input data for the finite element model and submitt-
ing it for analysis is set up in an efficient menu structure. This structure also 
allows you to perform different types of analysis on the same problem geometry 
without leaving GEOSTAR. In addition, the results of one analysis module can be 
transferred to another as loads for a multidisciplinary analysis (see Chapter 12). 
To accommodate the various needs of novice and experienced users alike, 
COSMOS/M provides a flexible set of tools to make the process of performing 
an analysis an efficient one.

This chapter explains the commands required for performing an analysis in the 
Basic System, with emphasis on specifying various options for analysis and out-
put. For more information on commands mentioned in this chapter, please refer
 to COSMOS/M Command Reference Manual (Volume 2). This chapter also pro-
vides some common pitfalls you may come across while performing an analysis 
in the Basic System and suggests the required remedies.

Performing Analysis in COSMOS/M
The process of performing a finite element analysis using the Basic FEA System 
can be categorized into the following phases:
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• Pre-analysis operations 
• Specifying output options
• Transferring loads from multidisciplinary analyses
• Specifying analysis options 
• Verification of analysis options 
• Performing analysis 

The commands required for executing the above phases is shown in the table 
below.

Table  9-1. Analysis Operations and Required Commands

* Please refer to Appendix B, Command Summary, for locating the path to 
menus from cryptic commands.

✍ Unless otherwise specified, all commands referred to in this chapter are found 
in the Analysis menu, OUTPUT OPTIONS, STATIC, and FREQUENCY/
BUCKLING submenus.

Analysis Task Required Commands (Cryptic) *

Pre-analysis operations

SHOW_MERGE, NMERGE, NCOMPRESS 
ECOMPRESS 
ECHECK 
DATA_CHECK 
R_CHECK 

Specifying Output Options
PRINT_OPS 
PRINT_NDSET 
PRINT_ELSET 

Transferring loads from other modules for 
multidisciplinary analyses (ESTAR, 
FLOWSTAR, and HSTAR)

EMFREAD 
NPRREAD 
TEMPREAD 

Specifying analysis options

LCSET, LCLIST 
A_STATIC 
A_STRESS 
ADAPTIVE 
A_BUCKLING 
A_FREQUENCY 

Verification of analysis options A_LIST 

Performing analysis

R_STATIC 
R_STRESS 
R_BUCKLING 
R_FREQUENCY 
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Pre-Analysis Operations
Pre-analysis operations refers to those operations you need to perform before 
submitting your model for analysis. These operations may include merging of 
nodes, checking the model data for errors, and specifying the options for renum-
bering of nodes and stress computations. The following paragraphs discuss these 
operations in more detail.

Compatibility Requirements

Since the mesh generation is performed independently for each region of your 
model, there will be duplicate definitions of nodes on common boundary curves 
and surfaces. Compatibility requirements dictate that the nodes on the common 
boundaries be merged in order to avoid problems in analysis (except for the crack 
or bound element). For example, consider the geometry shown in the figure 
below:

Figure 9-1. Merging of Nodes on Common Boundaries

The command NIDENT (Edit > IDENTIFY > Nodes) can be used to identify the 
generated nodes. At the common boundary, the node labels pointed by the arrow 
in the above figure are:

Regions for meshing Finite element mesh

Enlarged view of some 
common boundary nodes

Notice two node 
labels at the 
same point 

Finite element mesh after 
node merging and node 
label compressing
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Control Panel: Edit > IDENTIFY > Nodes
Pick node id:19,37.5 25 0,
Pick node id:14,37.5 25 0,

You can notice that nodes 14 and 19 have the same x,y,z coordinates at (37.5, 25, 
0), and one of these nodes needs to be merged using the NMERGE (Meshing > 
NODES > Merge) commands. The SHOW_MERGE (Meshing > NODES > Show 
Merged Node) command can be used to determine which nodes need to be 
merged. The use of the NMERGE (Meshing > NODES > Merge) command results 
in coinciding nodes (whose coordinates are within a specified tolerance) to be 
merged. You can merge selectively, or with respect to all nodes. The nodes are 
merged only if the differences between their corresponding X, Y, and Z coordi-
nates are all less than the tolerance specified. The all/among flag specifies whether 
all the nodes in the model are to be checked for merging with the specified pat-
tern of nodes, or to check merging only among the nodes specified in the pattern. 
The echo flag controls whether to give a message when two nodes are merged. 
The low/high flag determines which node to keep and which node to delete when 
two nodes get merged.

Element connectivity, load and boundary conditions are automatically updated 
after merging. If two nodes are merged and both have prescribed loads or bound-
ary conditions, then the highest magnitude for each component is retained. If the 
loads or boundary conditions on the two merged nodes are specified in different 
coordinate systems, then the prescribed conditions for the retained node are 
enforced and the prescribed conditions for the deleted node are ignored.

If you plan to generate finite element meshes from existing meshed geometric 
entities by operations like extrusion, sweeping, flipping, moving, etc., then you 
are recommended (for proper association of the mesh with geometric entities) to 
postpone the use of NMERGE (Meshing > NODES > Merge) command until all 
such operations have been performed.

Since the merging operation deletes some nodes, the node numbers will not be 
consecutive. The NCOMPRESS (Edit > COMPRESS > Nodes) command which 
consecutively renumbers the nodes in the specified pattern can be used to remove 
the numbering gaps.

✍ In general, it is a good practice to use the NCOMPRESS (Edit > COMPRESS 
> Nodes) command so that the resulting consecutive node numbers are within 
the upper limit on the number of nodes.
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✍ On a similar note, if you have deleted parts of your mesh, it is a good practice 
to use the ECOMPRESS (Edit > COMPRESS > Elements) command so that 
the resulting consecutive element numbers are within the upper limit on the 
number of elements.

Model Verification

To provide more flexibility's to the novice and experienced users alike, 
COSMOS/M features a hierarchic approach to checking the finite element model 
data before it can be submitted for analysis. You can verify the validity of either 
selected elements or the entire finite element mesh. Further, you can also verify if 
the complete finite element model is sound.

The ECHECK (Meshing > ELEMENTS > Check Elements) command checks the 
aspect ratio for the elements specified in the pattern. A message is issued if the 
aspect ratio of an element exceeds the specified value. The command automati-
cally deletes degenerate elements from the database. It is recommended to issue 
this command before running the desired analysis.

The DATA_CHECK (Analysis > Data Check) command verifies that an element 
group, a material property set and a real constant set (if needed) have been 
defined for each element in the database. GEOSTAR automatically constrains 
any extra degrees of freedom (dof). This command does not constrain any dof. It 
is in general recommended that the DATA_CHECK (Analysis > Data Check) com-
mand be issued prior to any solution step.

✍ The DATA_CHECK (Analysis > Data Check) command is a subset of the 
R_CHECK (Analysis > Run Check) command which performs many other 
checking operations. Therefore, for a thorough check on the finite element 
model developed, you should consider using the R_CHECK (Analysis > Run 
Check) command.

The R_CHECK (Analysis > Run Check) command performs a thorough check on 
the database of the problem at hand and writes a report on the status of the input 
in a file, probname.CHK.

The following checks are performed:
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1. Performs all functions of DATA_CHECK (Analysis > Data Check), namely 
checking that there is an element group, a material property set and a real 
constant set associated with each element.

2. Issues a warning message if a non existing node is used to define an element.

3. For PLANE2D and all shell elements, a warning message is issued in the 
following cases:
a. If the aspect ratio for an element exceeds 5.0.
b. If an angle in a 3-node element is less than 20 or more than 135 degrees.
c. If an angle in a 4-node element is less than 45 or more than 135 degrees.

4. For solid elements, only the aspect ratio is checked.

5. For BEAM3D and BOUNDARY elements and all triangular shell elements, 
the element connectivity is checked and a warning is issued if the area defined 
by the three nodes is less than 1.0E-15.

6. It is recommended that this command be always issued before running any 
analysis.

A typical output from R_CHECK (Analysis > Run Check) is as follows:

Output from CHECK program

Maximum node label  = 63
Number of nodes  = 63
Maximum element label  = 48
Number of elements  = 48
Check all elements (Aspect ratio, Material properties
Connectivities, Real constants, . . .)

Total number of elements checked  = 48
Total warnings found  0
Total errors found  0
Checking completed
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Enabling/Disabling Stress Calculations

The STRESS command sets up the calculation of stresses. By default, the compu-
tation of stresses is always on. However, for large problems, it is a good idea to 
run only the displacement solution and verify the solution before proceeding to 
stress calculations.

Node Renumbering

The RENUMBER (Analysis > Renumber) command renumbers the nodes to min-
imize the profile and bandwidth of the stiffness matrix. The RENUMBER (Analy-
sis > Renumber) command only reads and stores the assigned value of the flag 
argument. Actual renumbering is done in the analysis program.

✍ If you do not use this command, the program proceeds with node renumber-
ing.

When you execute any analysis command, renumbering (module RENUM) is the 
first operation performed, followed by input processing (module PRE1) and the 
respective analysis modules. The summary of renumbering is written to a file, 
jobname.RNM. 

Figure 9-2. Model for Renumbering

The renumbering summary is printed in the jobname.RNM file as follows:

1

2
3

4 5

67

8

9

10

Before Renumbering

12

3
4 5

6 7

8

9

10

After Renumbering
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Specifying Output Options
The PRINT_OPS (Analysis > OUTPUT OPTIONS > Set Print Options) com-
mand controls the printing of displacements, velocities, accelerations, mode 
shapes, stiffness matrix, temperatures, temperature gradients, heat flow values, 
and detailed input information in the output file. This command has options to 
control the printing of displacements, velocities, accelerations, mode shape coor-
dinates, etc. by means of respective flags. Additionally, if you request for input 
print flag, the nodal coordinates, element connectivities, material and real con-
stant sets, applied loads, etc., will be written to the output file.

Filtered Output

For large problems, the output file can be very large as the results are written for 
all nodes and elements by default. However, before executing the analysis, you 
can specify the node and/or element numbers so that the output is generated for 
only the specified nodes and elements. The PRINT_NDSET (Analysis > OUTPUT 
OPTIONS > Set Nodal Range) command defines groups of nodes for which dis-
placements, velocities and accelerations will be written in the output file (used 
with STAR and NSTAR modules only). Up to 10 groups can be specified.

   Number of nodes     = 10
   Number of elements  = 12

   Before resequencing - - -
     Node difference  8
     Profile  37
     Average node difference 3.70
     RMS node difference  3.96

   After resequencing by GPS
     Node difference  3
     Profile  28
     Average node difference 2.80
     RMS node difference  2.90

     1     1     1
     ... ...
   The time required to reduce the Bandwidth is    1 Seconds
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The PRINT_ELSET (Analysis > OUTPUT OPTIONS > Set Element Range) 
command defines groups of elements for which stresses will be written in the out-
put file (used with STAR and NSTAR modules only). Up to 10 groups can be 
specified.

Reaction Forces

The REACTION (Analysis > Reaction) command requests the calculation of reac-
tion forces and/or moments at all constrained d.o.f.'s. Reaction forces are only 
calculated at constrained degrees of freedom. By default the reaction force is cal-
culated for all constrained d.o.f’s. Use this command only when you do not want 
to calculate the reactions.

Grid Force Balance

You may request Grid Force Balance at each node using a flag in the A_STATIC 
(Analysis > STATIC > Static Analysis Options) command. STAR calculates and 
lists the forces from all elements sharing the node. The forces at each free node 
should be in equilibrium. However, at constrained nodes, these internal forces 
should be balanced by reaction forces. If reaction force is not requested with the 
grid force balance, then reactions are the opposite of the out-of-balance forces. 
Use the DISLIST (Results > LIST > Displacement) command to list reaction 
forces.

Transferring Loads for Multidisciplinary Analyses
The commands TEMPREAD (LoadsBC > LOAD OPTIONS > Read Temp as 
Load), NPRREAD (LoadsBC > LOAD OPTIONS > Read Fluid Pressure), 
and EMFREAD (LoadsBC > LOAD OPTIONS > Read Emag Force) can be used 
to transfer loads from the HSTAR, FLOWSTAR and ESTAR modules of 
COSMOS/M. Chapter 12 presents detailed procedures for performing multidisci-
plinary analyses with examples.

The TEMPREAD (LoadsBC > LOAD OPTIONS > Read Temp as Load) com-
mand associates nodal temperatures from a steady-state or transient heat transfer 
analysis at a particular time step to a linear static analysis load case. If the type of 
heat transfer analysis performed is steady-state, then you need to associate time 
step number 1 to the desired load case.
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✍ The heat transfer analysis must have been successfully completed before issu-
ing the above command. The special thermal loading flag must be activated 
using the A_STATIC (Analysis > STATIC > Static Analysis Options) com-
mand in order to consider thermal effects.

The EMFREAD (LoadsBC > LOAD OPTIONS > Read Emag Force) command is 
used for magneto-structural coupling, it provides the structural module with the 
magnetic nodal forces. You need to specify the time step number (in case of tran-
sient magnetic analysis) at which nodal magnetostatic forces are to be transferred 
for elastostatic analysis. If the type of magnetic analysis performed is steady-
state, then you should specify 1 for this flag.

✍ Magnetic analysis with active force calculation option should be performed 
before using this command. 

The fluid pressures computed after performing an analysis in FLOWSTAR can be 
transferred to the Basic System as pressure loading on elements. The NPRREAD 
(LoadsBC > LOAD OPTIONS > Read Fluid Pressure) applies the pressures cal-
culated at any time step on the faces of elements associated with the specified 
curves. When you use this command, you will be required to provide information 
on the type of geometric entity at the transfer surfaces and their label numbers. 
Currently, only the curve entities are supported.

✍ The NPRREAD (LoadsBC > LOAD OPTIONS > Read Fluid Pressure) com-
mand is currently applicable for 2D problems only.

Specifying Analysis Options
The A_STATIC (Analysis > STATIC > Static Analysis Options) command speci-
fies details of the linear static analysis to be later performed by the R_STATIC 
(Analysis > STATIC > Run Static Analysis) command. The A_STRESS (Analy-
sis > STATIC > Stress Analysis Options) command specifies details of the stress 
analysis to be later performed by the R_STRESS (Analysis > STATIC > Run 
Stress Analysis) command. The A_BUCKLING (Analysis > FREQUENCY/
BUCKLING > Buckling Options) command specifies details of the buckling 
analysis to be later performed by the R_BUCKLING (Analysis > FREQUENCY/
BUCKLING > Run Buckling) command. The A_FREQUENCY (Analysis > FRE-
QUENCY/BUCKLING > Frequency Options) command specifies details of the 
natural frequency analysis to be performed by the R_FREQUENCY (Analysis > 
COSMOS/M Basic FEA System
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FREQUENCY/BUCKLING > Run Frequency) command. Please refer to the 
Command Reference Manual (V. 2) for more information.

Specifying Adaptive FEA Options

The ADAPTIVE (Analysis > STATIC > Adaptive Method) command specifies 
adaptive meshing for linear static problems. The parameters of this command are 
used by the R_STATIC (Analysis > STATIC > Run Static Analysis) command to 
progressively improve the mesh until a desired accuracy level is reached. Mesh 
improvement is based on an estimate of the error in the strain energy norm using 
results from stress analysis. The highest errors are usually associated with ele-
ments at locations of stress concentration and elements with high aspect ratios.

Three methods are available for mesh improvement:

1. The H-method: Elements with high relative error are progressively subdivided 
until the error in the von Mises stress for each element approaches the average 
error within the specified tolerance.

2. The P-method: The polynomial order is increased from the present order to 
the specified one. This is done internally without introducing any new nodes 
in the database. The number of elements remains unchanged.

3. The HP-method: This method combines the H- and the P-methods. The 
H-method is progressively used until the error criterion is satisfied or the 
maximum number of loops is reached. After that the P-method is used to solve 
the refined mesh using the specified polynomial order.

Please refer to the Command Reference Manual (V. 2) for more information.

Specifying Load Case Options - Multiple Load Steps

The LCSET (Analysis > STATIC > Activate Load Case) command activates or 
deactivates specified primary load cases for static analysis. The LCLIST (Analy-
sis > STATIC > List Load Case) command lists the type, number and run flag for 
the defined load cases.
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Verification of Analysis Options
The A_LIST (Analysis > List Analysis Option) command lists the detailed 
options specified for various analyses. The analysis types supported by this com-
mand are shown below:

Performing Analysis
The R_STATIC (Analysis > STATIC > Run Static Analysis) command performs 
linear static analysis. It calculates nodal displacements using the STAR program. 
Upon a successful run, the command, automatically runs the STRESS program to 
perform stress calculations unless otherwise specified by the STRESS (Analysis 
> STATIC > Stress Analysis Options) command. The STRESS (Analysis > 
STATIC > Stress Analysis Options) command sets the flag for stress calcula-
tions. The flag is used by the R_STATIC (Analysis > STATIC > Run Static 
Analysis) command.

✍ By default, the program always computes stresses. Stresses are computed for 
all primary load cases that are set to run.

Type of Analysis “type” Flag

Static analysis (default) STATIC

FFE Static analysis FFESTATIC

Stress analysis STRESS

Frequency analysis FREQ

Buckling analysis BUCK

Fatigue analysis FATIGUE

Nonlinear analysis NONLIN

Thermal analysis THERMAL

FFE Thermal analysis FFETHERMAL

Fluid Flow analysis FLOW

Electromagnetic analysis EMAGNETIC

Optimization analysis OPTIMIZE

Sensitivity analysis SENSITIVITY

High frequency electromagnetic analysis HFREQUENCY
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The command R_BUCKLING (Analysis > FREQUENCY/BUCKLING > Run 
Buckling) is used for performing eigenvalue buckling analysis. This command 
uses flags specified by the A_BUCKLING (Analysis > FREQUENCY/BUCK-
LING > Buckling Options) command.

The R_FREQUENCY (Analysis > FREQUENCY/BUCKLING > Run 
Frequency) command performs natural frequency analysis. It computes the fre-
quencies and mode shapes using the DSTAR program. This command uses flags 
specified by the A_FREQUENCY (Analysis > FREQUENCY/BUCKLING > 
Frequency Options) command.

Analysis Problems
The following is a partial list of possible errors and recommended remedial 
procedures when you perform analysis using the Basic System. This list is by no 
means complete, and has been provided to supplement your engineering judg-
ment. For more comprehensive list of errors, refer to the Trouble Shooting sec-
tion of this manual.

Problem: Crashing Before Assembling the Stiffness Matrix
a. You may not have a finite element mesh. You can use the NLIST (Edit > 

LIST > Nodes) and ELIST (Edit > LIST > Elements) commands to make 
sure the nodes and elements have been properly created.

b. You may have zero degrees of freedom. This may result as a consequence 
of applying constraints on all nodes of the model. Check to see if the 
model has unconstrained degrees of freedom by using the DLIST (LoadsBC 
> STRUCTURAL > DISPLACEMENT > List) command. For large size 
problems, you may request for a detailed print out by activating the input 
print flag in the PRINT_OPS (Analysis > OUTPUT OPTIONS > Set Print 
Options) command.

c. You may have a corrupted database. Create a new problem and read in the 
session file of the corrupted database problem using the FILE (File > 
Load...) command.

d. You may not have sufficient hard disk space available. The program warns 
you of this situation in the analysis screen.
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Problem: Program Crashing During the Assembly of Stiffness Matrix
a. You may have degenerate elements. Run the ECHECK (Meshing > ELE-

MENTS > Check Elements) command to detect and delete these elements.
b. You may have inadmissible element group associated with some elements 

(for example, 4-node PLANE2D elements associated with a mesh of 3-node 
triangles generated by automatic meshing commands). Redefine the appro-
priate element group or change the mesh to the relevant type of elements by 
using MASFCHANGE (Meshing > AUTOMATIC > Surface Mesh Type) or 
other similar commands.

c. You may have very small element dimensions. Change the problem units.
d. You may have wrong element connectivity, especially for elements gener-

ated using the EL (Meshing > ELEMENTS > Define Element) command. 
Refer to Chapter 4, Element Library, in the COSMOS/M User Guide for the 
proper approach to generating element connectivity.

e. You may have two dimensional model in an inadmissible plane (for exam-
ple, PLANE2D elements in X-Z plane).

Problem: Execution Abort Due to Singular Stiffness Matrix
a. You may have insufficient boundary conditions. Add constraints to prevent 

the possible rigid body motions.
b. You may have unmerged nodes. For models with multiple regions or surfac-

es, the nodes and elements are generated independently for each region/sur-
face. However, compatibility conditions require that nodes on the common 
boundaries be merged. Use the NMERGE (Meshing > NODES > Merge) 
command with a proper merging tolerance.

c. You may have unconstrained nodes which are only attached to non-structur-
al elements (e.g. CLINK, RLINK, MASS,…). Fix these nodes in all direc-
tions.

d. You may have incompatible nodes at the common boundaries. This may 
result from adjacent meshes with different element sizes and/or types. 
Regenerate the mesh with proper element sizes and connectivity or use the 
BONDDEF (LoadsBC > STRUCTURAL > Define Bond Parameter) com-
mand to bond dissimilar element meshes.

e. You may have exceeded the critical buckling load while the in-plane effect 
flag (see A_STATIC (Analysis > STATIC > Static Analysis Options) com-
mand) is on. Deactivate the in-plane effect flag or run a nonlinear analysis.
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f. You may have a unstable structure due to constraining only the rigid body 
motion using GAP elements. Execute the problem with the soft springs 
option (see A_STATIC (Analysis > STATIC > Static Analysis Options) 
command) or add soft trusses on top of the gap elements.

g. You may have part of your axisymmetric model on the negative X-axis 
which is disallowed.

h. You may have defined physically inconsistent material properties for some 
elements (e.g. NUXY=0.6 or EX=0.0). Redefine these material properties.

i. You may have defined physically inconsistent  material properties. In such 
cases, you need to define admissible values for all components of Poisson's 
ratio (e.g. NUXY, NUYX, NUXZ, NUZX, NUYZ, and NUZY). Redefine 
these material properties.

j. You may have wrong real constants values (for example, zero or negative 
thickness). Note: in case of singular stiffness matrix with zero diagonal 
term, run the static analysis with the soft spring option in A_STATIC (Anal-
ysis > STATIC > Static Analysis Options) command. Animate the defor-
mation so that you can detect the rigid body motion direction. You can then 
proceed to constrain that direction.

Problem: Execution Abort During Stress Analysis
a. You may have run out of disk space (deactivate the stress print out flag).
b. You may have unrealistic input for the material properties or the real con-

stants associated with the element causing the program termination.
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10 Postprocessing
Introduction

Postprocessing in the Basic System is an efficient way to quickly analyze the 
analysis results for making design decisions. Postprocessing refers to the graphi-
cal manipulation of results in an organized and manageable form for easy inter-
pre-tation. Finite element analysis results typically produce voluminous data, 
normally written to an output file. By allowing you to selectively choose data 
for either graphical processing on the screen or ascii listing on the screen, 
COSMOS/M provides one of the most powerful postprocessing features for finite 
element analysis results.

Features like sectioning, isoplots, and line section plots will assist you in better 
analyzing the results graphically on-screen. This chapter presents some examples 
of using these features. 

✍ Please refer to the COSMOS/M User Guide (V.1) for complete information on 
postprocessing in GEOSTAR, including hardcopy printing and plotting.

Postprocessing

The main postprocessing operations in the Basic System are: plotting and listing 
the desired component of analysis results. The following table lists the different 
postprocessing functions and the required commands. The commands in this 
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table can be found in the Results menu and ACTIVATE, PLOT, LIST, and 
EXTREMES submenus.

Table  10-1. Postprocessing Commands for Analysis Results in the Basic System

* Refer to Appendix B, Command Summary, for locating the path 
to menus from cryptic commands.

Postprocessing Operation
Command
(Cryptic) *

Preliminary postprocessing operations
LCCOMB
AVERAGE
RESULTS?

Activating the type of analysis for postprocessing ACTPOST

Activating the component for plotting or listing

ACTSTR
ACTSTN
ACTDIS
ACTUSRPLOT

Plotting the activated component

IDRESULT
ANIMATE
DEFPLOT
DISPLOT
STRPLOT
STNPLOT
SMPLOT
ISOPLOT
SECPLOT
LSECPLOT
USRPLOT

Listing the activated component

DISLIST
STRLIST
STNLIST
SMLIST
BEAMRESLIST
GAPRESLIST
FREQLIST

Listing the extreme values of activated component

DISMAX
STRMAX
STNMAX
SMMAX
BEAMRESMAX

Setting on-screen plotting options
SETPLOT
SETLSECPLOT
SETERASE

Printing/plotting to hardcopy devices see Vol. 1

Saving graphical results in various image file formats see Vol. 1
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✍ Results from an advanced dynamics analysis performed in the ASTAR mod-
ule may be combined with the results of static analysis. This function is per-
formed by the READ_PDRESP (Results > Read Post-Dyn Response) 
command.

The procedure for postprocessing is quite simple in COSMOS/M: perform the 
required preliminary operations such as combining load cases, etc., activate the 
required component of analysis result, and either plot or list for easy on-screen 
interpretation of analysis. Since most of postprocessing is a GEOSTAR function, 
it will not be attempted to list all details of postprocessing in this chapter. You 
can refer to Chapter 3, Exploring GEOSTAR, of the COSMOS/M User Guide 
(Volume 1) for more information. In the following section, some of the new 
postprocessing features will be discussed.

Plotting of Line Sections, Isoplanes and Cross Sections

It is now possible to graphically view the variation of a result component along a 
section line or a section plane using the commands LSECPLOT (Results > PLOT 
> Path Graph and SECPLOT (Results > PLOT > Stress or Displacement) with 
Section Plot option. You can also plot planes of same stresses or displacements 
for 3D models (isoplanes) using the command ISOPLOT (Results > PLOT > 
Stress or Displacement) with Isoplot option. These commands are applicable for 
any contour filled plot in 2D and 3D space. 

The LSECPLOT (Results > PLOT > Path Graph) command generates an xy-plot 
from a filled contour plot in the active window. A path is specified by a number 
of nodes. The x-axis is used for the distance between nodes on the path and the 
reference node. The y-axis is the value of the plotted contour data. Two to twenty 
nodes can be used to define the path, and linear interpolation is used to calculate 
data along the section. For the following illustration, a line section plot was 
drawn by tracing a polyline through the cross section of the knuckle joint from 
top to bottom. 
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Figure 10-1. Line Section Plot of the Resultant Displacements in 2D Space

For the same knuckle joint, the SECPLOT (Results > PLOT > Stress or 
Displacement) command was used in 3D space to plot 12 sections of resultant 
displacement contour plot. The figure below shows the geometry as well as the 
section plot.

Figure  10-2. Cross Section Plot of the Resultant Displacements in 3D Space
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The knuckle joint model was also analyzed with a plot of equal displacement con-
tours. The ISOPLOT (Results > PLOT > Stress or Displacement) command plots 
isosurfaces for the active quantity in the plot buffer. The command works for 3D 
models only. A similar plot of isolines can be obtained for 2D models using the 
line option in contour plots. The figure below shows the geometry of the knuckle 
joint as well as the isoplots of resultant displacement.

Figure 10-3. Isoplots of the Resultant Displacements in 3D Space
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11 Modeling and 
Analysis Examples
Introduction

This chapter presents some examples on the analyses you can perform in the 
Basic System. These examples cover detailed discussions of linear static analysis, 
buckling, and natural frequencies and mode shape computations. Almost all 
examples discussed in this chapter document commands required for model cre-
ation, mesh generation, load and boundary condition enforcement, analysis and 
postprocessing. Where possible, comparisons have been made with analytical 
solutions to indicate the accuracy of COSMOS/M.

To use these examples, enter GEOSTAR, and simply execute the commands as 
instructed. The computer prompts for commands are shown in 10 point Courier 
and the corresponding inputs are shown in bold, as illustrated below:

Geo Panel: Propsets > Material Property

Material property set > 1
Material Property Name > EX: Elasticity modulus 1st dir

Property value > 15.5E6

Material Property Name > 

(Click on cancel to terminate)

Please refer to the COSMOS/M User Guide (V. 1) for more information on using 
GEOSTAR.
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Input files for the examples discussed here are available in the PROBLEMS.EXE 
file installed in the COSMOS/M directory (Macintosh and Unix Workstation ver-
sions may have a separate folder or directory with a title Example Problems or 
PROBS, respectively). On PCs, the file PROBLEMS.EXE can be unpacked by 
typing the command PROBLEMS at the DOS prompt. For other machines, follow 
the instructions provided to unpack or expand the archived file.

✍ The second part of this manual presents many verification problems on all 
analysis features of the Basic System. You are recommended to use these 
examples to learn more about the Basic System.

Table  11-1. List of Modeling and Analysis Examples

List of Examples

Contact/Gap LGAP1 - Hertzian Contact Using Node-to-Node Linear Gap 
Elements. See List

Bond BOND1 - Static Analysis of a U-Frame with Non-compatible 
Elements. See List

Linear Elastic 
Fracture 

Mechanics 
Analysis

LEFM1 - Stress Intensity Factor of a Plate with Two Edge 
Cracks. See List

LFEM2 - Stress Intensity Factor of Three Point Bend 
Specimen. See List

Buckling 
Analysis

BUCKL1 - Buckling of a Rectangular Plate under Uniform 
Pressure. See List

Modal 
Analysis

MODAL1 - In-Plane Effects on the Natural Frequencies of 
a Column. See List

MODAL2 - Modal Analysis of a Square Frame with Rigid 
Body Modes. See List

Submodeling

LSUBM1 - Using Submodeling for Shell Problems.
 See List

LSUBM2 - Using Submodeling with Tetrahedral Elements.
 See List

LSUBM3 - Using Submodeling for Shell Problems.
 See List

ASME Stress 
Requirement

ASME.GEO - ASME Code Stress Evaluation. 
See List

Use of Multiple 
Thermal Load 

Cases

TEMP1.GEO - Multiple Thermal Load Cases
See List
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Examples on Linear Static Stress Analysis

The types of linear static problems you can analyze in the Basic System include 
models with various combinations of mechanical, thermal, and gravitational loads, 
cracks, gaps and contact surfaces, substructuring, cyclic symmetry, and many oth-
ers. The examples discussed in this section only address some features of the linear 
static analysis module STAR owing to space limitations. The verification prob-
lems presented in the second part of this manual cover almost all aspects of linear 
static modeling and analysis.

Example on Contact

Contact problems are best solved as nonlinear problems. The example in this chap-
ter shows the procedure to solve a simple contact problem using linear analysis. It 
should be noted that the principle of superposition, valid for regular analysis, may 
not hold when using linear analysis to solve contact problems.

The complete input for this example is available in the file LGAP1.GFM. The 
study of stresses caused by the pressure between elastic bodies are important in 
the design of train tracks, ball and roller bearings, expansion joints for steel gird-
ers, and many 

other practical problems. Due to 
the stresses developed at contact 
areas which may be as high as the 
yield limit, the study of contact 
problems is often analyzed as a 
nonlinear finite element problem. 
However, a good approximation 
for the contact stresses can be 
obtained using the linear node-to-
node contact/gap elements in the 
Basic System. The figure below 
shows the half model of a cylinder 
for contact stress analysis using 
node-to-node gap elements. The 

Example LGAP1 - Hertzian Contact Using 
Node-to-Node Linear Gap Elements

Half model of a cylinder on a flate 
plate (Hertz contact problem)

P

R

E = 3E5
ν  = 0.3
R = 10
P = 100,000

Figure  11-1. Problem Geometry for Analysi
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material properties, dimensions and applied load are also shown in the figure.

Since the complete input for this example is available to you, there is no need to 
issue any command for generation of the finite element mesh. The only two com-
mands you need are the FILE (File > Load...) command to load the input file and 
the R_STATIC (Analysis > STATIC > Run Static Analysis) command to execute 
analysis. In what follows, you will be presented with information on how the 
finite element model was developed for analysis. Where ever a command is 
required to be executed, you are clearly instructed to do so.

To start with, copy the file LGAP1.GFM to your working directory, enter 
GEOSTAR, and execute the FILE (File > Load...) command as illustrated below:

Geo Panel: File > Load...

Input file name with extension > LGAP1.GFM

Accept Defaults

The file LGAP1.GFM includes information on the problem geometry such as 
points, curves, contours, and regions as well as the finite element data such as 
nodes, elements, properties, loads, and analysis specifications. You will see the 
finite element model constructed and displayed as the input is read in. To prop-
erly see the model, use the Perfect Scaling icon, and the View icon to set the 
X-Y view.

The command ACTNUM (Control > ACTIVATE > Entity Label) can be used to 
activate numbering of geometric or finite element entities to see the respective 
labels generated. The geometry of the cylinder was generated by using the com-
mand CRARC3PT (Geometry > CURVES > CIRCLES > by 3 Points) for the 
curved part and CRLINE (Geometry > CURVES > Line with 2 Pts) for the 
straight line. These curves were further broken using the command CRBRK 
(Geometry > CURVES > MANIPULATION MENU > Break (equally)) to 
smaller segments to construct regions for mesh transition from coarse to fine. 
The figure below shows the curve, contour, and region labels of the cylinder. 
The list commands such as PTLIST, CTLIST, RGLIST, (Edit > LIST > Points, 
Contours, Regions, ...) etc., can be used to list the created geometric entities.
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Figure    11-2. Curve, Contour and Region Plots of the 

There are two types of elements used in this model. The PLANE2D element mod-
els the continuous domain of the cylinder in a state of plane strain whereas the 
GAP element was used to connect the cylinder to the contact surface. These ele-
ments were defined using the command EGROUP (Propsets > Element Group). 
The PLANE2D element was defined under group 1 and the GAP element was 
defined under group 2. Since the PLANE2D element models plane strain behav-
ior, there are no section constants required for this element under real constant 
set 1.

The finite element mesh of the cylinder was generated using the command 
MA_RG (Meshing > AUTO MESH > Regions) for all four regions. The com-
mand NMERGE (Meshing > NODES > Merge) was used to merge the nodes at 
the common boundary curves. The GAP element is a special element which 
needs to be created by properly activating the required real constant sets as 
explained in the following paragraph.

The figure below shows the complete finite element model of the cylinder with 
the applied loading and constraints. The GAP element was defined by using the 
EL (Meshing > ELEMENTS > Define Element) command which connects the 
specified nodes defined by the ND (Meshing > NODES > Define) command. In 
the Basic System, the gap closure tolerance (gdist) is defined as a real constant 
parameter. Therefore, each gap element requires a real constant set which has to 
be activated before the element is defined. For this problem, five gap elements 
numbered 72 through 76 were used.
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Figure 11-3. Finite Element Model of the 

The figure below shows a clear view of the connection between the cylinder and 
the bottom contact surface. To start with, the element group 2 was activated for 
gap elements, and nodes 76 through 80 were defined at a y-coordinate of zero and 
x-coordinates equal to the exact coordinates of the respective nodes of the cylin-
der to which they are connected. It is important to specify the exact x-coordinates 
for the nodes of the gap element as a slight eccentricity will introduce lateral 
components of forces on the gap. In the next step, real constant 2 was activated 
and the first gap element (label 72) was defined using the EL (Meshing > 
ELEMENTS > Define Element) command. This element connects nodes 7 and 
76. Similarly, the remaining gap elements were defined after activating the 
respective real constant sets.

Figure 11-4. Enlarged View of the Contact Surface
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For a gap element, you need to specify the allowable relative motion between the 
two nodes beyond which the gap will resist compression or tension. For compres-
sion gaps, the most common situation is to specify the relative motion between 
the two nodes as equal to the initial distance between them such that they come 
into contact before resisting compression. Due to the amount of labor involved in 
inputting these distances for a large number of gaps, an option is provided in the 
element group definition (EGROUP (Propsets > Element Group) command) to 
instruct the program to calculate and use the initial distance between the nodes of 
each gap element. Refer to Chapter 4, Element Library, in the COSMOS/M User 
Guide. In this case there is no need to define the real constants associated with the 
gaps and any input will be ignored.

The bottom nodes of all gap elements were fixed using the DND (LoadsBC > 
STRUCTURAL > DISPLACEMENT > Define Nodes) command. Node 6 which 
represents the node directly in contact with the bottom surface was also fixed 
using the same command. Along the vertical axis of symmetry, the symmetric 
boundary conditions (UX = 0) were imposed using the DCR (LoadsBC > 
STRUCTURAL > DISPLACEMENT > Define Curves) command. The force at 
the top was applied using the FND (LoadsBC > STRUCTURAL > FORCE > 
Define Nodes) command. There is only one material set for this problem, defined 
for the cylinder. The properties E and ν were defined using the MPROP (Propsets 
> Material Property) command. To check the accuracy of the solution, the com-
putation of reaction forces was requested using the REACTION (Analysis > 
Reaction) command.

After you have inspected the model, execute the command R_STATIC (Analysis > 
STATIC > Run Static Analysis) to perform linear static analysis. The output file 
was examined for reaction forces on the nodes in contact. As shown in the illus-
tration below, the vertical component of reaction forces adds up to 100,000 which 
is the force applied, thus providing equilibrium check. 
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   LOAD CASE NUMB

   FORCES IN THE 

      ELEMENT    

         72   0.0

         73   0.0

         74   0.0

      TOTAL   0.0

 R E A C T I O N 

  NODE CSYS      
     6   0 0.1
To see the stress results, the required component of stress can be plotted using 
STRPLOT (Results > PLOT > Stress). The figure below shows the horizontal and 
vertical components of stresses as well as the von Mises stress contour plots.

Figure 11-5. Stress Contour 

Hertz (1895) developed the mathematical theory supported by experimental 
results for surface stresses and deformations produced by pressure between 
curved bodies. The maximum compressive stresses according to his theory occur 
at the center of the contact surfaces while the maximum shear stresses occur at 
the interior of the compressed parts. The maximum contact stress is given by the 
following equation (Roark's Formulas for Stress and Strain, Sixth Edition, Young, 
1989):

ER. . . . . . . . . . . . =   1

CLOSED BOUNDARY/GAP ELEMENT(S), NCE =     3

FX           FY           FZ      GAP DISTANCE  NORMAL FORCE

000E+00   0.4404E+05   0.0000E+00   0.5163E-01   0.4404E+05

000E+00   0.3153E+05   0.0000E+00   0.2032E+00   0.3153E+05

000E+00   0.6277E+03   0.0000E+00   0.4496E+00   0.6277E+03

000E+00   0.7620E+05   0.0000E+00

   F O R C E S

 RFX      RFY RFZ RMX RMY RMZ

373E+05 0.2380E+05 ---- ---- ---- ----            
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(11-1)

where p is the load per unit length and D is the diameter of the cylinder. Using 
the above equation, the vertical component of stress at the contact surface is 
3.2376E6 whereas the maximum vertical component of stress computed at the 
center of element 5 is 4.43372E6. Because of the very small contact area in what 
one initially approximates as a line or a point, contact stresses for even lighter 
loads can be very high. Since in reality the stresses are highly localized and triax-
ial, the actual stress intensity can be very high, and this cannot be accounted for 
by linear elastic contact mechanics theories. Therefore the solutions provided by 
the finite element analysis can indeed be viewed as accurate.

The command DEFPLOT (Results > PLOT > Deformed Shape) can be used to 
see the deformed shape of the cylinder. The DISPLOT (Results > PLOT > 
Displacement) command can be used to view the displacement contours. The fig-
ure below shows the deformed shape (full and enlarged) as well as the vertical 
and resultant displacement contours of the cylinder model.

Figure    11-6. Deformed Shape and Displacement Contour 
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See 
List
There are many modeling problems in which the compatibility of elements and 
nodes at the common boundaries is often difficult to produce during mesh gener-
ation. As recommended in Chapter 8, Modeling Guidelines, the compatibility of 
elements must be always maintained, and only for exceptional cases, the bond 
feature can be used to tie the non-compatible parts of the mesh.

Example BOND1 - Static Analysis of a 
U-Frame with Non-compatible Elements

The input for the geometry 
of this problem including 
some geometric entities is 
provided to you in the file 
BOND1.GFM. In the 
descriptions to follow, the 
procedures for defining 
higher order geometric enti-
ties such as polyhedrons 
and parts, mesh generation, 
defining bonding surfaces, 
applying constraints and 
loads, and performing anal-
ysis are explained in detail. 
The model for analysis con-
sists of a u-shaped cantile-
ver solid subjected to 
pressure loading. The figure below shows the geometry of the model with applied 
boundary conditions and loads. The locations of the bonding surfaces are also 
indicated since the model will be meshed in such a way that the elements will be 
mismatched at these interfaces.

✍ There are about 4000 nodes, 2200 elements, and 11,700 equations in this 
example. Solution of linear static analysis requires about 30 Mb of free disk 
space on a IBM PC with 16 Mb of RAM. Make sure you have this disk space 
available on your computer before attempting to solve this example. 

Example on Bond

Fixed 
Edge

Applied 
Pressure
Loads

Surfaces for 

Figure 11-7. Model for Analysis Showing 
Locations for Bond Enforcement
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As you can notice, there are four solid volumes in this model. Half of the solid 
volumes will be meshed with hexahedral solid (SOLID) elements of different 
element size, and the remaining half will be meshed with tetrahedron solid 
(TETRA10) elements, also of different sizes. This process will result in a 
mesh with non-compatible SOLID-to-SOLID, SOLID-to-TETRA10, and 
TETRA10-to-TETRA10 element interfaces. In a conventional finite element 
solver, this type of mesh will be unusable for analysis. However, with the bond 
feature of COSMOS/M, all you need is the command BONDDEF (LoadsBC > 
STRUCTURAL > BONDING > Define Bond Parameter) to connect the non-
compatible parts of the mesh together for providing compatibility, and proceed 
with the analysis. The bond definition process is performed at the geometric 
entity level such that the nodes and elements at the bonding interfaces are auto-
matically identified and interconnected by means of constraint relations. Note 
that the term non-compatible here refers to the mismatching of nodes at the 
interfaces, and it is different from incompatible which refers to cases where the 
interface has matching nodes but the deformation fields of the elements are not 
compatible.

To start with, copy the file BOND1.GFM to your working directory, enter 
GEOSTAR, and execute the FILE (File > Load...) command as illustrated below:

Geo Panel: File > Load...
Input file name with extension > BOND1.GFM

Accept Defaults

You will see the geometry of the model constructed and displayed on the screen 
as the input commands are read. As you can notice from the geometry of the 
model, there are four solid volumes in this model. The geometry created includes 
curves, surfaces, regions, and two volumes. These two solid volumes created as 
volume entities will be meshed with brick elements using the parametric 
(mapped) mesh generation scheme (M_VL (Meshing > PARAMETRIC MESH > 
Volumes) command). The remaining two solid volumes are created by using 
polyhedron and part definitions and are subsequently meshed with tetrahedron 
elements using the MA_PART (Meshing > AUTO MESH > Parts) command.

We will proceed with the definition of polyhedrons and parts using existing sur-
faces and regions for 3D automatic meshing. The procedures for 3D automatic 
meshing is explained in COSMOS/M User Guide. In order to define a polyhe-
dron, you need to first identify only those surfaces and regions that constitute the 
polyhedron. This is best achieved by making use of the selection feature available 
in GEOSTAR. The surfaces and regions constituting polyhedrons (also parts) 1 
and 2 are shown in the figure below. Notice that surface 22 is common to both 
parts.
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Figure 11-8. Regions and Surfaces for Part Entities 1 and 2

Before defining the first polyhedron, execute the INITSEL (Control > SELECT > 
Initialize) command as illustrated below separately for surfaces and regions:

Geo Panel: Control > SELECT > Initialize

Entity Name > Surfaces

Initialization Flag > Yes

Selection Set number > 1

Entity Name > Regions

Initialization Flag > Yes

Selection Set number > 1

As seen from the above figure, the first polyhedron is bounded by surfaces 13, 14, 
15, 16, and 22, and regions R1 and R3. You need to place these entities in the 
selection list using the command SELINP (Control > SELECT > by Label) as 
illustrated below:

Geo Panel: Control > SELECT > by Label

Entity Name > Surfaces

Beginning Entity > 13

Ending Entity > 16

Increment > 1
Selection Set number > 1

Geo Panel: Control > SELECT > by Label

Entity Name > Surfaces

Beginning Entity > 22
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Ending Entity > 22

Increment > 1
Selection Set number > 1

Geo Panel: Control > SELECT > by Label

Entity Name > Regions

Beginning Entity > 1
Ending Entity > 3
Increment > 2
Selection Set number > 1

If you clear the screen and issue SFPLOT; and RGPLOT; (Edit > PLOT > 
Surfaces, Regions) commands successively, you will see that only those sur-
faces placed in the selection list will be now plotted. You can now issue the PH 
(Geometry > POLYHEDRA > Define) command to define a polyhedron, and the 
program will only select the surfaces and regions in the selection list to form the 
entity. Specify an average element size of 5 for the first polyhedron as shown 
below:

Geo Panel: Geometry > POLYHEDRA > Define

Polyhedron Label > 1
Reference entity name > Surfaces

Surface/Region Label > 1
Average element size > 5
Tolerance > 0.0001

Redefine element size on bound > Change size

The polyhedron is a hollow entity, and it needs to be converted to a solid volume 
by using the PART (Geometry > Define Part) command as illustrated below:

Geo Panel: Geometry > Define Part

Part Label > 1
Polyhedron 1 > 1
Polyhedron 2 > 1

Similarly, the surfaces and regions that constitute the second polyhedron are iden-
tified and placed in the selection list as illustrated below:

Geo Panel: Control > SELECT > Initialize

Entity Name > Surfaces

Initialization Flag > Yes

Selection Set number > 1
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Geo Panel: Control > SELECT > Initialize

Entity Name > Regions

Initialization Flag > Yes

Selection Set number > 1

Geo Panel: Control > SELECT > by Label

Entity Name > Surfaces

Beginning Entity > 17

Ending Entity > 22

Geo Panel: Control > SELECT > by Label

Entity Name > Regions

Beginning Entity > 2
Ending Entity > 4
Increment > 2
Selection Set number > 1

Next, proceed to define the second polyhedron with an element size of 7.5 and 
the part entity as illustrated below:

Geo Panel: Geometry > POLYHEDRA > Define

Polyhedron Label > 2
Reference entity name SF or RG > Surfaces

Surface/Region Label > 22

Average element size > 7.5

Tolerance > 0.0001

Redefine element size on bound > Change size

Geo Panel: Geometry > Define Part

Part Label > 2
Polyhedron 1 > 2
Polyhedron 2 > 2

To make all surfaces and regions available for other modeling purposes, you need 
to re-execute the INITSEL (Control > SELECT > Initialize) command for all enti-
ties as illustrated below:

Geo Panel: Control > SELECT > Initialize

Entity Name > All

Initialization Flag > Yes

Selection Set number > 0
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The procedures you executed so far focused on preparing the geometry for mesh-
ing. To reiterate, volumes 1 and 2 to be meshed with brick elements were pre-
defined as volume entities and the command M_VL (Meshing > PARAMETRIC 
MESH > Volumes) can be directly applied on these volumes. The remaining two 
solid volumes were defined as part entities 1 and 2 for automatic mesh generation 
with tetrahedron elements using MA_PART (Meshing > AUTO MESH > Parts) 
command.

We will first generate the 8-node brick elements in volumes 1 and 2 using the 
mapped mesh generation scheme. Select the M_VL (Meshing > PARAMETRIC 
MESH > Volumes) command and specify input as illustrated below:

Geo Panel: Meshing > PARAMETRIC MESH > Volumes

Beginning Volume > 1
Ending Volume > 1
Increment > 1
Number of nodes per element > 8

Number of elements on 1st curve > 3

Number of elements on 2nd curve > 10

Number of elements on 3rd curve > 4

Accept Defaults ...

The 8-node brick elements (SOLID) generated will be assigned with element 
group number 1 by default. Repeat the M_VL (Meshing > PARAMETRIC MESH 
> Volumes) command for the second volume with a different number of elements 
along each curve as illustrated below:

Geo Panel: Meshing > PARAMETRIC MESH > Volumes

Beginning Volume > 2
Ending Volume > 2
Increment > 1
Number of nodes per element > 8

Number of elements on 1st curve > 4
Number of elements on 2nd curve > 15

Number of elements on 3rd curve > 6

Accept Defaults...
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Before generating the tetrahedron elements in parts 1 and 2, you need to first acti-
vate a different element group number for proper association with the generated 
10-node tetrahedron (TETRA10) elements:

Geo Panel: Control > ACTIVATE > Set Entity

Set Label > Element Group

Element Set number > 2

You can now proceed to generating the mesh for parts 1 and 2 using tetrahedron 
elements. Since surface 22 is common to both parts 1 and 2, and part 2 with ele-
ment size 7.5 was last defined, the element density on surface by default will be 
7.5. Therefore, before meshing part 1, you need to reset the element density on all 
surfaces of part 1 to 5 using the PHDENS (Meshing > MESH DENSITY > 
Polyhedron Elem Size) command as shown below:

Geo Panel: Meshing > MESH DENSITY > Polyhedron Elem Size

Beginning Polyhedron > 1
Beginning Polyhedron > 1
Increment > 1
Average element size > 5

Use the command MA_PART (Meshing > AUTO MESH > Parts) to generate 10-
node tetrahedron elements as shown below:

Geo Panel: Meshing > AUTO MESH > Parts

Beginning Part > 1
Ending Part > 1
Increment > 1
Hierarchy check flag > Check Hierarchy

Element order > High

Number of Smoothing Iterations > 4

Repeat the PHDENS (Meshing > MESH DENSITY > Polyhedron Elem Size) 
command and mesh the second part with 10-node tetrahedron elements as shown 
below:

Geo Panel: Meshing > MESH DENSITY > Polyhedron Elem Size

Beginning Polyhedron > 2
Beginning Polyhedron > 2
Increment > 1
Average element size > 7.5
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Geo Panel: Meshing > AUTO MESH > Parts

Beginning Part > 1
Ending Part > 1
Increment > 1
Hierarchy check flag > Check Hierarchy

Element order > High

Number of Smoothing Iterations > 4

Clear the screen and issue HIDDEN,1; (Display > DISPLAY OPTION > Hidden 
Element Plot) and EPLOT (Edit > PLOT > Elements) commands to obtain an 
element plot of the model without hidden lines. You can notice from the finite 
element mesh that at all three common boundaries, the elements do not match. 
The figure below shows a three dimensional view as well as 2D enlarged views of 
the mesh at the common boundaries.

Figure 11-9. Generated Finite Element Mesh with Non-compatible Interfaces

✍ Since the element types are incompatible, do not attempt to merge the nodes 
for this problem even if they appear to be coincident at the common bound-
aries. At interfaces with full compatibility, the nodes may however be merged. 

You need to identify the surfaces that form the common boundary where the ele-
ments are mismatched. Clear the screen, activate surface label display using 
ACTNUM,SF,1 (Control > ACTIVATE > Entity Label) command and plot all sur-
faces using SFPLOT (Edit > PLOT > Surfaces) command. You can zoom-in on 
the three interfaces for bond definition so that you can clearly identify the surface 
numbers for input. The figure below shows the enlarged views of the surfaces 
with labels at the common boundaries.

Enlarged View of Mismatched Elements 
at BOND Surfaces in the X-Y Plane
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Figure  11-10. Surfaces at the Common Boundaries

From the above figure, you will find that:

• at the SOLID-to-SOLID element interface, surfaces 7 and 9 are 
interconnected and can be used for bond set 1,

• at the SOLID-to-TETRA10 element interface, surfaces 11 and 16 are 
interconnected, and can be used for bond set 2,

• at the TETRA10-to-TETRA10 element interface, surface 22 connects the two 
part entities and can be used for bond set 3.

The above information is helpful in bond definition using the command 
BONDDEF (LoadsBC > STRUCTURAL > BONDING > Define Bond Parame-
ter). Select this command and specify the surface numbers for the first bond set 
as illustrated below:

Geo Panel: LoadsBC > STRUCTURAL > BONDING > Define Bond 
Parameter

Bonding set > 1
Primary Geometric entity type > Surface

Primary Surface > 9
Secondary Geometric entity type > Surface

Beginning Surface > 7
Ending Surface > 7
Increment > 1
Direction flag > Bi Dir

Repeat this procedure for the remaining two interfaces as shown below:
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Geo Panel: LoadsBC > STRUCTURAL > BONDING > Define Bond 
Parameter

Bonding set > 2
Primary Geometric entity type > Surface

Primary Surface > 11

Secondary Geometric entity type > Surface

Beginning Surface > 16

Ending Surface > 16

Increment > 1
Direction flag > Bi Dir

Geo Panel: LoadsBC > STRUCTURAL > BONDING > Define Bond 
Parameter

Bonding set > 3
Primary Geometric entity type > Surface

Primary Surface > 22

Secondary Geometric entity type > Surface

Beginning Surface > 22

Ending Surface > 22

Increment > 1
Direction flag > Bi Dir

If you make a mistake in bond set definition, you can delete that set using the 
BONDDEL (LoadsBC > STRUCTURAL > BONDING > Delete Bond Parameter) 
command. Use the command BONDLIST (LoadsBC > STRUCTURAL > 
BONDING > List) to verify the geometric entities bonded together. This com-
mand will provide the bonding information between primary (or source) and sec-
ondary (or target) entities on the screen as shown below:

The actual constraint relations between the nodes of source and target geometric 
entities are formed and computed in the analysis stage. During this process, the 
bond sets defined above are further divided into subsets in which each source 
node is connected to one or more target nodes in its vicinity. It is possible to 
obtain a listing of the source and target nodes in the subsets, as explained a little 
later.

Set  Stype  Source   Ttype   #Targets   Targets    

1     SF       9      SF        1          7

2     SF      11      SF        1         16

3     SF      22      SF        1         22
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You can now proceed with applying boundary conditions and loads. Use the com-
mand DSF (LoadsBC > STRUCTURAL > DISPLACEMENT > Define Surface) 
to restrain all degrees of freedom at the left end (surface 4) as illustrated below:

Geo Panel: LoadsBC > STRUCTURAL > DISPLACEMENT > Define Sur-
face

Beginning Surface > 4
Displacement Label > ALL: All 6 DOF

Value > 0.0

Ending Surface > 4
Increment > 1

The pressure loading on the right end as well as the top surface of the right half is 
applied using the PSF (LoadsBC > STRUCTURAL > PRESSURE > Define 
Surface) command as illustrated below;

Geo Panel: LoadsBC > STRUCTURAL > PRESSURE > Define Surface

Beginning Surface > 18

Pressure Magnitude > 500

Ending Surface > 18

Increment > 1
Pressure at the end of direction 1 > 500

Pressure at the end of direction 2 > 500

Pressure Direction > Normal

Geo Panel: LoadsBC > STRUCTURAL > PRESSURE > Define Surface

Beginning Surface > 19

Pressure Magnitude > 500

Ending Surface > 19

Increment > 1
Pressure at the end of direction 1 > 500

Pressure at the end of direction 2 > 500

Pressure Direction > Normal

The input of material properties and element group data completes the model 
preparation phase:
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Geo Panel: Propsets > Pick Material Lib

Material property set > 1
Material Name > A_STEEL

Unit Label > FPS

Geo Panel: Propsets > Element Group

Element group > 1
Element category > Volume

Element type (for volume) > SOLID: 8- to 20-node 3D solid element

Accept Defaults ...

Geo Panel: Propsets > Element Group

Element group > 2
Element category > Volume

Element type (for volume) > TETRA10: 10-node tetrahedral solid element

Accept Defaults

Before executing linear static stress analysis, you need to activate the input print 
flag using the command PRINT_OPS (Analysis > OUTPUT OPTIONS > Set 
Print Options) in order to obtain a listing of primary node vs. secondary nodes 
bonding information.

Geo Panel: Analysis > OUTPUT OPTIONS > Set Print Options

Displacement Print Flag > Yes

... ...
Input Print Flag > Yes

As mentioned earlier, do not merge nodes for this example before performing 
analysis. Use the command R_STATIC (Analysis > STATIC > Run Static 
Analysis) to execute a linear static stress analysis. The solution of this example 
requires about 30 Mb of free disk space on a personal computer with 16 Mb of 
memory.

After the analysis is successfully executed, you can inspect the output file 
(jobname.OUT) for results. You will notice that the bond information is written 
in the following form:
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   Joint 

   ------

 Ref.; Re

 Types of

    EQ. P

    EQ. P

 Set Type

   1  PTS

   2  PTS

   ... ..
The set in the above listing refers to the subsets derived from the bond sets you 
earlier defined using the BONDDEF (LoadsBC > STRUCTURAL > BONDING > 
Define Bond Parameter) command. 

You can view the displacement and stress results after activating the required 
components using the (Results > PLOT > Stress, Displacement) command. The 
figures below show contours of resultant displacement and von Mises stresses. 
These figures reinforce the fact that the results obtained using the bond feature 
are continuous and smooth as if a fully compatible mesh were used.

Figure 11-11. Displacement and Stress 

Bond coupling information

-------------------------

ference node

 coupling

TC ; Point to curve

TS ; Point to surface

  Ref.   NODE1 NODE2 NODE3 NODE4 NODE5 NODE6 NODE7 NODE8 NODE9 NODE10

  3224   3075  3079  3035  3031

  3225   3079  3083  3039  3035

.

COSMOS/M Basic FEA System

http://www.cosmosm.com


Part 1   Linear Statics, Modal, and Buckling Analysis

ee 
ist
There are two quarter-point singular elements (8-node PLANE2D and 20-node 
SOLID) available in the Basic System to model problems with cracks. When you 
use these elements, the fracture parameter computed is the stress intensity factor 
for the applicable mode of fracture. Other fracture parameters such as the 
J-integral or the energy release (G) can be calculated based on the computed 
stress intensity factors or directly compute through the J_integral option of the 
Basic System. The following two examples illustrate the computation of stress 
intensity factors for problems with different crack geometry. It should be under-
stood that in the following examples, due to structural symmetry, only half or one 
quarter of the structure is modeled. However, in more general cases, you may 
have to define a crack element for each one of the two faces of a crack.

In the examples of this section only the use of crack element is considered in the 
evaluation of the fracture mechanics characteristics. However, you may use the 
J-integral option to evaluate the same for 2D problems (using TRIANG and 
PLANE2D elements), as well.

Example LEFM1 - Stress Intensity Factor 
of a Plate with Two Edge Cracks

The input for this problem is available to you in the file LEFM1.GEO. This 
example considers the mode-I stress intensity factor solution of a plate with two 
through-thickness edge cracks under far-field tensile stresses as shown in the fig-
ure below. The elastic material properties and other dimensions are shown in the 
figure below.

Linear Elastic Fracture Mechanics 
Analysis Examples 

S
L
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Figure 11-12. Problem for Stress Intensity Factor 

The symmetry of the problem enables us to use a quarter of the model for analy-
sis. Set the view to 2D X-Y using the Viewing (Binocular) icon. The geometry 
and the finite element mesh are created as illustrated in the following commands:

Geo Panel: Geometry > GRID > Plane

Rotation/Sweep Axis > Z
Offset on Axis > 0.0

Grid Line style > Solid

Geo Panel: Display > VIEW PARAMETER > View

Accept defaults...

Geo Panel: Geometry > SURFACES > Draw w/ 4 Coord

Surface > 1
XYZ-Coordinate of Keypoint 1 > 30,30,0

XYZ-Coordinate of Keypoint 2 > 150,30,0

XYZ-Coordinate of Keypoint 3 > 150,150,0

XYZ-Coordinate of Keypoint 4 > 30,150,0

Click on Auto Scale icon ...

Geo Panel: Meshing > PARAMETRIC MESH > Surfaces

Beginning Surface > 1
Ending Surface > 1
Increment > 1

2W

a a

Quarter Model
for Analysis

120

= 100

120

Crack

a=20 t = 0.5
   = 0.28ν

E = 30E6

Plate with Through- 
Thickness Edge Cracks

σ 8

σ 8

σ 8
COSMOS/M Basic FEA System

http://www.cosmosm.com


Part 1   Linear Statics, Modal, and Buckling Analysis
Number of nodes per element > 8

Number of elements on the 1st curve > 12

Number of elements on the 2nd curve > 15

Spacing ratio for 1st curve > 1.0

Spacing ratio for 2nd curve > 1.0

Note that the mesh was generated with higher order elements in order to use the 
quarter-point element. The PLANE2D element required to be used for this prob-
lem is selected using the EGROUP (Propsets > Element Group) command 
whereas the material and sectional property data are entered as follows:

Geo Panel: Propsets > Element Group

Element Group > 1
Element Category > Area

Element Type (for area) > PLANE2D: 2D 4- to 8-node plane element

Accept Defaults ...

Geo Panel: Propsets > Pick Material Lib

Material Property set > 1
Material Name > A_STEEL

Unit Label > FPS

Geo Panel: Propsets > Real Constant

Associated Element group > 1
Real Constant set > 1

Start loc. of the real const > 1
No. of real const to be entered > 2

RC1: Thickness > 0.5

RC2: Material angle (Beta) > 0.0

Symmetric boundary conditions are enforced along the vertical and horizontal 
axes of symmetry. Since the crack represents a traction free edge and a disconti-
nuity in the geometry, there are no displacement boundary conditions enforced on 
the crack. Therefore, after you apply displacement boundary conditions on the 
curve entity, you need to remove the constraints placed on the crack. The follow-
ing commands illustrate:
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Geo Panel: LoadsBC > STRUCTURAL > DISPLACEMENT > Define 
Curves

Beginning curve > 1
Displacement Label > UY: Y translation

Value > 0.0

Ending curve > 
Increment > 1

Geo Panel: LoadsBC > STRUCTURAL > DISPLACEMENT > Define 
Curves

Beginning curve > 4
Displacement Label > UX: X translation

Value > 0.0

Ending curve > 4
Increment > 1

Geo Panel: LoadsBC > STRUCTURAL > DISPLACEMENT > Delete 
Nodes

Beginning node > 1
Displacement Label > UY: Y translation

Ending node > 4
Increment > 1

The far-field tensile stresses on the top edge can be applied using the PCR 
(LoadsBC > STRUCTURAL > PRESSURE > Define Curves) command as 
shown below:

Geo Panel: LoadsBC > STRUCTURAL > PRESSURE > Define Curves

Beginning curve > 2
Pressure magnitude > -100

Ending curve > 2
Increment > 1
Pressure at the end of direction 1 > -100

Pressure Direction > Normal Direction

You can now proceed to define the quarter-point element at the crack tip. As 
outlined in Chapter 8, Modeling Guidelines, the command CRACK (Analysis > 
STATIC > CRACK > Define Crack) is used to identify the nodes at the crack tip. 
The first node is always at the crack tip, and the second node at the corner of the 
same element, away from the crack tip. The third node is required for 3D crack 
problems only. The CRACK (Analysis > STATIC > CRACK > Define Crack) 
command is illustrated below:
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Geo Panel: Analysis > STATIC > CRACK > Define Crack

Crack number > 1
Node 1 > 5
Node 2 > 3
Node 3 > 

The commands CRACKLIST and CRACKDEL (Analysis > STATIC > CRACK > 
List Crack, Delete Crack) from the CRACK submenu can be used to list or delete 
quarter-point elements defined. The figure below shows the finite element model 
with applied loading and boundary conditions. The figure also shows the node 
numbers at the crack tip and the corner of the quarter-point element.

Figure 11-13. Finite Element Model with Boundary Conditions and Load 

You can now proceed to performing a linear static stress analysis of the model 
using the command R_STATIC (Analysis > STATIC > Run Static Analysis). The 
Basic System computes the stress intensity factors and prints them in the output 
file. To see the effect of geometric singularity introduced by the crack on the 
stress distribution, you can use the command STRPLOT (Results > PLOT > 
Stress). The figures below show a plot of von Mises stresses as well as the 
deflected shape of the model.
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Figure 11-14. Stress Contours and Deformed Shape Plot of the Cracked Plate

The stress intensity factors are read from the output file (jobname.OUT). For this 
example, they were found to be:

Note that the mode-II stress intensity factor is not relevant for this problem. The 
analytical solution for the mode-I stress intensity factor is as follows (Keer and 
Freedman, 1973):

(11-2)

The table below shows a comparison between the analytical and COSMOS/M 
solutions.

Table  11-1. Comparison Between COSMOS/M and Analytical Solution for KI

     CRACK STRESS INTENSITY FACTORS FOR CRACK 1

       KI   =  0.885133E+03

KI Solution Result Error (%)

Theoretical 884.763 N/A

COSMOS/M 300 elements 885.133 0.42
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The input for this problem is available to you in the file LEFM2.GEO. This 
example considers the mode-I stress intensity factor solution of a beam with a 
through-thickness edge crack at the center subjected to a point load as shown in 
the figure below. Otherwise known as a 3-point bend specimen, this type of 
model is commonly used to experimentally determine the mode-I stress intensity 
factor. The elastic material properties and other dimensions are shown in the fig-
ure below.

Figure 11-15. Problem for Stress Intensity Factor Computation

The symmetry of the problem enables us to use one half of the model for analysis. 
Change the view to 2D X-Y using the View (Binocular) icon. The geometry and 
the finite element mesh are created as illustrated in the following commands:

Geo Panel: Geometry > GRID > Plane

Rotation/sweep Axis > Z
Offset on Axis > 0.0

Grid Line Style > Solid

Geo Panel: Geometry > SURFACES > Draw w/ 4 Coord

Surface > 1
XYZ-Coordinate of Keypoint 1 > 20,20,0

XYZ-Coordinate of Keypoint 2 > 100,20,0

XYZ-Coordinate of Keypoint 3 > 100,60,0

XYZ-Coordinate of Keypoint 4 > 20,60,0

Click on Auto Scale icon ...

Example LFEM2 - Stress Intensity Factor 
of Three Point Bend Specimen

Three Point Bend Test for 
Mode-I Fracture Toughness

P/2

P

Crack

P/2
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a
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s s
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P/2=0.5

B=0.5

E=30E6

ν=0.28

Model for Analysis
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Geo Panel: Meshing > PARAMETRIC MESH > Surfaces

Beginning surface > 1
Ending surface > 1
Increment > 1
Number of nodes per element > 8

Number of elements on the 1st curve > 20

Number of elements on the 2nd curve > 10

Accept Defaults...

As in the previous example, the mesh was generated with higher order elements 
in order to use the quarter-point element. The PLANE2D element required to be 
used for this problem and the material and sectional property data are entered as 
follows:

Geo Panel: Propsets > Element Group

Element Group > 1
Element Category > Area

Element Type (for area) > PLANE2D: 2D 4- to 8-node plane element

Accept Defaults ...

Geo Panel: Propsets > Pick Material Lib

Material Property set > 1
Material Name > A_STEEL

Unit Label > FPS

Geo Panel: Propsets > Real Constant

Associated Element group > 1
Real Constant set > 1

Start loc. of the real const > 1
No. of real const to be entered > 2

RC1: Thickness > 0.5

RC2: Material angle (Beta) > 0.0

Symmetric boundary conditions are enforced along the vertical axis of symmetry. 
Since the crack represents a free edge, there are no displacement boundary condi-
tions enforced on the crack. Along the vertical axis of symmetry (except at the 
crack), the horizontal displacements are specified to be zero. The boundary con-
ditions are input as shown below:
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Geo Panel: LoadsBC > STRUCTURAL > DISPLACEMENT > Define 
Nodes

Beginning node > 1
Displacement Label > UY: Y translation

Value > 0.0

Ending node > 1
Increment > 1

Geo Panel: LoadsBC > STRUCTURAL > DISPLACEMENT > Define 
Nodes

Beginning node > 351

Displacement Label > UX: X translation

Value > 0.0

Ending node > 351

Increment > 1

Repeat the above command for UX at nodes 372, 413, 434, 475, 496, 537, 558, 
599, 620 and 661. The point load at the top is specified as shown below:

Geo Panel: LoadsBC > STRUCTURAL > FORCE > Define Node

Beginning node > 661

Force label > FY: Y force

Value > -0.5

Ending node > 661

Increment > 1

You can now proceed to define the quarter-point element at the crack tip. For this 
example, the first node which is always at the crack tip is 351, and the second 
node which is at the corner of the same element away from the crack tip, is 289. 
These nodes are specified using the CRACK (Analysis > STATIC > CRACK > 
Define Crack) command as illustrated below:

Geo Panel: Analysis > STATIC > CRACK > Define Crack

Crack number > 1
Node 1 > 351

Node 2 > 289

Node 3 > 289

The figure below shows the finite element model with loads and boundary condi-
tions. The figure also shows the node numbers at the crack tip and the corner of 
the quarter-point element.
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Figure 11-16. Finite Element Model with Boundary Conditions and Loads

You can now proceed to performing a linear static stress analysis of the model 
using the command R_STATIC (Analysis > STATIC > Run Static Analysis). The 
effect of geometric singularity introduced by the crack on the stresses can be 
viewed using the command STRPLOT (Results > PLOT > Stress). The figures 
below show a plot of von Mises stresses as well as the deflected shape of the 
model.

Figure 11-17. Stress Contours and Deformed Shape Plot of the Cracked Plate

The stress intensity factors are read from the output file (jobname.OUT). For this 
example, they were found to be:

     CRACK STRESS INTENSITY FACTORS

       KI   =  0.294492E+01
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Once again, the mode-II stress intensity factor is not relevant for this problem. 
The analytical solution for the mode-I stress intensity factor is as follows (Gross 
and Srawley, 1972):

(11-3)

The table below shows a comparison between the analytical and Basic System 
solutions. A second finite element solution obtained with 800 elements, shows 
convergence towards the analytical solution for mode-I stress intensity factor.

Table  11-2. Comparison Between COSMOS/M and Analytical Solution For KI

KI Solution Result Error (%)

Theoretical 3.3541 N/A

COSMOS/M 200 elements 2.94492 12.2

COSMOS/M 800 elements 3.03311 9.57
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Buckling analysis which determines the critical buckling loads and mode shapes 
can be performed on many types of practical problems in the Basic System. Vari-
ous eigenvalue extraction methods and modeling features available in the 
DSTAR module will enable you to address almost all types of modeling and anal-
ysis situations. Owing to space limitations, it is not possible to demonstrate all of 
these features. The example presented here discusses the application of some of 
the features outlined in Chapter 1. In addition, the second part of this manual pre-
sents more than twelve verification problems you may find useful in understand-
ing many aspects of the buckling analysis capabilities available.

✍ The second part of this manual presents more than 100 verification problems 
on all analysis features of the Basic System. You are recommended to use 
these examples to learn more about the Basic System.

Example BUCKL1 - Buckling of a Rectangular Plate 
Under Uniform Pressure

The input for this example is available in the file BUCKL1.GEO. This example 
considers the eigenvalue buckling of a rectangular plate under uniform pressure. 
The material properties and dimensions of the plate are shown in the figure 
below. Two opposite edges of the plate are simply supported whereas the remain-
ing two edges are clamped. The plate is subjected to a uniform pressure loading 
of unit intensity so that the computed eigenvalues will directly yield the critical 
buckling loads. Otherwise, the eigenvalues are treated as multipliers to the actual 
buckling loads.

Buckling Analysis Examples S
L
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Figure 11-18. Problem for Critical Buckling Load 
and Applied Boundary Conditions

One of the clamped edges of the plate is subjected to uniform pressure. However, 
in order to induce buckling in the finite element model, the x-component of the 
displacements was released on this edge whereas the other clamped edge was 
restrained with respect to all components of displacements. The figure above also 
shows the applied boundary conditions on the plate in 3D space.

The geometry and the finite element mesh of the plate are created as illustrated 
below:

Geo Panel: Geometry > GRID > Plane

Rotation/sweep Axis > Z
Offset on Axis > 0.0

Grid Line Style > Solid

Geo Panel: Geometry > SURFACES > Draw w/ 4 Coord

Surface > 1
XYZ-Coordinate of Keypoint 1 > 20,20,0

XYZ-Coordinate of Keypoint 2 > 80,20,0

XYZ-Coordinate of Keypoint 3 > 80,40,0

XYZ-Coordinate of Keypoint 4 > 20,40,0

Geo Panel: Meshing > PARAMETRIC MESH > Surfaces

Beginning surface > 1
Ending surface > 1
Increment > 1
Number of nodes per element > 4

Number of elements on 1st curve > 20

Number of elements on 2nd curve > 10

Accept Defaults

E  = 30E6
ν  = 0.3

a  = 60
b  = 20
t   = 0.3

Simply Supported

Simply SupportedC
la

m
p

e
d

C
la
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e
d

Rectangular Plae Under Uniform Compression

b

a
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Click on Auto Scaling icon to view the model clearly. The simply supported 
boundary condition on two edges of the plate was modeled by restraining the z-
component of displacements. The pressure loading and the displacement boundary 
conditions are applied as shown in the commands below:

Geo Panel: LoadsBC > STRUCTURAL > DISPLACEMENT > Define 
Curves

Beginning curve > 1
Displacement label > UZ: Z translation

Value > 0.0

Ending curve > 4
Increment > 1

Geo Panel: LoadsBC > STRUCTURAL > DISPLACEMENT > Define 
Curves

Beginning curve > 3
Displacement label > ALL: All 6 DOF

Value > 0.0

Ending curve > 3
Increment > 1

Geo Panel: LoadsBC > STRUCTURAL > DISPLACEMENT > Define 
Curves

Beginning curve > 4
Displacement label > UY: Y translation

Value > 0.0

Ending curve > 4
Increment > 1

Displacement label > RX: X rotation

Displacement label > RY: Y rotation

Displacement label > RZ: Z rotation

Geo Panel: LoadsBC > STRUCTURAL > PRESSURE > Define Curves

Beginning curve > 4
Pressure magnitude > 1
Ending curve > 4
Increment > 1
Pressure at the end of direction 1 > 1
Pressure direction > Normal Direction

The plate will be modeled with SHELL4 elements selected using the EGROUP 
(Propsets > Element Group) command. The material and sectional property data 
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are entered using MPROP (Propsets > Material Property) and RCONST (Propsets 
> Real Constant) commands as follows:

Geo Panel: Propsets > Element Group

Element group > 1
Element category > Area

Element type (for area) > SHELL4: 4-node thin shell element

OP1: Type > QUAD4

... ...
Accept Defaults

Geo Panel: Propsets > Material Property

Material property set > 1
Material property name > EX: Elasticity modulus 1st dir

Property value > 30E6

Material property name > NUXY: Poisson ratio 2nd to 1st

Property value > 0.3

Geo Panel: Propsets > Real Constant

Associated Element group > 1
Real constant set > 1

Start loc. of the real const. > 1
No. of real const. to be entered > 6
RC1: Thickness > 0.3

... ...
Accept Defaults

The number of buckling modes as well as the method of eigenvalue extraction is 
specified using the A_BUCKLING (Analysis > FREQUENCY/BUCKLING > 
Buckling Options) command. We will input for the first five modes of buckling 
using Lanczos method for this problem as shown below:

Geo Panel: Analysis > FREQUENCY/BUCKLING > Buckling Options

Number of Eigenvalues > 5
Method > Lanczos method

... ...
Accept Defaults

The command R_BUCKLING (Analysis > FREQUENCY/BUCKLING > Run 
Buckling) can now be issued to compute the critical buckling loads. The results 
of execution are written to the output file, jobname.OUT, and you can examine 
this file for buckling load factors and the corresponding mode shape deflections. 
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The critical buckling loads can also be listed on the screen using the FREQLIST 
(Results > LIST > Natural Frequency) command. The listing below shows the 
buckling load factors for the first five modes:

The analytical solution for this problem can be found in Roark's Formulas for 
Stress and Strain (Sixth Edition, Young, 1989) and is given below for a/b = 3:

(11-4)
 

where b is the length of the shorter side, and t is the thickness. The following 
table shows the comparison between the analytical and the Basic System solu-
tions.

Table  11-3. Comparison Between COSMOS/M and Analytical Solution

As seen in the above table, the Basic System solutions are very accurate. The 
command DEFPLOT (Results > PLOT > Deformed Shape) can be used to plot 
the buckling mode shapes. The first three buckling modes are shown below in the 
isometric viewing position.

  B U C K L I N G    E I G E N V A L U E (S) 

                 by 

  L A N C Z O S   A L G O R I T H M

    EIGENVALUE      EIGENVALUE

      NUMBER       

         1        0.2712670E+05

         2        0.2775493E+05

         3        0.3398611E+05

         4        0.3840657E+05

         5        0.5011349E+05

First Buckling Mode Solution Result Error (%)

Analytical 26925.82 N/A

COSMOS/M 200 elements 27126.70 0.75
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Figure 11-19. Buckling Mode Shapes of the Plate In 3-D Space

You can change the viewing position to 2D space to see the lateral deformations 
clearly. The figure below shows the three buckling modes corresponding to the 
above figure in the side view position.

Figure 11-20. Corresponding Buckling Mode Shapes In 2D Space
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Modal analysis which determines the natural frequencies and mode shapes can be 
performed on many types of practical problems in the Basic System. Various 
eigenvalue extraction methods and modeling features available in the DSTAR 
module will enable you to address almost all types of modeling and analysis situ-
ations. Owing to space limitations, it is not possible to demonstrate all of these 
features. Two examples presented here (MODAL1 and MODAL2) discuss the 
application of some of the features outlined in Chapter 1. In addition, the second 
part of this manual presents many verification problems you may find useful in 
understanding many aspects of the modeling and analysis capabilities.

Example MODAL1 - In-plane Effects on 
the Natural Frequencies of a Column

The input for this prob-
lem is available to you in 
file MODAL1.GEO. 
For slender structures 
with in-plane loading, 
the natural frequencies 
are significantly altered 
depending on the type 
of preload applied. As 
explained in Chapter 2, 
Mathematical Back-
ground, compressive 
loads tend to decrease the 
natural frequencies 
whereas tensile preloads 
increase them. The effect 
of a preload on the natural 
frequencies is significant 
for the first few modes 
and its influence gradually diminishes for higher modes. This example quantita-
tively demonstrates the effects of compressive and tensile preloads on the natural 
frequencies with respect to those obtained with no preloads.

Modal Analysis Examples S
L

Figure  11-21.Problem for Modal Analysis
with In-Plane Effects

55

E = 30E6
A = 1.0
 I  = 0.01
ρ = 7.246E-4

P = 1000

Problem Geometry Finite Element Model
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The geometry and the finite element mesh for this problem are created as illus-
trated in the following commands:

Geo Panel: Geometry > GRID > Plane

Rotation/sweep Axis > Z
... ...
Accept Defaults

Geo Panel: Geometry > CURVES > Draw Polyline

Curve > 1
XYZ-Coordinate of Keypoint 1 > 50,0,0

XYZ-Coordinate of Keypoint 2 > 50,55,0

XYZ-Coordinate of Keypoint 3 > 50,55,0

Geo Panel: Meshing > PARAMETRIC MESH > Curves

Beginning curve > 1
Ending curve > 1
Increment > 1
Number of nodes per element > 2

Number of elements on each curve > 8
Spacing ratio > 1.0

The column will be modeled using 2D beam elements (BEAM2D). This element 
is selected using the EGROUP (Propsets > Element Group) command whereas 
the material and sectional property data are entered as follows:

Geo Panel: Propsets > Element Group

Element group > 1
Element category > Line

Element type (for line) > BEAM2D: 2D elastic beam element

Accept Defaults

Geo Panel: Propsets > Real Constant

Associated Element group > 1
Real constant set > 1

Start loc. of the real const. > 1
No. of real const. to be entered > 8

RC1: Cross-sectional area > 1.0

RC2: Moment of inertia IZ > 0.01

RC3: Depth > 1.0
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Geo Panel: Propsets > Pick Material Lib

Material Property set > 1
Material name > A_STEEL

Unit label > FPS

The displacement boundary conditions at the top and bottom are enforced using 
the DND (LoadsBC > STRUCTURAL > DISPLACEMENT > Define Nodes) 
command where as the vertical load on the column is specified using the FND 
(LoadsBC > STRUCTURAL > FORCE > Define Nodes) command. In the first 
run, we will obtain natural frequencies in the presence of a compressive preload. 
The following lines illustrate the use of these commands:

Geo Panel: LoadsBC > STRUCTURAL > DISPLACEMENT > Define 
Nodes

Beginning node > 1
Displacement label > ALL: All 6 DOF

Value > 0.0

Ending node > 1
Increment > 1

Geo Panel: LoadsBC > STRUCTURAL > DISPLACEMENT > Define 
Nodes

Beginning node > 9
Displacement label > UX: X translation

Value > 0.0

Ending node > 9
Increment > 1

Geo Panel: LoadsBC > STRUCTURAL > FORCE > Define Nodes

Beginning node > 9
Force label > FY: Y force

Value > -1000

Ending node > 9
Increment > 1

The effect of a preload on the natural frequencies is specified by activating 
the in-plane effects flag in the A_FREQUENCY (Analysis > FREQUENCY/
BUCKLING > Frequency Options) command as illustrated below. The number 
of eigenvalues are also input in the same command. We will investigate the first 
five modes of the column.
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Geo Panel: Analysis > FREQUENCY/BUCKLING > Frequency Options
Number of frequencies > 5
Method > Subspace iteration method

Maximum number of iterations > 16

Sturm sequence flag > No

Shift flag > No Eigenvalue Shift

Shift value > 0.0

In-plane effect flag > Yes

... ...
Accept Defaults

You can use the command R_FREQUENCY (Analysis > FREQUENCY/BUCK-
LING > Run Frequency) to compute the first five natural frequencies of the col-
umn in the presence of a compressive preload. After the analysis is successfully 
executed, you can use the command FREQLIST (Results > LIST > Natural 
Frequency) to list the computed natural frequencies on the screen.

Delete the load at the top of the column and define a tensile preload as illustrated 
below:

Geo Panel: LoadsBC > STRUCTURAL > FORCE > Delete Nodes

Beginning node > 9
Force label > FY: Y force

Ending node > 9
Increment > 1

Geo Panel: LoadsBC > STRUCTURAL > FORCE > Define Nodes

Beginning node > 9
Force label > FY: Y force

Value > 1000

Ending node > 9
Increment > 1

Before executing another normal modes analysis, you need to activate a flag so 
that the results of the analysis you last performed are not over-written with the 
new results. Use the command PRINT_OPS (Analysis > OUTPUT OPTIONS > 
Set Print Options) as illustrated below:
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Geo Panel: Analysis > OUTPUT OPTIONS > Set Print Options

Displacement Print Flag > Yes

... ...
Output Flag > Append

Re-execute the problem using the command R_FREQUENCY (Analysis > FRE-
QUENCY/BUCKLING > Run Frequency) to compute the first five natural fre-
quencies of the column in the presence of a tensile preload.

Delete the load at the top of the column using the command FNDEL (LoadsBC > 
STRUCTURAL > FORCES > Delete Nodes) and deactivate the in-plane effects 
flag in the A_FREQUENCY (Analysis > FREQUENCY/BUCKLING > 
Frequency Options) command. Execute another analysis to obtain results with-
out the effects of preloads. Again, you can use the command FREQLIST (Results 
> LIST > Natural Frequency) to list the computed natural frequencies. The 
results are also written to the output file (jobname.OUT). 

The table below shows a summary of results for the first five modes. The results 
clearly show the effects of tensile and compressive preloads on the natural fre-
quencies. As stated earlier, the influence of preloads on the natural frequencies 
decrease for higher mode shapes.

Table  11-4. Comparison of Natural Frequencies With and Without Preloads

The effect of tensile and compressive preloads on the natural frequencies are bet-
ter represented in the following figure.

Mode 
Number

In-plane Load - Frequency (Hz)

Compressive No Tensile 

1 11.71 16.44 20.03

2 48.43 53.26 57.68

3 105.92 110.83 115.54

4 183.02 187.90 192.66

5 275.20 279.88 284.47
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Figure 11-22. Effect of Tensile and Compressive Preloads on the 
Natural Frequencies 

The DEFPLOT (Results > PLOT > Deformed Shape) command can be used for 
plotting the free vibration modes of the column. The figure below shows the first 
three modes for the column with no preloads.

Figure 11-23. Free Vibration Modes of the Column
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The input for this problem is available to you in file MODAL2.GEO. The analy-
sis problem consists of a box-shaped frame with material and cross sectional 
properties and dimensions as shown in the figure below. The frame which lies in 
2D space is unsupported, and it is required to determine the first ten natural fre-
quencies and mode shapes.

Figure 11-24. Problem for Modal Analysis with Rigid Body Modes

The geometry and the finite element mesh for this problem are created as illus-
trated in the following commands:

Geo Panel: Geometry > GRID > Plane

Rotation/sweep Axis > Z
Offset on Axis > 0.0

Grid Line Style > Solid

Geo Panel: Geometry > CURVES > Draw Polyline

Curve > 1
XYZ-Coordinate of Keypoint 1 > 20,20,0

XYZ-Coordinate of Keypoint 2 > 80,20,0

XYZ-Coordinate of Keypoint 3 > 80,80,0

XYZ-Coordinate of Keypoint 4 > 20,80,0

XYZ-Coordinate of Keypoint 5 > 20,20,0

Example MODAL2 - Modal Analysis of a Square Frame 
with Rigid Body Modes 

S
L

E = 30E6
A = 1.0
 I = 0.01
ρ = 7.246E-4

Problem Geometry Finite Element Model

60

60
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Geo Panel: Meshing > PARAMETRIC MESH > Curves

Beginning curve > 1
Ending curve > 4
Increment > 1
Number of nodes per element > 2

Number of elements on each curve > 5
Spacing ratio > 1.0

Click on the View (Binocular) icon and change the view to X-Y. You can scale 
the image to fit the viewport by clicking on the Auto Scale icon. The frame will 
be modeled with 2D beam elements (BEAM2D). This element is selected using 
the EGROUP (Propsets > Element Group) command whereas the material and 
sectional property data are entered as follows:

Geo Panel: Propsets > Element Group

Element group > 1
Egroup category > Line

Element type (for line) > BEAM2D: 2D elastic beam element

Accept Defaults

Geo Panel: Propsets > Real Constant

Associated Element group > 1
Real constant set > 1

Start loc. of the real const. > 1
No. of real const. to be entered > 8

RC1: Cross-sectional area > 1
RC2: Moment of inertia (IZ) > 0.01

RC3: Depth > 1
... ...
Accept Defaults

Geo Panel: Propsets > Pick Material Lib

Material Property set > 1
Material name > A_STEEL

Unit label > FPS

Since the finite element mesh for each curve is generated independently, there 
will be two nodes at the corners. For compatibility requirements, these nodes 
have to be merged into one. The NMERGE (Meshing > NODES > Merge) and 
NCOMPRESS (Edit > COMPRESS > Nodes) commands are used to merge the 
nodes and consecutively number them, respectively.
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Since the behavior of the finite model is confined to 2D space, you can expect to 
see three rigid body modes: two translations and a rotation. As described in Chap-
ter 2, Mathematical Background, problems with rigid body modes can be dealt 
with in two ways: using an eigenvalue shift, or a soft spring addition, specified 
using the A_FREQUENCY (Analysis > FREQUENCY/BUCKLING > Frequency 
Options) command. We will use both options and compare the results.

We will compute the first ten free vibration modes and mode shapes for this prob-
lem. The number of eigenvalues as well as the eigenvalue shift are input in the 
A_FREQUENCY (Analysis > FREQUENCY/BUCKLING > Frequency Options) 
command as illustrated below:

Geo Panel: Analysis > FREQUENCY/BUCKLING > Frequency Options

Number of frequencies > 10

Method > S: Subspace iteration

Maximum number of iterations > 16

Sturm sequence flag > No

Shift flag > Shift by program

Shift value > 0.0

... ...
Accept Defaults

The command R_FREQUENCY (Analysis > FREQUENCY/BUCKLING > Run 
Frequency) is next executed to perform modal analysis of the square frame. After 
the analysis is successfully executed, you can use the command FREQLIST 
(Results > LIST > Natural Frequency) to list the computed natural frequencies 
on the screen. The table below shows the mode numbers and the corresponding 
natural frequencies using the shift option. The first three modes shown represent 
rigid body modes with negligible frequencies. This table also shows the frequen-
cies obtained using the soft spring option, explained a little later.
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Table  11-5. Comparison of Natural Frequencies Using 
Eigenvalue Shift and Soft Spring Option

The command DEFPLOT (Results > PLOT > Deformed Shape) can be used to 
plot the mode shapes. The rigid body modes can also be computed using the soft 
spring option. As explained in Chapter 2, Mathematical Background, the addition 
of soft spring stiffness results in each diagonal term of the structural stiffness 
incremented by a small value to provide numerical stability. In the Basic System, 
you can vary the value of soft spring stiffness. The soft spring addition is speci-
fied as shown below:

Geo Panel: Analysis > FREQUENCY/BUCKLING > Frequency Options

Number of frequencies > 10

Method > S: Subspace iteration

Maximum number of iterations > 16

Sturm sequence flag > No

Shift flag > No Eigenvalue Shift

Shift value > 0.0

In-plane effect > No

Tolerance > 0.000010

Soft Spring flag > Yes

... ...
Accept Defaults

Use the command PRINT_OPS (Analysis > OUTPUT OPTIONS > Set Print 
Options) to append the new analysis results to the previous one in the output 
file. Next, use the command R_FREQUENCY (Analysis > FREQUENCY/
BUCKLING > Run Frequency) to compute the natural frequencies and mode 

Mode Number
Option Frequency (Hz)

Shift Soft Spring 

1 2.40086e-06 1.70049e-03 

2 9.05758e-06 1.70051e-03 

3 1.25760e-05 1.70122e-03

4 5.08984e+00 5.08985e+00 

5 8.84410e+00 8.84410e+00

6 1.71626e+01 1.71626e+01

7 1.71626e+01 1.71626e+01

8 2.00285e+01 2.00285e+01

9 3.74398e+01 3.74398e+01 

10 4.47586e+01 4.47586+01
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shapes of the square frame. After the analysis is successfully executed, you can 
use the command FREQLIST (Results > LIST > Natural Frequency) to list the 
computed natural frequencies on the screen. As shown in the previous table, the 
first three modes representing rigid body displacements have negligible natural 
frequencies. You can notice from the table that the natural frequencies for the 
deformable modes (mode 4 onwards) are identical with those obtained using the 
eigenvalue shift option. The figure below shows the three rigid body modes 
obtained using the soft spring option.

Figure 11-25. Rigid Body Modes Computed Using Soft Spring Option

The DEFPLOT (Results > PLOT > Deformed Shape) command can be used in 
either approach for plotting the deformable free vibration modes of the square 
frame. The figure below shows the fourth, fifth and six free vibration modes.

Figure 11-26. Deformable Free Vibration Modes of the Square 
Frame Using Soft Spring Option

Rigid Body Mode Rigid Body Mode 2 Rigid Body Mode 3
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Submodeling is a feature of STAR which can be used to improve the solution at 
locally critical areas without having to rerun for the whole model. This can 
reduce the CPU time substantially for large problems.

Example LSUBM1 - Using Submodeling for Shell Problems

The input for the modeling 
part of this example is 
available in the file 
LSUBM1.GEO. The 
figure below shows a 3D 
view of the model con-
strained at one end and 
subjected to forces at the 
other end.

After the initial run of 
the model the von Mises 
stress distribution viewed 
from a more convenient 
orientation, is displayed 
in the following figure. 
Change the view to X-Z 
using the Viewing icon.

Geo Panel: Results > PLOT > Stress

Load case number > 1
Component > VON

Layer number > 1
Coordinate system > 0
Stress Flag > Nodal Stress

Face of element > Top Face

Select Contour and Accept Defaults

Examples on Submodeling S
L

Figure  11-27. Model Geometry for the Analysis
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Figure 11-28. von Mises Stress Distribution of the Original Run

To improve the results at the areas of high stress concentrations, four portions 
surrounding the constrained holes are selected by repeated use of SELWIN 
(Control > SELECT > by Windowing) command (see the LSUBM1.GEO file for 
selected elements):

After the element selection is made to define the submodel, use the SUBMODEL 
(Analysis > STATIC > Define SubModel) command to activate submodeling and 
refine the local mesh. Run STAR to solve for the submodel.

Geo Panel: Analysis > STATIC > Define SubModel

Submodeling option > On

Push boundary node flag > No

Geo Panel: Analysis > STATIC > Run Static Analysis

The following figure displays von Mises stress results. Note that you need to 
bring back the rest of the model (not analyzed with the submodel) to visualize 
results on the entire model.

Geo Panel: Control > SELECT > Initialize

Entity name > Elements

... ...
Accept Defaults
COSMOS/M Basic FEA System
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Geo Panel: Results > PLOT > Stress

Load case number > 1
Component > VON

Layer number > 1
Coordinate system > 0
Stress Flag > Nodal Stress

Face of element > Top Face

Select Contour and Accept Defaults

Figure 11-29. von Mises Stress Distribution After Running the Submodel

The maximum von Mises stresses calculated by the submodel shows a modifica-
tion of about 10% over the original run (diagram).

If you deactivate submodeling (use the SUBMODEL (Analysis > STATIC > 
Define SubModel) command to deactivate submodeling) and run the program for 
the entire model it takes more than 20 minutes to complete the job on a 66 Hz, 
486 PC, whereas it takes only 3 minutes to run for the submodel. Time savings 
increase substantially as the problem size becomes larger. More interestingly, the 
maximum von Mises stress obtained in the entire model run (including the 
refined mesh) is almost the same as the one calculated by the submodel. The 
accuracy obtained by the submodel depends on how far are the boundaries of the 
submodel from the stress concentration areas.
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The input for the model of this example is available in the file LSUBM2.GEO. 
The figure below shows von Mises stress distribution of the joint after the initial 
run.

Figure 11-30. von Mises Stresses for the Initial Run

A view along the Y-direction (X-Z plane) is chosen for a better selection of the 
submodel region, using the Viewing icon.

Geo Panel: Control > SELECT > by Windowing

... Select Desired Area ...

(Note: alternatively, you may use the SELRANGE (Control > SELECT > by 
Range) command to select partially through the depth of the model).

Geo Panel: Analysis > STATIC > Define SubModel

Submodeling option > On

Push boundary node flag > No

Geo Panel: Analysis > STATIC > Run Static Analysis

Example LSUBM2 - Using Submodeling with Tetrahedral 
Elements

S
L
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Figure 11-31. Region Selected for Submodeling

The following figure displays the von Mises stresses after running for the sub-
model. You can change the view to isometric by using the Viewing icon.

Geo Panel: Control > SELECT > Initialize

Entity name > Elements

... ...
Accept Defaults

Geo Panel: Results > PLOT > Stress

Load case number > 1
Component > VON

Layer number > 1
Coordinate system > 0
Stress Flag > Nodal Stress

Face of element > Top Face

Select Contour and Accept Defaults
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Figure 11-32. von Mises Stresses for the Submodel

Maximum von Mises stresses are increased form the initial value of 470 psi to 
517 psi after solving for the submodel.

2.908900

517.2600
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The input for this problem is provided to you in the file LSUBM3.GEO. The 
model represents a car dashboard subjected to surface pressure and concentrated 
loads. The figure below shows von Mises stresses after the initial run. To improve 
the results at the lower part of the model, the SELWIN (Control > SELECT > by 
Windowing) command with the circular window option is used to select a circu-
lar area to define the submodel.

Figure 11-33. von Mises Stress for the Initial Run

Geo Panel: Analysis > STATIC > Run Static Analysis

(For initial run ...)

Geo Panel: Control > SELECT > by Windowing

(Select critical area for submodeling)

Geo Panel: Analysis > STATIC > Define SubModel

Submodeling option > On

Push boundary node flag > No

Geo Panel: Analysis > STATIC > Run Static Analysis

(Run analysis on the submodel)

Example LSUBM3 - Using Submodeling for Shell Problems S
L
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Geo Panel: Control > SELECT > Initialize

Entity name > Elements

... ...
Accept Defaults

Geo Panel: Results > PLOT > Stress

Load case number > 1
Component > VON

Layer number > 1
Coordinate system > 0
Stress Flag > Nodal Stress

Face of element > Top Face

Select Contour and Accept Defaults

Figure 11-34. Local von Mises Stresses for the Submodel 
(refined area is the actual submodel)

The maximum von Mises stress increased from the initial value of 2.61E5 psi to 
2.72E5 psi.
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The stresses are reevaluated in the following example on the bases of the redun-
dant forces and moments along a section associated with shell-type structures in 
order to be able to compare them with allowable stresses, Sm, 1.5 Sm and 3 Sm, 
specified by the ASME code section III and in accordance with Gordon, 1976 
(refer to Chapter 2 Mathematical Backgrounds, as well as to Appendix C).

Example ASME.GEO - ASME Code Stress Evaluation

The input for this problem is 
provided to you in file 
ASME.GEO. The stresses are 
evaluated at the two ends of a 
section defined on a cross-sec-
tional slice of an axisymmetric 
nozzle subjected to internal 
pressures according to the 
ASME code stress evalua-
tions. This examples is 
intended to show the general 
use of this capability. However, 
in a typical problem you may 
need to consider several sec-
tions in order to find the maxi-
mum stresses. A section is 
defined by the two nodes at its 
ends. These nodes could be 
defined any where within the 
model and are not confined to 
the FEA mesh (i.e., they do not have to be associated with any elements). To find 
a proper orientation for sections at irregular areas such as in the nozzle to shell 
junctions please refer to Appendix C.

In the following only the commands related to ASME code stress requirement are 
discussed. 

In order to use this option, activate the ASME flag in the A_STRESS (Analysis > 
STATIC > Stress Analysis Options) command:

Example on ASME Stress Requirement S
L

Figure 11-35. A Section Defined 
Through
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Geo Panel: Analysis > STATIC > Stress Analysis Options

AISC code check > No

... ...
ASME code check flag > Yes

Geo Panel: Analysis > STATIC > ASME CODE > Define ASME Section

ASME section > 1
First node > 55

Second node > 75

Number of points > 25

Radius of curvature: 0=plane > 0 axisym -1 straight > -1

Thickness direction bending stress flag > Yes

In the above command, the section is labeled one. You may define up to 300 sec-
tions at different locations of the structure. By the entries for second and third 
prompts, the section is defined at two ends by nodes 55 and 75. By choosing the 
default as 25 points for the fourth prompt, the program is instructed to consider 
only 25 integration points along the section. However, for a section with a very 
large stress gradient you may consider up to 65 points (i.e., you may check stress 
variation by plotting von Mises stresses along the section using the LSECPLOT 
(Results > PLOT > Path Graph) command).

The fifth prompt, “Radius of curvature” indicates whether the computation is 
considered for the plane type of problems (such as plane stress, plane strain or for 
axisymmetric problems approximated by Cartesian formulation) or true axisym-
metric formulation such as the one considered in the present example. If you con-
sider the structure at section 1 to be locally a cylinder with straight walls (inner 
and outer walls), then it is proper to consider the radius of curative to be infinite 
(see Appendix C, Subsection “Axisymmetric Formulation” for definition of the 
curvature-radius). This can be represented as -1 or equivalently a large number 
for that prompt. However, if you want to consider the curvature at the lower part 
of the section, you may do so, by choosing the radius of curvature of the average 
mid-wall centerline which in this model can be approximated to be equal to 2 
inches. 

The last prompt is used to consider or ignore the thickness direction bending 
stresses (see Appendix C for more details). You may use “A_LIST, STRESS” 
(Analysis > List Analysis Option) to check the status of this option as well as 
“ASMESECLIS and ASMESECDEL” (Analysis > STATIC > ASME CODE > List 
ASME Section, Delete ASME Section) to list or delete the sections. After run-
ning the analysis, the results are printed at the end of output file which you may 
compare with the allowable stresses required by the ASME code.
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Since all the computations for the ASME code stresses are performed during the 
stress calculation, you do not need to perform the displacement calculation part of 
the solution, every time you need to rerun for modified or added sections. In that 
case simply reissue the R_STRESS (Analysis > STATIC > Run Stress Analysis) 
command. Furthermore, if you wish to define the section along a path which do 
not coincide with the natural boundary of the element mesh, you may do so by 
first defining two nodes anywhere within the model and then associate them to 
the two ends of the desired section. In addition to the static analysis, the ASME 
code stress evaluation option is also available with the Advanced Dynamic mod-
ule for the time history analysis.
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Thermal effects can be considered in all of the primary load cases and may be 
input directly by the user as nodal temperatures or may be read from a prior heat 
transfer analysis. In the following example the application of both types of ther-
mal loadings is illustrated.

Example TEMP1.GEO - Multiple Thermal Load Cases

The input for this problem is provided to you in file TEMP1.GEO. The model of 
an axisymmetric nozzle is subjected to five different loading environments, each 
represented by a load case as follows:

a. Load case 5:
Concentrated force at the 
tip of the nozzle plus nodal 
temperatures from step 6 of 
a prior transient heat 
transfer analysis.

b. Load case 10:
Nodal temperatures defined 
at certain nodes.

c. Load case 20:
Nodal temperatures defined 
at certain nodes.

d. Load case 30:
Nodal temperatures from 
step 20 of the prior transient 
heat transfer analysis.

e. Load case 40:
Nodal temperatures from 
step 10 of the prior transient 
heat transfer analysis.

Example on the Use of Multiple Thermal Load 
Cases

S
L

Figure  11-36. Axisymmetric Nozzle
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Figure 11-37. Nozzle Heated by Fluid

Assuming the nozzle is heated by a fluid flow with temperature variation as 
shown in the figure above, the first step is to solve the transient heat transfer 
problem using HSTAR or FFE Thermal. To review the commands pertinent to 
thermal part of the problem, refer to the TEMP1.GEO file. After you solve the 
thermal problem, activate the thermal loading flag:

Geo Panel: Analysis > STATIC > Static Analysis Options

Loading flag > T
... ...
Accept Defaults

To define load case number 5:

Geo Panel: Control > ACTIVATE > Set Entity

Set label > LC

Load case set number > 5

(Activate load case 5)

Geo Panel: LoadsBC > STRUCTURAL > FORCE > Define Nodes

Beginning node > 101

Force label > FX: X force

Value > 100

Ending node > 101

Increment > 1

(Apply a nodal force of 100 at node 101)

60

150

300

0.02
0.1

0.12
0.2

Time (HR)

Temp
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Geo Panel: LoadsBC > LOAD OPTIONS > Read Temp as Load

Time step label > 6
Load case number > 5

(Assign temperature profile from time step 6 of heat transfer analysis 
to load case 5)

To define load case number 10:

Geo Panel: Control > ACTIVATE > Set Entity

Set label > LC

Load case set number > 10

(Activate load case 10)

Geo Panel: LoadsBC > THERMAL > TEMPERATURE > Define Nodes

Beginning node > 101

Value > 200

Ending node > 104

Increment > 1

(Define a temperature of 200 at nodes 101 through 104)

To define load case number 20:

Geo Panel: Control > ACTIVATE > Set Entity

Set label > LC

Load case set number > 20

(Activate load case 20)

Geo Panel: LoadsBC > THERMAL > TEMPERATURE > Define Nodes

Beginning node > 101

Value > 400

Ending node > 104

Increment > 1

(Define a temperature of 400 at nodes 101 through 104)

To define load case number 30:

Geo Panel: Control > ACTIVATE > Set Entity

Set label > LC

Load case set number > 30

(Activate load case 30)
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Geo Panel: LoadsBC > LOAD OPTIONS > Read Temp as Load

Time step label > 20

Load case number > 30

(Add the thermal effect from the heat transfer time step 20)

To define load case number 40:

Geo Panel: LoadsBC > LOAD OPTIONS > Read Temp as Load

Time step label > 10

Load case number > 40

(To consider the thermal effect from the heat transfer time step 10)

Once all the load cases are defined, you may run the static analysis by issuing the 
R_STATIC (Analysis > STATIC > Run Static Analysis) command. Postprocess-
ing will be available for all load cases as usual.
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12 Multidisciplinary 
Analysis
Introduction

In COSMOS/M, the pre- and postprocessing module, GEOSTAR, provides a one-
screen solution to all analysis modules. You can build a finite element model and 
perform different types of analysis on the same model within GEOSTAR. In addi-
tion, it is possible to consider the interaction of different analysis modules such 
that the analysis results of one module can be transferred as load to another. This 
type of interaction is very useful for many practical analysis problems. For exam-
ple, you can perform a transient heat transfer analysis using HSTAR, and transfer 
the output as thermal loads to the Basic System using the command TEMPREAD 
(LoadsBC > LOAD OPTIONS > Read Temp as Load). This chapter considers 
the interaction of advanced modules with the Basic System only, and for a com-
plete picture of interactions between various analysis modules of COSMOS/M, 
refer to Chapter 3, Exploring GEOSTAR, of the COSMOS/M User Guide.

The term multidisciplinary analysis in this manual refers to the interaction of 
electromagnetic, heat transfer, nonlinear, and fluid flow analyses with linear 
static, buckling, and modal analysis available in the Basic FEA System. The 
interaction of advanced modules, ESTAR, HSTAR, NSTAR, and FLOWPLUS 
with the STAR and DSTAR modules of the Basic System is unidirectional. You 
need to first perform the required finite element analysis using an advanced anal-
ysis module. After successful completion of the analysis, the results are trans-
ferred using one of the read commands as equivalent mechanical or thermal loads 
to the Basic System for further analysis.
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This chapter presents a detailed discussion on how to perform a multidisciplinary 
analysis in the Basic System. The required commands and procedures are 
explained through examples which include all relevant steps with figures and 
illustrations.

✍ It is also possible to combine the results of advanced dynamics analysis (using 
the ASTAR module) with the results of the Basic System analysis during the 
dynamic analysis or afterward, during the postprocessing.

Multidisciplinary Analysis in COSMOS/M

The interaction of advanced analysis modules with the Basic System is repre-
sented in the figure below. The terms thermoelastic analysis, quasi-static analysis, 
and magnetoelastic analysis, refer to the types of analyses you can perform as a 
result of interaction with the Basic System. In order to perform these analyses, 
you must have the respective advanced modules in addition to the Basic System. 
Note that there is a unidirectional coupling between thermal and electromagnetic 
modules and it is specified using A_MAGNETIC (Analysis > ELECTRO 
MAGNETIC > Analysis Options) or A_THERMAL (Analysis > HEAT 
TRANSFER > Thermal Analysis Options) commands. The temperature results 
can be then moved to the Basic System for thermoelastic analysis. 

Figure 12-1. Interaction of Advanced Analysis Modules with the Basic System

Thermal
 Module 
HSTAR

Thermo-Electric  Coupling

Magnetic 
Nodal Forces
(EMFREAD)

Element Pressure
Loading Due
 to Fluid Flow
 (NPRREAD)

Nodal
Temperatures
(TEMPREAD)

 Basic FEA System
STAR, DSTAR

Electromagnetic
  Module 
ESTAR

 Fluid  Flow 
Module

FLOWPLUS

Nonlinear
 Module 
NSTAR

Note:
ESTAR is discontinued
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This feature can be used to analyze problems such as thermal strains due to Joule 
heating. For frequency and buckling analysis, you may generate the stiffness ma-
trices based on their material nonlinearities by using the NSTAR module. Then, 
using the DSTAR module, you can evaluate the frequency or buckling character-
istics of your model. Use the appropriate flags in A_FREQUENCY (Analysis > 
FREQUENCY/ BUCKLING > Frequency Options) or A_BUCKLING (Analysis 
> FREQUENCY/ BUCKLING > Buckling Options) commands for this purpose. 
See also the NSTAR portion of the Advanced Modules manual for more informa-
tion.

The command TEMPREAD (LoadsBC > LOAD OPTIONS > Read Temp as 
Load) assigns nodal temperatures from a steady state or transient heat transfer 
analysis at a specified time step to load cases of a linear static analysis, whereas 
the command NPRREAD (LoadsBC > LOAD OPTIONS > Read Fluid Pressure) 
applies the pressure calculated by the fluid flow analysis at the given time step 
on the faces of elements associated with the specified curves. The EMFREAD 
(LoadsBC > LOAD OPTIONS > Read Emag Force) command is used for mag-
neto-structural coupling, and it provides the Basic System with the magnetic 
nodal forces. The table below summarizes the functions of these commands and 
the corresponding sections where they are discussed in more detail with exam-
ples. All commands in this table are found in LoadsBC menu, and LOAD 
OPTIONS submenu.

List of Examples
Table  12-1. Commands for Performing Multidisciplinary Analysis

Type of Data 
Transfer to Basic 

System

Command 
(Cryptic)

See Section…

Heat Transfer 
(HSTAR) 

(STAR, DSTAR)
TEMPREAD

Thermoelastic Analysis Using HSTAR and STAR.
See List
Example TEMPR1 - Thermal Stress Analysis of a 
Heat Exchanger. See List

Fluid Flow 
(FLOWPLUS) 

(STAR, DSTAR)
NPRREAD

Quasi-static Stress Analysis using FLOWPLUS 
and STAR. See List

Electromagnetics 
(ESTAR)

 (STAR, DSTAR)

EM_OUTPUT 
EMFREAD

Magnetoelastic Analysis using ESTAR and STAR
See List
Example EM16 - Magnetoelastic Analysis of 
Long Cylinder. See List
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All analysis modules (except the thermal module, HSTAR) write the results of 
analysis into an output file with extension OUT. The results of thermal analysis 
are written to a file with extension TEM. However, the contents of the output files 
are replaced with the results of last performed analysis by default. Therefore, if 
you like to preserve the results output from the previous execution, you need to 
use the PRINT_OPS (Analysis > OUTPUT OPTIONS > Set Print Options) com-
mand.

✍ The input files of examples discussed in this chapter are provided to you in a 
compressed form in the file, PROBLEMS.LZH, installed in the COSMOS/M 
directory. However, it is instructive to practice these examples step by step 
as presented in this chapter.

As mentioned earlier, it is possible to combine the results of an advanced dynam-
ics analysis (using the ASTAR module) with the results of the Basic System anal-
ysis, only during postprocessing. This task can be accomplished using the 
command READ_PDRESP (Read Post-Dyn Response) from the Results menu. 
This command reads displacements and stresses for a specified time step (or fre-
quency) of an advanced dynamic analysis and stores it as a secondary load case 
for postprocessing in the Basic System. The secondary load case can be com-
bined with primary load cases of the Basic System analysis using the command 
LCCOMB (Results > Combine Load Case). The application of the READ_PDRESP 
(Results > Read Post-Dyn Response) command requires the advanced dynamics 
analysis results to be in the same database as that of the Basic System analysis.

The following sections discuss the application of the commands for unidirec-
tional interaction between advanced analysis modules and the Basic System with 
detailed examples.

The thermal module HSTAR can be used to perform linear and nonlinear heat 
transfer analysis of conduction, convection and radiation problems. Irrespective 
of the type of thermal analysis you perform, it is possible to transfer the results 
as thermal loads to the Basic System. The TEMPREAD (LoadsBC > LOAD 
OPTIONS > Read Temp as Load) command associates nodal temperatures from 
a transient heat transfer analysis at a specified time step and to a load case of the 
Basic System. You can specify the time step number of a transient thermal analy-
sis at which nodal temperatures are to be used. For steady state heat transfer prob-
lems, you should consider 1 for the time_step. You may consider up to 50 thermal 

Thermoelastic Analysis Using HSTAR and STAR
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load cases in your analysis. Please refer to Chapter 7, Loads and Boundary Condi-
tions, for more details.

✍ You need to activate the special thermal loading flag using the A_STATIC 
(Analysis > STATIC > Static Analysis Options) command in order to con-
sider thermal loading.

This example (file name, TEMPR1.GEO) deals with thermal stress analysis of a 
heat exchanger consisting of a 30°  pipe section with fins on the outer surface for 
cooling. In the figure below, the material properties as well as the thermal bound-
ary conditions for heat transfer analysis are shown. The figure also shows an 
enlarged view of a fin with varying ambient temperatures. For structural analysis, 
it is assumed that the top and bottom surfaces of the pipe section are fixed, and 
the only loading imposed is thermal, read from heat transfer analysis.

Figure 12-2. Geometry and Thermal Boundary Conditions 
and Loads of the Cooling System

The geometry of the heat exchanger can be easily created by first constructing the 
cross section and sweeping it by an angle of 30°  about the y-axis. The procedure 
used here for building the model is not necessarily the optimum one, as the 
emphasis is to show how the thermal module and the Basic System interact.

Example TEMPR1 - Thermal Stress Analysis of a Heat Exchanger

Temperature  =  80
o

Film  Coefficient  =  0.01

75
o

65
o

o
60

70
o

K  =  1
α   =  0.01
E  = 3E6
ν   =  0.3

Temperature  =  80
o
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To start with, after entering GEOSTAR, establish a working plane as instructed 
below:

Geo Panel:  Geometry > GRID > Plane

Rotation/sweep Axis > Z
Offset on Axis > 0.0

Grid Line Style >Solid

Next, establish keypoints for surfaces and lines using the PT command with coor-
dinates as shown below:

Geo Panel:  Geometry > POINTS > Define

Keypoint > 1
XYZ-coordinate of Keypoint 1 > 25,150,0

Repeat the above command for points 2 through 20 at the following coordinates:

Point No. XYZ Coordinates
2 40,150,0
3 40,140,0
4 35,135,0
5 25,0,0
6 40,0,0
7 40,10,0
8 35,15,0
9 35,75,0
10 55,75,0
11 35,65,0
12 55,65,0
13 35,85,0
14 55,85,0
15 35,95,0
16 55,95,0
17 35,55,0
18 55,55,0
19 35,150,0
20 35,0,0

Use the SCALE (Auto Scale icon) command if necessary to see all keypoints you 
just created. Next, using these keypoints, you need to create three surfaces and 
five lines. The surfaces, when swept about the y-axis, form volumes representing 
the pipe section whereas the lines form the cooling fin surfaces after sweeping. 
The surfaces and lines of the cross section are created as illustrated below:
COSMOS/M Basic FEA System

http://www.cosmosm.com


Part 1   Linear Statics, Modal, and Buckling Analysis
Geo Panel: Geometry > SURFACES > Define by 4 Pt

Surface > 1
Keypoint 1 > 5
Keypoint 2 > 20

Keypoint 3 > 19

Keypoint 4 > 1
Underlying Surface >

Repeat the above command to create surface 2 using keypoints 19,2,3,4 and sur-
face 3 using keypoints 8,7,6,20.

Geo Panel: Geometry > CURVES > Line with 2 Pts

Curve > 13

Keypoint 1 > 15

Keypoint 2 > 16

Repeat the above command to create curve 14 between keypoints 13,14, curve 15 
between 9,10, curve 16 between 11,12, and curve 17 between 17,18.

Clear the screen and change the view to three dimensional one as illustrated 
below. Use the VLSWEEP (Geometry > VOLUMES > GENERATION MENU > 
Sweeping) command to sweep surfaces 1 through 3 about the y-axis, resulting 
in the formation of three volumes. You can next sweep curves 13 through 17 
about the y-axis using the command SFSWEEP (Geometry > SURFACES >
 GENERATION MENU > Sweeping) to form the fin surfaces, as illustrated 
below:

Geo Panel: Geometry > VOLUMES > GENERATION MENU > Sweeping

Beginning surface > 1
Ending surface > 3
Increment > 1
Axis symbol > Y
Angle of the arc > 30

Number of segments > 1

Geo Panel: Geometry > SURFACES > GENERATION MENU > Sweeping

Beginning curve > 13

Ending curve > 17

Increment > 1
Rotation/sweep Axis > Y
Angle of the arc > 30

Number of segments > 1

The volumes representing the pipe section will be meshed with solid elements 
where as the cooling fins are modeled with quadrilateral shell elements; see illus-
tration below:
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Geo Panel: Propsets > Element Group

Element group > 1
Element category > Volume

Element Type (for volume) > SOLID: 8- to 20-node 3D solid element

... Accept Defaults ...

Geo Panel: Meshing > PARAMETRIC MESH > Volumes

Beginning volume > 1
Ending volume > 1
Increment > 1
Number of nodes per element > 8

Number of elements on 1st curve > 3

Number of elements on 2nd curve > 30

Number of elements on 3rd curve > 3

... Accept Defaults ...

Geo Panel: Meshing > PARAMETRIC MESH > Volumes

Beginning volume > 2
Ending volume > 3
Increment > 1
Number of nodes per element > 8

Number of elements on 1st curve > 2

Number of elements on 2nd curve > 3

Number of elements on 3rd curve > 3

... Accept Defaults ...

The elements in the fins will be associated with element group and section con-
stant set number 2:

Geo Panel: Control > ACTIVATE > Set Entity

Set label > RC

Real constant set number > 2

Geo Panel: Propsets > Element Group

Element group > 2
Element category > Area

Element Type (for area) > SHELL4: 4-node thin shell element

... Accept Defaults ...
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Geo Panel: Meshing > PARAMETRIC MESH > Surfaces

Beginning surface > 19

Ending surface > 23

Increment > 1
Number of nodes per element > 4

Number of elements on 1st curve > 4

Number of elements on 2nd curve > 3

... Accept Defaults ...

The nodes at the common boundaries need to be merged in order to satisfy com-
patibility, using the command NMERGE (Meshing > NODES > Merge). The 
NCOMPRESS (Edit > COMPRESS > Nodes) command removes the numbering 
gaps in nodes, resulting from merging operations.

Geo Panel: Meshing > NODES > Merge

Total number of nodes merged = 52

Geo Panel: Edit > COMPRESS > Nodes

Number of Nodes compressed = 52

You can next proceed to defining the thermal boundary conditions. Clear the 
screen and issue ACTNUM,SF,1 (Control > ACTIVATE > Entity Label) and 
SFPLOT (Edit > PLOT > Surfaces) commands to plot surfaces with numbers. 
Zoom-in using the icon on the top and bottom surfaces of the pipe section (sepa-
rately) on which you need to impose a temperature of 80° . As shown in the figure 
below, these surfaces are numbered 6 and 9 at the top, and 4 and 16 at the bottom.

Figure 12-3. Enlarged Views of the Top and Bottom Surfaces of the Pipe
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Select the NTSF (LoadsBC > THERMAL > TEMPERATURE > Define 
Surfaces) command to apply temperatures at all nodes associated with the top 
and bottom surfaces, as illustrated below:

Geo Panel: LoadsBC > THERMAL > TEMPERATURE > Define Surfaces

Beginning surface > 6
Value > 80

Ending surface > 9
Increment > 3

Beginning surface > 4
Value > 80

Ending surface > 16

Increment > 12

Geo Panel: LoadsBC > THERMAL > CONVECTION > Define Elements

Beginning Element > 310

Convection coefficient > 0.01

Ambient temperature > 60

Face number > 5
Ending Element > 366

Increment > 4
Time curve for ambient temperature > 0

Beginning Element > 309

Convection coefficient > 0.01

Ambient temperature > 65

Face number > 5
Ending Element > 365

Increment > 4
Time curve for ambient temperature > 0

Beginning Element > 308

Convection coefficient > 0.01

Ambient temperature > 70

Face number > 5
Ending Element > 364

Increment > 4
Time curve for ambient temperature > 0

Beginning Element > 307

Convection coefficient > 0.01

Ambient temperature > 75
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Face number > 5
Ending Element > 363

Increment > 4
Time curve for ambient temperature > 0

The elements on the cooling fins are numbered from 307 to 366. Each fin has four 
rows of elements corresponding to the four ambient temperatures imposed. You 
can activate the element numbering using the command ACTNUM,EL,1 (Control 
> ACTIVATE > Entity Label) and plot these elements using the command 
EPLOT,307,366 (Edit > PLOT > Elements). Zoom-in on these elements to obtain 
a clear view of the element numbers. The outermost row of elements are num-
bered in such a way that you can apply film coefficients and ambient tempera-
tures on all fins by incrementing the element numbers by 4. The illustration above 
shows the application of film coefficients and ambient temperatures for all fins 
using the CEL (LoadsBC > THERMAL > CONVECTION > Define Elements) 
command. The element face numbers (5 for the top face, as input above) are 
explained in more detail in the Chapter 4, Element Library, of the COSMOS/M 
User Guide. The figure below shows the finite element mesh of the cooling sys-
tem as well as an enlarged view of the fins with convection coefficient defini-
tions.

Figure     12-4. Finite Element Mesh and Enlarged View of the Cooling Fins
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The definition of thermal conductivity and sectional data for the shell elements 
illustrated below, will complete the input for heat transfer analysis:

Geo Panel: Propsets > Material Property

Material property set > 1
Material property name > KX; X Thermal conductivity

Property value > 1

Geo Panel: Propsets > Real Constant

Associated element group > 2
Real constant set > 2

Start loc. of the real const. > 1
No. of real const. to be entered > 6

RC1: Thickness > 0.1

... Accept Defaults ...

Use the command R_THERMAL (Analysis > HEAT TRANSFER > Run Thermal 
Analysis) to perform a steady-state heat transfer analysis. After the analysis is 
successfully executed, the control returns to the GEOSTAR screen. To consider 
thermal loading, you need to associate the results from the thermal steady-state 
analysis with the desired load case using the TEMPREAD (LoadsBC > LOAD 
OPTIONS > Read Temp as Load) command. The commands ACTTEMP and 
TEMPPLOT (Results > PLOT > Thermal) can be successively issued to graphi-
cally view the temperature results that will be considered for the Basic System. 
The thermal loading considered is equivalent to applying nodal temperatures 
from the thermal analysis to all nodes using the NTND (LoadsBC > THERMAL > 
TEMPERATURE > Define Nodes) command. If you activate the input print flag 
using the PRINT_OPS (Analysis > OUTPUT OPTIONS > Set Print Options) 
command, the thermal loading considered will be written to the output file.

Geo Panel: LoadsBC > LOAD OPTIONS > Read Temp as Load

Time step label > 1
Load case number > 1

For thermal stress analysis, the top and bottom surfaces are fixed in all directions 
using the DSF (LoadsBC > STRUCTURAL > DISPLACEMENT > Define 
Surfaces) command. Additional material properties required for stress analysis 
are the elastic modulus and Poisson's ratio, defined as shown below:
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Geo Panel: LoadsBC > STRUCTURAL > DISPLACEMENT > Define 
Surfaces

Beginning surface > 4
Displacement label > ALL; All 6 DOF

Value > 0.0

Ending surface > 16

Increment > 12

Beginning surface > 6
Displacement label > ALL; All 6 DOF

Value > 0.0

Ending surface > 9
Increment > 3

Geo Panel: Propsets > Material Property

Material property set > 1
Material property name > EX: Elasticity modulus 1st dir

Property value > 

Material property name > ALPX: Therm expansion coeff 1st dir

Property value > 0.01

In COSMOS/M, thermal and gravitational loading are treated as special loading 
(see Chapter 7, Loads and Boundary Conditions), as such they need to be acti-
vated using the A_STATIC (Analysis > STATIC > Static Analysis Options) com-
mand before performing an analysis. In addition, using the same command, the 
soft spring option was activated as the element types used in this example have 
incompatible displacement fields. Alternately, you can restrain the θz component 
at any node of a shell element in each fin to provide stability. The addition of soft 
springs (explained in Chapter 2, Mathematical Background) does not significantly 
alter the results. 

Geo Panel: Analysis > STATIC > Static Analysis Options

Loading flag > T: Thermal loading

In-plane effect flag > No

Soft Spring flag > Yes

... Accept Defaults ...

You can now proceed with thermal stress analysis using the command R_STATIC 
(Analysis > STATIC > Run Static Analysis). After the execution is successfully 
completed, you can proceed with postprocessing. Since static stress analysis was 
last performed, it becomes the active analysis type for postprocessing. You can 
postprocess the results of heat transfer analysis by first activating it as illustrated 
below:
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Geo Panel: Results > SET UP > Set Postprocess Type

Analysis type > Thermal

You can plot the temperature contours using the command TEMPPLOT (Results > 
PLOT > Thermal), or list heat transfer analysis results using TEMPLIST (Results 
> LIST > Thermal Results). To view stress analysis results, repeat the ACTPOST 
(Results > SET UP > Set Postprocess Type) command and specify 0 for linear 
static analysis. The commands DEFPLOT (Results > PLOT > Deformed Shape) 
and ACTSTR with STRPLOT (Results > PLOT > Stress) can be used to plot the 
deformed shape and stress contours respectively. The figure below shows the 
deformed shape as well as temperature and stress contours.

Figure 12-5. Temperature Contour, Deformed Shape, and Stress Contour Plots
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Magneto-solid mechanics is the study of the effect of magnetic forces on the 
deformations and stresses of solids. In magnetoelastic analysis, the treatment of 
these effects is linear. The need for magnetoelastic analysis arises from a consis-
tent increase in applications ranging from switches, generators, superconducting 
motors, fusion reactors, magnetic levitation trains, MHD (magnetohydrodynam-
ics) devices, and many others. Using the Basic System, the types of analysis you 
can perform include magnetoelastic stress, and magnetoelastic stability problems.

The observable quantities in magnetoelastic analysis include the displacements 
(u), strains (ε ), stresses (σ), electric current (J), magnetic flux (B), and tempera-
ture (T). The effect of electromagnetic fields on the mechanical behavior include 
(Moon, 1984):

• Change in static stresses due to electromagnetic body forces.
• Generation of angular moments due to body couples.
• Generation of thermal energy due to Joule heating or ferromagnetic 

hysteresis.
• Change in strains due to magnetic fields (magnetostriction).
• Joule-heating-induced thermoelastic strains.

Of the above mentioned effects, only the first one is accessible directly by using 
ESTAR and the Basic System. Note that the generation of thermal energy due to 
Joule heating can be considered by performing a coupled thermo-electric analysis 
in COSMOS/M. The last effect dealing with thermoelastic strains induced due to 
Joule heating can be considered by first performing a coupled thermo-electric 
analysis, and subsequently transferring the results as thermal loading 
(TEMPREAD (LoadsBC > LOAD OPTIONS > Read Temp as Load) command) 
for structural analysis in the Basic System.

Computation of Electromagnetic Forces

In COSMOS/M, there are two approaches to computing electromagnetic forces:

• Lorentz law
• Virtual work method

Magnetoelastic Analysis Using ESTAR and STAR
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The first method which computes Lorentz forces is only applicable for current 
carrying conductors and it is based on the following equation:

(12-1)

where X represents the vector cross product. The virtual work technique can be 
used for obtaining the forces on ferromagnetic solids under externally applied 
field as well as current carrying conductors. The details of this technique are 
rather involved and they can be found in the literature (see Advanced Modules 
Manual). In order to calculate the forces on an object, the user needs to identify 
the region containing the object and assign virtual displacement of a unit value to 
the elements within this object. The rest of the region in the model is assigned a 
virtual displacement of zero (default for magnetic elements). It should be noted 
that the object must be surrounded by a layer of air in order to use this method.

The EM_OUTPUT (Analysis > ELECTRO MAGNETIC > Output Options) com-
mand is used to specify one of the above methods of force calculation before exe-
cuting an analysis using ESTAR. The types of force calculation available are 
Lorentz forces (default), and the computation of forces using the virtual work 
method. 

✍ The Lorentz force calculation is only available for 2D and axisymmetric mod-
els, and the virtual work option is not available for models with 3D 
current sources. 

After the analysis is successfully completed using ESTAR, the electromagnetic 
forces are transferred as nodal point loads to the Basic FEA System (and other 
modules) using the EMFREAD (LoadsBC > LOAD OPTIONS > Read Emag 
Force) command. You need to specify the time step number at which the mag-
netic forces are to be transferred to linear static analysis. The forces transferred 
can be plotted and listed using the commands FPLOT and FLIST (LoadsBC > 
STRUCTURAL > FORCE > Plot, List).

Modeling Hints

The following are some hints you can use in modeling magneto-structural prob-
lems:
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• To start with, the finite element model must consist of only those elements 
which are valid for electromagnetic analysis using ESTAR. The valid element 
types currently supported in the electromagnetic module and their equivalent 
elements in the Basic System are shown below:

• After successful completion of the electromagnetic analysis, delete parts of 
your mesh that are not required for structural analysis. These parts may 
include air gaps, fluids surrounding magnets, and others.

• If the dead loads due to the deleted parts of the mesh are significant and are 
required to be considered in structural analysis, you can approximate and 
define them separately as loads.

• Redefine the element type for the remaining parts of your mesh using the 
equivalent structural element indicated in the above table and make sure the 
element type selected conforms to the existing nodes.

• Use the EMFREAD (LoadsBC > LOAD OPTIONS > Read Emag Force) 
command to transfer electromagnetic forces on the structure. The commands 
FPLOT (LoadsBC > STRUCTURAL > FORCE > Plot) or FLIST (LoadsBC > 
STRUCTURAL > FORCE > List) can be used to plot or list the forces so 
transferred. Note that due to numerical tolerances adopted, you may some 
times see components of forces that are not significant when FPLOT 
(LoadsBC > STRUCTURAL > FORCE > Plot) command is issued for all 
components.

This example (file EM16.GEO) deals with stress distribution in a long thick sole-
noid due to magnetic forces resulting from a uniform distribution of circumferen-
tial current. The solenoid is assumed to be made of isotropic elastic material. 
Since the solenoid is very long, the length in the axial (vertical) direction is 
assumed to be infinite. For convenience, a 0.2 cm length of the cylinder is consid-
ered for analysis as shown in the figure below. To model the infinite length 
effects, the axial displacements are set to zero at the top and bottom faces of the 
model for analysis. It is also assumed that the magnetic field outside the solenoid 
is zero, and the only non-zero component of the magnetic flux is in the axial 

ESTAR Basic System

MAG2D PLANE2D

MAG3D SOLID

TETRA4 TETRA4, TETRA4R

TETRA10 TETRA10

Example EM16 - Magnetoelastic Analysis of a Long Cylinder 
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direction. Dirichlet boundary condition of zero magnetic potentials are imposed 
at the center r = 0, and, at r = 2, the magnetic potentials set to be equal. All other 
boundaries are subjected to Neumann boundary conditions automatically.

Figure 12-6. Geometry of the Solenoid for Magnetoelastic Analysis

After entering GEOSTAR, establish a working plane as instructed below:

Geo Panel:  Geometry > GRID > Plane

Rotation/sweep Axis > Z
Offset on Axis > 0.0

Grid Line Style > Solid

Change the view to XY using the Viewing icon. Next, establish keypoints for cre-
ating surfaces using the PT (Geometry > POINTS > Define) command with coor-
dinates as shown below:

Geo Panel: Geometry > POINTS > Define

Keypoint > 1
XYZ-coordinate of Keypoint 1 > 0,0,0

a = 1 cm
b = 2 cm
t  = 0.2 cm
E = 10.75E11 Dyne/cm
    = 0.33
J = 10 Ab Amp/cm
Relative Permeability = 1

ν
2

2

Air

b
a

t

Model of AnalysisProblem Geometry

J

b

a
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Repeat the above command to create the following keypoints:

Point No. XYZ Coordinates
2 1,0,0
3 1,0.2,0
4 0,0.2,0
5 2,0,0
6 2,0.2,0

Use the SCALE command (or Auto Scale icon) if necessary to clearly see all key-
points you just created. Next, using these keypoints, you need to create two sur-
faces:

Geo Panel: Geometry > SURFACES > Define by 4 Pt

Surface > 1
Keypoint 1 > 1
Keypoint 2 > 2
Keypoint 3 > 3
Keypoint 4 > 4
Underlying surface > 0

Geo Panel: Geometry > SURFACES > Define by 4 Pt

Surface > 2
Keypoint 1 > 2
Keypoint 2 > 5
Keypoint 3 > 6
Keypoint 4 > 3
Underlying surface > 0

The first surface represents the cross section of the air gap, and the second sur-
face represents that of the solenoid. These two surfaces will be modeled using 
one row of elements, with fewer elements in the air gap. 

Geo Panel: Meshing > PARAMETRIC MESH > Surfaces

Beginning surface > 1
Ending surface > 1
Increment > 1
Number of nodes per element > 4

Number of elements on 1st curve > 8
Number of elements on 2nd curve > 1

... Accept Defaults ...
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Geo Panel: Meshing > PARAMETRIC MESH > Surfaces

Beginning surface > 2
Ending surface > 2
Increment > 1
Number of nodes per element > 4

Number of elements on 1st curve > 20

Number of elements on 2nd curve > 1

... Accept Defaults ...

The surface plot and finite element mesh are shown in figure below:

Figure 12-7. Surface and Finite Element Mesh Plots of the Solenoid Model

Activate the label display of curves using the command ACTNUM,CR,1 (Control 
> ACTIVATE > Entity Label) (this can also be done in the status table using 
STATUS1 icon). Clear the screen and plot all curves, using Edit > PLOT > 
Curves.

At r = 0 which corresponds to curve number 3, the magnetic potential is set to 
zero using the command NPCR (LoadsBC > E-MAGNETIC > MAGNETIC 
POTENTIAL > Define by Curves) as shown below:

Geo Panel: LoadsBC > E-MAGNETIC > MAGNETIC POTENTIAL > 
Define by Curves

Beginning Curve > 3
Value > 0
Ending Curve > 3
Increment > 1

Clear the screen and activate node numbers using the ACTNUM (Control > 
ACTIVATE > Entity Label) command. Plot all nodes using NPLOT (Edit > 
COSMOS/M Basic FEA System
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PLOT > Nodes) and zoom-in on the right edge of the finite element model. At 
this edge (r = 2), the magnetic potentials are set to be equal using the command 
MCPDEF (LoadsBC > E-MAGNETIC > CurntSrc/MagCoupling > Define 
Magnetic Coupling) as shown below:

Geo Panel: LoadsBC > E-MAGNETIC > CurntSrc/MagCoupling > Define 
Magnetic Coupling

Pattern 1 Beginning Node > 39

Pattern 1 Ending Node > 39

Pattern 1 Increment > 1
Pattern 2 Beginning Node > 60

Pattern 2 Ending Node > 60

Pattern 2 Increment > 1

Clear the screen and issue SFPLOT (Edit > PLOT > Surfaces) command. The 
solenoid is subjected to a uniform distribution of current which can be applied 
using the command JESF (LoadsBC > E-MAGNETIC > ELEMENT CURRENT 
> Define by Surfaces) on surface 2:

Geo Panel: LoadsBC > E-MAGNETIC > ELEMENT CURRENT > Define 
by Surfaces

Beginning Surface > 2
Value > 10

Ending Surface > 2
Increment > 1

You can now proceed to defining the material properties and element group defi-
nitions as illustrated below:

Geo Panel: Propsets > Material Property

Material property set > 1
Material Property Name > MPERM: Magnetic Permeability

Property value > 1

Geo Panel: Propsets > Element Group

Element Group > 1
Element Name > MAG2D: 2D magnetic element

OP1: 2D Type > Axisymmetric

... Accept Defaults ...
COSMOS/M Basic FEA System 12-21

http://www.cosmosm.com


Chapter 12   Multidisciplinary Analysis

12-22
The magnetic force calculation is specified as shown below:

Geo Panel: Analysis > ELECTRO MAGNETIC > Output Options

Magnetic field info flag 0=No N=steps > 1
Postprocessing info flag > Yes

Force Calc. > Standard

... Accept Defaults ...

Since the units have been specified in CGS units, you need to use the 
A_MAGNETIC (Analysis > ELECTRO MAGNETIC > Analysis Options) com-
mand and use this system of units in analysis. With the finite model completed 
for electromagnetic analysis, you can proceed with analysis after merging nodes 
on the common boundary as illustrated below:

Geo Panel: Meshing > NODES > Merge

Geo Panel: Analysis > ELECTRO MAGNETIC > Analysis Options

Analysis option > S; Magnetostatic

Units > CGS

... Accept Defaults ...

Geo Panel: Analysis > ELECTRO MAGNETIC > Run EMag Analysis

After the electromagnetic analysis is successfully completed, you can postprocess 
various components of results (see Advanced Modules Manual for more infor-
mation). Since the air gap is not required for stress analysis, you can delete the 
elements in surface 1 using the MSFDEL command, MSFDEL,1,1,1; (Edit > 
DELETE > Element on Surface). Ignore warning messages when you delete the 
elements in surface 1. The forces for stress analysis are transferred as follows:

Geo Panel: LoadsBC > LOAD OPTIONS > Read Emag Force

Time step label > 1

You can use the commands FPLOT and FLIST (LoadsBC > STRUCTURAL > 
FORCE > Plot, List) to plot and list the forces transferred from the electromag-
netic analysis. The top and bottom curves of surface 2 are constrained in the 
axial direction (y-axis) for stress analysis as illustrated below:
COSMOS/M Basic FEA System

http://www.cosmosm.com


Part 1   Linear Statics, Modal, and Buckling Analysis
Geo Panel: LoadsBC > STRUCTURAL > DISPLACEMENT > Define by 
Curves

Beginning Curve > 5
Displacement label > UY: Y Translation

Value > 0.0

Ending Curve > 6
Increment > 1

The material properties for stress analysis are appended to material set 1 as fol-
lows:

Geo Panel: Propsets> Material Property

Material property set > 1
Material Property Name > EX: Elasticity modulus in X mat.  dir.

Property value > 10.76E11

Material Property Name > NUXY: XY Poisson’s ratio

Property value > 0.33

For stress analysis, the equivalent element is PLANE2D with the axisymmetric 
modeling option activated as illustrated below:

Geo Panel: Propsets> Element Group

Element group > 1

Element Name > PLANE2D: 2D 4- 8 node plane element

OP1:S/F flag > Solid

OP2:Integr Type > QM6

OP2:Type > Axisymmetric

... Accept Defaults ...

Before performing static stress analysis, you need to use the PRINT_OPS 
(Analysis > OUTPUT OPTIONS > Set Print Options) and A_STRESS (Analysis 
> STATIC > Stress Analysis Options) commands if the results from electromag-
netic analysis need to be preserved in the output file:

Geo Panel: Analysis > OUTPUT OPTIONS > Set Print Options

Displacement Print Interval > 1
... ...
Output Flag > Append
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Geo Panel: Analysis > STATIC > Stress Analysis Options

AISC code check flag > 0
Stress print flag > 0
... Accept Defaults ...

You can now proceed with static stress analysis using the command R_STATIC 
(Analysis > STATIC > Run Static Analysis). You can activate the required com-
ponent of stress using ACTSTR command and plot the stress contours using 
STRPLOT (Results > PLOT > Stress). The figure below shows the von Mises 
stress contours.

Figure 12-8. Von Mises Stress Contours of the Solenoid Model

For a thick long solenoid, the exact solutions for circumferential and radial 
stresses are as follows (Moon, 1984):

(12-2)
COSMOS/M Basic FEA System

http://www.cosmosm.com


Part 1   Linear Statics, Modal, and Buckling Analysis

ELEMENT  STRESS  OUT
NUMBER     NODE  SIGMA

      14
              24     -.390934E+0
              25     -.390934E+0
              46     -.390935E+0
              45     -.390935E+0

          CENTER     -.390935E+
where the constants A and B are computed using the following equations:

(12-3)

In the above equations, a and b are the inner and outer diameters respectively, 
α=a/b, µo is the free space permeability (of air in this case), Jo is the uniform 
current density, and γ  is defined by:

γ  = (1 - 2ν)  / (1 - ν)

Using the above equations, the circumferential stress was computed at r = 1.3 and 
compared against COSMOS/M results. The table below shows the results of this 
comparison.

The COSMOS/M result was obtained from the output file as follows. The coordi-
nate r = 1.3 corresponds to nodes 25 and 46. From the output file (job-
name.OUT), the stress results for element 14 which connects these nodes were 
located. When the PLANE2D element is used in the axisymmetric mode, the cir-
cumferential component of stress is printed under SIGMA-Z header. The result 
indicated in the table above was therefore read from the output file as shown 
below:

Stress
Component

Exact
(Dyne/cm2)

COSMOS/M
(Dyne/cm2)

σθ at r = 1.3 974.07 974.957

PUT
-X   SIGMA-Y             TAU-XY              SIGMA-Z               VON MISES      SIGMA-P+        SIGMA-P-     ANGLE

1 0.339922E+03 0.128491E-05 0.103397E+04 0.915733E+03 0.339922E+03 -.390934E+01   90.000
1 0.320446E+03 0.128491E-05 0.974957E+03 0.863647E+03 0.320446E+03 -.390934E+01   90.000
1 0.320446E+03 0.128491E-05 0.974957E+03 0.863647E+03 0.320446E+03 -.390935E+01   90.000
1 0.339922E+03 0.128491E-05 0.103397E+04 0.915733E+03 0.339922E+03 -.390935E+01   90.000

01 0.330184E+03 0.128491E-05 0.100447E+04 0.889690E+03 0.330184E+03 -.390935E+01   90.000
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13 Non-Axisymmetric Loading 
and Mode Shapes
Introduction

Axially symmetric models with asymmetric loading are usually modeled as three 
dimensional structures. However, a three dimensional problem is often expensive 
to setup and run. That is why axisymmetric elements with asymmetric loading 
options are used. A Fourier series method is used to express the given load as the 
sum of several harmonic component loadings and analysis is done for each load 
component only on a 2D axisymmetric section of the structure, thus reducing the 
size of the problem by several orders of magnitude. According to the principle of 
superposition, the original problem is solved by superposing the solutions of the 
component problems. Thus, the original 3D problem is replaced by a series of 
2D problems.

List of Examples

Static Analysis with Asymmetric Loading. See page 13-9.

Example 1: Static Analysis of a Circular Vessel. See page 13-12.

Example 2: Static Analysis of a Circular Vessel. See page 13-22.

Example 3: Static Analysis of A Nozzle. See page 13-26.

Example 4: Static Analysis of a Nozzle. See page 13-33.

Non-axisymmetric Mode Shape (Frequency) Analysis. See page 13-38.

Example 5: Frequency Analysis of a Circular Vessel. See page 13-40.

Non-axisymmetric Buckling Analysis. See page 13-44.
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Available Models and Capabilities

There are basically two types of elements available in the STAR module of for 
this purpose – the PLANE2D and SHELLAX elements. In a finite element model 
of a solid of revolution (PLANE2D) or a thin-walled shell of revolution 
(SHELLAX), nodes represent circles rather than points. The Shell element is a 
2-noded element whereas the axisymmetric solid has 4 to 8 nodes. The analysis is 
confined to linear elastic models for both isotropic and orthotropic materials. In 
addition to static analysis, mode shape calculation (frequency analysis) at differ-
ent harmonics with or without geometric stiffening is also available for both 
types of elements. For buckling analysis, the program marches from the specified 
minimum harmonic to the maximum harmonic to find the minimum buckling 
load within the specified range of harmonics. The effect of gravity and/or centrif-
ugal loading may be considered only in the axial direction.

Geometric Conventions

In general, displacements and stresses are defined in the global cylindrical coor-
dinates according to Figure 13-1. For displacements, ux corresponds to the radial 
direction, uy corresponds to the axial direction, and uz corresponds to the circum-
ferential direction.

Figure 13-1.
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The results are written to the output file. To display the results graphically, follow 
the following conventions:

1. Displacements: 
The displacements are available in the radial (ux), axial (uy), and circumferen-
tial (uz) directions for the SHELLAX and PLANE2D elements as shown in 
Figure 13-1(a). UX, UY, and UZ are used in GEOSTAR instead of ux, uy, and 
uz respectively.

2. Stresses:
a. For PLANE2D elements, normal stresses are available in the radial (σx), cir-

cumferential (σy) and axial (σz) directions. Shear stresses are defined 
accordingly. Figure 13-1(b) illustrates these components. This convention 
is valid only when the stresses are requested in the global coordinate system 
as specified in the EGROUP command (prior to the execution of the pro-
gram). For stresses requested in the local or element coordinate systems, the 
element cube shown in Figure 13-1 (b) will be rotated about the circumfer-
ential direction accordingly. SX, SY, and SZ are used in GEOSTAR instead 
of σx, σy, and σz respectively.

b. For SHELLAX elements, the stresses are defined in the element coordinate 
system as shown in Figure 13-1(c). These directions differ substantially 
from the directions used for PLANE2D elements.

✍ This difference in the directions of stresses between these two types of ele-
ments should be considered when you compare the results generated from the 
two element types for the same model.

For more detailed description of these results as well as the calculated internal 
forces and moments for SHELLAX elements, please refer to the Element Library 
in the COSMOS/M User’s Guide.

✍ For SHELLAX elements, the stress results are available for both top and 
bottom faces of shell element. You may use the SHADE (Display, 
Display_Options, Shaded Element Plot) command to distinguish the top 
face (red color by default) from the bottom face (blue color by default).
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Load Input

The nodal forces defined in the X-Y plane cross section are considered to be dis-
tributed on the actual 3D model along a circular path (or surface for pressure 
loads). The amplitude of these loads vary in the circular direction as specified by 
the associated curve. 

There are basically two options to define the axisymmetric loads (force/pressure) 
as follows:

1. Direct Load Input: The user defines the loads exactly as they vary along the 
nodal circle (in circumferential direction). When the program is executed, first 
it finds the equivalent Fourier series representing the load, and then proceeds 
to find the response for each harmonic and at the end superposes all the 
harmonic responses to find the actual response. This is the easier and often the 
more convenient of the two types of input available for axisymmetric loading.
Notes:
a. Only those load harmonics within the requested range (specified by the 

A_ASYM (Analysis > STATIC > Asymmetric Load Options) command) 
will be processed. Usually, a few lower harmonics adequately approximate 
most load patterns. More harmonics may be needed to represent loads that 
vary significantly within a small circumferential angle. 

b. The equivalent Fourier series of the direct load input is available in the out-
put file if it is requested by the input flag in the PRINT_OPS (Analysis > 
OUTPUT OPTIONS > Set Print Options) command. Refer to the examples 
at the end of this chapter.

2. Fourier Series Input: This option may be used when the information for load 
vector is in this form or when the load is available essentially applied in the 
harmonic form. Instead of defining the actual load versus circumferential 
angle (direct input), the user may define up to 1000 Cosine and/or Sine 
coefficients of Fourier series. These coefficients are defined for load “F” 
according to:

F(θ) = Po + P1 cos θ + P2 cos 2θ + P3 cos 3θ + P4 cos 4θ + … 
+ q1 sin θ + q2 sin 2θ + q3 sin 3θ + q4 sin 4θ + …

Thus, the response of an axially symmetric body to asymmetric loads can be 
analyzed by superposing component analyses, each of which represents the 
response due to one component of the total load. The Sine terms in the Fourier 
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series are called odd or antisymmetric, as they correspond to antisymmetric 
types of loads. Cosine terms are called even or symmetric as they represent 
symmetrical types of loads, i.e., 

For COSINE: F(θ) = F(–θ)

For SINE: F(θ) = –F(–θ)

Therefore, the user may consider only Cosine terms if the load is symmetric 
relative to the X-Y plane or Sine terms if it is distributed antisymmetrically or 
a combination of both for general types of loads. The following figures illus-
trate the loads represented by various harmonics.

Loads Corresponding to Harmonic 0 (Po term)

This is the case of axially symmetric:

Figure 13-2.
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Loads Corresponding to Harmonic 1

For Cos θ:

Figure 13-3. The Peak Values Occur at θ = 0

For Sin θ:

The above configuration corresponds to Sin θ,  if the loads are rotated + 90°  in 
the circumferential direction θ.

Loads Corresponding to Harmonic 2

For a better visualization of this type of loading, the X-Z plane view of the load-
ing is considered.
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For Cos 2θ:

Figure 13-4.

For Sin 2θ:

The above configuration corresponds to Sin 2θ,  if the loads are rotated 45°  in 
the circumferential direction θ.

Loads in Other Directions

The fundamental loads as displayed in the above figures are in radial, tangential, 
or axial directions. Loads in other directions may be considered by combination 
of loads in these directions. For example, a uniform load in the x-direction can be 
constructed by adding the following two harmonics.

Figure 13-5.
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Command Summary and Description

The following commands are essential for asymmetric loading analysis. They 
provide information on the analysis type, Fourier Sine and Cosine coefficients, 
and asymmetric loads defined as a function of circumferential angle, θ.

A_ASYM (Analysis > STATIC > Asymmetric Load Options)
ACTSET (Control > ACTIVATE > Set Entity)
CURDEF (LoadsBC > FUNCTION CURVE > Time/Temp Curve)
CURLIST (LoadsBC > FUNCTION CURVE > List Time/Temp) 
CURDEL (LoadsBC > FUNCTION CURVE > Delete Time/Temp Curve)

In the following, brief outlines involving the application of specific commands 
required for different analysis options are presented.
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See 
List
In the following, only the commands essential to set up the static analysis of an 
axisymmetric model under asymmetric loading will be listed. The model is 
assumed to have been defined.

1. EGROUP Command:
a. For the PLANE2D element, the asymmetric option must be assigned to acti-

vate the Z-coordinate as an additional Degree of Freedom that will be con-
sidered in the formulation of this element.

b. For the SHELLAX element, no special option is needed to be activated.

2. ANALYSIS Command:
The A_ASYM (Analysis > STATIC > Asymmetric Load Options) command 
specifies that the loading (or mode shapes, in case of Frequency or Buckling) 
will be non-axisymmetric and also it will specify whether the load is being 
applied as an odd or even Fourier expansion and, finally, the circumferential 
angles at which output results for the printing and plotting are desired. This 
command should be issued prior to the ACTSET and CURDEF commands, as 
noted below. Use the “A_LIST, STATIC” (Analysis > List Analysis Option) 
command to list flags for static analysis, including flags related to asymmetric 
loading.

3. ACTSET Command:
This command activates the type of load and the pattern set number. By 
assigning FCOS, FSIN, or FCOEF to the first prompt, the active load type will 
be defined in the form of a Fourier series type (Cosine and/or Sine) or direct 
load input (load versus circumferential angle). The second prompt corre-
sponds to the pattern set number. The user can define up to 25 patterns for a 
Fourier series type and/or 25 patterns for direct load input. The load will be 
assigned to the active pattern set number (see the following example).

4. CURDEF Command:
Defines the load versus circumferential angle or the coefficients of Fourier 
series for different harmonics. These load coefficients are considered as multi-
pliers to the actual loads defined by GEOSTAR “force” or “pressure” com-
mands. Use the CURLIST (LoadsBC > FUNCTION CURVE > List Time/
Temp) command to list the harmonics assigned or use the CURDEL (LoadsBC 
> FUNCTION CURVE > Delete Time/Temp Curve) command to delete any 

Static Analysis with Asymmetric Loading
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curve. Note that only the range of harmonics assigned in the A_ASYM (Analy-
sis > STATIC > Asymmetric Load Options) will be considered in the compu-
tations. The assigned out-of-range coefficients of the CURDEF (LoadsBC > 
FUNCTION CURVE > Time/Temp Curve) command will be ignored. (You 
may use the option for reading the curve values from external files.)
For direct load input (load versus circumferential angle, θ), the range of angle 
θ is -180°  < θ < 180°  for general option (Sine + Cosine terms). However, if 
the load has even or odd characteristics and the Sine option or Cosine option 
is intended to be used, the range of the angle θ (for which the load is to be 
defined) reduces to 0°  < θ < 180° .

5. LISTING Commands:
In addition to the A_LIST (Analysis > List Analysis Option) and CURLIST 
(LoadsBC > FUNCTION CURVE > List Time/Temp) commands already 
mentioned in items 2 and 4, you may list the defined forces or pressures by 
using the FLIST (LoadsBC > STRUCTURAL > FORCE > List) or the PLIST 
(LoadsBC > STRUCTURAL > PRESSURE > List) commands. The first 
listed row for each node or element corresponds to the force or pressure value 
and the second row corresponds to the associated curve number.

6. PRINT_OPS Command:
Activating the “detailed print option” flag of this command provides (in addi-
tion to the regular output) the maximum displacements and stresses of each 
individual harmonic in the output file. These maximum correspond to the 
maximum response of the structure along each circumferential circle.

7. Postprocessing Commands:
a. Cross-sectional Plots

The displacements and stresses for each one of the circumferential angles, 
assigned by the A_ASYM (Analysis > STATIC > Asymmetric Load 
Options) command, are stored as a load case. Use the RESULTS (Results > 
Available Results) command to identify the available load cases, and then 
use the ACTDISP or ACTSTR command to activate the desired load case 
(i.e. circumferential angle). To display the results, use the DISPLOT or 
STRPLOT (Results > PLOT > Displacement, Stress) commands. In addi-
tion, you may use the “list” commands, such as DISPLIST or STRLIST 
(Results > LIST > Displacement, Stress Component) to list the results.
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b. 3D Plots
Displacement, deformation, and stress plots may be plotted over a 3D dis-
play of the model. Results are displayed in the cylindrical coordinate system 
according to coordinate directions defined in Figure 13-1. To be able to gen-
erate 3D plots, you must activate the special element plot flag in the 
SETEPLOT (Meshing > ELEMENTS > Set Element Plot) command and 
activate shading using the SHADE (Display > DISPLAY OPTION > Shad-
ed Element Plot) command. The PSCALE (or Perfect Scaling icon) com-
mand should also be used for scaling. With this setting, all plots will be 
3D based.

The following examples illustrate the use of commands pertinent to the asymmet-
ric loading. Additional examples are included in the verification problem section 
of the manual (problems S79 through S83).
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See 
age 
3-1.
Line forces defined by the “Direct Load Input” option.

Given:

E = 30,000 ksi

r = 10 in

Thickness = 0.1

Poisson Ratio = 0.3

Loads:

Loads are applied in the radial 
direction and are symmetric 
relative to the X–Y plane with 
their variations shown in the 
above figure. Radial loads FR

1 
and FR

2 distributed along the 
circumference have the same 
pattern and the ratio of their amplitudes is fixed for different angles and, as will be 
shown later, they may be represented with the same pattern set. However, FR

3 has 
a different pattern from the other two loads and must be assigned to another pattern 
set. Only the loads in the positive θ have to be defined. Note that the loads in the 

Example 1: Static Analysis of a Circular Vessel p
1

FR (θ) = FR (– θ)

q° FR
1 FR

2 FR3

0
3
6
9

12
15
18
21
24
27
30
31

–20000
–19000
–17800
–16400
–14600
–13000
–11000
–8800
–6400
–3800
–1000

0

–10000
–9500
–8900
–8200
–7400
–6500
–5500
–4400
–3200
–1900
–500

0

–5000
–4400
–3700
–2900
–2000
–1000

0
0
0
0
0
0

Y

Z

X, R

FR
1

FR
2

FR
3

60° 60°

r

Figure  13-6.
COSMOS/M Basic FEA System

http://www.cosmosm.com


Part 1   Linear Statics, Modal, and Buckling Analysis
figure are not drawn to scale. Use Fx in place of radial forces (FR) to model the 
problem.

GEOSTAR Commands
The following commands cover the modeling of the problem.

Geo Panel: Propsets > Element Group
EGROUP,1,SHELLAX,0,0,0,0,0,0,0,

(Defining the element group as SHELL)

Geo Panel: Propsets > Material Property
MPROP,1,EX,3.E7,NUXY,.3,

(Defining the material properties)

Geo Panel: Propsets > Real Constant
RCONST,1,1,1,1,0.1,

(Defining the thickness of SHELL)

Geo Panel: Geometry > GRID > Plane
PLANE,Z,0,1,

Use View icon for X-Y
VIEW,0,0,1,0,

Geo Panel: Geometry > POINTS > Define
PT,1,0,0,0,
PT,2,10,0,0,

Geo Panel: Geometry > CURVES > CIRCLES > Circle in Plane
CRPCIRCLE,1,1,2,10,60.,1,

(Defining the circular geometry of SHELL)

Geo Panel: Meshing > PARAMETRIC MESH > Curves
M_CR,1,1,1,2,30,1,

(Generating 30 elements)

Geo Panel: LoadsBC > STRUCTURAL > DISPLACEMENT > Define 
Nodes

DND,1,ALL,0,1,1,
DND,2,RY,0,31,1,RX,,

(Apply the displacement constraints)

Use Auto Scaling icon
SCALE,0,
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Commands Pertinent to Asymmetric Loading

Geo Panel: Analysis > STATIC > Asymmetric Load Options

Asymmetric loading option >Yes

(Activating the asymmetric type)

Harmonic type > COS

(Considering only Cosine harmonic)
Beginning Harmonic number > 0

(Start from harmonic 0)
Ending Harmonic number > 10

(End at harmonic 10)
Starting angle for output > 0

(Start at 0 circumferential angle for output results)
Ending angle for output > 360

(End at angle 360° )
Increment angle for output > 10

(At intervals of 10° )

You may use the command “A_LIST, STATIC” (Analysis > List Analysis Option) 
to verify your input. In the above, we utilized the symmetrical pattern of loads 
relative to circumferential direction and assigned “Cosine” to avoid unnecessary 
computation for non-existent (or numerically negligible) “Sine” harmonics. 
However, if there is any doubt about the distribution of the load, you may use the 
general option (both Sine and Cosine terms) provided that you define the loading 
along the entire circular path. The number of angles for result output should not 
exceed 50.

Now, we define the first pattern set for loads FR
1 and FR

2: 

Geo Panel: Control > ACTIVATE > Set Entity

Set label > FCOEF: Fourier Cosine Coeff

(Assign the Input Load Option)
Coeff. set > 1

(Pattern set number 1)

Now, we define the load curve pattern:
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Geo Panel: LoadsBC > FUNCTION CURVE > Time/Temp Curve

Curve type > FCOEF: Fourier Cosine Coeff

(Assign “Direct Load Input”)

Curve number > 1

(Pattern set 1)

Start point > 1

(Start from beginning)

Circumf. angle for point 1 > 0
Circumf. load for point 1 > 20000

.

.

.
Circumf. angle for point 10 > 27

(Define the first 10 points on the curve)
Circumf. load for point 10 > 3800

Since CURDEF only allows 10 points to be defined every time it is used, you have 
to repeat the command to define points 11 and 12.

Geo Panel: LoadsBC > FUNCTION CURVE > Time/Temp Curve

Curve type >FCOEF; Fourier Cosine Coeff
Curve number > 1

(For the same set No. 1)
Start point > 11

(Start from point 11)
Circumf. angle for point 11 > 30

Circumf. load for point 11 > 1000

(Define the last 2 points)
Circumf. angle for point 12 > 31

Circumf. load for point 12 > 0

(Refer to the on-line help to read curve values from external files.)

You may use the commands “CURLIST, FCOEF” to verify your input. 

Next, define the radial loads FR
1 and FR

2 with the proper load multipliers –1 and 
–0.5 to account for the negative sign of the load and the differences in the magni-
tudes of the two.
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Geo Panel: LoadsBC > STRUCTURAL > FORCE > Define Nodes

Beginning node > 31

Force label > FX: X Force

Value > -1
Ending node > 31

Increment > 1

(Define the load curve multiplier for FR
1 at node 31)

Geo Panel: LoadsBC > STRUCTURAL > FORCE > Define Nodes

Beginning node > 20

Force label > FX: X Force

Value > -0.5

Ending node > 20

Increment > 1

(Define the load curve multiplier for FR
2 at node 20)

✍ (Note that Fx stands for radial loads in the command structural)

You may use FLIST (LoadsBC > STRUCTURAL > FORCE > List) command to 
verify the latest input.

Now, we have to activate set number two for the third load (FR
3).

Geo Panel: Control > ACTIVATE > Set Entity

Set label > FCOEF: Fourier Cosine Coeff

Coefficient set > 2

(Activate set No. 2)

Defining the load pattern:

Geo Panel: LoadsBC > FUNCTION CURVE > Time/Temp Curve

Curve type > FCOEF: Fourier Cosine Coeff

Curve number > 2

(Define the second curve)
Start point > 1
Circumf. angle for point 1 > 0
Circumf. load for point 2 > 5000

.

.

.
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Circumf. angle for point 7 > 18

Circumf. load for point 7 > 0

Defining the load multiplier for FR
3:

Geo Panel: LoadsBC > STRUCTURAL > FORCE > Define Nodes

Beginning node > 10

Force label > FX: X Force

Value > -1
Ending node > 10

Increment > 1

(Assigns value of –1)

Geo Panel: Analysis > OUTPUT OPTIONS > Set Print Options

Displacement print flag > Yes

... ...
Output flag > Append

(Requesting maximum response at each harmonic)

Geo Panel: Analysis > STATIC > Run Static Analysis

(Evaluate the displacements and stresses and print the results)

Results

1. For displacements and stresses, the output printout contains not only the total 
response at the requested circumferential angles, but also the maximum 
response (displacement and stresses) along the circumferential circle for each 
individual harmonic if it has been requested by the PRINT_OPS (Analysis > 
OUTPUT OPTIONS > Set Print Options) command (see the modeling 
section of this example).

2. In addition to the maximum response along the circumferential circle for each 
node, the maximum among all the nodes is also available in the printout for 
each displacement harmonic as well as for the total displacement.

3. The individual harmonic response helps in finding out the contribution of 
each harmonic to the total response. Therefore, it is a good indicator for the 
termination of higher non-essential harmonics in subsequent runs, resulting in 
less computational efforts.
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4. Bearing in mind the above statement, one may first run the displacement 
analysis only (by suppressing the stress calculation flag in the STRESS 
(Analysis > STATIC > Activate Stress Calc) command, and after reviewing 
the contribution of each harmonic to the total displacement, select a smaller 
range of harmonics (by reissuing the A_ASYM (Analysis > STATIC > 
Asymmetric Load Options) command) and run stresses for the new reduced 
range.

5. You may run stresses for a different range of angles without having to 
recalculate displacements.

6. Displacements and stresses are in element coordinates (see the Geometric 
Convention section of this chapter).

7. You may display the results by using the “display” commands. The results for 
each circumferential angle, specified by the A_ASYM (Analysis > STATIC > 
Asymmetric Load Options) command, is stored in the plot file as a load case.

8. Results may be displayed for the full 3D model as shown below.

9. Use the SHADE command prior to plotting the elements in 3D view for 
SHELLAX element to distinguish the top (red color) surface from the bottom 
surface (blue color). This helps to distinguish the stresses on the two surfaces 
of element.

Postprocessing Using 3D Model

Postprocessing may be performed on a cross-section or on the 3D model. Cross-
section postprocessing is useful in the case of area elements like PLANE2D and 
TRIANG. Postprocessing SHELLAX elements should be processed using the 3D 
model. To activate 3D postprocessing, activate the special element plotting flag 
in the SETEPLOT (Meshing > ELEMENTS > Set Element Plot) command and 
activate shading as follows.

Geo Panel: Meshing > ELEMENTS > Set Element Plot

Element plot order > Linear

Plot beam orientation > No

Special element plot > Yes

Geo Panel: Display > DISPLAY OPTION > Shaded Element Plot
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Deformation Plot

Click on View icon, isometric

Geo Panel: Results > PLOT > Deformed Shape

Click on Auto Scaling icon

Figure 13-7. 3D Deformation Plot

A resolution of 10 degrees in the circumferential direction is used as specified by 
the A_ASYM (Analysis > STATIC > Asymmetric Load Options) command prior 
to running analysis. Refer to figure #1 in Figure 13-1 for the positive direction of 
the circumferential angle.

Displacement Contour Plot
Contour plots are available for plotting at the resolution specified in the A_ASYM 
(Analysis > STATIC > Asymmetric Load Options) command. The following 
commands will generate a contour plot for the displacement in the radial direction. 
Note that SETEPLOT (Meshing > ELEMENTS > Set Element Plot) and SHADE 
(Display > DISPLAY OPTION > Shaded Element Plot) commands must have 
been issued.

Geo Panel: Results > PLOT > Displacement

(For UX in the deformed configuration)

Click on the Auto Scaling icon
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Figure 13-8. Radial Displacement Contour Plot

Stress Plot
Stress results for SHELLAX elements are available in the local element coordinate 
system as specified in Figure 13-1. The following commands generate the hoop 
stress contour plot. Note that SETEPLOT and SHADE must have been issued 
earlier.

Geo Panel: Results > PLOT > Stress

(For SZ element stresses in the deformed configuration)

Click on Auto Scaling icon

Figure 13-9. Hoop Stress Contour Plot
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✍ Stress results for SHELLAX elements are only available in the local element 
coordinate system. Only element stresses are available. The stress values dis-
played between two consecutive angles in the tangential direction correspond 
to the values at the beginning of the interval.

Improving Resolution
You may improve the displayed results by specifying a smaller angle resolution at 
any time and run the stresses without having to run displacements. You may for 
example recalculate the stresses with better resolution between angles 270 and 360 
degrees as follows:

Geo Panel: Analysis > STATIC > Asymmetric Load Options

Asymmetric loading option > Yes

Harmonic type > COS

Beginning Harmonic number > 0
Ending Harmonic number > 10

Starting angle for output > 270

Ending angle for output > 360

Increment angle for output > 2

Geo Panel: Analysis > STATIC > Run Stress Analysis

Figure 13-10 shows the improved Hoop stress contour plot.

Figure 13-10. Improved Hoop Stress Plot

Note that when the stress angle resolution is different than that of displacements, 
then you may not plot stresses on the deformed shape.
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See 
age 
3-1.
Pressure loads defined by the “Direct Load Input” option.

Given:

E = 30,000 ksi

r = 10 in

Thickness = 0.1

Poisson Ratio = 0.3

Loads:

Loads are applied normal to the 
outer surface of the shell, and are 
defined in the above figure (not 
drawn to scale). We only need to 
define one load pattern set for the 
problem. For problems with more 
than one load pattern, the procedure 
is the same as described in the pre-
vious example.

Example 2: Static Analysis of a Circular Vessel p
1

q° P

–150
–135
–120
–105
–90
–75
–60
–45
–30
–15

0
+15
+30
+45
+55

500
1100
1800
2600
3400
4200
5000
5000
4100
3250
2450
1700
1000
350

0

Y

Z

X, R

60°

r

Figure  13-11.
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Contrary to the previous problem, due to the lack of symmetry (in the circumfer-
ential direction), the load along the entire circular path must be defined.

GEOSTAR Commands

Please refer to previous example for descriptions of the commands below.

Geo Panel: Propsets > Element Group
EGROUP,1,SHELLAX,0,0,0,0,0,0,0,

Geo Panel: Propsets > Material Property
MPROP,1,EX,3.E7,NUXY,.3,

Geo Panel: Propsets > Real Constant
RCONST,1,1,1,1,0.1,

Geo Panel: Geometry > GRID > Plane
PLANE,Z,0,1,

Use View icon for X-Y view
VIEW,0,0,1,0,

Geo Panel: Geometry > POINTS > Define
PT,1,0,0,0,
PT,2,10,0,0,

Geo Panel: Geometry > CURVES > CIRCLES > Circle in Plane
CRPCIRCLE,1,1,2,10,60.,1,

Geo Panel: Meshing > PARAMETRIC MESH > Curves
M_CR,1,1,1,2,30,1,

Geo Panel: LoadsBC > STRUCTURAL > DISPLACEMENT > Define 
Nodes

DND,1,ALL,0,1,1,
DND,2,RY,0,31,1,RX,,

Geo Panel: Analysis > OUTPUT OPTIONS > Set Print Options
PRINT_OPS,1,0,0,1,0,1,0,0,0,1,

Use Auto Scaling icon
SCALE,0,
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Commands Pertinent to Asymmetric Loading

Geo Panel: Analysis > STATIC > Asymmetric Load Options

Asymmetric loading option > Yes

(Activating the asymmetric type)

Harmonic type > GEN

(Considering both Sine and Cosine terms)

Beginning Harmonic number > 0

(Start from harmonic 0)
Ending Harmonic number >10

(End at harmonic 10)
Starting angle for output > 0

(Start at 0 circumferential angle)
Ending angle for output > 360

(End at angle 360° )
Increment angle for output > 90

(At intervals of 90° )

In the above command, we have specified that the analysis be performed by con-
sidering both Sine and Cosine harmonic terms (general option). It is also assumed 
that 10 harmonics will be sufficient although, at the end, the user can examine the 
contributions from each harmonic to determine if more or less are required for 
subsequent runs as noted in the previous example.

Geo Panel:  Control > ACTIVATE > Set Entity

Set label > FCOEF: Fourier Cosine Coeff

(Assign the Input Load Option)

Coeff. set > 1

(Assign the load set)

Defining the load curve pattern:

Geo Panel: LoadsBC > FUNCTION CURVE > Time/Temp Curve

Curve type > FCOEF: Fourier Cosine Coeff

Curve number > 1

Start point > 1
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Circumf. angle for point 1 > –150

Circumf. load for point 1 > 500

.

.

.
Circumf. angle for point 10 > –15

Circumf. load for point 10 > 3250

(Define the first 10 points)

Defining the rest of the curve:

Geo Panel: LoadsBC > FUNCTION CURVE > Time/Temp Curve

Curve type > FCOEF: Fourier Cosine Coeff

Curve number > 1

Start point > 11

Circumf. angle for point 11 > 0
Circumf. load for point 11 > 2450

.

.

.
Circumf. angle for point 15 > 55

Circumf. load for point 15 > 0

(Define the last 5 points)

Defining the pressure on the elements at the tip:

Geo Panel: LoadsBC > STRUCTURAL > PRESSURE > Define Element
PEL,29,–50, 1,30,1,4

(Pressure defined on elements 29 and 30)

Geo Panel: Analysis > OUTPUT OPTIONS > Set Print Options
PRINT_OPS,1,0,0,1,0,1,0,0,1,0,

Geo Panel: Analysis > STATIC > Run Static Analysis
R_STATIC

(Evaluate the response and print the results)

For options available for the postprocessing, please refer to the previous example.
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See 
age 
3-1.
Loads defined by “COSINE” Fourier Series.

Figure 13-12.

Given:

E = 30,000 ksi

H = 30 in.

A = 10 in.

B = 5 in.

Poisson Ratio = 0.3

Loads:

Loads are distributed around the tip of the nozzle and are approximated by Fou-
rier series as shown in the above figure. The two radial forces (FR) have the same 
pattern (though different amplitudes), therefore only one pattern is sufficient to 
define both of them (Set 1 in the following commands). However, for axial load 
(FY) it is necessary to define a new pattern (Set 2).

GEOSTAR Commands

The following commands cover the modeling of the problem.

Example 3: Static Analysis of a Nozzle p
1

B

Y
Y

H

X, R

A

FR
1

FR
2

F = -20,000 [ cos(2θ) + 3cos(4θ) + 6cos(5θ) ]

= -10,000 [ 1 + 2cos(θ) + 4cos(2θ) ]

= -30,000 [ 1 + 2cos(θ) + 4cos(2θ) ]
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Geo Panel: Geometry > GRID > Plane
PLANE,Z,0,1,

(Project the X–Y Plane)

Use View icon to set X-Y view
VIEW,0,0,1,0,

Geo Panel: Geometry > CURVES > Draw Polyline
CRSPOLY,1,10,0.,0.,L,10.,30.,0.,L,15.,30.,0.,L,20,0.,0.,L,10.,0.,0.,

Use Scaling icon
SCALE,0,

(Form the boundary of the section)

Geo Panel: Geometry > SURFACES > Define by 2 Cr
SF2CR,1,2,4,0,

(Assign a surface by 2 opposite edges)

Geo Panel: Propsets > Element Group
EGROUP,1,PLANE2D,0,0,3,0,0,0,0,

(Define a PLANE2D element with asymmetric option)

Geo Panel: Propsets > Material Property
MPROP,1,EX,30E6,NUXY,.3,

(Define Material Properties)

Geo Panel: Meshing > PARAMETRIC MESH > Surfaces
M_SF,1,1,1,4,5,8,1,1,

(Generate 4-node elements)

Geo Panel: LoadsBC > STRUCTURAL > DISPLACEMENT > Define 
Curves

DCR,4,ALL,0,4,1

(Constrain bottom end of the nozzle)

Geo Panel: Analysis > OUTPUT OPTIONS > Set Print Options
PRINT_OPS,1,0,0,1,0,1,0,0,1,0,

(Ask for detailed printout)

In the above EGROUP (Propsets > Element Group) command, it is essential to 
activate the asymmetric option for the PLANE2D element (not required for the 
SHELLAX element).
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Commands Pertinent to Asymmetric Loading

Geo Panel: Analysis > STATIC > Asymmetric Load Options

Asymmetric loading option > Yes

(Activating the asymmetric type)

Harmonic type > COS

(Considering only Cosine harmonic)

Beginning Harmonic number > 0

(Start from harmonic 0)
Ending Harmonic number > 5

(End at harmonic 5)
Starting angle for output > 0

(Start at zero circumferential angle for output results)
Ending angle for output > 90

(End at angle 90° )
Increment angle for output > 10

(At intervals of 10° )

You may use the command “A_LIST, STATIC” (Analysis > List Analysis Option) 
to check your input for the A_ASYM (Analysis > STATIC > Asymmetric Load 
Options) command.

Now, we define the first pattern set for loads FR
1 and FR

2:

Geo Panel: Control > ACTIVATE > Set Entity

Set label > FCOS: Fourier Cosine Coeff

COSINE Coeff. set > 1

(Activate COSINE Fourier Series set No. 1 for loads)

Geo Panel: LoadsBC > FUNCTION CURVE > Time/Temp Curve

Curve type > FCOS: Fourier Cosine Coeff

(For COSINE Fourier)

Curve number > 1

(Set Pattern Number 1)

Start point > 1

(Start from the beginning)
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Cosine Harmonic for point 1 > 0

(For Harmonic 0)
Fourier Cosine Coeff. for point 1 > 1

(Define 1 as the coefficient of Harmonic)
Cosine Harmonic for point 2 > 1
Fourier Cosine Coeff. for point 2 > 2

(For Harmonic 1, assign 2 as coeff.)
Cosine Harmonic for point 3 > 2
Fourier Cosine Coeff. for point 3 > 4

(For Harmonic 2, assign 4 as coeff.)

The above command defines pattern 1 for both radial loads (as was mentioned 
earlier in the “load” section of this example).

Geo Panel: LoadsBC > STRUCTURAL > FORCE > Define Nodes
FND,6,FX,–10000.,6,1

(Define a load of –10000 at node 6 in radial direction, FR, as the mul-
tiplier to the current active Set 1)

FND,30,FX,–30000.,30,1,

(Similarly define a radial load of –3000 at node 30 for the same active 
Set 1)

Since the axial load in this example consists of a different harmonic set, we have 
to define a new set:

Geo Panel: Control > ACTIVATE > Set Entity

Set label > FCOS: Fourier Cosine Coeff

COSINE Coeff. set >2

(Active Cosine Fourier set No. 2)

Geo Panel: LoadsBC > FUNCTION CURVE > Time/Temp Curve

Curve type > FCOS: Fourier Cosine Coeff

Curve number > 2

(For Pattern Number 2)

Start point >1
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Cosine Harmonic for point 1 > 2
Fourier Cosine Coeff. for point 1 > 1
Cosine Harmonic for point 2 > 4

(Define the second set for Fourier loads)
Fourier Cosine coeff. for point 2 > 3
Cosine Harmonic for point 3 > 5
Fourier Cosine coeff. for point 3 > 6

You may use the “CURLIST, FCOS” (LoadsBC > FUNCTION CURVE > List 
Time/Temp) command to check your input.

Geo Panel: LoadsBC > STRUCTURAL > FORCE > Define Nodes
FND,1,FY,–20000,1,1

(Define the axial load of –20000 as the multiplier to the active Fourier 
set No. 2 at node 1)

Geo Panel: Analysis > STATIC > Run Static Analysis
R_STATIC

(Evaluate the displacements and stresses and print out the results)

✍ Any harmonic in the range specified by A_ASYM (Analysis > STATIC > 
Asymmetric Load Options), for which there is no load factor, will have zero 
contribution for the total response. For instance, harmonic 3, which is absent 
in both load patterns, has no contribution to total response as can be verified 
in the output file by looking at the results for maximum displacement at har-
monic 3. Also, any harmonic terms of the specified load which are not includ-
ed in the range of computation (specified by the A_ASYM command) will be 
ignored.

Postprocessing Using Cross-Section Display

As mentioned earlier, you may postprocess results in 2D or 3D format. The spe-
cial element plot flag in the SETEPLOT (Meshing > ELEMENTS > Set Element 
Plot) command controls the type of postprocessing. The default is to use 2D post-
processing. You should deactivate the special element plot flag in the SETEPLOT 
command to return to default value if you have activated it earlier. The results are 
available in the element coordinate system.
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Displacement Plot

Results at the circumferential angle 40 degrees are stored under load case 5. To 
display displacements in the tangential direction at 40 degrees:

Geo Panel: Meshing > ELEMENTS > Set Element Plot
SETEPLOT;

Geo Panel: Results > PLOT > Displacement
ACTDIS, 5, UZ,
DISPLOT;

Figure 13-13. Tangential Displacements at 40 Degrees

Stress Plot

Radial stresses at angle 90 (stored in load case 10) can be plotted as follows:

Geo Panel: Results > PLOT > Stresses
ACTSTR, 10, SX;
STRPLOT;
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Figure 13-14. Radial Stresses at 90 Degrees

Postprocessing Using the 3D Display

To be able to view results in 3D, you need to activate the special element plotting 
using the SETEPLOT (Meshing > ELEMENTS > Set Element Plot) command 
and shading has to be activated. You may proceed with generating deformed 
shape plots and displacement and stress contours as has been described in the first 
example in this chapter.
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See 
age 
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Loads defined by COSINE and/or SINE terms of Fourier Series.

Figure 13-15

Given:

E = 30,000 ksi

H = 30 in.

A = 10 in.

B = 5 in.

Poisson Ratio = 0.3

Loads:

In this example, the radial force (FR) consists of both Cosine and Sine terms 
whereas the axial load (FY) consists of only the Sine terms.

GEOSTAR Commands

Commands pertinent to modeling.

Geo Panel: Geometry > GRID > Plane
PLANE,Z,0,1, 

(Project the X–Y Plane)

Example 4: Static Analysis of a Nozzle p
1

B

Y

H

X, R

A

FY = -20,000 [ sin(2θ) + 3sin(4θ) ]

FR = -10,000 [ 2cos(θ) + 4cos(3θ) + 3sin(θ) + 5sin(2θ) ]
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Use View icon to set X-Y view
VIEW,0,0,1,0,

Geo Panel: Geometry > CURVES > Draw Polyline
CRSPOLY,1,10,0.,0.,L,10.,30.,0.,L,15.,30.,0.,L,20,0.,0.,L,10.,0.,0.,

Use Auto Scale icon
SCALE,0,

(Form the boundary of the section)

Geo Panel: Geometry > SURFACES > Define by 2 Cr
SF2CR,1,2,4,0,

(Assign a surface by 2 opposite edges)

Geo Panel: Propsets > Element Group
EGROUP,1,PLANE2D,0,0,3,0,0,0,0,

(Define a PLANE2D element with asymmetric option)

Geo Panel: Propsets > Material Property
MPROP,1,EX,30E6,NUXY,.3,

(Define Material Properties)

Geo Panel: Meshing > PARAMETRIC MESH > Surfaces
M_SF,1,1,1,4,5,8,1,1,

(Generate 4-node elements)

Geo Panel: LoadsBC > STRUCTURAL > DISPLACEMENT > Define 
Curves

DCR,4,ALL,0,4,1,

(Constrain bottom end of the nozzle)

Geo Panel: Analysis > OUTPUT OPTIONS > Set Print Options
PRINT_OPS,1,0,0,1,0,1,0,0,1,0,

(Ask for detailed printout)

As mentioned in the previous example, it is essential to activate the asymmetric 
condition (Option 3) for the PLANE2D element (defined by the EGROUP 
command).

Commands Pertinent to Asymmetric Loading

Geo Panel: Analysis > STATIC > Asymmetric Load Options

Asymmetric loading option > Yes

(Activating the asymmetric type)
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Harmonic type > GEN

(Considering both Sine and Cosine harmonics)

Beginning Harmonic number > 1

(Start from harmonic 1)
Ending Harmonic number > 4

(End at harmonic 4)
Starting angle for output > 0

(Start at zero circumferential angle for output results)
Ending angle for output > 360

(End at angle 360° )
Increment angle for output > 10

(At intervals of 10° )

In the above command, we have instructed the program to analyze from harmonic 
1 to 4 (which covers the entire range of load harmonics) for both Sine and Cosine 
harmonics. The fact that the load FY has no Cosine term assignments causes no 
problems since the program internally assigns zero coefficients for missing load 
harmonics.

(You may use the list command “A_LIST, STATIC” (Analysis > List Analysis 
Option) to check your input.)

Geo Panel: Control > ACTIVATE > Set Entity

Set label > FSIN: Fourier Sine Coeff

SINE Coeff. set > 1

(Activate SINE Fourier Series set No. 1 for axial loads)

Geo Panel: LoadsBC > FUNCTION CURVE > Time/Temp Curve

Curve type > FSIN: Fourier Sine Coeff

(For SINE Fourier)

Curve number > 1

(Set Pattern Number 1)

Start point > 1

(Start from the beginning)

Sine Harmonic for point 1 > 2

(For Sine Harmonic 2)
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Fourier Sine Coeff. for point 1 > 1

(Define 1 as the coefficient of Harmonic)
Sine Harmonic for point 2 > 4
Fourier Sine Coeff. for point 2 >3

(For Harmonic 4, assign 3 as coefficient)

You may use the “CURLIST, FSIN” (LoadsBC > FUNCTION CURVE > List 
Time/Temp) command to check your input.

Geo Panel: LoadsBC > STRUCTURAL > FORCE > Define Nodes
FND,1,FY,–20000,1,1

(Define the axial load of –20000 as the multiplier to the active Fourier 
set No. 1 at node 1)

Now, let us define the radial load (FR):

Geo Panel: Control > ACTIVATE > Set Entity

Set label > FSIN: Fourier Sine Coeff

SINE Coeff. set > 2

(Activate SINE Fourier set No. 2)

Geo Panel: LoadsBC > FUNCTION CURVE > Time/Temp Curve

Curve type > FSIN: Fourier Sine Coeff

(For SINE Fourier)

Curve number > 2

(Set Pattern Number 2)

Start point > 1

(Start from the beginning)

Sine Harmonic for point 1 > 1

(For Sine Harmonic 1)
Fourier Sine Coeff. for point 1 > 

(Define 3 as the Harmonic coefficient)
Sine Harmonic for point 2 > 2
Fourier Sine Coeff. for point 2 > 5

(For Harmonic 2, assign 5 as coeff.)
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Before issuing the force command, we have to define the Cosine part of the Fou-
rier series by first activating the Cosine terms for the same active set (set number 
2).

Geo Panel: Control > ACTIVATE > Set Entity

Set label > FCOS: Fourier Cosine Coeff

COSINE Coeff. set > 2

(Activating the same set number for the Sine terms of radial load)

Geo Panel: LoadsBC > FUNCTION CURVE > Time/Temp Curve

Curve type > FCOS: Fourier Cosine Coeff

(For Cosine Fourier)

Curve number > 2

(Set Pattern Number 2)

Start point > 1

(Start from the beginning)

Cosine Harmonic for point 1 > 1

(For Cosine harmonic 1)
Fourier Cosine Coeff. for point 1 > 2

(Define 2. as the harmonic coeff.)
Cosine Harmonic for point 2 > 3
Fourier Cosine coeff. for point 2 > 4

(For harmonic 3, assign 4. as coeff.)

Geo Panel: LoadsBC > STRUCTURAL > FORCE > Define Nodes

(Define the radial load of –10000 as the multiplier to the active SINE 
and COSINE with the same set No. 2)

Geo Panel: Analysis > STATIC > Run Static Analysis

(Evaluate the displacements and stresses and print out the results)

For proper interpretation of the results, please refer to the notes at the end of the 
first example.

Use the ACTDISP or ACTSTR command in combination with the DISPLOT 
(Results > PLOT > Displacement) or STRPLOT (Results > PLOT > Stresses) 
command to display the results at certain circumferential angles.
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See 
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The frequencies and corresponding mode shapes can be calculated for any speci-
fied harmonic number. The program can evaluate up to 200 mode shapes of the 
structure for the requested harmonic depending on the eigenvalue extraction tech-
nique used. You may use Subspace, Lanczos, Power Inverse techniques for this 
purpose, as well as the frequency shift, Sturm Sequence check, geometric stiffen-
ing, and all other available options of the DSTAR Module of COSMOS/M. The 
mode shapes are evaluated at different circumferential angles along the circum-
ferential direction and are printed in the output file. The Mode Shape evaluation 
is available for both PLANE2D and SHELLAX elements.

The commands essential to set up the asymmetric mode shape computation are 
described below. The model is assumed to have been defined.

1. EGROUP Command:
Similar to the static analysis, the Asymmetric Option must be activated for the 
PLANE2D element (for the SHELLAX element, no additional options are 
required to activate).

2. ANALYSIS Command:
a. Choice of harmonic (Sine or Cosine) is irrelevant here. Use any option.
b. Your choice of harmonic number is specified only by the beginning har-

monic prompt, therefore, the ending harmonic prompt is ineffective here 
(use default).

The prompts for angles are applicable to the results in the output file for writ-
ing and plotting of the mode shapes. To account for geometric stiffening (if 
desired), the load must be applied only in an axisymmetric manner as is done 
for regular static problems (see the following example).
The A_FREQUENCY (Analysis > FREQUENCY/BUCKLING > Frequency 
Options) command specifies the required parameters for eigenvalue solution 
such as the eigenvalue technique, number of mode shapes, frequency shift, in-
plane stiffening effects, and so on. However, the harmonic number input is 
ignored in this case.

Non-Axisymmetric Mode Shape 
(Frequency) Analysis

p
1

COSMOS/M Basic FEA System

http://www.cosmosm.com


Part 1   Linear Statics, Modal, and Buckling Analysis
Stresses can also be evaluated for all mode shapes by issuing the R_STRESS 
(Analysis > STATIC > Run Stress Analysis) command and are available in 
the output file as well as in the plot file for maximum values along the circum-
ferential direction.

3. LISTING Commands:
Use the “A_LIST, FREQ” (Analysis > List Analysis Option) command to list 
general assignments for frequency analysis, including assignments made by 
the A_ASYM (Analysis > STATIC > Asymmetric Load Options) command. 
Use the FLIST (LoadsBC > STRUCTURAL > FORCE > List) or PLIST 
(LoadsBC > STRUCTURAL > PRESSURE > List) command to list applied 
loads in case the geometric stiffening effects are considered.

4. PRINT_OPS Command:
Activating the “detailed print option” flag of this command (with the mode 
shape flag of A_FREQUENCY) instructs the program to print also the maxi-
mum mode shape value along each node circle for every requested mode, oth-
erwise, only the actual mode shapes along nodal circles at requested 
circumferential angles will be printed.

The following example, together with verification problems F25 and F26, illus-
trate the proper use of commands pertinent to the non-axisymmetric mode shape 
calculation.
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Evaluating the first five frequencies 
and mode shapes of the second har-
monic (with geometric stiffening 
effect).

Given:

E = 30,000 ksi

r = 10 in

Poisson Ratio = 0.3

GEOSTAR Commands

The following commands cover the 
modeling of the problem.

Geo Panel: Propsets > Element Group
EGROUP,1,SHELLAX,0,0,0,0,0,0,0,

(Defining the element group as SHELLAX)

Geo Panel: Propsets > Material Property
MPROP,1,EX,3.E7,NUXY,.3,DENS,0.1,

(Defining the material properties)

Geo Panel: Propsets > Real Constant
RCONST,1,1,1,1,0.1,

(Defining the thickness of SHELLAX)

Geo Panel:  Geometry > GRID > Plane
PLANE,Z,0,1,

Use View icon to set X-Y view
VIEW,0,0,1,0,

Geo Panel: Geometry > POINTS > Define
PT,1,0,0,0,
PT,2,10,0,0,

Example 5: Frequency Analysis of a Circular Vessel S
p
1

Y

Z

X, R
60°

r

Figure  13-16.
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Geo Panel: Geometry > CURVES > CIRCLES > Circle in Plane
CRPCIRCLE,1,1,2,10,60.,1,

(Defining the circular geometry of SHELLAX)

Geo Panel: Meshing > PARAMETRIC MESH > Curves
M_CR,1,1,1,2,30,1,

(Generating 30 elements)

Geo Panel: LoadsBC > STRUCTURAL > DISPLACEMENT > Define 
Nodes

DND,1,ALL,0,1,1,
DND,2,RY,0,31,1,RX,,

(Apply the displacement constraints)

Use Auto Scaling icon
SCALE,0,

Geo Panel: Analysis > OUTPUT OPTIONS > Set Print Options
PRINT_OPS,1,0,0,1,0,1,0,0,1,0,

(Requesting maximum response at each harmonic)

Geo Panel: Analysis > FREQUENCY/BUCKLING > Frequency Options
A_FREQ,5,S,16,,,,1,,,,,,,,

(Specifying 5 frequencies and applying Subspace method with 
geometric stiffening effect)

Geo Panel: LoadsBC > STRUCTURAL > FORCES > Define Nodes)
FND,31,FY,100,31,1

(Define an axisymmetric load in axial direction to account for 
geometric stiffening)

Commands Pertinent to Asymmetric Mode Shapes

Geo Panel: Analysis > STATIC > Asymmetric Load Options

Asymmetric loading option > Yes

(Activating the asymmetric type)

Harmonic type > GEN

(Irrelevant; use default)

Beginning Harmonic number > 3

(Consider the second harmonic)
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Ending Harmonic number > 3

(Irrelevant; use default)
Starting angle for output > 0

(Start at 0 circumferential angle for output results)
Ending angle for output > 360

(End at angle 360° )
Increment angle for output >10

Geo Panel: Analysis > FREQUENCY/BUCKLING > Run Frequency

(Perform frequency analysis)

Geo Panel: Analysis > STATIC > Run Stress Analysis

(To evaluate stresses over the mode shapes)

Maximum stresses (along the circumferential direction) for each individual mode 
shape are evaluated and printed. These stress quantities represent the harmonic 
coefficients of each mode which, in reality, correspond to the maximum value of 
the harmonic terms along each circumferential (node) circle.

3D Plots

The resolution in the circumferential direction is controlled by the angle incre-
ment in the A_ASYM (Analysis > STATIC > Asymmetric Load Options) com-
mand. Use the following sequence of commands to plot the first mode shape:

Geo Panel: Meshing > ELEMENTS > Set Element Plot
SETEPLOT, , , 1;

Click on View icon to set isometric view
VIEW, 1, 1, 1, ,

Geo Panel: Results > PLOT > Deformed Shape
DEFPLOT, 1;

Click on Perfect Scale icon
PSCALE;

The third mode may be plotted as follows.

Geo Panel: Results > PLOT > Deformed Shape
DEFPLOT, 3;

Figure 13-17 shows that the first mode along the wall of the vessel (meridian 
direction) is somewhat similar to that of a cantilever beam. In the circumferential 
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direction however the vessel deformed in three distinct modes demonstrating that 
the third harmonic is present. View from the Y-direction (VIEW, 0, 1, 0;) to get a 
better view.

Figure 13-17. First Mode of Third Harmonic

Figure 13-18 shows that the wall of the vessel deforms (in the meridian direction) 
similar to the third mode of a cantilever beam while the three distinct oscillations 
are maintained in the circumferential direction.

Figure 13-18. Third Mode of Third Harmonic
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Buckling analysis of axisymmetric models is limited to cases involving axisym-
metric loads. The program marches through the calculation of buckling loads 
(and modes) incrementing the harmonic number from the specified minimum 
number until the one for which the minimum load value occurs is determined. 
The buckling load factor and the corresponding mode shape (at requested circum-
ferential angles) as well as the maximum mode shape at each circumferential 
node circle are written in the output file.

In the expanded form (requested by the “detailed print option” flag in the 
PRINT_OPS (Analysis > OUTPUT OPTIONS > Set Print Options) command), 
the program considers all harmonics in the requested range and writes all the 
results in the output file.

The program calculates the first numerical eigenvalue of each harmonic which 
corresponds to the lowest buckling load. The actual buckling load is found by 
multiplying the calculated buckling load factor by the applied load.

The commands essential to set up the asymmetric buckling computation are 
described below. The model is assumed to have been defined.

1. EGROUP Command:
Similar to the static analysis, the Asymmetric Option must be assigned for 
PLANE2D element (for the SHELLAX element, no additional options are 
required to activate).

2. ANALYSIS Command:
The A_ASYM (Analysis > STATIC > Asymmetric Load Options) command 
has a similar function as in the case of static analysis, except that:
a. Choice of harmonic number is irrelevant here. Use any option.
b. The beginning and ending harmonics specify the range of harmonics for 

buckling analysis.
The prompts for angles are applicable to the results written in the output files 
for the buckling mode shapes.

Non-Axisymmetric Buckling Analysis p
1
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3. LISTING Commands:
Use the “A_LIST, BUCKL” (Analysis > List Analysis Option) command to list 
general assignments for buckling analysis, including assignments made by the 
A_ASYM command. Use the FLIST or PLIST (LoadsBC > STRUCTURAL > 
FORCE, PRESSURE > List) commands to list the applied buckling loads.

4. PRINT_OPS Command:
Activating the “detailed print option” flag of this command instructs the pro-
gram to calculate the buckling loads (and corresponding mode shapes) for all 
the harmonics specified in the range and print all the results in the output file, 
otherwise, the program stops when the minimum buckling load is found and 
the results will be available only for the corresponding harmonic in the output 
file. Contrary to the static analysis, there is no need for using the ACTSET 
(Control > ACTIVATE > Set Entity) command with options FCOS, FSIN and 
FCOEF, nor is there any need for the CURDEF (LoadsBC > FUNCTION 
CURVE > Time/Temp Curve) command.

Verification problems B14 and B15 illustrate the proper use of commands perti-
nent to the non-axisymmetric buckling mode calculation.

3D Plots

Buckling mode shapes in 3D may be plotted following the same procedure 
described for frequency analysis. The only difference is that all plots correspond 
to the first frequency in the axial direction (meridian direction) and the mode 
shape number prompt (in the DEFPLOT (Results > PLOT > Deformed Shape) 
command) corresponds to the harmonic number (frequency contents in the cir-
cumferential direction).
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14 Large File Managements 
(for STAR and DSTAR)
Introduction

In running large models, there is often the problem of shortage of disk space. To 
overcome this problem, you may direct the program to create and store some of 
the files or even portions of a large file into other drives (directories) where there 
are available disk spaces. Dispersion of files in multiple drives is available prima-
rily for such files as Stiffness, Consistent Mass, and Geometric Stiffness which 
could have unproportionally larger size than other files of the database. This 
option is available for the STAR and DSTAR modules which generate these files. 
However, it is also utilized by ASTAR when reading these files. Basically there 
are three options available to manage the database files as follows. Use the 
SELDIR (Control > MISCELLANEOUS > Select Dir for Partition) command to 
activate these options.

Option 1

This option is used when the general Stiffness, the Geometric Stiffness, and/or 
the Consistent mass files are so large that there is not enough disk space in the 
working directory to store them. If there are other drives available, then each 
one of the above files could be broken to several pieces and each piece could be 
written to a different drive. The size of each piece is automatically computed and 
is proportional to the available disk space in each drive. In addition to the local 
drives, you may take advantage of networking drives as well as removable drives.
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Notes:

1. The Stiffness file and other similar files are structured based on memory 
blocks. A block is the smallest unit in these files and the default size of a block 
is equal to the available RAM (memory). Therefore, every individual file seg-
ment can contain only an exact number of blocks (with no fraction). For 
machines with large RAM (memory), the size of these blocks could be very 
huge, and therefore make it difficult to utilize the available disk spaces to 
accumulate the segmented files conveniently (i.e., when the available disk 
space of a participating drive is smaller than the default size of a block). 
Therefore, in using the SELDIR (Control, Miscellaneous, Select Dir for Par-
tition) command you have the option of reducing the block size in order to 
make the files more manageable.

2. In addition to the mentioned three files (Stiffness, Geometric Stiffness, and 
Consistent mass) there are other temporary files which could be generated 
during the run of the program as a duplicate file in special cases. All these 
files have exactly the same size and will be segmented and generated in the 
requested directories, except for files: ORI.STF, ORI.MAS, and ORI.GST 
which are for the external use by the user (upon request) and are generated 
each in one piece in the current directory. For more description on these files 
and how to generate them in other drives see option 3.

3. The name of Stiffness matrix file for each segment consists of the PROBLEM 
NAME plus an extension “.Sij”, where “ij” is a two digit number correspond-
ing to the segmentation number (for example, the third segment has an exten-
sion in the form of “.S03”). Similarly, the Consistent mass as well as the Geo-
metric stiffness file are segmented to files with extension “.Gij”.

Option 2

This option is similar to option 1, except that the user is able to assign the size of 
each segment. 

Notes:

1. In Option 1, all the segment size allocations are made automatically based on 
the available disk spaces. However, for this option the user should be aware 
(for the accurate estimation of the required drive disk space) of the temporary 
files which will be created by the program in certain situations and will be 
also segmented in the same way. These temporary files, which are deleted 
immediately after the problem is solved, are:
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a. Files with Problem name and extension “.Kij”. The above files (with “ij” 
corresponding to the segment number) are duplicate of geometric stiffness 
files and are generated when one of the following conditions exists in a 
multi-block buckling problem:

 i. There is a frequency shift.

ii. There are nonzero prescribed displacements.

b. Files with problem name and extension “.Uij”. These files are generated 
in the Buckling problems as duplicate of the Geometric stiffness and in the 
frequency problems with Consistent mass option as the duplicate of Mass 
matrix when the Sturm Sequence Check is requested. (Also when in 
frequency problems, Modal Acceleration Method, MAM, flag is on 
together with the Shift flag.)

Option 3

In this option, the user may request generation of certain files in other directories. 
These files will not be segmented to smaller files and the entire files will be cre-
ated at the assigned directories. These files are:

1. Stiffness Matrix file (Extension: .STF)
2. Geometric Stiffness Matrix file (Extension: .ST2)
3. Consistent Mass Matrix file (Extension: .ST2)

There are also similar files for external use which are generated upon request 
(flag in the PRINT_OPT command) and can be transferred to specified directories 
with the following complete names:

4. ORI.STF (Stiffness Matrix)
5. ORI.MAS (Consistent Mass Matrix)
6. ORI.GST (Geometric Stiffness Matrix)

In addition to the above files there are some temporary files which have the same 
size as the above files and are deleted upon the termination of the program run. 
These files can also be transferred to specified directories and their complete 
names are:

7. KLIN.STF

The above file is a duplicate of Geometric Stiffness file and is generated under 
the same conditions explained earlier for files with extension “.Kij” in the Note 
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for Option two. If this file is to be generated, it will be generated in the same 
directory for which the actual Geometric Stiffness file will be generated.

8. TMP.STU

The above file is generated as a duplicate of Geometric Stiffness file and has the 
same function as the files with extension “.Uij” have in the previous options (as 
described earlier). For this file (contrary to the “KLIN.STF file) the user may 
select a specific directory path.

The above eight files have the same size and may be generated in the assigned 
directories (drives).
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Introduction

A brief description for the two commonly used systems of units in structural anal-
ysis is presented in this appendix. These are: the international system of units 
(SI), and the U.S. customary units. In COSMOS/M, you can adopt any system 
of units, including standard and non-standard systems. However, units must be 
consistent and you should remember to interpret the output accordingly. Failure 
to use consistent units could result in incorrect and misleading results.

✍ This appendix presents information about units for analysis using the Basic 
System only. For other types of analysis units, please refer to Appendix B of 
the COSMOS/M User Guide.

International System of Units

The basic units in this system are the units of length, mass and time and are, 
respectively, meter (m), kilogram (kg), and second (s). Other units are derived 
from these basic units. Principal SI units used in structural mechanics are illus-
trated in Table A-1.
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Table  A-1. Principal SI Units Used in Structural Mechanics

Quantity Unit Symbol

Length Meter m

Mass Kilogram kg

Time Second s

Area Square meter m2

Solids volume Cubic meter m3

Liquid volume Liter L = 10-3 m3

Velocity Meter per second m/s

Acceleration Meter per second squared m/s2

Angle Radian rad

Angular velocity Radians per second rad/s

Angular acceleration Radians per second squared rad/s2

Density Kilogram per cubic meter kg/m3

Force Newton N = kg m/s2

Moment of a force Newton-meter N m

Stress and pressure Pascal Pa = N/m2

Frequency Hertz Hz = cycles/s

Impulse Newton-second N s

Work Joule J = N m

Power Watt W = J/s

Thermal conductivity (K)
Watt per meter per degree 
centigrade

W/m ° C

Specific heat (C)
Joule per kilogram per degree 
centigrade

J/kg ° C

Convection film coefficient
Watt per meter squared per 
degree centigrade

W/m2 ° C

Heat generation per source (Q) Watt W

Heat flux (heat generation per area) Watt per meter squared W/m2

Heat generation per unit volume (QE) Watt per cubic meter W/m3
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U.S. Customary System of Units

The basic units in this system are the foot (ft) for length, the pound (lb) for 
weight, and the second (s) for time. The weight (not mass) is a basic system, con-
trary to the SI system. The system is gravitational (and not absolute) since the 
weight of a body depends on the value of the acceleration of gravity. For instance, 
the weight of a body varies slightly on Earth and the same weight on Earth is 
about six times its weight on the moon. The pound is defined as the weight of a 
platinum standard, called the standard pound, at sea level and latitude of 45 
degrees.

While the standard pound is used as a unit of mass in many commercial transac-
tions, it should not be so used in engineering practice. The mass in the U.S. cus-
tomary system is the slug. The slug is defined as the mass which attains a unit 
acceleration (ft/s2) when subjected to a unit force (lb). Principal U.S. customary 
units used in mechanics and their equivalent in the SI system are shown in the 
table below:
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Table  A-2. Conversion Table for U.S. Customary and SI Units

Quantity U.S. Customary Unit SI Equivalent

Length
ft
in.
mi.

0.3048 m
25.40 mm
1.609 km

Area
ft2

in2
0.0929 m2

645.2 mm2

Volume
ft3

in3
0.02832 m3

16.39 cm3

Liquid Volume
gal
qt

3.785 L
0.9464 L

Velocity

ft/s
in/s
mi/h (mph)
mi/h

0.3048 m/s
0.0254 m/s
0.4470 m/s
1.609 km/h

Acceleration
ft/s2

in/s2
0.3048 m/s2

0.0254 m/s2

Mass

oz mass
lb mass
slug
ton

28.35 g
0.4536 kg
14.59 kg
907.2 kg

Force
kip
lb weight
oz weight

4.448 kN
4.448 N
0.2780 N

Moment of a force
lb ft
lb in

1.356 N m
0.1130 N m

Area moment of inertia in4 0.4162 x 106 mm4

Mass moment of inertia lb ft s2 1.356 kg m2

Stress and pressure
lb/ft2

lb/in2 (psi)
47.88 Pa
6.895 kPa

Work or energy ft lb 1.356 J

Impulse or momentum lb s 4.448 N s

Power ft lb/s 1.356 W
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Engineering Prefixes

Multiple and sub multiple units commonly used in engineering practice are 
shown in the table below:

Table  A-3. Common Engineering Prefixes and Symbols

Multiplication Prefix Symbol

1012 tetra T

109 giga G

106 mega M

103 kilo k

102 hekto h

101 deca da

10-1 deci d

10-2 centi c

10-3 milli m

10-6 micro m

10-9 nano n

10-12 pico p

10-15 femto f

10-18 atto a
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Description

Length

Elastic Modulus

Shear Modulus

Poisson's Ratio

Mass Density

Coeff. of Thermal 
Expansion

Material Angle

Anisotropic Material 
Stiffness 

Anisotropic Material 
Compliance 

Piezoelectric Material 
Constants

Dielectric Material 
Constants

Temperature

Translational 
Displacements

Rotational 
Displacements

Forces (nodal)

Moments (nodal)

Pressure

Distributed Beam Load
Consistent Units

Table A-4 shows the proposed consistent units for analysis using the Basic Sys-
tem.

Table  A-4. Consistent Units for Linear Static Analysis

COSMOS Name
*FPS1

(gravitational)
*SI2

(absolute)
*MKS3

(gravitational)
CGS4

(absolute)

Measure

X, Y, Z in m cm cm

Material Properties

EX, EY, EZ lbs/in2 Newton/m2 
or Pascal

kg/cm2 dyne/cm2

GXY, GYZ, GXZ lbs/in2 N/m2 or Pa kg/cm2 dyne/cm2

NUXY, NUYZ, NUXZ in/in (no units) m/m (no units) cm/cm (no units) cm/cm

DENS lbs sec2/in4 kg/m3 kg sec2/cm4 g/cm3

ALPX, ALPY, ALPZ in/(in ° F) m/(m ° K) cm/(cm ° C) cm/(cm ° K)

Beta degree degree degree degree

MC11,…,MC66 
(total of 21 constants)

lbs/in2 Newton/m2 kg/cm2 dyne/cm2

MC11,…,MC66 
(total of 21 constants)

in2/lbs m2/Newton cm2/kg cm2/dyne

PC11,…,PC63 
(total of 18 constants)

---- Volt/m ---- Volt/cm

DC11,…,PC33
 (total of 6 constants)

---- Farad/m ---- 10-13 Farad/cm

Loads and Boundary Conditions

° F ° K ° C ° K

UX, UY, UZ in m cm cm

RX, RY, RZ radians radians radians radians

FX, FY, FZ lbs Newton kg dyne

MX, MY, MZ in lbs m N cm kg cm dyne

P lbs/in2 N/m2 or Pa kg/cm2 dyne/cm2

PB lbs/in N/m kg/cm dyne/cm
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Description

Linear Acceleration

Angular Velocity

Angular Acceleration

Reaction Forces

Reaction Moments

Displacements

Stresses

Strains

* Units are consiste
1 FPS refers to the U
2 SI refers to the In
3 MKS refers to the
4 CGS refers to the
Table  A-4. Consistent Units for Linear Static Analysis (Concluded)

COSMOS Name
*FPS1

(gravitational)
*SI2

(absolute)
*MKS3

(gravitational)
CGS4

(absolute)

Loads and Boundary Conditions (Continued)

ACEL in/sec2 m/sec2 cm/sec2 cm/sec2

OMEGA, CGOMEGA rad/sec rad/sec rad/sec rad/sec

DOMEGA, 
DCGOMEGA

rad/sec2 rad/sec2 rad/sec2 rad/sec2

Results

UX, UY, UZ lbs Newton kg dyne

RX, RY, RZ in lbs m N cm kg cm dyne

UX, UY, UZ, RES in m cm cm

SX, SY, SZ, TXY, 
TYZ, TXZ, P1, P2, P3, 
VON, INT

lbs/in2 N/m2 or Pa kg/cm2 dyne/cm2

EPSX, EPSY, EPSZ, 
GMXY, GMYZ, GMXZ, 
ESTRN

in/in
(no units)

m/m
(no units)

cm/cm
(no units)

cm/cm
(no units)

nt with the COSMOS/M material database.
.S. customary system of units.

ternational system of units.
 Metric system of units.
 French system of units.
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B Summary of Commands
Introduction

This appendix presents a brief description of all commands applicable for per-
forming linear static, buckling, and modal analysis. For a complete description of 
commands, please refer to the COSMOS/M Command Reference Manual.

The format of the descriptions in the following pages is as shown below:

As seen above, all commands are shown in bold characters, and the correspond-
ing menu where these commands can be found (referred to as the command path) 
are separated by horizontal arrows.

Cryptic 
Command Name Command Path Brief Command 

Description

ACEL LoadsBC > STRUCTURAL > 
GRAVITY > Define Acceleration

Define acceleration.

ACTDIS Results > PLOT > Displacement Load the specified 
displacement component 
into the plot buffer.
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Cryptic 
Command Name

ACEL

ACTDIS

ACTPOST

ACTSTN

ACTSTR

ACTUSRPLOT

ADAPTIVE

ANIMATE

ASMESECDEF

ASMESECLIST

ASMESECDEL

AVERAGE

A_BUCKLING

A_FREQUENCY

A_LIST

A_STATIC

A_STRESS
Command Path Brief Command Description

LoadsBC > STRUCTURAL > 
GRAVITY > Define Acceleration

Define acceleration.

Results > PLOT > Displacement Load the specified displacement 
component into the plot buffer.

Results > SET UP > Set Postprocess 
Type

Specify the type of analysis for 
postprocessing.

Results > PLOT > Strain Load the specified strain component into 
the plot buffer.

Results > PLOT > Stress Load the specified stress component into 
the plot buffer.

Display > XY PLOTS > Activate User 
Plot

Activates a user plot for postprocessing.

Analysis > STATIC > Adaptive 
Method

Select (H, P, or HP) methods for static 
analysis.

Results > PLOT > Animate Animate the deformations and mode 
shapes of structures.

Analysis > STATIC > ASME CODE > 
Define ASME Section

Specify a section for stress evaluation 
according to ASME code.

Analysis > STATIC > ASME CODE > 
List ASME Section

List the specified ASME sections.

Analysis > STATIC > ASME CODE > 
Delete ASME Section

Delete the specified ASME sections.

Results > Average Nodal Stress Specify the procedure to calculate average 
nodal stresses.

Analysis > FREQUENCY/BUCKLING 
> Buckling Options

Specify details for the buckling analysis.

Analysis > FREQUENCY/BUCKLING 
> Frequency Options

Specify details for the frequency analysis.

Analysis > List Analysis Option List active options for various types of 
analyses.

Analysis > STATIC > Static Analysis 
Options

Specify details of analysis for the static 
module.

Analysis > STATIC > Stress Analysis 
Options

Specify details of analysis for the stress 
module.
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Cryptic 
Command Name

BEAMRESLIS

BEAMRESMAX

BMSECDEF

BMSECLIST

BONDDEF

CGLOC

CGOMEGA

CPCNS

CPCNSDEL

CPCNSLIST

CPDOF

CPDOFDEL

CPDOFLIST

CPDOFPLOT

CPEQN

CPEQNDEL

CPEQNLIST
Command Path Brief Command Description

Results > LIST > Beam End Force List the nodal forces, moments and 
stresses for beam elements.

Results > EXTREMES > Beam End 
Force

List the extreme nodal forces and stresses 
for beam elements.

Propsets > Beam Section Define standard beam cross section 
dimensions and real constants.

Edit > LIST > Beam Sections Delete standard beam sections and the 
associated real constants.

LoadsBC > STRUCTURAL > 
BONDING > Define Bond Parameter

Bond various types of structural elements.

LoadsBC > STRUCTURAL > 
GRAVITY > Orig of Inertial Sys

Define the origin of the inertial reference 
frame.

LoadsBC > STRUCTURAL > 
GRAVITY > Avg. Vel. of GL CS

Define angular velocity of the global 
Cartesian system.

LoadsBC > STRUCTURAL > 
COUPLING > Define Constraint Set

Define a point-to-(point, curve, or surface) 
constraint.

LoadsBC > STRUCTURAL > 
COUPLING > Delete Constraint Set

Delete point-to-(point, curve, or surface) 
constraints.

LoadsBC > STRUCTURAL > 
COUPLING > List Constraint Set

List point-to-(point, curve, or surface) 
constraints defined using the CPCNS 
command.

LoadsBC > STRUCTURAL > 
COUPLING > Define DOF Set

Define a pattern of coupled degrees of 
freedom.

LoadsBC > STRUCTURAL > 
COUPLING > Delete DOF Set

Delete sets of coupled degrees of freedom.

LoadsBC > STRUCTURAL > 
COUPLING > List DOF Set

List coupled degrees of freedom.

LoadsBC > STRUCTURAL > 
COUPLING > Plot DOF Set

Plot defined coupled degrees of freedom.

LoadsBC > STRUCTURAL > 
COUPLING > Define Constraint Eq.

Define a constraint equation.

LoadsBC > STRUCTURAL > 
COUPLING > Delete

Delete coupling equations.

LoadsBC > STRUCTURAL > 
COUPLING > List Constraint Eq.

List coupling equations defined using the 
CPEQN command.
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Cryptic 
Command Name

CPEQNVAL

CRACK

CRACKDEL

CRACKLIST

CURDEF

CURDEL

CURLIST

DATA_CHECK

DCDEL

DCGOMEGA

DCR

DCT

DCTDEL

DEFPLOT

DISLIST

DISMAX

DISPLOT

DLIST
Command Path Brief Command Description

LoadsBC > STRUCTURAL > 
COUPLING > Constr Eq. Constant

Define the right hand side of a constraint 
equation.

Analysis > STATIC > CRACK > 
Define Crack

Define a crack set and specifies the 
corresponding nodes.

Analysis > STATIC > CRACK > 
Delete Crack

Delete a pattern of crack sets.

Analysis > STATIC > CRACK > List 
Crack

List a pattern of crack sets and the 
associated nodes.

LoadsBC > FUNCTION CURVE > 
Time/Temp Curve

Define (time, temperature, or B-H) curves.

LoadsBC > FUNCTION CURVE > 
Delete Time/Temp Curve

Delete a pattern of previously defined 
curves.

LoadsBC > FUNCTION CURVE > 
List Time/Temp

List previously defined curves.

Analysis > Data Check Check element groups, material and real 
constant sets. 

LoadsBC > STRUCTURAL > 
DISPLACEMENT > Delete Curves

Delete displacements at all nodes 
associated with a curve(s).

LoadsBC > STRUCTURAL > 
GRAVITY > Ang. Acc. of GL CS

Define angular acceleration of the global 
Cartesian system.

LoadsBC > STRUCTURAL > 
DISPLACEMENT > Define Curves

Specify displacements at nodes associated 
with curves.

LoadsBC > STRUCTURAL > 
DISPLACEMENT > Define Contours

Specify displacements at nodes associated 
with contours.

LoadsBC > STRUCTURAL > 
DISPLACEMENT > Delete Contours

Delete displacements at all nodes 
associated with a contour(s).

Results > PLOT > Deformed Shape Load and plot the deformed configuration.

Results > LIST > Displacement Displacement components.

Results > EXTREMES > Min/Max 
Displacement

List the extreme values of displacements.

Results > PLOT > Displacement Plot the displacement component loaded 
into plot buffer.

LoadsBC > STRUCTURAL > 
DISPLACEMENT > List

List prescribed nodal displacements on the 
screen.
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Cryptic 
Command Name

DND

DNDEL

DOMEGA

DPDEL

DPLOT

DPT

DRDEL

DRG

DSDEL

DSF

EGDEL

EGLIST

EGROUP

EMFREAD

EM_MODEL

EM_OUTPUT

EPROPCHANGE

EPROPSET
Command Path Brief Command Description

LoadsBC > STRUCTURAL > 
DISPLACEMENT > Define Nodes

Specify displacements at a pattern of 
nodes.

LoadsBC > STRUCTURAL > 
DISPLACEMENT > Delete Nodes

Delete prescribed displacements at a 
pattern of nodes.

LoadsBC > STRUCTURAL > 
GRAVITY > Angular Acceleration

Define angular acceleration.

LoadsBC > STRUCTURAL > 
DISPLACEMENT > Delete Points

Delete displacements at nodes associated 
with keypoints.

LoadsBC > STRUCTURAL > 
DISPLACEMENT > Plot

Plot prescribed nodal displacements on the 
screen.

LoadsBC > STRUCTURAL > 
DISPLACEMENT > Define Points

Specify displacements at nodes associated 
with keypoints.

LoadsBC > STRUCTURAL > 
DISPLACEMENT > Delete Regions

Delete displacements at all nodes 
associated with a region(s).

LoadsBC > STRUCTURAL > 
DISPLACEMENT > Define Regions

Specify displacements at nodes associated 
with regions.

LoadsBC > STRUCTURAL > 
DISPLACEMENT > Delete Surfaces

Delete displacements at all nodes 
associated with a surface(s).

LoadsBC > STRUCTURAL > 
DISPLACEMENT > Define Surfaces

Specify displacements at nodes associated 
with surfaces.

Edit > DELETE > Element Groups Delete element groups from the database.

Edit > LIST > Element Groups List defined element groups on the screen.

Propsets > Element Group Define an element group.

LoadsBC > LOAD OPTIONS > Read 
EMag Force

Enable magneto-structural coupling.

Analysis > ELECTRO MAGNETIC > 
Conductor Model

Specify stationary or uniformly moving 
conductors.

Analysis > ELECTRO MAGNETIC > 
Output Options

Control the printing intervals of results. 

Propsets > Change El-Prop Change the property set association for 
elements.

Propsets > New Property Set Assign attributes to elements generated 
from existing ones.
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Cryptic 
Command Name

FCDEL

FCR

FCT

FCTDEL

FLIST

FLOWLIST

FLOWMAX

FLOWPLOT

FLOWPROP

FND

FNDEL

FPDEL

FPLOT

FPT

FRDEL

FREQLIST

FRG

FSDEL
Command Path Brief Command Description

LoadsBC > STRUCTURAL > 
FORCE > Delete Curves

Delete forces at all nodes associated with a 
curve(s).

LoadsBC > STRUCTURAL > 
FORCE > Define Curves

Specify forces at all nodes associated with 
a curve(s).

LoadsBC > STRUCTURAL > 
FORCE > Define Contours

Specify forces at all nodes associated with 
a contour(s).

LoadsBC > STRUCTURAL > 
FORCE > Delete Contours

Delete forces at all nodes associated with a 
contour(s).

LoadsBC > STRUCTURAL > 
FORCE > List

List prescribed nodal forces on the screen.

Results > LIST > Flow Result List the quantities related to a fluid flow 
analysis.

Results > EXTREMES > Min/Max 
Flow

List the extreme values of flow 
components.

Results > PLOT > Fluid Flow Plot the flow component loaded into the 
plot buffer.

Results > LIST > Flow Properties List film coefficient and mass flow rate.

LoadsBC > STRUCTURAL > 
FORCE > Define Nodes

Specify forces at a pattern of nodes.

LoadsBC > STRUCTURAL > 
FORCE > Delete Nodes

Delete forces at a pattern of nodes.

LoadsBC > STRUCTURAL > 
FORCE > Delete Points

Delete forces at nodes associated with 
keypoints.

LoadsBC > STRUCTURAL > 
FORCE > Plot

Plot prescribed nodal forces on the screen.

LoadsBC > STRUCTURAL > 
FORCE > Define Points

Specify forces at nodes associated with 
keypoints.

LoadsBC > STRUCTURAL > 
FORCE > Delete Regions

Delete forces at all nodes associated with a 
region(s).

Results > LIST > Natural Frequency List the natural frequencies of the model.

LoadsBC > STRUCTURAL > 
FORCE > Define Regions

Specify forces at all nodes associated with 
a region(s).

LoadsBC > STRUCTURAL > 
FORCE > Delete Surfaces

Delete forces at all nodes associated with a 
surface(s).
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Cryptic 
Command Name

FSF

GRVLIST

IDRESULT

INITXYPLOT

ISOPLOT

J_INTCRDEF

J_INTCRDEL

J_INTCRLIST

J_INTCRPLOT

LCCOMB

LCLIST

LCSET

LSECPLOT

MAKE_CYCLIC

MASSPROP

MPDEL

MPLIST

MPROP

NTCDEL
Command Path Brief Command Description

LoadsBC > STRUCTURAL > 
FORCE > Define Surfaces

Specify forces at all nodes associated with 
a surface(s).

LoadsBC > STRUCTURAL > 
GRAVITY > List Gravity Load

List components of gravity and centrifugal 
loading.

Results > PLOT > Identify Result Display the location and the value of the 
plotted quantity.

Display > XY PLOTS > Initialize Restore the default settings for x-y plots.

Results > PLOT Plots isoplanes for postprocessing quantity.

Analysis > STATIC > J_Integral Curve 
> Define Curve

Define J_ Integral paths.

Analysis > STATIC > J_Integral Curve 
> Delete Curve

Delete J_ Integral paths.

Analysis > STATIC > J_Integral Curve 
> List Curve

List J_ Integral paths.

Analysis > STATIC > J_Integral Curve 
> Plot Curve

Plot J_ Integral paths.

Results > Combine Load Case Combine the response of desired load 
cases.

Analysis > STATIC > List Load Case List load cases.

Analysis > STATIC > Activate Load 
Case

Activate load cases for static analysis.

Results > PLOT > Path Graph Plot path variation graphs of post-
processing quantity.

LoadsBC > FUNCTION CURVE > 
Repeat Time/Temp

Repeat a pattern of (time, temperature, or 
B-H) curves.

Control > MEASURE > Find Mass 
Property

List mass property information for a pattern 
of elements.

Edit > DELETE > Material Props Delete material property sets from the 
database.

Edit > LIST > Material Props List defined material property sets on the 
screen.

Propsets > Material Property Define a material property set.

LoadsBC > THERMAL > 
TEMPERATURE > Delete Curves

Delete temperatures at all nodes 
associated with a curve(s).
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Cryptic 
Command Name

NTCR

NTCT

NTCTDEL

NTLIST

NTND

NTNDEL

NTPDEL

NTPLOT

NTPT

NTRDEL

NTRG

NTSDEL

NTSF

NTVDEL

NTVL

OMEGA

PBEDEL
Command Path Brief Command Description

LoadsBC > THERMAL > 
TEMPERATURE > Define Curves

Specify a temperature at all nodes 
associated with a curve(s).

LoadsBC > THERMAL > 
TEMPERATURE > Define Contours

Specify a temperature at all nodes 
associated with a contour(s).

LoadsBC > THERMAL > 
TEMPERATURE > Delete Contours

Delete temperatures at all nodes 
associated with a contour(s).

LoadsBC > THERMAL > 
TEMPERATURE > List

List prescribed nodal temperatures.

LoadsBC > THERMAL > 
TEMPERATURE > Define Nodes

Specify a temperature at a pattern of 
nodes.

LoadsBC > THERMAL > 
TEMPERATURE > Delete Nodes

Delete prescribed temperatures at a 
pattern of nodes.

LoadsBC > THERMAL > 
TEMPERATURE > Delete Points

Delete temperatures at nodes associated 
with keypoints.

LoadsBC > THERMAL > 
TEMPERATURE > Plot

Plot a symbol at nodes with specified 
temperatures.

LoadsBC > THERMAL > 
TEMPERATURE > Define Points

Specify a temperature at nodes associated 
with keypoints.

LoadsBC > THERMAL > 
TEMPERATURE > Delete Regions

Delete temperatures at all nodes 
associated with a region(s).

LoadsBC > THERMAL > 
TEMPERATURE > Define Regions

Specify a temperature at all nodes 
associated with a region(s).

LoadsBC > THERMAL > 
TEMPERATURE > Delete Surfaces

Delete temperatures at all nodes 
associated with a surface(s).

LoadsBC > THERMAL > 
TEMPERATURE > Define Surfaces

Specify a temperature at all nodes 
associated with a surface(s).

LoadsBC > THERMAL > 
TEMPERATURE > Delete Volumes

Delete temperatures at all nodes 
associated with a volume(s).

LoadsBC > THERMAL > 
TEMPERATURE > Define Volumes

Specify a temperature at all nodes 
associated with a volume(s).

LoadsBC > STRUCTURAL > 
GRAVITY > Angular Velocity

Define angular velocity.

LoadsBC > STRUCTURAL > 
PRESSURE > Delete Beam Elem 
Load

Delete beam element loading.
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Cryptic 
Command Name

PBEL

PBELIST

PCDEL

PCR

PEDEL

PEL

PICK_MAT

PICK_SEC

PLIST

PPLOT

PRDEL

PRG

PRINT_ELSET

PRINT_NDSET

PRINT_OPS

PSDEL

PSF
Command Path Brief Command Description

LoadsBC > STRUCTURAL > 
PRESSURE > Define Beam Elem 
Load

Specify beam element loading.

LoadsBC > STRUCTURAL > 
PRESSURE > List Beam Elem Load

List beam element loading.

LoadsBC > STRUCTURAL > 
PRESSURE > Delete Curves

Delete pressure on all elements associated 
with a curve(s).

LoadsBC > STRUCTURAL > 
PRESSURE > Define Curves

Specify pressure on all elements 
associated with a curve(s).

LoadsBC > STRUCTURAL > 
PRESSURE > Delete Elements

Delete pressure on a pattern of elements.

LoadsBC > STRUCTURAL > 
PRESSURE > Define Elements

Specify pressure on elements.

Propsets > Pick Material Lib Pick a material from the COSMOS/M 
material library.

Propsets > AISC Sect. Table Pick a standard section from the AISC 
tables.

LoadsBC > STRUCTURAL > 
PRESSURE > List

List prescribed pressures on the screen.

LoadsBC > STRUCTURAL > 
PRESSURE > Plot

Plot prescribed pressures on the screen.

LoadsBC > STRUCTURAL > 
PRESSURE > Delete Regions

Delete pressure on all elements associated 
with a region(s).

LoadsBC > STRUCTURAL > 
PRESSURE > Define Regions

Specify pressure on all elements 
associated with a region(s).

Analysis > OUTPUT OPTIONS > 
Set Element Range

Define groups of elements for stress 
evaluation.

Analysis > OUTPUT OPTIONS > 
Set Nodal Range

Define groups of nodes for results 
evaluation.

Analysis > OUTPUT OPTIONS > 
Set Print Options

Control writing of results to the output file.

LoadsBC > STRUCTURAL > 

PRESSURE > Delete Surfaces
Delete pressure on all elements associated 
with a surface(s).

LoadsBC > STRUCTURAL > 

PRESSURE > Define Surfaces
Specify pressure on all elements 
associated with a surface(s).
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B-10

Cryptic 
Command Name

RCDEL

RCLIST

RCONST

REACTION

RESULTS?

R_BUCKLING

R_CHECK

R_FREQUENCY

R_STATIC

R_STRESS

SECPLOT

SELDIR

SELDIRLIST

SETERASE

SETPLOT

SETXYPLOT

SMLIST

SMMAX
Command Path Brief Command Description

Edit > DELETE > Real Constants Delete real constant sets from the 
database.

Edit > LIST > Real Constants List defined real constant sets on the 
screen.

Propsets > Real Constant Define a real constant set.

Analysis > Reaction Request reaction forces computation at all 
nodes.

Results > Available Result Results for postprocessing.

Analysis > FREQUENCY/BUCKLING 
> Run Buckling

Perform buckling analysis.

Analysis > Run Check Check element's connectivity, aspect ratio, 
and other element attributes.

Analysis > FREQUENCY/BUCKLING 
> Run Frequency

Calculate natural frequencies and mode 
shapes.

Analysis > STATIC > Run Static 
Analysis

Run linear static analysis.

Analysis > STATIC > Run Stress 
Analysis

Perform stress analysis for linear static 
problems.

Results > PLOT Plot sections of postprocessing quantity.

Control > MISCELLANEOUS > Select 
Dir for Partition

Define allocation of disk space for large 
problem.

Control > MISCELLANEOUS > List 
Dir for Partition

List disk allocation space for large problem.

Results > SET UP > Set Clear Screen 
Options

Provide the option to clear screen before 
new plots.

Results > SET UP > Color/Value 
Range

Set the plot type and specify extreme 
values.

Display > XY PLOTS > Set Plot 
Parameter

Set flags and parameters for x-y plots.

Results > LIST > Shear/Moment 
Value

List the shearing forces and bending 
moments for beam elements.

Results > EXTREMES > Shear/
Moment

List the extreme forces (over full length) for 
beam elements.
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Cryptic 
Command Name

SMPLOT

SPDEL

SPELE

SPLIST

SPROT

SPSTR

STNLIST

STNMAX

STNPLOT

STRAIN_OUT

STRESS

STRLIST

STRMAX

STRPLOT

SUBMODEL

TEMPREAD
Command Path Brief Command Description

Results > PLOT > Shear Diagram Plot shear and moment diagrams for beam 
elements.

Analysis > STATIC > 
SUBSTRUCTURE > Delete Super 
Element

Delete super elements from the database.

Analysis > STATIC > 
SUBSTRUCTURE > Define Super 
Element

Define connectivity for a super element.

Analysis > STATIC > 
SUBSTRUCTURE > List Super 
Element

List super elements and their super nodes.

Analysis > STATIC > 
SUBSTRUCTURE > Rotate Super 
Element

Rotate a super element in the global 
Cartesian system.

Analysis > STATIC > 
SUBSTRUCTURE > Set SubStr 
Analysis

Create super elements and defines type of 
analysis.

Results > LIST > Strain Component List the strain components.

Results > EXTREMES > Min/Max 
Strain

List the extreme values of strains.

Results > PLOT > Strain Plot the strain component previously 
loaded into plot buffer.

Analysis > OUTPUT OPTIONS > Set 
Strain Output

Control writing of strain components in the 
output file. 

Analysis > STATIC > Activate Stress 
Calc

Activate stress calculations in the static 
module.

Results > LIST > Stress Component List the stress components.

Results > EXTREMES > Min/Max 
Stress

List the extreme values of stresses.

Results > PLOT > Stress Plot the stress component previously 
loaded into plot buffer.

Analysis > STATIC > Define 
SubModel

Specify region(s) as submodel.

LoadsBC > LOAD OPTIONS > Read 
Temp as Load

Use information from a thermal to a linear 
static analysis.
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Cryptic 
Command Name

TREF

TUNIF

USER_MAT

USRPLOT

XYIDENTIFY

XYLIST

XYPLOT

XYPTLIST

XYRANGE

XYREFLINE
Command Path Brief Command Description

LoadsBC > LOAD OPTIONS > 
Reference Temp

Define the reference temperature for the 
model.

LoadsBC > LOAD OPTIONS > 
Uniform Temp

Define a uniform temperature for all nodes 
in the model.

Propsets > User Material Lib Pick a material from the user-created 
material library.

Results > PLOT > User Result Plots user-defined plot.

Display > XY PLOTS > Identify Point Identify the coordinates of a point in the 
graph range.

Display > XY PLOTS > List Info List the available information to produce x-y 
plots.

Display > XY PLOTS > Plot Curves Generate the time-history-like plots.

Display > XY PLOTS > List Points List a pattern of points for loaded graphs.

Display > XY PLOTS > Set Plot 
Range

Specify the graph ranges and scale factors.

Display > XY PLOTS > Set Reference 
Line

Plot a reference line parallel to the x or y 
axis.
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C A Brief Theoretical Background 
for ASME Stress Code Evaluation
Introduction

This chapter contains additional details on  ASME code, section III, for stress 
evaluation.

Section Orientation in Junctions

For sections in the nozzle to shell junc-
tions, rational planes of bending should 
be approximated such that they are per-
pendicular to the mid-plane and have the 
same angle between the section and the 
surface on both sides. This is done by 
forming an isosceles triangle which has 
the section as its base and the mid-plane 
as its altitude as shown in the figure 
below. One side of the triangle is tangent 
to the fillet at the point of interest. 

LC

Figure C-1. Defining a Section 
in an Irregular Area
COSMOS/M Basic FEA System C-1

http://www.cosmosm.com


Appendix C   A Brief Theoretical Background for ASME Stress Code Evaluation

C-2
Stress Linearization

For plane stress, plane strain and axisymmetric structures, stress linearization is 
performed along a section path. A section is defined by nodes N1 and Nn accord-
ing to the following figure. The program interpolates n-2 equally spaced (integra-
tion) points along the path between nodes N1 and Nn. For each point, structural 
elements are searched to identify an element which contains that point. Once the 
element is identified, the stresses at that point are interpolated linearly from the 
element corner nodes. These stresses are denoted as actual stresses.

The equivalent linearized stresses are found along a section by evaluating the 
membrane and bending stresses according to one of the following two methods. 

Cartesian Formulation (Approximation)

This formulation is applicable to 
plane stress and plane strain prob-
lems as well as axisymmetric prob-
lems where the radial dependency 
could be ignored. For axisymmetric 
structures the radial dependency is 
due to the fact that there is more 
material at a greater radius than at a 
smaller one. This option is imple-
mented into the calculation if the 
input quantity “curvature_radius” in 
command ASMESECDEF (Analysis 
> STATIC > ASME CODE > Define 
ASME Section) is set to zero (see the 
Axisymmetric Formulation section 
for the definition of 
curvature_radius).

The membrane components of the stresses are evaluated by integrating along the 
section path according to:

N2

N1

LC

N3

Nn-1

Nn

N4

Figure C-2. A Section with “n” Equally
Spaced Integration Points
Along its Path
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(C-1)

where, superscripts m and a correspond to membrane and actual stresses, respec-
tively, l is the length of the section, x and y are the local coordinates along and 
perpendicular to the section path (see figure below) with an origin at the mid-
wall, and X, Y and Z are the global Cartesian coordinates. Membrane stresses are 
considered to be constant along the section.

The bending component of stresses at position x along the section path is calcu-
lated according to:

(C-2)

where superscript b corresponds to the 
bending stress.

The linearized stress at any point along 
the section is the sum of membrane and 
bending stresses.

LC

N1Y

X

y

x, ηηηηη Nn

/2
/2

Figure C-3. Definition of the Section 
Local Coordinates
COSMOS/M Basic FEA System C-3

http://www.cosmosm.com


Appendix C   A Brief Theoretical Background for ASME Stress Code Evaluation

C-4
Axisymmetric Formulation

In this case the axisymmetric fea-
tures of the model are more prop-
erly implemented in the 
formulation, for axisymmetric 
structures, than the Cartesian case. 
This option is considered in stress 
evaluation if a non-zero value is 
assigned to the input quantity 
“curvature_radius” in the com-
mand ASMESECDEF (Analysis > 
STATIC > ASME CODE > Define 
ASME Section). Curvature_radius 
corresponds to the radius of curva-
ture of the average mid-wall center-
line in the xy plane as represented 
by “ρ” in the figure below. A large 
value (or -1) for curvature_radius 
corresponds to straight walls (e.g., 
cylinder or cone). 

In order to find the linearized 
stresses, it is desired to obtain 
applied forces and moments along 
the section. The figure below rep-
resents a free-body diagram of the 
section. A right-handed local coor-
dinate system, x, y, and z is estab-
lished on the section with the 
origin at the mid-wall (same as in 
the two figures above). FN and FT 
correspond to the in-plane normal 
and shear forces on the section in y 
and x directions and MZ is the 
bending moment.

φ

ρ

L

N1

Y

X

C

y x

x

Nm

Figure C-4. Curvature-Radius 
of the Mid-Wall

x, ηηηηη

MZ

L

Y

X

C

FT
MZ

FT

FN

Figure C-5. Applied Forces and Moments
Along the Section
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The three in-plane forces and moment on the section over a small sector (∆θ) in 
the hoop direction are defined as:

(C-3)

where, σya and σxya are the actual stresses along the section in local coordinates, 
X is the global coordinate (or equivalently the radius) of point being integrated 
along the section and xf in local coordinates is the offset of the sector neutral axis 
from the center line. 

From FN in the above equation, the average normal membrane stress in the y-
direction is computed once it is divided by the sector area (Xc is the global coor-
dinate of the mid-section). 

(C-4)

The MZ contribution to the normal bending stress in the y-direction is computed 
by applying the familiar relationship s = Mz (x-xf) / I, with I as moment of inertia 
of the sector.

(C-5)
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C-6
An average membrane shear stress (xy component) is computed by dividing FT 
(in Equation C-3) by the sector area, assuming that xy bending shear stress has 
insignificant contribution (since the shear stress distribution is assumed to be par-
abolic and equal to zero at the two free surface ends).

(C-6)

Average membrane stress in the x-direction is computed by averaging the actual 
stresses along the section according to:

(C-7)

The bending stress in the x direction (thickness direction) is ignored if in com-
mand ASMESECDEF (Analysis > STATIC > ASME CODE > Define ASME 
Section) the corresponding flag is set to one, otherwise it is approximated at the 
two ends as the difference of the actual and membrane stresses.

The hoop membrane and bending stresses are calculated by considering a small 
sector (∆φ) in the XY plane. By integrating the total normal force on the sector 
and averaging it over the corresponding area, the average membrane stress (in 
hoop direction) is computed according to:

(C-8)

For straight walls where ρ approaches infinity, Eq. (C-8) reduces to the familiar 
form. 
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The hoop bending stress is calculated by evaluating the applied bending moment 
on the sector. Once the bending moment is evaluated, the hoop bending stress is 
found analogous to that of the y direction bending stress.

(C-9)

As mentioned before, the linearized stress at any point along the section is the 
sum of membrane and bending stresses.
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D Troubleshooting
Introduction

This appendix lists, in alphabetical order, the error messages produced by the 
direct solvers for linear static analysis (STAR and STRESS) and frequency and 
buckling analyses (DSTAR). Messages from the two auxiliary models (PRE1 and 
RENUM) used in the basic system are also presented. Possible conditions leading 
to the message and the needed corrective measures are provided.

The RENUM Auxiliary Module

RENUM is called by STAR and DSTAR to renumber the nodes in order to mini-
mize the bandwidth of the assembled stiffness matrix. Reduction in the band-
width results in a substantial reduction in the computational time and resources 
required to solve the problem.

The PRE1.EXE Module

The PRE1 module is used by STAR and DSTAR to:

• Assign the proper index to each global degree of freedom (DOF).
• Compute the equivalent nodal forces for applied pressures for the static and 

buckling analyses as well as frequency analysis when the effect of loads 
(in-plane loading or stress stiffening effect) on the natural frequencies is 
considered.
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D-2

All The Nodes Defined For 
CE Constraints Should Be 
Either Inside Or Outside 
Of The Submodel For CE 
Constraint: <Number>
Linear Static Analysis

Linear static analysis uses RENUM (optional), PRE1, STAR, and STRESS. The 
STAR.EXE module uses information prepared by PRE1.EXE and RENUM.EXE 
to:

• Compute the stiffness matrix of each element.
• Assemble the global stiffness matrix from the element stiffness matrices. 
• Decompose the assembled matrix and solve for displacements at each degree 

of freedom for all active load cases.
•  The STRESS module is then used to calculate stresses from displacement 

profiles.

✍ When the in-plane stiffening effect is considered the above procedure will be 
different.

Frequency and Buckling Analyses

Frequency and buckling analyses use RENUM (optional), PRE1, STAR, and 
DSTAR. The steps are as follows:

• RENUM and PRE1 prepare the information as described above.
• STAR calculates the stiffness and mass matrices for each element and 

assembles and decomposes the global stiffness and mass matrices.
• DSTAR extracts the specified number of frequencies (frequency analysis), or 

critical load factors (buckling analysis) using the specified algorithm.
• STRESS (optional) is used to calculate stresses based on the normalized mode 

shapes. Note that the actual values are meaningless but the profile indicates 
the stress distribution when the structure is vibrating in a certain mode. 

STAR.EXE Module

The nodes defining a Constraint Equation set (CE) should be either all 
inside or all outside of a submodel. Please check the mesh carefully. Define 
a new submodel and either include or exclude all those nodes from that 
submodel.

Define a new submodel which includes or excludes all these constraints.
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All The Nodes Defined For 
PTL Constraints Should Be 
Either Inside Or Outside Of 
The Submodel For PTL 
Constraint: <Number>

All The Nodes Defined For 
PTP Constraints Should Be 
Either Inside Or Outside Of 
The Submodel For PTP 
Constraint: <Number>

All The Nodes Defined For 
PTS Constraints Should Be 
Either Inside Or Outside Of 
The Submodel For PTS 
Constraint: <Number>

Allocated Memory Needs 
To Be Increased. Use 
RENUM Command To 
Increase The Memory By 
A Factor Of: <Factor>

Angle Increment For 
Printout Is Zero

Anisotropic Option Is 
Not Available For Fluid 
Elements
STAR.EXE Module

The nodes defining a point-to-line constraint set should be either all inside 
or all outside of a submodel. The specified coupling set includes a node 
label which is not present in the submodel.

Define a new submodel which includes or excludes all these constraints

STAR.EXE Module 

The nodes defining a point-to-point constraint set should be either all inside 
or all outside of a submodel.

Define a new submodel which includes or excludes all these constraints.

STAR.EXE Module

The nodes defining a point-to-surface constraint set should be either all 
inside or all outside of a submodel. Please check the mesh carefully. 

Define a new submodel which includes or excludes all these constraints.

RENUM.EXE Module 

A shortage of the memory for this problem

Use the virtual memory by using the RENUM command (Analysis, 
Renumber) to apply the specified factor and rerun the problem. If the error 
message persists, then multiply with new factor, re-apply it in the RENUM 
command, and rerun the problem. See also the comments regrading the 
Error Message: “Not enough memory to run RENUM”.

STAR.EXE, STRES.EXE or DSTAR.EXE Module

The requested angle increment, in circumferential direction, for evaluation 
of response in the analysis of your asymmetric problem is zero or very 
small (smaller than 1.0E-6)

Use the A_ASYM command (Analysis, Static, Asymmetric Load Options) to 
specify an acceptable value and try again.

STAR.EXE, and STRES.EXE Module

This version of COSMOS/M does not support direct input of the elastic 
matrix for incompressible materials (fluid element option).

Change the element type from fluid to solid or use isotropic or orthotropic 
material properties. 
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D-4

Approximate Disk Space 
Required . . . (MEGABYTES
=<Size>. Available Free Disk 
Space . . . (MEGABYTES) 
= <Size>

 

Approximate Total Size Of 
The Problem (Unit) = <Size> 
Available Free Disk Space 
(Unit) = <Size>

At Least Two Sets Of 
Requested Plot Ranges 
Have Common Steps

Bond Nodes Should Be 
Either Inside Or Outside 
Of The Submodel For 
Bond Constraint: 
<Number>

Center Node Not Defined For
a SHELL9 Element Used Wit
9-Node Option, at Element: 
<number> For Element 
Group: <group number>

Command ECHECK Needs 
To Be Issued To Correct 
The Wrong Collapsed 
Nodes Of Element Number 
<Number>
STAR.EXE Module

The free disk space available in the working drive is smaller than the 
required size for this particular problem. 

You may redirect storage to one or more other drives. Refer to the Large 
File Management chapter in the Basic System manual.

STAR.EXE Module

The available free disk space is not sufficient to run this problem.

Use the Large File Management utility to use one or more drives in storing 
the problem database. Refer to the Large File Management chapter in the 
Basic System manual.

STRES.EXE Module After Running Advanced Dynamic Analysis (DPOST.EXE). 

This message indicates that at least two plot sets requested using the 
PD_PLOT command (Analysis, Post Dynamic, PD_OUTPUT, Set Plot 
Options) share the same time step. 

Use the PD_PLTLIST command (Analysis, Post_Dynamic, PD_OUTPUT, 
List Plot Info) to examine requested plot sets and use the PD_PLOT 
command (Analysis, Post_Dynamic, PD_OUTPUT, Set Plot Options) to 
correct your input and then try the stress analysis again.

STAR.EXE Module

The nodes belonging to a Bond set should be either all inside or all outside 
of a submodel. Please check the mesh carefully. 

Define a new submodel which includes or excludes all these constraints

 STAR.EXE Module 

The specified element belongs to a SHELL9 or SHELL9L group for which 
the 9-node element option has been selected. The ninth (center) node has 
not been defined.

Either re-define a center node for the element or change the corresponding 
element group to the “8-node option” using the EGROUP command 
(PropSets, Element Group).

STAR.EXE or STRES.EXE Module

The connectivity of this element is invalid. For the SHELL9 elements, only 
the third, fourth and seventh nodes are allowed to collapse.

Use the ECHECK command (Meshing, Elements, Check Elements) to fix 
the connectivity of this element.

) 

 
h 
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Composite Damping 
Not Available With 
Consistent Mass

Computation Of 
Displacement Not 
Performed/completed. 
Press Enter Key To Quit 
From The Program

Convergence May Not 
Have Achieved For 
Harmonic <Number>

Convergence Not Achieved 
For The Requested 
Tolerance Within Specified 
Number Of Iteration 

Convergence Not 
Achieved For Requested 
Tolerance Within Specified 
Number Of Iteration. Save 
The Results (Y/N)?
STAR.EXE Module

You have requested frequencies using the consistent mass matrix 
formulation. DSTAR supports the composite damping option only with the 
lumped matrix formulation.

Use the A-FFEQUENCY command (Analysis, Frequency/Buckling, 
Frequency Options) to specify lumped mass formulation and try again. 

STRES.EXE Module 

It indicates that the pre-stress calculation (displacement calculation) has 
not been completed successfully. 

If you are running the modules interactively (one by one outside GEOSTAR) 
make sure that you did not skip the PRE1.EXE and STAR.EXE modules. 
Check the output file to see whether displacement calculations were 
completed. The total elapsed time should be recorded in the output file for 
displacement calculations at the final stage of computation. You might have 
pressed the ESC key earlier to terminate the calculation of displacements. 
Rerun the problem from the beginning (displacements and stresses). 

STAR.EXE Module

Convergence was not achieved for the specified harmonic number or you 
have two close modes and the program converged to the higher mode.

Use the A-FFEQUENCY command (Analysis, Frequency/Buckling, 
Frequency Options) to Increase the number of iteration, or introduce a 
small shift to avoid convergence to a higher harmonic.

DSTAR.EXE Module 

Convergence has not been achieved with the specified tolerance and 
number of iterations. 

Increase the number of iterations or relax the tolerance level and rerun the 
problem again. 

DSTAR.EXE Module

For Subspace method, if the user’s requested convergence is not achieved 
within the specified number of iteration, then by responding yes (pressing 
“Y” key) the results will be saved in data base, otherwise the program 
terminates without saving the results.
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D-6

Displacement/Reaction 
Not Found From Old File 
For Node <Number>

Displacement Not 
Available In Old File For 
Load Case <Number>

Do You Wish To Save 
The Current Iteration 
Results (Y/N)?

8 Node Option Is Not 
Available Yet For 
SHELL9L(P)

Elastic Matrix Not Positive-
Definite For Orth. Mat.  Set 
<Number>
 STAR.EXE Module

This message occurs when trying to retrieve information for submodeling. 
The old file refers to the displacement file for the last run of the problem. 
The program gives this message when it can not retrieve results for the 
specified boundary node (at the interface between the submodel and the rest 
of the model).

Check your disk and your submodeling procedure and try again.

STAR.EXE Module

The displacement results are not available for the specified load case in the 
displacement file generated in the previous run (prior to running the current 
submodel). 

You may have activated a new load case prior to running the current 
submodel for which no results are available from the previous run.

DSTAR.EXE Module

You may get this message if you press the Esc key during the execution of 
the DSTAR.EXE program.

If you press Y, the program will complete the current iteration and save it 
before quitting. The completion time depends on the size of the problem as 
well as the stage of calculation at which you have pressed the ESC key. If 
you press N, the computation will be terminated immediately. Note that 
even if you initially press Y, you can still terminate the program at any time 
by pressing the ESC key again.

STAR.EXE Module

You chose to use the P-method for the adaptive solution with this element. 
Currently, the 8-node SHELL9L element does not support the P- and HP-
method. It only supports the H-method.

You may use the 9-node SHELL9L element or use the H-method.

STAR.EXE Module

The orthotropic material properties of the specified set led to an elastic 
matrix that is not positive definite. The elastic matrix relates strain and 
stress tensors.

Check the validity of the material properties in the specified set and try 
again.
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Element Area Is Zero, 
Element <Element>

Element Thickness 
Is Smaller Than 
Tolerance <Value>, 
Element <Number>

Element Volume Is Smaller
Than Limit <Value> For 
Element <Number>

Error In Calculating 
The Direction 
Cosines For Pipe 
Element <Number>

Error In Calculating 
Normal To The Side Of 
Element <Number>

Error In Eigenvector 
Calculation. {PHIi} [M] 
{PHIi}=0
STAR.EXE Module 

The specified 2D element is invalid because its area is zero.

List the element and check the validity of its nodes and their connectivity.

STAR.EXE or STRES.EXE Module

Element thickness is not defined or its defined value is smaller than the 
specified value. 

List the element, check the associated real constant set. Modify the real 
constant set to include a valid value for thickness.

STAR.EXE or STRES.EXE Module

The volume of the specified element is smaller than the tolerance value. 
Elements smaller than the tolerance value cause numerical difficulty in the 
computation and should be avoided. 

Refer to the message “Stop - Element area is smaller than tolerance 
<value>, element <number> for notes.

 STAR.EXE Module

For the specified PIPE element, an error was encountered during the 
computation of direction cosines relating local and global coordinate 
systems.

List the element and check its connectivity. In particular, check the validity 
of the third node relative to the two end nodes. The three nodes may not be 
collinear.

STAR.EXE Module

The SOLIDL element may have inconsistent number of nodes on the top 
and bottom faces (i.e., one face may have collapsed nodes). 

List the element and examine the validity of its nodes and their connectivity.

DSTAR.EXE   Module

Error occurs during the normalization of eigenvectors with respect to mass.    
In the error   message {PHIi} corresponds to the i-th. eigenvector and [M] 
to the mass matrix. 

The multiplication expressed in the error message should always be a 
positive number. 
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D-8

Error - For Incompressible 
4-node Fluid Element 
<Number> Shear Modulus 
(GXY) Must Be Smaller 
Than <Value>

ERROR - Less Number Of 
Nodes Than Required For 
Element Number 
<Number>

ERROR - Material 
Property Not Admissible 
For Element <Number>

Error - Multi-Base Motion 
File (.MBS) Is Not Available

Error - No Master 
Nodes Defined For A 
Guyan Reduction

ERROR - Non-existent 
Coupled Node <Number> 
For Set <Number>
STAR.EXE Module

For the specified 4-node Fluid plane element, the shear modulus is smaller 
than the limit value.

List the element and find out the associated material set. List the material 
set and modify the set to include a valid value for GXY.

STAR.EXE Module

The number of nodes defining the specified element is insufficient.Check 
the mesh at the specified element.

List the specified element and make sure that it belongs to a proper element 
group. Redefine the element group to be valid for this element, or fix the 
element by redefining it or remeshing.

STAR.EXE and STRES.EXE Module

The material set corresponding to the specified element has inconsistent 
material properties.

List the element and find out the associated material set. List the material 
set and modify it as needed to be admissible.

STRES.EXE Module 

The problem-name.MBS file is generated during frequency analysis.

Make sure that the Multi-base motion input information is provided before 
running frequency analysis using the DSTAR.EXE module. 

DSTAR.EXE Module

No master nodes defined.

Define the master nodes properly and rerun the problem.

STAR.EXE Module

The specified coupled set includes a node label which is not present in the 
model. The node may have been deleted after defining the set. 

List the coupling set and modify it as needed using the Loads-BC, 
Structural, Coupling) menu. 
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ERROR - Not Enough 
Memory To Run 
Piezoelectric

Error- Number Of Requested
Steps For Plot Exceeds The 
Limit <Number>

Error In Opening 
.LC1 File As New

Error In Opening 
.LCD FIle As New

Error In Opening  
The Plot File To Write   
Mass Participations

Error In Opening 
The Stress File
STAR.EXE Module

In order to run this problem, you need to increase the amount of free 
memory.

Increase the size of the memory available by closing other applications. If 
the size of the RAM on your machine is small, you may increase the memory 
by installing extra RAM.

STRES.EXE Module After Running Advanced Dynamic Analysis (DPOST.EXE). 

The number of the requested steps for plot exceeded the specified limit.

Reduce the number of plots and rerun the STRESS.EXE module again.

STAR.EXE Module

The file problem-name.LC1 file is an internal file used to store 
displacement results of asymmetrical problems. The error message 
indicates that the file already exists.

Delete or rename the file and try again.

STAR.EXE Module

The file problem-name.LCD file is an internal file used to store 
displacement results. The error message indicates that the file already 
exists.

Delete or rename the file and try again.

DSTAR.EXE Module

The problem-name.LCM is used to store the mass participation factors. An 
error was encountered in opening this file.

Check your disk space. The database may have been corrupted. Contact 
SRAC if the error persists.

STRES.EXE Module 

An error has been encountered in opening the problem-name.STE file 
(stress file for static analysis), or the problem-name.STP file (stress file for 
dynamic analysis). 

Delete the file and rerun the Stress module again.
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D-10

Error In Opening/reading 
File .LCD (For Submodel 
Constraints)

Error In Reading 
Temperature File 
(.HTO) 

Error - Orthotropic 
Properties Are Not 
Proper (See Output)

Error Reading Dispersed 
File (To Another Drive): 
<Name.ext>

Error Reading .MAS 
File <Data>
STAR.EXE Module

The problem-nam.LCD file is the main displacement file which is used 
along with the problem-name.LC2 file for submodeling problems. An I/O 
error has occurred in opening the LCD file.

Check your system and input.

STAR.EXE or STRES.EXE Module

The problem_name.HTO contains nodal temperatures. It is generated by 
thermal analysis (HSTAR or FFE Thermal). STAR and FFE Static may use 
this file to calculate displacements, strains, and stresses due to thermal 
loading specified by this file. The STAR.EXE or the STRES.EXE module 
has failed in reading this file.

Check your input for the TEMPRead command (Loads-BC, Load-Options, 
Read Temp. As Load). View temperature results. Run thermal analysis 
again if you can’t view temperatures and then try static analysis again. 

STAR.EXE Module

Orthotropic properties are not proper for a material set. The Poisson’s ratios 
do not obey the following rule:NUij*NUji>1, where indices i and j run 
from 1 to 3 and represent global directions X, Y and Z.

Check the end of the output file for error messages indicating the material 
set number with this problem.

STAR.EXE and DSTAR.EXE Modules

The specified file corresponds to one of the partitioned files redirected for 
storage on other drives. The first character of the name extension specifies 
the type of file (S = Stiffness, G = Geometric Stuffiness/Consistent Mass 
and K = duplicate file for Geometric Stiffness). The second and third 
character constitute a two digit number specifying the partition number. 

Contact SRAC if you got this message.

DSTAR.EXE Module

The file with extension “MAS” is a major internal file in DSTAR. 

The <data> corresponds to the information which can not be read from the 
file. If the <data> is displayed as MAXA, it corresponds to the offset 
information of the stiffness file. If <data> is displayed as AM, then it 
corresponds to the mass matrix data.
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Error Reading Material
 Damping Value From
File: .MSF

Error - Target Element 
Length/area Is Zero 
(Bonding/CPCNS Set 
No. = <Number>)

Error - Target Element 
Type Is Unacceptable 
(Bonding/CPCNS Set 
No. = <Number>)
STAR.EXE or STRES.EXE Modules

You have specified to use material damping. The problem-name.MSF file 
contains the relevant information. The program found wrong information 
in this file indicating possible database corruption. Refer to the on-line help 
for the PD_DAMPREAD command (Analysis, Post Dynamic, PD_DAMP/
GAT, Read Material Damp.)

Review your input and try again. Contact SRAC if the error persists.

STAR.EXE Module 

If the specified set corresponds to a point-to-curve type of constraint, then 
the length of the target curve must be greater than zero. The distance 
between points 2 and 3 must be greater than zero as in figure D-1. If the 
specified set corresponds to a point-to-surface type of constraint, then the 
area of the target element must be greater than zero (see Figure D-2)

List the constraint set and check the element connectivity for possible 
overlapping or collapsing of the target nodes.

STAR.EXE Module 

If the specified set corresponds to a point-to-curve type of constraint (or 
bonding), then the total number of nodes can only be 3 or 4 and should be 
arranged on the curve according to:

Figure D-1. Point-to-Line Constraints

If the specified set corresponds to a point-to-surface type of constraint (or 
bonding), the total number of nodes can only be 4, 7, 5, 9, or 10 and should 
be arranged on the surface according to the following convention:

X

Point
(Node 1)

3

2

Line Defined by 
Nodes 2 and 3.

X

Point
(Node 1)

3

2

Curve Defined by 
Nodes 2, 4,  and 3.

4
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D-12

Error - Unable To Find 
Reference Coordinates 
For Source Point 
(Boundary/CPCNS Set 
No. = <Number>)

Error, Zero Or Negative 
Jacobian Determinant, 
Element: <Number>

ERROR - Zero Volume.  
Element Number <Number>
Figure D-2. Point-to-Surface Constraints

STAR.EXE Module

The program uses an iterative algorithm to find the reference coordinates 
for the source node within the target area (element) in the case of point-to-
line, point-to-surface, or bonding constraints. The error message is 
displayed when the reference coordinates are not found within the 
maximum number of iterations(=50), or when the target element may not 
properly defined.

Check your input and try again. 

STAR.EXE or STRES.EXE Module

The determinant of the Jacobian matrix for the specified element is equal 
to or less than zero.

The element may have excessive distortion or elements with zero area or 
volume. List and plot the element, check its connectivity and shape. You 
may need to remesh or redefine the element.

STRES.EXE Module 

The specified element has zero volume (or area). 

List the element and verify the validity of its nodal connectivity. Examine 
collapsed nodes if any.
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File X.BAT Not 
Found. Execution 
Aborted

Fluid Option Is Not 
Available With Non-
axisymmetric 
Loading

Fluid Element Stresses 
Are Not Available With 
Random Vibration

For Asymmetric 
Buckling, Only Inverse 
Method Is Available

For Asymmetric Problems, 
Geometric Stiffness (Or In-
plane Loading Effect) Is 
Calculated Only In Frequenc
And Buckling Analyses
RENUM.EXE, STAR.EXE or STRES.EXE Module

The X.BAT is created internally by the pre-processor. It is used to track the 
name of problem to be solved when various modules are used. Once all 
modules associated with the problem are executed, the file is used to open 
the pre-processor again. The STAR.EXE module could not find this file. 

You should not see this error if you are running analysis from the pre-
processor. If you are running the problem manually outside the pre-
processor (i.e., one module at a time), make sure that this file exists after 
execution of the PRE1.EXE module. See note below:

✍ For example, to run a static analysis manually: 1)create an ASCII text named 
X.BAT, 2) type the name of the problem (without any extension) and then 
close the file, 3) Close the Pre-processor, 4) Execute RENUM (if desired), 5) 
Execute Pre1, 6) execute STAR, and finally, 7) execute Stress (if desired). 

STAR.EXE Module

The fluid option is not available with asymmetric loading.

Redefine the element group or use full 3D model. This version does not 
support the two option simultaneously.

STRES.EXE Module 

You requested to perform random vibration analysis on incompressible 
materials.

This version does not support Fluid option (incompressible materials) for 
random Vibration analysis.

STAR.EXE Module

You have used an option other than Inverse Method to evaluate the 
Buckling loads and mode shapes for Asymmetric buckling analysis. In this 
release, only the Inverse Method is available for this type of problems. 

Use the A-BUCKLING command (Analysis, Frequency/Buckling, Buckling 
Options) to choose the Inverse Power Method and run buckling analysis 
again.

STAR.EXE Module

You have included the Stress Stiffening effect (in-plane effect) for a Static 
analysis of an Asymmetric model. This option is not supported in this 
release.

Use the A-STATIC command (Analysis, Static, Static Analysis Options) to 
deactivate the stress-stiffening flag (in-plane effect). 

y 
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D-14

For Random Vibration, 
Support Motion Must Be 
Defined In Global Cartesian
Coordinate System

For Response Spectra, 
Support Motion Must Be 
Defined In Global Cartesian
Coordinate System

Forming Stiffness 
(Required Shift Might Be 
Different Than Saved One)

Forming Stiffness (Saved 
Stiffness Matrix Affected 
By Frequency Shift)

Geometric Stiffness 
Not Available For 
Elbow Element

Geometry Of A 2D 
Element Is Reduced To A 
Line, Element <Number>
STAR.EXE Module

You have defined the Support Motion (for Multiple Base Motion) in a local 
coordinate system. This feature is supported for Time History and 
Harmonic analyses only. It is not supported for Response Spectra and 
Random Vibration analyses.

Use the Global Cartesion coordinate system to specify support motion.

STAR.EXE Module

You have defined the Support Motion (for Multiple Base Motion) in a local 
coordinate system. This feature is supported for Time History and 
Harmonic analyses only. It is not supported for Response Spectra and 
Random Vibration analyses.

Use the Global Cartesion coordinate system to specify support motion

STAR.EXE Module

This is only a warning message. 

See the message above.

STAR.EXE Module

This is only a warning message. You have requested to use the decomposed 
stiffness matrix from the previous run instead of calculating a new one. The 
stored data from the previous run indicates that the previous run was 
computed for a frequency analysis with a frequency shift. Any non-zero 
shift alters the structure of stiffness matrix and makes it unusable for any 
future static runs (as well as future frequency runs with a shift different than 
the original value used to save the stiffness matrix).

The program gives this message, deletes the saved decomposed stiffness 
matrix and calculates a new one.

STAR.EXE Module

The ELBOW element does not support calculation of the geometric 
stiffness which is needed for buckling, static, frequency problems with 
active in-plane stiffening effect.

Use a fine mesh of BEAM3D elements instead of each ELBOW element.

STAR.EXE Module

The specified 2D element is reduced to a line as its corner nodes are 
collapsed. Its area is zero.

List the element and check the validity of its nodes and their connectivity. 
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ID Array File (.IDA) 
Missing

Ignoring The 
Geometric Stiffness 
In Mode Shape Cal. 

Improper First Row 
In .DIR File

Improper Third Node 
For Beam Element 
Number <Number>

IO-ERROR, FILE: 
<Extension>

IO: ERROR, 
FILE:.IDA
STAR.EXE or STRES.EXE Module

The problem-name.IDA file is an internal file that stores ID Array 
information. STAR or STRES could not find the file. The file was not 
generated or was generated but then deleted.

Try again.

STAR.EXE Module

This is only a warning message indicating that the in-plane stiffening is not 
allowed in frequency analysis of piezolectric materials.

Note the warning.

 STAR.EXE Module

The Problem-name.DIR file is created by the program to specify the storage 
locations for large problems where the available disk space on one directory 
(or disk) is not sufficient.

The first row of this file does not specify a valid directory. Refer to the Large 
File Management chapter in the COSMOS/M Basic System manual for 
details.

STAR.EXE or STRES.EXE Module

The third node is used to define the orientation of the cross section of the 
beam element in space. The third node may not be collinear or (almost 
collinear) with the other two node.

Redefine the element such that the third node is not collinear with the other 
two nodes.

DSTAR.EXE Module

This message indicates that there is some input/output error in the file 
specified by its extension. The files with extensions “.MSF”, “IDA” or 
“OUT”, correspond to frequency, ID array or output files, respectively.

Check your input and system and try again.

STAR.EXE Module

The file problem-name.IDA file is an internal file created for buckling 
analysis of asymmetric problems. The error message indicates that the file 
already exists.

Delete or rename the file and try again.
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D-16

I/O Error In Reading 
Displacement File .LCD

I/O Error In Reading 
Old Displacement File

I/O Error In 
Writing File .LCM

I/O Error <Number> 
In File, <Name>

Improper Third Node 
For Boundary Element 
Number<Number>

In Random Vibration , 
AnalysisAll The Support  
NodesAssociated To A  
Multi-baseMotion Curve,    
Must  Have The Same 
Curve Multiplier
STRES.EXE Module 

Displacements can not be read from the displacement file (with the 
extension LCD). Make sure that the file exists in the working directory. 

You may try to rerun the problem from the beginning. If the error persist 
contact us in the SRAC to fix the problem.

 STAR.EXE Module

Refer to the message “Displacement/Reaction not found from old file for 
node <number>”.

DSTAR.EXE Module 

This error occurs during the storage of mode shape results in the plot file 
with extension “LCM”. 

Check your disk and try again.

STAR.EXE Module

The problem-name.LCD file is the main displacement file and the problem-
name.LC2 file is the auxiliary displacement file. The .LC2 file is used in 
special analysis cases like submodeling and asymmetric loading. An I/O 
error has occurred.

Check your system and input and then try again.

STRES.EXE Module 

The specified third node of this element is not valid.

List the element and check that the three nodes are not collinear. Redefine 
the element to use proper nodes and try again.”

STAR.EXE Module

You have associated more than one set of Support Levels to the same curve 
with each set assigned a different Curve Multiplier for Random Vibration 
analysis. 

In this release, all Support Level sets associated with a curve must be 
assigned the same Curve multiplier for Random Vibration Analysis.
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In Response Spectra Analysis,
All The Support Nodes 
Associated To A Multi-base 
Motion Curve, Should Be
Excited In The Same Direction

Inside And Outside Nodes 
Of Submodel Constrained 
By Eq. Set <Number>

Integration Pt. Not 
Inside Any Element For 
Point <Number>

Invalid Internal Analysis 
Flag For Basic System

Large Warping, Use 
Quad4 Element; Twisted 
Element <Number>
STAR.EXE Module

You have associated more than one set of Support Levels with the same 
curve with each set defined in a different excitation direction for Response 
Spectra analysis.

In this release, all the Support Level sets associated with a curve must be 
defined in the same excitation direction for Response Spectra Analysis.

RENUM.EXE Module 

The nodes defining a constraint equation should be either all inside or all 
outside of a submodel.

Modify your input and try again.

STRES.EXE Module 

For the ASME Stress Check, the specified integration point lies outside of 
the model and no stress results are available for it.

Use the ASMESECDEF command (Analysis, Static, ASME _CODE, Define 
ASME Section) to redefine the two ends of the section to avoid this 
situation.

STAR.EXE Module

The STAR.EXE program processes static, frequency and buckling 
analyses. The corresponding internal flags are 0, 2 and 1, respectively. The 
error message will be displayed when STAR finds a number other than 0, 
1, and 2.

This is an internal error that happens when STAR is executed outside 
GEOSTAR. You should never see this message if you run from GEOSTAR.

 STAR.EXE Module

The specified element is a rectangular shell element formulated using the 
quadratic option (QUAD option). This formulation is essentially suitable 
for flat or moderately twisted elements. Its use for excessively twisted 
elements results in substantial inaccuracy if it is used in its original form. 
For moderately twisted elements, applying Warping Correction could ease 
the problem and yield acceptable results. This message indicates that the 
amount of twisting for the specified element is beyond the level that can be 
fixed by applying the Warping Correction.

List the element to find out its element group and then use the EGROUP 
command (PropSets, Element Group) to redefine the element group 
formulation. Use the QUAD4 or QUAD2 formulation options. You may also 
remesh the model with triangular elements (SHELL3/SHELL3T). 
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D-18

Layer Thickness Is 
Less Than <Value> At 
Layer <Number>for 
Element <Number>

Load Balance Is Not 
Available With Asymmetric 
Option (Load Balance Is 
Not Checked)

Magnitudes Of Loads 
Are Too Small. Please 
Increase Them And 
Rerun The Program

Mass Matrix Not 
Defined (You May Not 
Have Defined Density)

Master D.O.F. 
Equal To Zero

Master D.O.F. Exceed 
The Limit <Number>

Material Property Is Not 
Homogeneous Inside J-
integral Path: <Number>
 STAR.EXE Module

The thickness of the specified layer in the specified element is either zero 
or too small.

List the element to find the associated real constant set and redefine it to 
include a valid value for the thickness.

STAR.EXE Module

This is only a warning message when the Force Balance at grid nodes is 
requested for asymmetric problems. In this version, the balance of forces 
can not be calculated for asymmetric problems.

The program will continue by ignoring the request for force-balance.

DSTAR.EXE Module 

The magnitude of the applied buckling loads are too small. Such small 
loads could cause numerical inaccuracy in the computation. 

Increase all the applied loads by a reasonably large factor. 

DSTAR.EXE module

The error indicates that the mass matrix is not calculated. Check to see 
whether you have properly defined the material density.

STAR.EXE Module

You are running a Substructuring problem with the number of master d.o.f. 
equal to zero. 

Check your model to see if you have defined proper master nodes.

STAR.EXE Module

You are running a Substructuring problem with the number of master d.o.f. 
larger than the specified limit. Refer to the end of the output file for the 
error message indicating the number of master d.o.f. in your problem.

You may have to reduce the number of master d.o.f. and try again.

STRES.EXE Module 

The elements inside the specified J-integral are not associated with the 
same material property set. 

If possible, reduce the size of the path such that it lies within one material.
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Material Property Is Not 
Isotropic Inside J-integral 
Path: <Number>

Missing File, Return To 
Preprocessor. <File.IDA>

Missing Files. Run The 
Pre-stress Analysis First

Modal Acceleration 
Method Not Available 
With Consistent Mass

Mode Acceler. Method 
Is Not Available With 
Consistent Mass
STRES.EXE Module 

Not all elements inside the specified J-integral have isotropic material 
properties. 

Redefine the path such that it is contained within one isotropic material

STAR.EXE Module

The problem_name.IDA file is missing. This file contains ID Array 
information and should have been generated by PRE1.EXE and then used 
by STAR.EXE. The above error message occurred during the reading of 
this file by STAR.EXE. PRE1.EXE has not generated the file or the file was 
deleted afterwards. A corrupt database may result in this message also.

Check your data and rerun the problem. You may have to regenerate a new 
database for this problem by loading the session file to a new problem.

STRES.EXE Module 

This message indicates that the pre-stress analysis has not been completed 
successfully prior to running the Stress module. Depending on the type of 
the analysis, the pre-stress analysis could be static displacement calculation 
(the STAR.EXE module), mode shapes (the DSTAR.EXE module), or 
dynamic displacements response (DPOST.EXE). 

Please run the appropriate pre-stress analysis first and then run the stress 
module if needed (running the static module includes running the stress 
module by default). 

STAR.EXE Module

You requested frequencies using the consistent mass matrix formulation 
and you are trying to run time-history analysis with the Modal Acceleration 
Method (MAM) option. DSTAR supports this option only if lumped matrix 
formulation was used to calculate frequencies in DSTAR.

Use the A-FFEQUENCY command (Analysis, Frequency/Buckling, 
Frequency Options) to specify lumped mass formulation and try again. 

DSTAR.EXE Module

You can not run a frequency analysis with both the consistent mass and 
mode acceleration flags activated simultaneously.

You may use the A-FREQUENCY command (Analysis, Frequency/
Buckling, Frequency Options) to switch to the lumped mass formulation 
and try again.
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D-20

Modulus Of Elasticity (Ex) 
Smaller Than 1.e-25 For 
Element <Number>. (Check 
Material Group <Number>)

MORE THAN <Number> 
Layers Are Used For A 
PLATE-SHELL Element 
<Number>

Multi-base Motion Is Not 
Available With Consistent 
Mass

No Gravity/centrifugal/
inertia Force Is Calculated 
(Material Density May Not 
Have Been Defined)

No Load Or Prescribed 
Displacement Is Defined 
(For Problems, With Special 
Loads Such As Thermal, 
Gravity and Centrifugal 
Activate The Proper Flag In 
A_STATIC Command)
STAR.EXE Module 

The modulus of elasticity (EX) for the specified element is smaller than 
1.e-25. 

Check the specified material group using the MPLIST command (PropSets, 
List Material Props). Use the PropSets menu to pick a material from the 
library or define an acceptable value for EX, and try again.

STRES.EXE Module

The number of layers is larger than the specified limit for the specified 
element. 

Reduce the number of layers and rerun the problem all over again.

DSTAR.EXE Module

You can not run a frequency analysis with both the consistent mass and 
multi-base motion flags activated simultaneously.

You may use the A-FREQUENCY command (Analysis, Frequency/
Buckling, Frequency Options) to switch to the lumped mass formulation 
and try again.

STAR.EXE Module

You have activated the gravity and/or centrifugal flag(s) and the program is 
not able to calculate the equivalent forces. The equivalent forces are 
computed by multiplying mass by acceleration.

Verify that a non-zero mass density is defined and check your input for the 
proper load case including acceleration and velocity values.

STAR.EXE Module

No loads were specified. You must specify some type of loading, otherwise 
all results are zeros. The external load could be in the form of mechanical 
loads (such as forces, pressures), thermal loads (such as nodal temperatures 
and thermal gradient on shell and beam elements), and Gravity or 
Centrifugal loads (due to mass inertia). This message may obtained while 
running static, buckling, or frequency analysis with active in-plane loading. 
Only the active load case is considered for buckling problems and static and 
frequency problems with active in-plane loading flag.

The user-defined mechanical loads are always considered in the problem 
solution. However, to consider other types of loading, you must activate the 
corresponding flag in the analysis options command. For gravity and 
centrifugal loading mass density must be specified. For thermal loading the 
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No Load Or Prescribed 
Displacement is Defined 
For ACTIVE LOADCASE 
(For Problems, With Special
Loads Such As Thermal, 
Gravity and Centrifugal 
Activate The Proper Flag In 
A_STATIC Command)

No. Of Interface Elements 
(In Main Model Side) Is 
Larger Than <Value>

No Thermal Load 
Application With 
Piezoelectric Materials

Non-existent Node For 
Element <Number> Node: 
<Number>

Not Enough Memory To 
Run; Extra Memory 
Needed <Unit> <Size>
coefficient of expansion must be specified. Also make sure that the proper 
load case is activated. Use the A_STATIC (Analysis, Static, Static Analysis 
Options) command to activate the proper flag(s).

STAR.EXE Module

No loads were specified.

For details, refer to the previous message “No Load or prescribed 
displacement is defined (for problems, with special loads such as Thermal, 
Gravity and Centrifugal activate the proper flag in the A_STATIC 
command).

STAR.EXE Module

The submodel is very large. The number of elements along the submodel 
interface is larger than the specified limit. 

Reduce the size of the submodel and rerun the problem. 

STAR.EXE Module

The piezoelectric element (SOLIDPZ) does not support thermal load 
application.

Deactivate thermal loading and try again.

STRES.EXE Module 

This message indicates that the specified element includes a node which is 
not available.

List the element and redefine it to use proper nodes that are available in the 
database.

STAR.EXE, DSTAR.EXE or STRES.EXE Modules

In order to run this particular problem you need to have the specified extra 
amount of free memory in the specified unit. The required memory 
increases as the size of the problem increases. 

Increase the size of the memory available by closing other applications. If 
the amount of RAM on your machine is small, you may need to install extra 
RAM on your computer.
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D-22

Not Enough Memory 
To Run RENUM

Not Enough 
Memory To Run 
The Problem

Not Enough RAM For 
Requested Memory To 
Store Stiffness Matrix.  
Available RAM Is: (Mega 
Bytes) = <Size>

NOTE: Sum Of The Free 
Disk Spaces Of 
Participating Drives Is 
Smaller That The Required
Space For This Problem: 
Total free disk spaces 
(<unit>) = <size>   Required
space (<unit>) = <size>

Options 1 And 2 Of File 
Transfer To Other 
Directories Not Available 
With Piezoelectric. You 
May Use Option 3 Instead
RENUM.EXE Module 

There is no enough memory to run this problem. 

Increase the size of the memory available by closing other applications and 
rerun the problem. You may also provide the needed memory by using the 
virtual memory. To do so, use the command RENUM command (Analysis, 
Renumber). If the size of RAM on your machine is small, we suggest to 
install additional RAM.

DSTAR.EXE Module for Guyan Reduction

In order to run this problem, you need to increase the amount of free 
memory.

Increase the size of the memory available by closing other applications. If 
the size of the RAM on your machine is small, you may increase the memory 
by installing extra RAM.

STAR.EXE Module

The specified size is the available size of memory which is smaller than the 
size requested by the user.

Reduce the requested size to the specified size. You may increase the size of 
the memory available by closing other applications or installing extra 
RAM. 

STAR.EXE Module

The total free disk space in all drives specified by the Large File 
Management utility is not sufficient to solve this problem.

In the absence of extra disk space, you may have to reduce the size of the 
problem by using larger elements. Sometimes using the other option in the 
RENUM program may reduce the stiffness bandwidth, and consequently 
the total size of the problem.

STAR.EXE Module

For this piezoelectric problem, you have requested to partition the stiffness 
file and store each part in a separate directory (options 1 and 2 of Large File 
Management). These two options are not available in this version for the 
piezoelectric problems.

You may use option 3 to transfer the whole stiffness matrix (or similar files) 
to directories other than the working directory.
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Options 1 And 2 Of File 
Transfer To Other 
Directories Not Available 
With Substructuring. You 
May Use Option 3 Instead

P-method Is Not Available 
With Asymmetric Option

Previous Run Is Done 
With Diff. Option In 
.DIR File, Thus Saved 
Stiffness Matrix Can 
Not Be Retrieved               

Problem Is Too Large 
For The Subspace 
Method. Number Of 
Eigenvalues Have Been 
Reduced To <Number>

Problem Too Large 
For The Program
STAR.EXE Module

For this substructuring problem, you have requested to partition the 
stiffness matrix and store each part in a separate directory (options 1 or 2 of 
Large File Management). These two options are not available in this 
version for substructuring problems.

You may use option 3 to transfer the whole stiffness matrix (or similar files) 
to directories other than the working directory.

STAR.EXE or STRES.EXE Module

The asymmetric option is only available with the H-Method. You have 
specified the P- or the HP-Adaptive Method for this Asymmetric problem. 

Use the H-Method and try again.

STAR.EXE Module

You have requested the use of the stiffness matrix from a previous run 
which used a Large File Management option to store the results. The option 
you are using now is different than the one that you have used when you 
saved the stiffness matrix. Due to this inconsistency, the current run failed.

Use the proper option number and rerun the problem.

DSTAR.EXE Module

This warning message only is displayed for the problems with Consistent 
Mass option when the problem is too large for the available memory.

If you still wish to solve the problem with the original options:

a. Increase the size of available memory, or,

b. Reduce the number of D.O.F., or,

c. Reduce the number of requested frequencies.

DSTAR.EXE Module

It indicates that the number of requested frequencies is larger than limit for 
the Lanczos method. 

Either reduce the number of frequencies or use another method such as 
Subspace and rerun the problem. 
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D-24

QM6 Option Not 
Available With 
Asymmetric Loading, 
Full Integration Used

Reactions Are Not 
Available With 
Asymmetric Option 
(Reaction Is Ignored)

Replace PREVIOUS Run 
Results With CURRENT 
Iteration (Y/N)?

Request For Program 
Termination Press Esc To 
Terminate Or Any Other 
Key To Continue

Requested Block Size Is 
Smaller Than Minimum 
<Size> <Unit>
STAR.EXE Module

This is only a warning message. The QM6 option of computing the stiffness 
matrix is not available for asymmetric PLANE2D elements.

The full integration option will be used instead.

STAR.EXE Module

This is only a warning message in asymmetric problems when the Reaction 
flag is on. In this version of COSMOS/M the reaction force can not be 
calculated at the constrained nodes. 

The program will continue by ignoring the request to calculate reaction 
forces.

DSTAR.EXE Module

You may get this message if you press the Esc key during the rerun of the 
DSTAR.EXE program when results are available from a previous run.

If you press Y then the program will complete the current iteration and use 
it to replace the results of the previous run. The completion time depends 
on the size of the problem as well as the stage of calculation at which you 
have pressed the ESC key. If you press N, the computation will be 
terminated and the previous results will be retained for postprocessing. 
Note that even if you initially press Y, you can still terminate the program 
at any time by pressing the ESC key again.

RENUM.EXE, STAR.EXE, DSTAR.EXE or STRES.EXE Modules

You have pressed the Esc key intentionally or accidentally. 

Pressing of the Esc key interrupts the module being executed. Press the Esc 
key again to terminate or press any other key to cancel the interruption and 
continue running.

STAR.EXE Module

The specified size is the minimum size required for an internal storage 
array in order to run this particular problem. The required memory 
increases as the size of the problem increases. This internal array is used to 
store two blocks of the stiffness matrix as well as other information at 
different stages of the run. These other tasks require the specified minimum 
size of memory in the prescribed unit (i.e., byte, kilo byte, mega byte). 

Increase the size of the memory available by closing other applications or 
add more memory to your computer to improve the performance.
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Same Base Excitation 
Is Defined In More Than 
One Support Level

Security Device Is Not 
Responding. Please Install 
Security Device And Type 
Any Key To Continue. Type 
Esc Key To Quit From The 
Program

Singularity In 
Computation Of 
Average Plane For 
Warped Element 
<Number>

Spin Softening Is 
Not Available With 
Consistent Mass

Static Analysis Data 
Not Available For 
The Dead Load Case 
<Number>
STAR.EXE Module

Multi-base excitations at a certain node in the same global Cartesian 
direction are referred to in more than one support level. This results in a 
node being assigned two different support levels in two different local 
coordinate systems which may have non-zero resultant component in the 
same direction of the global cartesian system) which is not supported in this 
release. The node label and corresponding direction is specified in the 
output file (problem-name.OUT).

Modify your input and try again.

STAR.EXE or DSTAR.EXE Module

Check your license scheme. If you are using a security lock, make sure that 
it is properly connected and the proper license file exists in the COSMOSM 
directory.

If you still can not execute the program please contact SRAC.

STAR.EXE Module

The program could not apply Warping Correction for the specified element 
defined with the QUAD option.

List the element to find out its element group and then use the EGROUP 
command (PropSets, Element Group) to redefine the element group 
formulation. Use the QUAD4 or QUAD2 formulation options. You may also 
remesh the model with triangular elements (SHELL3/SHELL3T).

STAR.EXE Module

You have activated the spin softening flag and specified consistent mass 
formulation. These two options are not compatible in this release of 
COSMOS/M. 

Use the A-FFEQUENCY command (Analysis, Frequency/Buckling, 
Frequency Options) to specify lumped mass formulation or deactivate the 
Spin Softening flag. 

STRES.EXE Module After The Advanced Dynamic Analysis (The DPOST.EXE Module). 

You have requested to use the results of a static load case. The results for 
the specified load case were not found. 

Make sure that you have run the static analysis (including the stress 
calculation) for this load case prior to running the advanced dynamics.
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D-26

STOP - ASME Stress 
Check Is Only Available 
When Stress Is Requested 
In Global Cartesian 
Coordinate System

Stop - Asymmetric 
Loading Is Used With 
More Than 1 Load Case

Stop - Consistent Mass 
is Not Available With 
SHELL6 (Switch to the 
Lump Mass Option)

Stop - Consistent Mass 
Is Not Available With 
SHELL9 (Switch To The 
Lump Mass Option)

Stop - Consistent Mass 
Is Not Available With 
SHELL9L (Switch To 
The Lump Mass Option) 
STRES.EXE Module 

Stop ASME stress check is only available when stress is requested in 
Global Cartesian Coordinate system.

Change the option for stress coordinate system in the element group 
command to global and run the stress module again (no need to run for 
displacement again).

STAR.EXE or STRES.EXE Module

Multiple load cases are activated with the asymmetric option. Only one 
load case may be activated.

Use the LCSET (Analysis, Static, Activate Load Case) command to make 
sure that only one load case is active for analysis.

STAR.EXE Module

Consistent Mass formulation is not available for SHELL6 elements.

Use the analysis command (Analysis, Frequency/Buckling, Frequency 
Options) to specify the lumped mass option. You may instead remesh your 
model with SHELL3T or SHELL9 elements and keep the consistent mass 
formulation option. 

STAR.EXE Module

The 8/9 node isoparametric shell element (SHELL9) does not support the 
consistent mass option.

Use the analysis command (Analysis, Frequency/Buckling, Frequency 
Options) to specify the lumped mass option. You may also replace the 
SHELL9 element with a lower order element such as SHELL4T which 
supports the consistent mass option.

 STAR.EXE Module

The 8/9 node isoparametric layered shell element (SHELL9L) does not 
support the consistent mass option. 

Use the analysis command (Analysis, Frequency/Buckling, Frequency 
Options) to specify the lumped mass option. You may also replace the 
SHELL9 element with a lower order element such as SHELL4T which 
supports the consistent mass option.
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Stop - Determinant of 
Jacobi Equal To Zero 
For Element <Number>

Stop - D.O.F. for Super 
Nodes Did Not Match. 
At Supper Element   
<Number>

STOP - Element Area 
Is Smaller Than 
Tolerance <Value>, 
Element <Number>

Stop - Error In Reading 
Displacement File (.LC1) 
STAR.EXE Module

The determinant of the Jacobian matrix for the specified element is equal 
to or less than zero.

The element may have excessively distorted elements or elements with zero 
area or volume. List and plot the element, check its connectivity and shape. 
You may need to remesh or redefine the element.

STAR.EXE Module

The number of degree of freedom for the specified superelement does not 
match between the two internal files.

The database may be corrupted. Start a new problem, load the session file 
using File-Load and try again.

STAR.EXE Module

The surface area of the specified element is smaller than the tolerance 
value. Elements smaller than specified value cause numerical difficulty in 
the computation and should be avoided. 

Check the following:

1.Check the mesh to make sure that all the nodes of the specified element 
are not collinear.

2.Check to see whether this problem is happening only for a few elements, 
you may be able to modify the mesh locally to produce larger size 
element(s).

3.If many elements have this problem, then may be the overall dimensions 
of the model is very small, you may regenerate your model using a smaller 
unit of length, and remesh the model. In this case, you also need to modify 
your material properties accordingly. 

4.In case you have a very fine mesh with a lot of elements, check the 
possibility of meshing with a larger element size without compromising the 
accuracy of the solution.

STRES.EXE Module

The problem-name.LC1 stores displacements for asymmetric problems. An 
error was encountered in reading this file.

Rerun the problem again to calculate displacements and stresses. Contact 
SRAC if the problem persists.
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D-28

Stop - Error In The 
Element Connectivity 
At Element <Number> 
Please Check The 
Output File For 
Detailed Information.

Stop - EX Is Equal To Zero 
For Element: <Number>

Stop - File .DIA 
Not Available

STOP - For Tetra, 
Polynomial Order 
<Number> Is Not 
Available Yet

STOP - Improper 
Crack. See Output 
File

Stop - Improper Real 
Constant Set Is 
Used For Beam 
Element <Number>
STAR.EXE Module

The specified element has improper connectivity.

List the element and check its nodal connectivity and associated element 
group. The output file provides the coordinates of the associated nodes for 
your review. If you created the element manually (not through meshing), 
check the order of the nodes.

STAR.EXE Module

Modulus of elasticity (EX) is not defined or is smaller than 1.e-20 for the 
specified element.

List the element to find out the associated material set. Use the PropSets 
menu to define a proper value of EX for the specified material set.

DSTAR.EXE Module

The problem-name.DIA file contains the diagonal of the stiffness matrix. 

Make sure that the STAR.EXE module was completed successfully prior to 
running the DSTAR.EXE module. If you are running the modules 
interactively (i.e., one by one outside GEOSTAR), make sure that you did 
not skip the STAR.EXE module.

STAR.EXE Module

The specified order for P-method is not available for Tetrahedral elements 
in this version. The maximum order for this type of element is 6 at present.

Use a polynomial order of 6 or smaller for Tetrahedral elements.

STAR.EXE Module

For a 3D-Crack element the three nodes defining the geometry of the crack 
are collinear.

Check the end of the output file for error messages to find the number of the 
crack element which has this problem. List the crack element and the 
associated solid element and check the nodal connectivity. Fix the error and 
try again.

STAR.EXE and STRES.EXE Module

The entries in the real constant set associated with this beam element are 
invalid. 

List the element to find out the associated real constant set and then list the 
real constant and examine its entries. Fix the problem by redefining the real 
constant set or associating the element with a valid real constant set.
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Stop - Invalid 
Element Type With 
Asymmetric Loading

STOP - Invalid PLANE2D 
Element Option For 
Asymmetric Loading

STOP: J-integral Is 
Not Available With 
Centrifugal Loads

STOP: J-integral Is 
Not Available With 
Gravitational Loads

STOP: J-integral Is 
Not Available With 
P-Methods
STAR.EXE or STRES.EXE Module

You have activated the Asymmetric option in your problem and your model 
contains element types that are not supported by the asymmetric option. 
The supported element types are: axisymmetric shell elements 
(AXISHELL) and rectangular plane elements (PLANE2D) only.

Remove or replace the incompatible elements and try again.

STAR.EXE or STRES.EXE Module

You have activated the asymmetric option in your problem but a wrong 
option was specified for a PLANE2D element group. Available options of 
PLAN2D elements are: Plane Stress, Axisymmetric, Plane Strain and 
Asymmetric. 

Use the EGROUP command (Propsets, Element Group) to select the 
Asymmetric option for PLANE2D element groups and try again. 

STRES.EXE Module

Body forces such as centrifugal loads are not supported in this version of 
COSMOS/M for the J-integral consideration. 

The only valid types of loads are concentrated loads, pressures and 
Thermal loads.

STRES.EXE Module 

Body forces such as gravitational loads are not supported in this version of 
COSMOS/M for the J-integral consideration. 

The only valid types of loads are concentrated loads, pressures and thermal 
loads.

STRES.EXE Module 

You are using the J-Integral with a P-method. The J-integral is available 
only with the H-methods. The valid elements are the PLANE2D and 
TRIANG types. 

Change the P-method to H-method and run the problem from the beginning 
(including the displacement calculations).
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D-30

Stop - KG Is Not Available 
For The SOLIDL Element

STOP - Maximum Node 
Number Exceeds The 
Limits

Stop - Missing File 
<Name.ext>

STOP - Modal RMS 
Disp. File Does Not Exit

Stop - Moment Of Inertia,
<Component> Is Equal 
To Zero <element>
STAR.EXE Module

The KG (Geometric Stiffness) is evaluated for buckling problems and 
linear static or frequency problems with active in-plane loading effects. 
Geometric stiffness is not calculated for SOLIDL elements. Therefore, you 
can not use this element for such problems. 

You may be able to use composite shell elements like SHELL3L, SHELL4L, 
or SHELL9L instead. Otherwise, remodel your geometry and use regular 
solid elements.

STAR.EXE Module

The number of nodes in your model is larger than the maximum allowable 
number.

Start a version that supports more nodes (the 128K or the 256K node/
element versions in your COSMOSM program group). Or remesh with a 
larger element size.

STRES.EXE Module 

The specified file could have one of the three extensions: “DIS”, “EIG” or 
“IDA”. The “DIS” corresponds to the internal file generated during the 
displacement calculation. If this file is missing, then most likely you have 
not run STAR to calculate displacements. The “EIG” extension 
corresponds to the internal file for the frequency analysis and “IDA” 
corresponds to the file storing the ID Array (relating the nodal d.o.f’s to the 
global d.o.f.’s).

Check your data and run static analysis again (displacements and 
stresses).

STRES.EXE Module 

The file including the modal displacement response from Random 
Vibration analysis is not available. 

Make sure to perform Random Vibration analysis successfully prior to 
running the stress module.

STRES.EXE Module

The specified component of cross-sectional inertia was not defined or was 
defined with a value of zero for the specified element.

Inertia component could be either IY or IZ. List the Real Constant sets, 
define the missing components and then run full static analysis 
(displacements and stresses).
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Stop, More Than <Number> 
Layers Are Used For A 
Shell9l Element <Number>

STOP - NBLK2 Exceed 
The Limit <Number> 
NBLK2 = <Number>

 Stop - Node File 
Is Not Available

Stop - Number Of 
Blocks Exceed The 
Limit: <Number>

Stop - Old Shift Is Diff. 
Than The New One. Run 
The Problem From The 
Beginning (Including 
The NSTAR Run) 
STAR.EXE Module

The number of layers in the specified element exceeded the limit.

List the element and redefine its real constant set. If you need more layers 
than the limit, consider remodeling your geometry and use multiple layers 
of elements.

STAR.EXE Module

It indicates that the number of stiffness blocks (NBLK2) is larger than the 
specified limit for a piezoelectric problem. The problem size is too large. 

Reduce the size of the problem or increase the size of memory. Increasing 
the size of memory reduces the number of blocks needed to solve the 
problem.

RENUM.EXE Module 

The absence of the node file indicates that the mesh has not been generated 
prior to running of the analysis. 

Make sure that the FEA model is properly defined before running analysis.

STAR.EXE Module

The number of blocks needed to store the stiffness matrix exceeds the 
specified limit.

Increase the size of each block by freeing more memory or adding more 
RAM. If you used the Large File Management utility and had intentionally 
reduced the size of the block, then you may want to increase it and try again.

DSTAR.EXE Module

You have requested the use of the stiffness matrix generated by the 
nonlinear analysis module NSTAR. The flag is controlled by the 
A_FREQUENCY command (Analysis, Frequency/Buckling, Frequency 
Options) or the A_BUCKLING command (Analysis, Frequency/Buckling, 
Buckling Options). If you apply a frequency shift in your first run, thus 
altering the stiffness matrix, then you can not rerun DSTAR for a second 
time using a different shift value unless you rerun the NSTAR to update the 
stiffness matrix prior to running DSTAR

Use the same shift as in the first analysis, or run NSTAR and DSTAR again 
with the desired shift value.
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D-32

STOP - PRE1 Program 
Has Not Completed 
Successfully

Stop - Problem Is Too Large 
For The Program (Lanczos)

STOP - Problem Too Large 
For The <Type> Version. 
Number Of Nodes For This 
Problem: <Number>. Limit 
on the number of nodes (for 
this version): <number>

Stop: Requested Harm. 
Type (COS/SIN) For 
Stress Calcul. Is Not 
The Same As Originally 
Considered In Disp. 
Calcul.
STAR.EXE Module

The STAR.EXE program is one of several modules executed for Static, 
Frequency and Buckling problems. In performing static analysis, the 
following modules are executed sequentially:

RENUM.EXE, PRE1.EXE, STAR.EXE, and STRES.EXE

In performing frequency and buckling problems the following modules are 
executed sequentially:

RENUM.EXE (optional), PRE1.EXE, STAR.EXE, DSTAR.EXE and 
STRES.EXE 

If the PRE1.EXE module is not successfully completed, then the above 
error message will be displayed by STAR.EXE

Check the output file (problem-name.OUT) for possible messages from 
PRE1. Check and fix the error. Also check your disk space.

DSTAR.EXE Module 

The problem is too large.

Either reduce the number of frequencies or increase the size of available 
memory.

STAR.EXE Module

The number of the nodes in this problem is larger than the limit for this 
version of COSMOS/M. 

GEOSTAR versions that support 64,000, 128,000, and 256,000 nodes/
elements are available in your COSMOSM directory. If you are not using 
the 256,000 nodes/elements version, make sure to use it from the 
COSMOSM program group. Otherwise contact SRAC.

STRES.EXE   Module 

There are three options for asymmetric problems: Sine terms, Cosine terms 
and combination of Sine and Cosine terms. Once you calculate the 
displacements using one of these options, you can not switch to a different 
option for calculating stresses.

Use the A_ASYM command (Analysis, Static, Asymmetric Load Options) to 
specify the use of the same option you used in calculating displacements 
and then run STRESS again.
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STOP - Singular Matrix For 
SHELL4L/SHELL3L Elemen
<Number>, Layer <Number>

Stop - Stiffness 
File (.udf) Not 
Available

Stop - Stiffness Matrix 
Is Singular At Equation 
<Number> Node = 
<Number> Direction = 
<Number> Check The 
Troubleshooting 
Section Of The Manual.
STAR.EXE Module

The stiffness matrix for these elements is not positive definite and hence not 
valid.

List the element to find out the associated real constant set and then list the 
real constant set to find the material set for the specified layer. List the 
material property set using the MPLIST command (PropSets, List Material 
Props) and check the validity of the elastic properties. Specify proper valid 
entries and rerun the problem. 

DSTAR.EXE Module

You have requested the use of the stiffness matrix generated by the 
nonlinear analysis module NSTAR for frequency or buckling analysis. The 
flag is controlled by the A_FREQUENCY command (Analysis, Frequency/
Buckling, Frequency Options) or the A_BUCKLING command (Analysis, 
Frequency/Buckling, Buckling Options). The problem-name.UDF file 
which contains the stiffness matrix generated by NSTAR was not found.

Verify that nonlinear analysis has been performed successfully on the same 
problem or deactivate the corresponding flag in the A_FREQUENCY 
command (Analysis, Frequency/Buckling, Frequency Options) or the 
A_BUCKLING command (Analysis, Frequency/Buckling, Buckling 
Options).

 STAR.EXE or DSTAR.EXE Module

Your stiffness matrix is singular (has zero or negative diagonal) at the 
specified equation (d.o.f.).

Check the following possibilities:    

1.You may have unattached node(s) or undefined element properties.    

2.You may need more constraints or you may want to turn on the soft-spring 
option in the relevant analysis option command.

3.You may have run out of disk space.

4.You may have assigned incompatible orthotropic material properties.

5.You may have activated in-plane loading and specified excessive loading 
which resulted in large displacements. 

6.You may have excessive spin softening if the corresponding flag is on (i.e., 
Angular velocity may be too large.)

The value of the diagonal term causing the singularity is recorded in the 
output file (problem-name.OUT).

t 
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D-34

STOP - Stress Not 
Available In Old File For 
Loadcase <Number>

STOP - Submodeling 
Is Not Available With 
Asymmetric Option

STOP - Submodeling 
Not Available With 
Substructuring Option

Stop - Temperature Is 
Greater Than Defined 
In The Curve

Stop - Temperature 
Is Smaller Than 
Defined In The Curve

Stop - The Latest Requested
Harmonics May Not Be 
Included In Originally 
Requested Harmonics For 
Which Disp. Is Calculated
STRES.EXE Module 

The old file corresponds to the stress plot file from the previous run. The 
present submodeling analysis can not read the stress results for the 
specified loadcase in that file. 

You may not have previously run the problem for the specified load case.

STAR.EXE Module

You have activated submodeling for an asymmetric problem. The two 
options may not be activated simultaneously.

Deactivate submodeling or the asymmetric option. This version does not 
support these two options together.

STAR.EXE Module

You have activated submodeling and substructuring for this problem. The 
two options may not be activated simultaneously.

Deactivate submoldeling or substructuring. This version does not support 
these two options together. 

STAR.EXE Module

The temperature curve does not cover the upper range of temperatures in 
your model. 

List your temperature curve making sure that it covers the full temperature 
range.

STAR.EXE Module

The temperature curve does not cover the lower range of temperatures in 
your model. 

List your temperature curve making sure that it covers the full temperature 
range.

STRES.EXE Module 

After calculating the displacements using a number of harmonics for 
asymmetric problems, you may speed up the stress calculation by running 
stress only while considering a number of harmonics that is smaller the 
number used in displacement calculations. The range of the harmonics in 
the stress calculation, however, should be within the range considered 
during displacement calculations. Displacement results must be available 
for each harmonics considered in stress calculations. 

Modify your input using the A_ASYM command (Analysis, Static, 
Asymmetric Load Options).

 

COSMOS/M Basic FEA System

http://www.cosmosm.com


Part 1   Linear Statics, Modal, and Buckling Analysis

STOP - Thermal Option 
Is Not Supported With 
AXSHELL Element

Stop - Thickness Equal 
To Zero For Pipe 
Element <Number>

Stop- Use A_STRESS 
To Specify The Layer 
Number For XY-PLOT

STOP - Zero Crack 
Length, See Output 
File

Submodeling Not 
Available With Frequency
/Buckling Analyses 

Temperature Dependent 
Materials Not Available 
With TETRA4R Use 
TETRA4 Or TETRA10 
Instead
STAR.EXE Module

The axisymmetric shell element (SHELLAX) does not support thermal 
loads. 

You may replace the SHELLAX element with the PLANE2D (axisymmetric 
option) element for which thermal loading is supported. 

STRES.EXE Module 

The thickness is not defined for the specified PIPE element. 

List the element to find out the associated real constant set, redefine the set 
by entering a valid value for the thickness, and run full static analysis 
(displacements and stresses).

STRES.EXE Module 

For dynamic problems modeled with multiple-layered elements, stress 
graphs (xy-plots) are available only for a user-specified single layer. 

Use the A_STRESS command (Analysis, Static, Stress Analysis Options) to 
specify the desired layer and rerun the stress module.

STAR.EXE Module

The length of a 3D CRACK element is smaller than the allowable limit of 
1.0E-6. The three crack nodes may not represent a face of a solid element 
or they are not associated properly with the proper element.

Check the end of the output file for error messages to find the number of the 
crack element which has this problem. List the crack element and 
associated solid element and check their nodal connectivity. Fix the error 
and try again.

STAR.EXE Module

Submodeling is only available for static analysis.

 Deactivate Submodeling prior to running frequency or buckling analysis.

STAR.EXE Module

You have defined temperature-dependent material properties for a material 
set which is associated with the TETRA4R element type. This version of 
COSMOS/M does not support temperature-dependent material properties 
for TETRA4R elements.

You may use TETRA4 or TETRA10 elements instead of TETRA4R elements. 
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D-36

TETRA Stress for Random
Vibration in Global 
Cartesian Coord. Only

Thermal Expansion 
Coefficient (ALPX) is 
Smaller Than 1.0e-30 for 
Element <Number>. Check 
Material Group <Number>

Thermal Flag Is Not 
Consistent With The 
One Considered During 
The Displacement 
Calculation

Total No. Of Integ. Pts. 
Along All J-paths Larger 
Than Limit <Number>

Total Number Of 
Integration Paths For 
J-integral Larger 
Than <Number>

Two Gaps Are Sharing 
The Same Node (See 
Output File)
STRES.EXE Module 

You have requested stresses for Random Vibration analysis to be calculated 
in a local coordinate system. For Tetrahedral elements, stresses may only 
be requested in the global Cartesian coordinate system for Random 
Vibration analysis.

Switch the flag from local to global in the corresponding element group 
command and rerun the stress module again (no need to run the pre-stress 
analysis again). You may request the stresses in the desired coordinate 
system during postprocessing.

STAR.EXE Module 

The coefficient of thermal expansion is too small. It must be larger than 
1.0E-30.

Check the specified material group using the MPLIST command (PropSets, 
List Material Props). Use the PropSets menu to pick a material from the 
library or define an acceptable value for the coefficient of thermal 
expansion ALPXEX, and try again. 

STRES.EXE Module 

It indicates that the thermal loading flag (in Analysis, Static, Static 
Analysis Options) has been changed (activated or deactivated) after 
calculating displacements and prior to running the stress analysis. This 
results in inaccurate results.

Change the flag to what it was originally and rerun the stress module 
(STRES.EXE) only (Analysis, Static, Run Stress Analysis). If the status of 
the flag is not the desired one, set as desired and run complete static 
analysis again.

STRES.EXE Module 

The total number of integration points along all J-integral paths is larger 
than the specified limit. 

Use the Analysis, J_integral menu to reduce the number of integration 
points and run STRES.EXE module. 

STRES.EXE Module 

The number of J-integral paths is larger than the limit.

Use the Analysis, J_integral menu to reduce the paths to be within the 
specified limit and rerun the STRES.EXE module. 

STAR.EXE Module
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Unable To Open 
Temperature File (.HTO)

Unable To Read 
Temperature File (.HTO)

Unable To Read 
Temperature File 
Records (.HTO)

Undefined Coordinate 
System Used To Apply 
CPDOF Command At 
Node: <Number>
This message indicates that a node is shared by two gaps which is not 
supported in this version of COSMOS/M. The two gaps and the sharing 
node are specified in the output file. 

You may be able to connect one of the two gaps to a different node without 
changing the behavior of the problem significantly (you may be able to 
change the mesh locally for that purpose). 

STAR.EXE or STRES.EXE Module

The problem_name.HTO contains nodal temperatures. It is generated by 
thermal analysis (HSTAR or FFE Thermal). STAR and FFE Static may use 
this file to calculate displacements, strains, and stresses due to thermal 
loading specified by this file. STAR could not open this file. The file was 
not generated or was deleted or modified after generation.

Run thermal analysis. Check your input for the TEMPRead command 
(Loads-BC, Load-Options, Read Temp. As Load). View temperature results. 
and run static analysis again.

STAR.EXE or STRES.EXE Module

See the: “Error in reading temperature file (.HTO)” message.

Check your input for the TEMPRead command (Loads-BC, Load-Options, 
Read Temp. As Load) making sure that to ask for loading of an existing time 
step. View or list the results of thermal analysis and then try static analysis 
again.

STAR.EXE Module

The file exists but STAR is unable to read the desired records. See the: 
“Error in reading temperature file (.HTO)” message above.

Check your input for the TEMPRead command (Loads-BC, Load-Options, 
Read Temp. As Load) making sure that to ask for loading an existing time 
step. View or list the results of thermal analysis and then try static analysis 
again.

STAR.EXE or STRES.EXE Module

The local coordinate system used to specify coupling at the specified node 
is not defined.

List the coupling set to find the undefined coordinate system, define the 
coordinate system and try again.
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D-38

Unsuitable Element For 
ASME Check (Use 
PLANE2D Or TRIANG)

Wall Thickness Is 
Equal To Outside 
Diameter For Elbow 
Element <Number>

Warning-assigned Penalty 
Term For Stiffness For 
Local Constraint May Not 
Be Large Enough To 
Ensure Proper Results, At 
Node <Node>, Direction 
<Number>

Warning-coupled Nodes 
Outside Of Submodel 
Ignored, Set <Number>

Warning - D Matrix Is 
Not Positive Definite 
For Element <Number>
STRES.EXE Module 

Only the axisymmetric PLANE2D and TRIANG elements support the 
ASME Stress Check. 

Deactivate the ASME Stress Check flag or use one of the supported 
elements. If you need to modify the type of element, make sure to run full 
static analysis on the problem (displacements and stresses).

STAR.EXE Module

The specified ELBOW element is invalid because the thickness of the 
element is equal to the outside diameter making the inside diameter zero.

List the element to find out the associated real constant set and then modify 
the real constant set by inputting acceptable parameters.

STAR.EXE Module

This is only a waring message. The value assigned for the penalty function 
applicable for local constraints may not be large enough to ensure proper 
results. The Maximum violation of the constraints occurred at the specified 
degree of freedom and it is larger than 1/200 of the maximum deformation 
in the structure.

You may improve the results by increasing the Penalty value (stiffness 
constant) in the A_STATIC command (Analysis, Static, Static Analysis 
Options).

STAR.EXE Module

This is only a warning message. It indicates that some of the nodes 
associated with the specified coupling set are outside of the submodel. 
During the submodeling analysis, the only nodes that will be considered in 
the coupling are those which are part of the submodel.

List the coupling sets and verify that your input is valid.

STAR.EXE and STRES.EXE Module

The Elastic Matrix which relates the Stress tensor to the Strain tensor is not 
positive definite for the specified element.

List the element to find out the associated material set, and then check the 
values of the material properties such as moduli of elasticity, Poisson’s 
ratio, and shear moduli. 
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Warning - In Substructuring
No. Of Reactions Are 
Limited To: <Number>

Warning- Material 
Strengths Not Defined 
For Failure Analysis

WARNING! Non-
existent Drive

Warning - Sandwich 
Formulation Ignored 
For Anisotropic Plate 

WARNING: Steady State 
Thermal Solution Is Not 
Associated To Any Load 
Case (You May Use 
TEMPREAD Command 
To Do So) 

Warning, Sturm 
Sequence Check Can 
Not Be Performed 
For Negative Shift
STAR.EXE Module

This is only a warning message. You are running a Substructuring problem 
with the number of support reaction d.o.f. larger than the specified limit for 
such problems.

The program calculates only the maximum number of reactions as specified 
be the given number.

STRES.EXE Module 

For a layered element the Failure analysis could not be performed because 
the strength of the material is not defined. 

The program will ignore the request for Failure Analysis and compute 
stresses as usual.

STAR.EXE Module

One of the requested drives specified by the SELDIR (Control, 
Miscellaneous, Select Dir for Partition) command, for use with the Large 
File Management utility, does not exist on your machine.

Correct the error by using the SELDIR command again.

STAR.EXE or STRES.EXE Module

The sandwich formulation option specified in the element group will be 
ignored if you provide the elastic matrix directly. If the matrix is not 
directly provided, the program will use the specified formulation to 
calculate the stiffness matrix as usual.

No action is needed.

STAR.EXE Module

This is only a warning message. Thermal loading was activated but it will 
be ignored because thermal loading from steady thermal analysis is not 
available for any active load case.

Use the TEMPREAD command (Loads-BC, Load-Options, Read Temp As 
Load) to assign a temperature profile from thermal analysis to a load case.

DSTAR.EXE Module

The program ignores the request of Sturm Sequence Check and terminates 
after calculating and storing the frequencies and mode shapes. 

You may correct the shift and rerun the problem.

 

COSMOS/M Basic FEA System D-39

http://www.cosmosm.com


Appendix D   Troubleshooting

D-40

Warning: Undefined 
GXZ Is Equated To 
GXY For material set: 
<Number>

Warning: Undefined NUXZ 
Is Set To 0 For Orthotropic 
Material Set: <Number>

WARRING - Zero Mass 
(Less Than <Value>) For 
Element <Number>
STAR.EXE or STRES.EXE Module

This is only a warning message. For the specified orthotropic material set, 
the undefined Shear Modulus GXZ is set equal to GXY. If the GXY itself 
is not defined for the specified set, then: the following equation is used:

GXZ=GXY=(EX*EY)/(EX+EY+2*NUXY*EY), where EX and EY are   
the modulus of elasticity in the X and Y directions, and NUXY is the 
poisson’s ratio. 

Since the set numbers are displayed one after another (for the sets with 
undefined GXZ), thus overwriting the previous set number. Consequently, 
the displayed set number is not necessarily the only one with this problem 
Refer to the output file for the complete list of the sets with undefined GXZ. 
Notice that the warning message is only displayed when the program 
considers the material set to be orthotropic. A material set is considered 
orthotropic when:

One of the three modulus of elasticity (EX, EY and EZ) differs from the 
others (if EY or EZ are not defined, then the undefined modulus is 
considered to be equal to EX).

One of the three Poisson’s ratios NUXY, NUYZ and NUXZ differs from the 
others (if NUYZ or NUXZ are not defined, then the undefined ratio is 
considered to be equal to NUXY). 

One of the three coefficients of the thermal expansion (ALPHAX, ALPHAY 
and ALPHAZ) differs from the others (if ALPHAY or ALPHAZ are not 
defined, then the undefined coefficient is considered to be equal to 
ALPHAX)

STAR.EXE module. 

This is only a warning message. For the specified orthotropic material set 
the undefined Poisson’s ratio NUXZ is considered to be zero. This warning 
message is displayed for each set with this problem. Consequently, the 
displayed set number is not necessarily the only one with this problem.

Refer to the output file for the complete list of sets with undefined NUXZ. 
For conditions which constitute a material set to be orthotropic, refer to the 
message: “Warning: Undefined GXZ Is Equated To GXY For material set: <Number>”.

STAR.EXE Module

This is only a warning message indicating that the mass of the specified 
element is too small.

The mass of an element is either calculated from the density (material 
property) or as a point element, like MASS, is specified by the associated 
real constant set.
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Warping Correction 
Applied For Small Warping
At Element <Number>

Wrong Edge Of Element 
Has Zero Length, 
Element <Number> (Edge 
Connecting The Element 
<Node_order> And 
<Node_order > Nodes)

Wrong Nodal Connectivity 
For Collapsed Element 
<Number> (Only Third 
And Forth Nodes May Be 
Collapsed. Use ECHECK)

Wrong Nodes Collapsed, 
At Element <Number> 
(Issue The ECHECK 
Command Prior To 
Running The Problem)
STAR.EXE Module

This is only a warning message indicating that Warping Correction was 
applied in order to get acceptable results for this element. See also the 
comments for the error message. “Large warping, use QUAD4 element; 
twisted element<number>”

No action is needed.

STAR.EXE Module 

The edge specified by its two end nodes for the specified element has a 
length smaller than 1.e-30. 

List the specified element and check the validity of its nodes and their 
connectivity. Check the coordinates of the nodes at the two ends of the 
specified edge. If the element is essentially a 4-noded element, then 
rearrange the nodes to form a triangular element with the third and fourth 
nodes collapsed. The ECHECK command (Meshing, Elements, Check 
Element) will fix this error.

STAR.EXE Module

The data for the specified element indicates that a triangular element is 
constructed from an originally rectangular element by collapsing two of its 
nodes. 

Check whether the collapsed nodes are the third and forth nodes. Any other 
combination of collapsed nodes is prohibited. As is suggested in the error 
message you may simply use the ECHECK command to fix the problem.

STAR.EXE Module 

For the specified 4-noded element, wrong corner nodes are collapsed to 
form a triangular-shaped element. For this type of element, only the third 
and forth corner nodes are allowed to collapse. Refer to Element Library 
chapter in the COSMOS/M User’s Guide for details.

List the element and check the validity of its nodes and their connectivity. 
The ECHECK command (Meshing, Elements, Check Element) may fix this 
error. 
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D-42

Wrong Nodes Collapsed  
To Form Prism In Solid  
Element <Number> (Use  
The ECHECK Command  
To Fix The Problem)

Wrong Nodes Collapsed 
To Form Pyramid In Solid 
Element <Number>

Zero Length Between 
Nodes 1-2 In Element 
<Number>

Zero Length For 
Beam Element 
Number <Number> 
Execution Aborted
 STAR.EXE Module

The data for the specified element indicates that a prism is intended to be 
constructed from wrong nodes. Only nodes 3 and 8 may be collapsed on 
face 1 and nodes 7 and 8 on face 2, to form a prism. Any other combination 
of nodes is invalid.

List the element and check its nodal connectivity. Use the ECHECK 
command to fix the order of collapsed nodes and rerun the problem

STAR.EXE Module

The data for the specified element indicates that a pyramid is intended to be 
constructed from wrong nodes. Only nodes 5, 6, 7 and 8 may be collapsed 
to form a pyramid. Any other combination of nodes is invalid. 

List the element and check its nodal connectivity. The ECHECK command 
may fix the problem

STAR.EXE and STRES.EXE Module

The length of the edge defined by the first and second corner nodes of the 
specified element is too small.

List the element and check whether the first and second nodes are 
coincident. If the model is actually too small, use a smaller unit of length. 
Note that the first and second nodes are not allowed to collapse for 
rectangular elements (only the third and fourth nodes may collapse).

STAR.EXE or STRES.EXE Module

The length of the specified beam element is smaller than the allowable limit 
of 1.0E-20.

Make sure your dimensions are correct. If so, use smaller units and modify 
your material properties accordingly.
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